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Introduction 

What is new in this release 
• Backup Manager Preferences 

 

About PrintSmith Vision 

PrintSmith™ Vision is a browser-based print management system for commercial printers, trade printers, copy 

shops, and quick printers. To help you run your business efficiently and profitably, PrintSmith Vision combines 

estimating, invoicing, billing, point of sale, and accounts receivable in a single product.  

 

PrintSmith Vision supports commercial printers, trade printers, copy shops, and quick printers. It provides the 

features needed in commercial printing (like support for web presses, digital presses, and large format presses) 

without requiring that you use or understand features that do not apply to your business. As your business grows 

and changes, however, PrintSmith Vision is flexible enough and powerful enough to grow with you.  

 

About Estimates and Invoices 

Estimates are quotes you give to prospective customers indicating what you will charge for the work they want 

you to perform. 

Invoices show the actual price of the job and then serve as a bill for the work you performed. 

Note: Because estimates and invoices in PrintSmith Vision are so similar, this manual often uses the 

term document to refer to them. 

 

An estimate or invoice may include more than one job, and typically also includes some charges related to the 

work involved, for example, a charge for design work, ink, cutting, or boxes.  

In many situations, estimates are unnecessary. If you know you have the job, you can just create an invoice for 

the customer. For complex work, however, estimates help you determine an accurate selling price as well as give 

you a way of submitting bids based on different quantities and different stock. If the customer accepts your quote, 

you convert the estimate to an invoice, meaning the estimate is won; If the customer rejects the quote, the 

estimate is archived (as part of the customer’s estimate history) and considered a loss.  

 
Tip: For small simple jobs, you can use POS (point of sale) in PrintSmith Vision to record a sale and print out 

a cash register style receipt. In this case, you typically bypass invoices altogether since the cost of 

preparing the invoice could exceed the amount of the order. 

 
The content of estimates and invoices is very similar, as is the procedure for creating them. Estimates and 

invoices each have their own numbering system, however, and they are handled differently in the system.  

 
Warning: If you use pre-printed forms for your estimates or invoices, they should not be numbered; PrintSmith  

Vision automatically assigns numbers to both estimates and invoices.  

 

Accurate estimating is a key part of the sales cycle. In PrintSmith Vision, you can create a simple quote quickly, 

as well as perform sophisticated estimating when you are bidding for jobs.  

PrintSmith Vision comes with a completely defined pricing system with definitions and functions for everything 

from prepress to packaging. This pricing system can be adapted to your business, so you are not defining the 

system from scratch. 
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You can price products, services, or materials using any combination of pricing methods such as flat rate, cost 

plus markup and/or rate, hourly rates, variable markups, and price lists. You can use the pre-press and bindery 

charges supplied by EFI, adapt them, or create your own. Likewise, you can use or adapt the stock, press, digital 

definitions, and price schedules supplied by EFI or create your own. 

 

About Estimating History 

The Estimate History report provides a record of the estimate activity for each customer or prospect. Use this 

report to answer questions about past estimates, to determine when a particular estimate was entered, to see 

whether an order was won or lost, or to open an old estimate and re-use its information in a new estimate or 

invoice. 

 

About Cash Register 

If your shop does walk-in business that does not require invoices, you record the work and payment for it in the 

Cash Register window. You can use this window for any work that does not require an invoice. 

Cash Register in PrintSmith Vision provides all the functions you normally expect of a dedicated cash register. 

You can enter sales and payments, keep a record of each transaction, print receipts, process credit cards, and 

open a cash drawer. 

Note: Integrated credit card processing, the cash drawer, and the receipt printer are optional purchases.  

Because the cash register is part of PrintSmith Vision rather than a dedicated machine, PrintSmith Vision can 

provide a detailed breakdown of each transaction by date/time, the person who performed it, what was done, and 

the account to which the transaction was posted. If you have an external cash regi ster, you can use POS to enter 

the totals from the register into PrintSmith Vision; this information then becomes part of the detailed sales analysis 

that is typically performed each day. 

Even if you have no need for a cash register, the cash register program serves as a link between estimating and 

accounts receivable by tracking each estimate and the status of all jobs in progress and those awaiting pickup or 

delivery. When an invoice is delivered to a customer and picked up in PrintSmith Vision, it is automatically posted 

to accounts receivable and added to the full account history for each customer. 

 

About Post Payments 

When you post invoices and charge them to an account you are creating an account receivable for that account. 

When the customer pays what was charged, you must apply the payments against the invoices, so they are 

recorded as Accounts Receivable receipts. This process reconciles the money you received with the money that 

was due (as recorded in your invoices). In PrintSmith Vision this is known as posting payments. 

Why posting payments is important 

A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up 

invoices without applying them to invoices. This has some undesirable side effects:  

• Invoices that were paid are still shown as open and may cause the account to become past due when it 

really is not. 

• Customers may not understand statements that include invoices they think they paid. 

• The receipt is considered “on account,” and is not included as a taxable cash receipt in Accounts 

Receivable. 

 

About Journal Entries 

A journal entry is a new transaction that counteracts or reverses the original transaction. Journal entries result in 

debit or credit memos. They are used to adjust the total due on an invoice, add or remove tax from an invoice 

after posting, write off bad debts, adjust account balances, and so on. 

 

About Register Tape 

PrintSmith Vision keeps a detailed record of all transactions for each sales “day” on an electronic register tape. A 

sales day ends when you perform a closeout and a new tape is started. The register tape records significant 
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events such as deposits, document voids, posted payments, finance charges, and journal entries. When you 

post transactions in the Cash Register window they are recorded on the register tape.  

 

About Closeout 

A closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or 

month. They can also be set up to do manually or automatic.  

 

About Pending Documents 
When you first create a new document, PrintSmith Vision puts it on the pending list. This list includes all the 

“active” invoices and estimates in your shop and is displayed in the Pending Documents window. This window 

is your “command center” in PrintSmith Vision for working with active documents.  

 
Tip You can also view a summary of the pending list from a mobile device. 

Eventually, each document in the Pending Documents window is removed as follows:  

• You convert estimates to invoices if you get the job, or void (cancel) or archive them if you do not get 

the job. You can track archived estimates in estimate history. 

• As work on invoices is completed, you pick up the invoices and indicate they were paid. You can track 

picked up and paid invoices in the history that PrintSmith keeps for accounts.  

The documents in estimate or account history are “locked” since they form part of the audit trail PrintSmith 

Vision maintains. All details in the document are retained, however, and you can copy these documents to new 

estimates or invoices. You can update the pricing with the latest prices when you copy a document, but all the 

descriptive information and notes you made on the job (the location and condition of the artwork, special pricing 

instructions, and so on) are retained. 

When you copy a document from history, PrintSmith Vision keeps track of the source document. For example, 

the old document number is displayed in the document window and printed on job tickets. If you file artwork by 

document number, and get a repeat order, the job ticket has the old document number so you can locate the 

artwork. 

 

About Web Product Templates 

Web products templates are set up under the Template section. You can create web product templates and map 

them to Market Direct StoreFront products. When your customer purchases a MDSF product the information from 

that mapped template is used to create an invoice document.  

 

About Purchase Orders and PO History 

Many jobs require items such as paper or ink that you must purchase. To help you manage the purchasing 

process, you can create purchase orders in PrintSmith Vision for the kinds of supplies or outside services that 

you typically need for the jobs you produce. Purchase orders can be created in the Invoice program and in PO 

history. 

The PO history will show you the current and closed purchase orders. Here you can v iew a specific purchase 

order and modify or change the status. There are several column headers that can be used to filter or search 

for purchase orders. 

 

About Quick Access Panel 

Quick Access panel not only provides shortcuts to your most commonly used features, it provides a view of the 

status of orders taken by the logged in user or for the entire plant. Quick Access includes:  

• Estimate, invoice totals and total orders for the previous day and current day. 

• Year to date and month to date totals of orders, sales, and journal entries.  

• Lists of invoices due today, overdue, and optional custom field. 
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• A list of estimates still in a pending state, with the ability to open and review them. When an estimate is 

open, you can convert it to an invoice so you can go ahead and produce the job and bill the customer. 

• A log of the communication that has taken place with customers, with the ability to follow up on issues. 

 

About Work in Progress 

Work in Progress displays the open jobs or documents. There are several options to filter the documents 

including those that are outsourced and for Fiery production. You can set up new filters or use the ones already 

setup based on due date. The jobs and documents can be set up by color to identify past due, pickup ready, hold 

or those with a firm wanted by date. 

From here you can access the jobs and documents and see the detail. You can also send jobs to Fiery 

production if that is part of your workflow.  

The Work in Progress reports, as their name suggests, help you track your orders – as represented by the 

invoices and estimates on the pending list – in various ways. 

 

About Accounts 

Accounts are a key part of your PrintSmith Vision system. Invoices are assigned and posted to accounts, 

payments are made for accounts, account histories are tracked, and sales statistics are k ept for each account.  

In PrintSmith Vision, you can define accounts for both prospects and customers. Prospects have not yet done 

business with you, but you hope to turn them into customers. Customers have done bus iness with you, and 

invoices have been created for them. Once you create an invoice for a prospect, that  prospect is automatically 

converted to a customer. If customers become inactive, they can be turned into prospects again.  

 

About Contacts 

Contacts are the people associated with an account, for example, those who receive statements or invoices or to 

whom you send promotional mailings. An account may have a sing le contact or may have many; it depends on 

the account. 

 

About Account History 

The Account History report provides a historical record of all accounting activity for a customer or prospect and is 

a powerful tool for managing your business. For example, you can use the history to answer specific questions 

about payments, determine when a particular order was placed, examine the unpaid (open) invoices on the 

account, print a detailed account activity report, and open an old invoice so you can copy it (and re-use it). 

 

About Stock import 

The Stock Import feature allows you to import stock definitions and update prices from an electronic price catalog 

from a vendor. 

 

About Stock Definitions 

The stock definitions window gives you a stock list where you can see a list of all of the stock. It includes stock 

that is in inventory as well as stock that is registered with MDSF. You also have the stock definition screen where 

you enter the information about your stock. That would include specifications, pricing, definition and inventory.  

You may also see tabs for information on Fiery Paper Catalog and web, if app licable. 

 

About Generating Statements 

Statements are optional but are an extremely important part of Accounts Receivable. You can review the status 

of accounts by aging them and apply finance charges as necessary. Typically, you generate statements at 

regular intervals (such as monthly) so that you can let customers know of their outstanding balances. Y ou can 

either print or e-mail statements. 
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About Ordering Stock 

PrintSmith Vision includes several features to help you order stock and track what you ordered. You can keep 

track of all the stocks that need to be ordered, as well as keep track of placed and received stock orders. You 

can also create purchase orders for your stock orders. When an order is received, inventories for the stock are 

automatically adjusted (if you track inventory for the stock).  

 

About Report Manager 

Report Manager is a separately licensed tool that is fully integrated with PrintSmith Vision and available from the  

Reports menu. You can use Report Manager to do the following: 

• Replace one of the standard PrintSmith Vision reports with one of your own reports. 

• Add and run custom reports.  

 

About Account Aging 

The purpose of account aging is to determine the status of customer accounts and warn you of accounts that 

may need collection action. An accurate gauge of your receivables is essential to running a healthy business. 

 

About Account Ranking 

The Account Ranking report lists accounts in order by different criteria, for example, by balance, number of 

orders, or sales. You can save these rankings, so they are available elsewhere in PrintSmith, for example, on the 

Sales Info tab in the Customer window (AR > Accounts). 

 

About Sales Tax Table 

In order to properly calculate and report your sales taxes, you need to set up tax tables in PrintSmit h Vision to 

define your tax rates. Where you sell determines how many tax tables you need.  

 

About Cash Drawer Status 

The Cash Drawer Status window is set up to aid in balancing your accounts and sales. 

 
 

PrintSmith Vision: EFI-Hosted vs. Customer-Hosted 

PrintSmith Vision can either be hosted by EFI (cloud -based) or hosted by you at your facility. 

 

EFI-hosted 

When EFI hosts PrintSmith Vision for you, PrintSmith Vision is installed on a server in the EFI hosting cen ter, not 

in your facility. This cloud-based option means that EFI takes care of the hardware and software infrastructure for 

you, as well as the installation of PrintSmith Vision, updates, backups, and so on . 

 

Customer-hosted 

 
If you are hosting PrintSmith Vision, the PrintSmith Vision server is at your facility, so you control the hardware 

and software infrastructure and are responsible for installing and updating PrintSmith Vision, performing 

backups, and so on. 

Most PrintSmith Vision procedures are the same whether EFI is hosting PrintSmith Visi on or you are hosting it, 

but some procedures are different and some apply only to EFI -hosted or only to customer-hosted installations. 

PrintSmith Vision - EFI-Hosted Guide explains what is different in EFI-hosted installations. If EFI is hosting 

PrintSmith Vision, be sure to use this guide together with other guides like this PrintSmith Vision – Setup and 

User Guide. Other guides will indicate when a feature or procedure app lies only to customer-hosted installations 

(not EFI-hosted). 
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Note: For problems involving infrastructure (i.e., computers, networks, operating systems, backup software, 

printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of 

issues. 

 

 
 

Contact Information 
 

EFI Support 

Web Site: https://customer.efi.com/support 

 

US Phone: 
1.855.EFI.4HLP 

480.538.5800 

UK Phone: +44 (0) 800.783.2737 

EU Phone: +49.2102.745.4500 

E-Mail: Printsmith.support@efi.com 

Regular US Service Desk hours are 7 A.M. to 5 P.M. Mountain Standard Time, Monday – Friday 

Regular UK Service Desk hours are 8 A.M. to 5 P.M. Greenwich Mean Time, Monday – Friday 

Regular EU Service Desk hours are 9 A.M to 6 P.M. Central European Time, Monday – Friday 

Outside of these hours, you may leave a voice mail message and an on -call support representative will be 

paged. Response time is based on the severity of the issue.8  
 

 

EFI Professional Services 
 

US Phone: 651.365.5321 

US Fax: 651.365.5334 

US E-Mail: ProfessionalServicesOperations@efi.com 

Outside US E-Mail: EMEAProfessionalServicesOperations@efi.com 

EFI Professional Services can help you perform EFI software installations and upgrades. This group can also help you 
implement, customize, and optimize your EFI software, plus offers a range of training options.  

 
 

System Requirements 

System requirements can be found in the Release Document for the current release. You should review that 

document and confirm your equipment meets those requirements.  

https://customer.efi.com/support
mailto:Printsmith.support@efi.com
mailto:ProfessionalServicesOperations@efi.com
mailto:EMEAProfessionalServicesOperations@efi.com


Defining Sales Tax |  17
7 

 

 

 

 

PrintSmith Vision Basics 

How PrintSmith Vision Works 

The computer where PrintSmith Vision and its database are installed is known as the server. If EFI is hosting 

PrintSmith Vision for you, the server is in the EFI hosting center; if you are hosting PrintSmith Vision, the server 

is at your location. 

To run PrintSmith Vision, you use a browser from a client computer. For information about supported browsers 

and client computers, see the PrintSmith Vision – Release Notes or the PrintSmith Vision - Installation and 

Upgrade Guide. 
 

Important: When PrintSmith Vision is customer-hosted, the server computer must be configured not to go to 

sleep. If the server goes to sleep, users who are running PrintSmith Vision from other computers will get a 

“server down” message and will be unable to use PrintSmith while the server is in sleep mode. 

When PrintSmith Vision is customer-hosted, you can also run PrintSmith from the server itself. 

 

Keyboard Shortcuts 

If you like to use the keyboard to accomplish tasks, several keyboard shortcuts are available. A keyboard 

shortcut is a combination of keys that you press at the same time, for example, CTRL+C means you press the 

CTRL key and c at the same time. 
 

Note: On a Macintosh computer is the equivalent of CTRL on a Windows computer, and OPTION is the 

equivalent of ALT. 

When a keyboard shortcut is available for a command on a menu, it is displayed next to the command, for example, 
CTRL+ALT+I for Invoice > Create Invoice. 

 

Searching 
For each program there is a search feature. You can search for different documents by using the dropdown. 
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Navigation 

 
 
 

When you see three dots in the program it indicates that there is more than one option listed there. 
Any field that is underlined is editable. 

This navigation panel is displayed at all times and allows you to navigate the different PrintSmith Vision 

programs. 
 

 

 
 

 

User Preferences 

You can modify the shortcuts that are displayed in the quick access panel by changing their location in the panel 

or removing them from the panel completely. To do this use the option under settings User Preferences. You 

access User Preferences in the same drop down as log off. 
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User Preferences consist of two sections: Menu Configuration and Summary Configuration. 
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To move the shortcuts, click and drag on the three lines to the left of the one you want to move. Use the slider to 
remove the item from the panel. 
 
Under Summary configuration you have the option to expand the Estimate/Invoice Summary or not. The estimate 
summary and invoice summary screens have a portion of the screen that is collapsed. If you check this box then it will 
open the summary screens expanded and if unchecked the summary screens will open with it collapsed.  

 

 

Template List 

Templates List will display all existing templates. The list includes Invoice, Estimated, Job  and Product 

templates. Product templates are handled differently and will be discussed in another section. For 

information on Product Templates. 

You can narrow the search to just a type of template by selecting the appropriate icon across the top of 

the page or you can choose to view all templates. 

Note The quantity of templates in the all tab does not include the number of product templates.  

 

 
 
 

 
 
 

Invoice, Estimate, and Job templates are all handled the same way. You have the same filtering options 

and the same processes. You can filter these templates by using any of the column headers. Just start 

typing and the program will filter the templates. You can also change the direction the templates or 

displayed by using the icon in the upper right-hand corner of each column heading field. Using the three 

dots you also have the option of duplicating or deleting the template. From here you can create template 

categories. 

 

Template Category 

If you select Template Category you will be taken to a screen that lis t the categories. Here you can 

search for a specific category using the columns at the top. Also, you can delete or duplicate the 

categories using the three dots next to the check box. As with other column headers you can search or 

sort the information. 

Create New 

Product 

Template 
Categories 
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You can create a new category by selecting the + Category button. That will take you to a new screen where you 

can add a category. You can add an image to the category or a layout. If user selects “Do not show in templat e” 

when creating a new template category, that category will only be available with Web products not with Invoice, 

estimate and job templates. 

Note Flex Categories that are associated with Web Product will not get carried forward to HTML . 

If user does not select this check box while creating Template category, that category will be available with Web 

products, Invoice, estimate and job templates. 
 

 

Web Product Templates 

Web Product Templates are created and mapped to Direct Market StoreFront products. When your customer 

places an order for a product the mapped template becomes the job information for that product and the invoice 

is placed in Pending Documents. 

Web products can also be used for Four51 integration, API integration, MDSF legacy integration.  For these 

integrations Map to MDSF option will not be available.  

Product template will not be included in All Type Tab. For product templates there are different columns  
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When eFlow based MDSF integration is enabled, then product list will display the product name, SKU, category, 

status, date modified and the MDSF Product Name columns 

Note For other integrations (i.e., Four51, API, MDSF Legacy) MDSF Product Name column won’ t be visible). 

On this page you can select the category for the template. The status will show you if a Product has been linked 

to a template or not. From this screen you can select the option map MDSF product(s) with PrintSmith product by 

clicking on Map to MDSF. From here users also have provision to edit Product detail. To edit Product detail, you 

have to click Product name, this action will redirect you to another screen where you will see other options 

depending on the status of the product. If the product is not linked to a template, then you will see the option to 

either select a template from the library or Set a New Template. If the product already has a template, then those 

buttons will be inactive, and you can review the information or use Map to MDSF to map PrintSmith product with 

MDSF product(s). User can delete or duplicate web products using three dots icon in first column  

You can also select the Map to MDSF from the first screen. Using either method will take you to another screen 

where you can map the web product to a MDSF product. 
 

The MDSF products will be listed at the bottom of the screen. You can map the specific MDSF products by 

checking the box to the left and they will be removed from the bottom of the screen and moved to the top of the 

screen to show you that they have been mapped. 

Note You can map more than one MDSF product(s) to the same PrintSmith web product, but only one job can  

be linked to a web product. 

To link a template to a product you can Select from Library or Set New Product. Select from Library takes to a list 

of existing templates. You can select from Job, Estimate or Invoice templates. If you select Job Templates, you 

will see a list of them. If you select Estimate or Invoice templates, you will need to enter the appropriate estima te 

or invoice number and then select Proceed. 
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If you use Set New Product, then you will need to create the template by entering the job information just 

as you would for add new job. See “Creating a New Job” for more information. 

 
If the user selects a Product that does not have a Template linked to it , you will be taken to the same new 

screen. The only difference is that if you are creating a new product you will need to enter the name. The 

SKU will be automatically entered. The SKU number consist of fixed prefixes and a number, the number is 

what makes the SKU unique and is incremented with each new SKU. The program will also not allow 

duplicates SKU. With the name and SKU entered you have the choice of adding a template from the 

library or creating a new template to link to the product.  

If you choose using a template from the library the user has the option to select template from Job 

Template list or from Invoices or Estimates. 

1. When job Template is selected the user has the option to add an existing template from Job Template List for the 
Web Product. 

2. When Invoice is selected the user has the option to search invoices with an invoice number and select job from 
the invoice to add an existing template for the web product. 

3. When Estimate is selected the user has the option to search estimates with an estimate number and select job 
from estimate to add as template for web product. 
Note If invoice/estimate contains multiple jobs, user will be able to select only one job for job template.  

4. To add template to Web Product, select templates or job from the list and click on Add. 
5. If you need to edit the template, you need to select the edit button in the template row and you will be taken 

to the template screen where you can modify the template. 
6. Save the template 
7. Save the product 
8. If you want to delete the template associated with Web Product you could do so by clicking on delete 

button present under Action Column. 

If you choose to create a new template, you will be taken to the template creation page where you enter the 

job information for the template. Once that is done: 

1. Save the template 
2. Save the product. 

If you have set the program up to integrate with MDSF then when you look at a product you will have the 

option to map that product to a MDSF product. 

Tip After you associate a template with a Web Product, you can later edit the template (by clicking Edit 

template) or remove it altogether (by clicking Remove template).  
 

 

Email Templates 

Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can e-mail 

various documents, for example, estimates, invoices, purchase orders, statements, and credit memos. As 

part of configuration, you can specify what the body of each type of e-mail includes. 
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To set up the email you must go to Preferences > Settings > System > Email. 

Customize e-mails 

By default, the recipient, subject, PDF file name, and body in an e -mail message are as follow: 

• Recipients  
For a document to be mailed, the default recipient must have an e-mail address defined: 

• For estimates and invoices, the default recipient is the invoice contact. 

• For credit memos, the default recipient is the invoice contact. 

• For statements, the default recipient is the account statement contact or invoice contact 
(depending which is being used for the statements). 

• For purchase orders, the default recipient is the supplier specified in the purchase order. 

• Subject 

The subject of the e-mail is Company Name: Document Type #xxx, for example, Vermont SuperPrints: 

Estimate #323. The company name is taken from the first line (Company) of the Address in your Company 

preferences. 

If, however, you select the Use log text as subject and file name check box in these E-Mail preferences, 

the log text you specify is used for the subject line instead.  

• PDF file name 
The name of the PDF attachment is Document Type #xxx.pdf, for example, Estimate #234.pdf or 

Statement #432.pdf. 

If, however, you select the Use log text as subject and file name check box in these E-Mail preferences, 

the log text you specify is used for the file name instead. 
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• Body 

The body of the e-mail is defined in these E-Mail preferences. 

To customize e-mails 

1. To allow users to customize certain types of e-mail messages before they are sent, select the Customize e- 

mail fields before sending check box. 

When the Customize e-mail fields before sending check box is selected, each time users click the E-Mail 

button in the Invoice or Estimate window or in the Purchase Order window, they can add recipients, change 

the subject of the e-mail, and edit the body. 

Important: The Customize e-mail fields before sending check box does not apply when you e-mail 

invoices from the Cash Register or Post Payments window, e-mail credit memos from the Journal Entry 

window, or e-mail statements (AR > Generate Statements). In these situations, the e-mails are sent without 

any input from users – the e-mails cannot be changed. 

2. To send a copy of the e-mail to the sender, select the Include sender on CC line check box. 

3. For the E-Mail Body, click each tab (Invoice, Estimate, Credit Memo, Statement, and Purchase Order) 

and enter the message you want the e-mail to include. 

Note: The body specified on the Invoice tab applies to e-mails sent from the Invoice window, the Cash 

Register window (for posted invoices), and the Post Payments window (for paid and posted invoices). 

The body of the e-mail can include: 

• Text 

Text can be anything you want. For example, depending on the e-mail being sent, you may want to include 

text such as Your invoice is attached, or We hope to do business with you again. 

• Enter the text and use the formatting toolbar to change the font, point size, style, color, and 
justification of text.  

Note: You can only select a font from the list; you cannot add your own fonts to the 

system. Currently extra spaces between characters are no t  preserved when you send e-

mails. 

• Place holders 

Place holders are replaced with actual data when the e-mail is sent. For example, [DocumentNumber] 

is replaced with the number of an invoice or estimate; [AccountName] is replaced with the name of the 

account; [Supplier] is replaced with the name of the supplier for purchase orders; and so on. The 

available choices depend on the type of e-mail you are sending. 

[FirstName], [LastName], [JobTitle], [UserName], and [EmailAddress] always come from the user 
definition of the logged-in user so are helpful if you want to identify the user who sent the e-mail in the 

e-mail itself. 

• To enter a place holder, select it in the Place Holder field and click Insert. 

Note: Place holders are always added at the end of the e-mail body, not where the pointer is. Once a 

place holder is added, cut it and paste it where you want it.  

You may want to include text next to some place holders to explain what the data represents, for 

example, precede [DocumentNumber] with Estimate Number or [DocumentTotal] with a currency 

symbol. 

• Images 

You can include an image such as your logo in the e-mail. To do so, click Add Image and locate and 

select the graphic you want to use. The name of the image ( not the image itself) is displayed. 

Note: Make sure the image is the correct size before you add it; you cannot resize images in PrintSmith  

Vision. The image is always added at the end of the e-mail body, not where the pointer is. Once it is 

added, cut the image (meaning IMAGE SOURCE=‘image name’) and paste it where you want it. 

• Hyperlinks 

To include a hyperlink in the e-mail body: 

• Enter the text for the link. For example, this could be a URL such as http://w3.efi.com/ or text such 
as Click here for more information or Visit the EFI web site. You can also hyperlink an image 

such as the Facebook or LinkedIn icon. 

• Select (highlight) the text of the link or name of the image (meaning IMAGE SOURCE= ‘image 
name’). 

• Enter the URL in the http:// field. (The http:// field is unavailable until the hyperlink text is selected.) 
The link (text or image) can now be clicked to take you to the specified site.  

4. To see what the e-mail will look like (together with any images you added), click Preview and then close 

http://w3.efi.com/
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the preview window.  (Place holders will be replaced with real data when the e-mail is sent.) 

 

Table Editor > Vendor 

Table Editor > Vendor will take you to a short cut menu where you can enter or edit vendor information. Selecting 

the plus + will allow you to add a vendor or you can select an existing vendor from the drop down. 

Note: You can only add vendors from this screen . The user must have access to suppl iers to edit or add 

vendors. 
 

Opening other portions of the screen will allow you to enter contact detail or miscellaneous information. You can 

enter up to 4 contacts on the contact screen. On the Miscellaneous screen you can enter information about the 

vendor such as the material they supply, tax ID, payment terms, etc. You can also identify when you need to 

send the vendor a tax exemption notice 

Note You must check the box “Use in Purchase Order” in order for this vendor to be disp layed on the vendor list 

in the purchase order program. 

 

Table Editor > Reasons 
This is where you set up reasons for lost estimates. (See Estimate History for more information on Reasons). 

 

Preferences > CardConnect® Setup and Credit Card manager 
This is used only if you are using CardConnect® to process you credit card transactions. For information on setting up and 
managing CardConnect® see the CardConnect® Integration document. 
 



Defining Sales Tax |  295 
 

 

 

 

Preferences > Stock and Sizes 

When creating an estimate or invoice and you go to the Job Detail tab there is a field where you can select 

the stock for the job. Normally the stock name is displayed in the search but using the stock and sizes feature 

you can select what you want to display in that search. In the example below the search has been set up to 

display the stock name, type and color. 

You can select the information you want to see on the search display and how you want the information 

divided. By checking the box, you can also display the chain of customer for the stock. 

 

Logging in to PrintSmith Vision 
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Defining Sales Tax or Value Added Tax 
 

About Taxes in PrintSmith Vision 
In order to properly calculate and report your sales taxes, you need to set up tax tables in PrintSmith Vision to define your 
tax rates. If you do not charge and collect sales tax, you should ensure that no (zero) tax is being calculated. 
 
Where you sell determines how many tax tables you need. For example, if your business sells exclusively in a single tax 
jurisdiction, you only need one tax table. If, however, your business sells in multiple tax jurisdictions, or is internationa l, 
you need to account for all these different taxes by setting up several tax tables. For example, international customers 
may require tax on tax and variable tax rates. Canada has a GST/HST tax. Chile also has special tax verification 
procedures. You must account for all these different tax situations. 

 

Default Tax table 
One tax table is always identified as the default tax table. This may be the only tax table you use. If, however, you have 
multiple tax tables, the default tax table should typically be for your most commonly used sales tax. The default tax table is 
automatically used for all taxable customers and invoices unless another tax table is assigned to an account or invoice. 

 

Product-Level taxation 
In some locations tax is based on the type of product you are selling, for example, brochure versus business card. 

 

Line-Item Taxation 
You may find it necessary to tax individual line items in an invoice independently. For example, in some tax jurisdictions 
an item that involves just labor (such as folding) may be taxed differently from an item that involves both labor and 
materials (such as printing). In addition, jobs in an invoice may be delivered to different locations that are subject to 
different taxes. When using line-item taxation you can have up to five different tax tables per invoice.  

 

Setting Up the Sales Tax Table 

EFI recommends that you start by defining your default tax table. This may be the only tax table you 

need, but if you plan to define additional tax tables, use the default tax table for your most commonly 

used sales tax. 

• Select Pricing > Sales Tax. The sales Tax window opens with no tax table displayed. 

• To add a new tax, select the Add button and the add sales tax window will open. You define the tax here. 

• Enter the name of the tax table. The tax name should be unique. 

Tip: Any tax table can be your default tax table; just select the radio button in Default column next to 

the tax table you want to be the default table. You can also name the default tax table whatever you 

want, although Default as the name makes the purpose of the table clear. 

• Enter an abbreviation for the tax table. It should be unique. 

• Enter the tax rate. (Up to three decimals) 

• Enter a minimum taxable amount, if applicable 

• Check any of the other options for that tax table. 

Tax Shipping 

Select this check box if you need to tax the amount you are charging for shipping (which is common in 

Canada). When the Tax Shipping check box is selected, all the check boxes in the Ship column are 

selected automatically so that all the tax elements in th e table are used to calculate taxes on shipping. 

If you want to choose which tax elements to apply to shipping, select the Separate Shipping check box 

and then clear the check boxes in the Ship column for the tax elements you do not want to use in the 

calculation. For example, in the figure below, the city tax is not applied to shipping.  
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Tax on Tax 

Select this check box if one tax must be applied to another. Normally, the rates in the tax table are 

added together to produce the effective tax rate. If you select the Tax on Tax check b ox, the effective 

tax rate is calculated differently. Suppose the first tax rate is 8% and the second rate is 2%. In this 

case, the 2% rate is applied to the 8% rate. An additional 0.16% (2% of 8%) is therefore added to the 

effective tax rate, and the result is 10.16%. 

Build Tax in Price 

(For future use) Select this check box if you want to hide the tax in the price for items and never show it 

separately. 

Round Tax up 

Select this check box if you want to round up all the tax rates in the table. Generally, this check box 

should be cleared. The only case where EFI recommends selecting the Round tax up check box is in 

the state of Florida which has a sales taxing system that uses a table to look up actual tax amounts 

instead of calculating with a formula. The closest PrintSmith could get to matching their system by 

formula exactly (based on the unofficial recommendation of the State of Florida tax departments) is to 

round up all taxes. 

• Enter one or more tax elements. For example, you may need to account for both a city and state tax. The tax 
elements result in the Effective Tax Rate. Each tax element consists of Description and Tax Rate fields as 
well as Ship and Show check boxes to control whether the tax is applied to shipping and/or is identified on 
an invoice, estimate, or receipt. 

Tax Elements are set up in Table Editor > Data List  
 

Once a tax element is set up in the table it is available to use in the Sales Tax Program.  

 
• Select the + to add a new tax element 
• Enter the Description using the drop down. It will display the elements that have been previously set up. 
• Enter the Tax rate 
• Check Ship if the tax is to also be applied to shipping 
• Select the check box in the Show column if you want the tax shown on invoices and estimates, as well as on 

receipts for POS (cash register) transactions. 



32  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

 

 

To remove the element, select the trash can under Action.  

• Verify the Effective Tax Rate. This rate is calculated based on the tax elements you entered. If this rate is 
not correct, adjust the tax elements. You can add multiple tax elements to the table 

• Click Save on the toolbar to save the tax table. 

Notes  

You can use the + button to add additional tax jurisdictions to the tax table .  

In many places in PrintSmith Vision you will see Tax Table set to Use Parent Tax Table. This means 

that the tax table assigned to the customer account is being used, unless this was overridden in the 

invoice, parent job, or cash register. 

 

Editing Tax Tables 
If the tax rate changes, for example, the state sales tax increases, you can edit the tax table to change the rate. 
 
When you make a change to a tax table that affects the tax calculation, PrintSmith Vision creates a new version of the 
tax table but leaves the original intact and lists it under Historic in the Sales Tax window. 
 
You cannot edit historic tax tables. If you select a historic tax table, you will get a warning that you are viewing historic 
data. To go back to the latest tax table, select the button for Switch to Current Tax Table. 

 

 

Tax Exemptions 

If some customers or orders are not subject to sales tax, EFI does not recommend that you set up tax 

tables with tax rates of 0% to handle these tax-exempt accounts or documents. 

Note If you set up tax table with a 0% tax rate, the amounts are sti ll considered taxable even though 

no tax is calculated. This makes sales analysis less accurate because the sales are considered 

taxable, except at a zero-tax rate. 

Instead, for an account, select the Tax-Exempt check box on the Credit/Tax Control tab in the account window. 

 

For a document, select the NO TAX check box in the Document Totals window. 
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Including More Than One Tax Element on a Document 

When a tax includes more than one element and you want to include all the tax element in documents, 

select the check box of each element in the Show column in the Sales Tax window. For example, you 

may want to break down the tax by state and city. The Show column also affects printed receipts. Any 

additional taxes that do not have Show selected are grouped together in the standard tax amount.  
 

 

Hiding Taxes in Prices 

If you do not want to break out the tax, but want to include it in your prices in the documents that 

customers see, do the following: 

1. In your document preferences: 

a. Select Admin > Document Preferences. 
b. Click the Page tab and select the Remove tax line check box. 
c. Click the Body tab and select the Hide tax in line items check box. 
d. Click OK. 

2. In your receipt preferences: 

a. Select Admin > Preferences > POS > Receipt. 
b. Select the Hide tax in line items check box so that receipts have the tax hidden in the price. 
c. Click OK. 

 

Using Product-Level Taxation 

In some locations tax is based on the type of product you are selling, for example, brochure versus 

business card. To accommodate this type of taxation, you can associate tax tables with product 

types as described next. 

 

Setting up Product-Level Taxation 
1. Use Pricing > Sales Tax to define the tax tables for products that require different taxation. For 

example, you may need one tax table for brochures and another for posters. 
2. Select Admin > Table Editor and select Products in the Tables field. 

By default, the Tax Table for a product in the Products table is set to Use Parent Tax Table. This 
means that the tax table associated with the estimate or invoice will be used for the product.  

3. To use a different tax table for a product, select it in the Tax Table column. 
4. Repeat step 3 for all the products that require separate taxation. 

Note The Key (Alpha) field in the Products table is required only if you are using the e-commerce 

API (separately licensed) and want to assign or use a product type (category) when importing or 

exporting invoices. The value in this field must be unique, but it can be anything you want. For 

information about this API, see the PrintSmith Vision – e-Commerce API Integration Guide. 

5. Click Save on the toolbar. 
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Taking Advantage of Product-Level Taxation 

When you add a job to an estimate or invoice and select a Product for the job, the tax associated with the 

product (in the Products table) is automatically set in the Tax Table field. 
 

 
 

The tax rate defined in the tax table is then applied to the subtotal of the invoice. 

Unless you are also using line-item taxation, only one tax table can be associated with an estimate or invoice. If 

you have multiple jobs on a single estimate or invoice, they cannot be for products that are associated with 

different tax tables. What this means: 

• When you add a job to an estimate or invoice for a product that has an associated tax table, that tax table is 
used for the entire estimate or invoice. 
Note: If you then try to change the tax table at the estimate/invoice level (in the Document Totals window, the 
system will prevent you. If you want to apply a different tax table to the invoice, you must change Tax Table for 
the job in the estimate/invoice to Use Parent Tax Table. 

• After you add one job to an estimate or invoice for a product that has an associated tax table, you cannot add 
more jobs for products with different tax tables. The Tax Table field for those jobs must be set to Use Parent 
Tax Table (which means the job inherits that tax table from the estimate or invoice). 
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Line-Item Taxation 
You may find it useful to tax individual line items in an invoice independently. For example, in some tax jurisdictions an item 
that involves just labor (such as folding) may be taxed differently from an item that involves both labor and materials (such as 
printing). In addition, jobs in an invoice may be delivered to different locations that are subject to different taxes (such as 
county or city tax in addition to state tax). When using line-item taxation you can have up to five different tax tables per in 
voice. 

Important Before enabling and using line-item taxation, read the material below to make sure you 

understand how line-item taxation works and find out if it is a good solution for your business. 

 
Warning Once you enable line-item taxes you cannot disable it. 
 

Enabling Line-Item Taxation 

To take advantage of line-item taxation: 

1. Navigate to Preferences > Settings > System. 

2. Select Behavior. 

3. Select the Enable line-item taxes check box and click Save. 

 

Taking advantage of line-item taxation 

When line-item taxation is enabled, you can indicate that a tax table should be “inherited” from its parent 

(which is the default behavior) or you can select a different tax table (so it is not the same as the parent). 

Whenever a Tax Table field is set to Use Parent Tax Table, the tax table is inherited. The order of 

inheritance is as follows: customer account > invoice/estimate > jobs > job charges (or sub jobs in a multi -

part job). If you select different tax tables for items in an invoice, they are taxed differently from their 

“parents.” 

When line-item taxation is enabled, you can do the following: 

• Have up to five different tax tables per invoice. 

• In the Document Totals window for an invoice, select a tax table to apply against the invoice, as well as any of its 
charges or jobs that have Tax Table set to Use Parent Tax Table. 

• Select a specific tax table for a job in an invoice. This tax table will also apply to any job charges or parts of a 
multi-part job that have Tax Table set to Use Parent Tax Table. 
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Hide Line-Item Tax on Invoice Summary 

You have the option to not display the line-item tax amount on the Invoice Summary screen. This is set up in the 

Preferences > Settings > System > HTML View. 
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Quick Access Panel 

Quick Access panel not only provides shortcuts to your most commonly used features, it provides a view 

of the status of orders taken by the logged in user or for the entire plant. Quick Access includes:  

• Estimate and invoice totals for the previous day and current day. 

• Year to date and month to date totals of orders, sales, and journal entries. 

• Lists of invoices due today, overdue, and optional custom field. To change the custom field, you must go 
Preferences > Settings > System > Dashboard. This allows you to set the location to be used to filter jobs. 

• A list of estimates still in a pending state, with the ability to open and review them. When an estimate is open, 
you can convert it to an invoice so you can go ahead and produce the jo b and bill the customer. 

• A log of the communication that has taken place with customers, with the ability to follow up on issues. 

• Quick access to other applications. 

Note The user has the option of displaying their user informat ion or the information for the entire ship. 

This is controlled by the Show Only My Records slide bar. If it is on, then the widgets will only display the 

users information and if it is off then the display will be of the entire shop. The headings for the widgets 

will indicate if you are seeing the shops information or the users.  

 
 

 
Search 

Options 

 

Quick 

Access 

Buttons 

for 

Other 

Applicat

ions 
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Show only my records changes the display for Due Today, Ordered, On Proof, Pending 

Estimates and Customer Log to display only items for the logged in user.  

Customize Mode allows you to remove Quick Access buttons or displays. Remove items by 

selecting the red X that is displayed when in the customize mode. 

Add/Remove Options allows you to change the display to only show the items you want to see by 

checking or unchecking the appropriate boxes. The display for the quick access buttons is limited to 

18 items. You can use the Add Remove Options to select the items you want to be displayed. 

 
Restore Default changes the display back to the original default status.  

In addition to the Customize Mode and the Add Remove Options you can remove individual panes 

by selecting the Remove Widget feature.  

 

Note If you have made changes to Quick Access those changes will still be in effect after the 

update. If a user does not have permission for a feature the feature will still be displayed but will be 

grayed out. 
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Defined in 

Production 

Locations 

Table 

Getting Ready to Use the Quick Access Panel 

A few steps are necessary to get Quick Access ready for use: 

1. Set your Quick Access Panel preferences. 

2. Decide which access groups should have permission to view the Quick Access. 

3. Understand the Taken by field. 

 

Set Your Quick Access Panel Preferences 

1. Go to Preferences > Settings 

2. Under System, click Dashboard 

3. Set the preferences as described below and click Save 

Dashboard preferences 

Use the Dashboard preferences to control some aspects of the Dashboard.  

 

 
1. To remind users after they log in that they have some number of items to follow up, select the Show 

follow-up count at user login check box. 

When this check box is selected, if a user has follow-up items that are either due today or past due, a 

Red flag is displayed by the Bell icon in the upper right-hand corner of the screen letting the user know 
that they have messages to review. 

 

2. By default, the sales and journal entry numbers in the Dashboard include tax. To omit tax from the 

totals, select the Exclude tax from Sales and Journal Entries check box. 

3. The My Location pane in the Dashboard lists all the invoices with jobs currently in the location that was 

selected in your Dashboard preferences. 

4. When the location of a job is set to the location defined in the Dashboard preferences, the invoice will 

be listed in the My Location pane. 

Accessing Quick Access Panel 

You can control access to the Quick Access through security settings. Any user who is part of an access 

group with Help > My Dashboard selected in the Security Setup window (Admin > Security Set up) can 

open and view Quick Access. Quick Access is identified as Dashboard in the security setup. 

To prevent the users in a particular access group from seeing all the customer log information in the shop, 

make sure the Help > Quick Access Show All Customer Logs permission in the Security Setup window is 

not selected. As a result, the All button is unavailable on the Customer Log tab.  

Also, if you want to prevent the users in a particular access group from seeing YTD and MTD total order, 

sales, and journal entry numbers, do not select the Help > Dashboard Show Sales Values setting in the 

Security Setup window. As a result, dashes instead of numbers are displayed.  

 
Note Users who do not have permission to review a document (Invoice > Review Any Document) or open a  

document from the pending list will also be prevented from opening a document from the Quick Access.
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Understand the Taken by Field 

When you create an estimate or invoice, the Taken by field in the Account Info window is automatically set to 

your user (login) name, but this field can be edited.  

Note The Taken by field is case insensitive (Dhina and dhina are the same).  

When you open Quick Access, the orders that you see are those that you took – they have your username in the 

Taken by field. You can, however, see orders taken by all other users (but not specific  users) by clicking All in 

some of the panes of Quick Access. 

Web orders, for example, orders coming from PrintSmith Site, Market Direct StoreFront, and Four51 are not taken 

by a particular user, however. In this case, the information in the Taken by field  in the Account Info window comes 

from the Taken by field on the Site tab of the Web Administration window (Admin > Web Administration) and is 

used for all incoming Web orders. 

If you are integrated with PrintSmith Site, Market Direct StoreFront, or Four51, EFI recommends that you set the 

Taken by field on the Site tab of the Web Administration window to the user (perhaps admin) who is most likely 

to want to track these Web orders in the Quick Access. Whoever opens the Web orders, however, can still edit 

the Taken by field in the Account Info window and enter a different username there. 

 

About the Quick Access Panel Contents 

Some information in the Quick Access applies to the logged in user (whose name is in the Taken by field in the 

Account Info window as described above). In the descriptions of the Quick Access that follow, “you” refers to the 

currently logged in user. Other information in the Quick Access applies to the entire shop. You can view your 

own information (for example, see orders that you have taken) or view information for the entire shop, but you 

cannot view information for another user. Likewise, another user cannot see your information. 

Note  As described in “Give access to the Quick Access” above, you need permission to view all customer logs.  

Tip  Quick Access Panel is updated automatically every 5 minutes. 

The sections that follow describe the different parts and features of the Quick Access Panel.  

 
 

Total Widget 

 

The Total Widget summarizes the estimates and invoices that were created on the previous and current day, as 

well as year-to-date and month-to-date totals for orders, sales, and journal entries. It shows those that came from 

the shop and those that came in over the web. 

Notes Unless you selected the Exclude tax from Sales and Journal Entries check box in the Quick Access 

preferences the Sales and Journal Entries numbers include tax. 

The totals exclude any voided estimates or invoices. 

 
Estimates 

• The Estimates section shows the total dollar amount of the estimates that were created on the previous 

day. The number of estimates is shown in parentheses. 

• The Invoices column shows the total dollar amount of the invoices that were created on the previous  

day. The number of invoices is shown in parentheses. 

 

Invoices 
• The Invoices section shows the total dollar amount of the estimates that were created so far on the 

current day. The number of estimates is shown in parentheses.  

• The Invoices column shows the total dollar amount of the invoices that were created so far on the 

current day. The number of invoices is shown in parentheses. 
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Total Orders 
The Total Orders columns provide information about invoices that were created for orders. Total Orders include 

invoices that are still on the pending list, as well as invoices that were picked up. Total Orders do not include 

voided invoices. 

If you do not have permission to see company sales numbers dashes are displayed instead of numbers under 

Total Orders. 

 

Sales 
The Sales columns provide information about all the invoices that were picked up (mea ning invoices that were 

charged or paid for by cash, check, or credit card). 

Note Unless the Exclude tax from Sales and Journal Entries check box is selected in the Quick Access  

preferences the Sales numbers include tax. 

• The “This Year” column shows the total dollar amount of invoices picked up so far during the current 

year. (The current year is based on the fiscal year set in your Business Calendar preferences and the 

range is displayed in the bottom left corner of the Quick Access.) 

• The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of invoices picked 

up so far during the current month. 

 
 

Journal Entries 
The Journal Entries columns provide information about journal entries that were recorded and posted. These 

numbers may be negative. Voided journal entries are not included. 

Note: Unless the Exclude tax from Sales and Journal Entries check box is selected in the Quick Access  

preferences the Journal Entries numbers include tax.  
 

• The “This Year” column shows the total dollar amount of journal entries posted so far during the current 

year. (The current year is based on the fiscal year set in your Business Calendar preferences and the 

range is displayed in the bottom left corner of the Quick Access.) 

• The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of journal entries 

posted so far during the current month by the shop as a whole and by you. 

If you do not have permission to see company sales numbers, dashes are displayed instead of numbers under 

Journal Entries. 

Notes 

The sum of the Sales and Journal Entries numbers represents actual sales for the period.  

The displayed information for each widget depends on if you have selected to “Show only my Records” or not. 

 
 

Due Today Widget 
 

 



48  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

• To help you track what needs to be done today, the Due Today widget lists invoices that are due today. 

The total number of the invoices due today is shown at the top of the pane. 

• If the list is long, click Show All to open a window that shows all your invoices that are due today. This will 

open Pending Documents in a new windows and display invoices. 

• To open an invoice and review its details, double-click it. 

 
Overdue Widget 
The Overdue widget lists all your invoices that have a due date in the past. The total number of these late  

invoices is shown at the top of the pane. 

Note: If an invoice is due today at 12:00 PM, it will be considered overdue any time after 12:00 PM, but it will still  

be listed in the Due Today pane. 

• If the list is long, click Show All and the pending documents window will display in a new window all overdue invoices. 
 

 

• To open an invoice and review its details, double-click it.  
 

 
 

My Location Widget 
 

The My Location widget lists all your invoices that have jobs in that location. The total number of these invoices 

is shown at the top of the pane. The Item# column identifies the job in the invoice that is in that location.  

Note: For invoices to be listed in the My Location pane, the location of a job in an invoice must be set to the 

location specified in your Dashboard preferences. 

The title of this pane will match the name of the location you selected in your Dashboard preferences, for 

example, if the location is Proofing, the title of the pane will be On Proofing. 

The Show all option will open the Work In Progress page in a new window. 
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Pending Estimates Widget 

 
The Pending Estimates tab at the bottom of Quick Access lists all your active estimates – these are quotes that 

either were not yet accepted by customers or were accepted but have not been converted t o invoices yet. The 

value of those estimates is displayed at the top of the tab.  

If a customer accepts an estimate and gives you the go -ahead to proceed with the job, you can open the 

estimate from the Dashboard and convert it to an invoice. An invoice includes the agreed -upon price and details 

of the work to be performed and then serves as a bill for this work.  

 
 

If the list is long, click Show All to open a Pending Documents window that shows all your pending estimates. 

From the Pending Documents window, you can open and edit an estimate. 

• To open an estimate and review or edit its details, double-click it or click Open. 

• To convert an estimate to an invoice when the customer has accepted your quote: 
1. Double-click the estimate or click Open. 
2. Make any necessary changes to the estimate. For example, if the estimate includes multiple quantities, select the 

one the customer wants. 
3. Select Invoice > Convert to Invoice. 
4. When asked about recalculating the document, click Yes to ensure the invoice has the latest pricing information. 
5. When the Account Info window opens, make any necessary changes and click OK. 
6. Click Save to save the invoice. 

 
 

Customer Log Widget 
The Customer Log widget at the bottom of Quick Access lists all customer issues that you logged with a follow- 

up date of today or in the past. 

Tip: You can log entries and enter follow-up reminders in the Notify Customer window. This window can be 

opened by clicking a Notify button in the following windows in PrintSmith Vision: Pending Documents, Contacts,  

Customer History, Work in Progress, Post Payments, and Journal Entry.  
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Creating Estimates 

Estimating 

Several of the options and steps to create an estimate are the same for creating an invoice. 

From the estimating application you can create new estimates or update an existing 

estimate. 

When you first open the estimating application, you will see the screen where you identify the customer, contact 

and how you want to create the estimate. You can create a new estimate from a new job, account history, jo b 

templates or templates. 

• Select the customer. You can just start typing or use the dropdown to select your customer. The default will 
display both accounts and contacts, so you can select either. You can also determine if you want to display 
prospect or not. 

You can search for an account based on account number, phone number, or email address using the search 

code prefixes listed below. 

 
 
 
 
 
 
 
 
 
 

• When searching with Account + Contact selected and Prospects unselected, you will only see accounts.  

• With Account + Contact unselected and Prospects selected, you will only search Prospects. 

• With both selected you will search for both Accounts and Prospects. 

 
Prospects have not yet done business with you, but you hope to turn them into customers. Customers have 

done business with you, and invoices have been created for them. Once you create an invoice for a prospect, 

that prospect is automatically converted to a customer. If customers become inactive, they can be turned into 

prospects again. 

 
You can identify the type of account by the symbol next to the name. 
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1. 1. Select the contact. When you select the account, the program will automatically enter the default contact 
person, but you can change the contact by using the dropdown. 

 

 
Why use customer accounts? 

 
EFI strongly recommends that you associate a customer account with most of the documents that you create. 

Not only does a customer account include key information such as name, address, and phone number, but it is 

also used to determine if an invoice exceeds the customer’s credit l imit. In addition, the account determines 

whether a deposit is needed, what type of payment is acceptable, whether a PO is required, or if an autom atic 

discount should be applied to the order. The tax table (which may change the tax rate), tax code, and tax status 

are also based on the assigned account. The customer account can even affect special instructions on job 

tickets and documents. 

When customers use your services, you want them to continue using your services. If you set up an account for 

them, you can examine their history, mark them as inactive, generate mailing labels, and market to them. The 

history that PrintSmith Vision maintains also helps you identify customers who only use you as a source for 

quotes and never send you any orders. You can find out why you never get their orders and decide whether you 

want to continue giving them estimates. 

For all these reasons, the walk-in account should be used just for customers you never expect to see again. If 

you start using the walk-in account for repeat business, you will have history for the walk -in account, not for 

individual customers. 

In addition, you could end up with history for the same customer in both the walk-in account and a customer 

account. Imagine that you select the walk-in account when creating an invoice for Bob’s Hardware and enter the 

customer name and address directly into the invoice. Later, you create a customer account nam ed Bob’s 

Hardware and create more invoices. Now you have several invoices for Bob’s Hardware, but one is for the walk - 

in account and the rest are for the Bob’s Hardware account. If you try to pick up all the invoices at once, 

PrintSmith Vision does not let you since invoices being picked up together must all belong to the same account. 

Worse, if you pick up just the walk-in invoice, it will not show up in Bob Hardware’s history — it is in the history 

for the walk-in account. 

Tip: To reduce this type of problem, EFI recommends that after you create a document for a new customer using 

the walk-in account, you use Invoice > Create Customer Document to create an account for that customer. 

Doing so also greatly reduces the number of documents assig ned to the walk-in account. If an account already 

exists, and the document was created using the walk-in account, click Account Info on the toolbar of the 

document window (or select Invoice > Change Account) to select the correct account. 

For one-time business, you can select the walk-in account (displayed as <<< WALK IN >>>). If necessary, you 

can always use the information you entered for a walk-in customer to create a new customer account.  

Note: EFI strongly recommends that you use th e walk-in account only for one-time business. If you select the 

walk-in account for many different customers, you will find it very difficult to track history effectively.  

 

2. Select the process you want to use to create the estimate. 

There are different options for creating a new estimate depending on your preference settings. Under 

Preference > HTML you have the option of selecting Template Category View. With this unchecked you will  
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see the options of creating an estimate from a new job, account history, job templates or invoice/estimating 

templates. With this checked the options will change to a new job, account history or template. When you 

select template, you will be shown a list of template categories that you can use to find a template. See 

“Creating Template Categories” for more information. 

3. Select Continue. This will take you to the Job Details screen where you will enter the information about the 

job. Often you do not need to make any changes to the account information but if you do you can move to 

that tab. Account information options will be discussed later in this document 

 

Create New Job (Job Methods) 

After selecting New Job, you will see several options as to Job Method. Once you have selected the job method 

you will see a job detail sheet specific to the job method you selected. Job Methods are defined under 

Preferences > Estimator > Pricing Method. 

Note The pricing methods that are available as selections and their names are controlled by preferences 

(Admin > Preferences > Estimator > Pricing Method). You may want to change the name of the pricing 

method so that it makes sense to your company. For example, you may want to change Printing to Offset, 

Outside Services to Outsourced or Buyouts, or Color to Digital Color. What you see in your job method 

therefore may not match some of the examples in this manual. In addition, if you activated and customized any 

of the “Merch” pricing methods, they will also be available as job method selections. 

Each pricing method is designed to handle a particular kind of job: This document will list some of the different 

job methods and how they are set up. 

• Printing for an offset job on a standard sheet-fed press.  

• Roll Fed for a job on an offset web press.  

• B&W for a black-and-white job on a copier or digital press.  

• Color for a color job on a copier or digital press.  

• Large Format for a wide-format digital job.  

• Charges Only for an order that includes just setup or finishing charges (no printing).  

• Blank for pricing a job for blank stock.  

• List for a job based on a price list.  

• Outside Services for a job that is sent to another vendor.  

• Merchandise for any other kind of job that is not accounted for by one of the other pricing methods.  

• Multi-Part Job for a job that includes sub-jobs.  

• Free Style 

 

Printing Job 

The Printing job method is for offset jobs that are printed on a sheet-fed press. These jobs are based on sheet- 

fed press definitions. 

1. Follow the general procedure for creating a job and select Printing as the job method. (Your company may 

use a different name for this job method.) 

2. The job method will default as printing but can be changed. 

3. Select the product. In the Product field, select the type of product the job represents. (You can use 

Table Editor to define product types in the Products table.) 

Note If Product Type for Job is selected in the Mandatory Field preferences, the Product field is 

outline in red. You must select a Product before you can save the job. 

4. If necessary, change the settings of the Brokered or Finished check boxes. (Brokered is automatically 

selected if you create a job based on the outside service pricing method.) Identify if the job is Finished 

5. If you are using Tracker, in the Location field, select the area where the job takes place. 
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6. Select the Press. This is the press configuration that will be used to determine the price of the job. 

Select the correct press definition for the job. (Your choice affects the price of the job.) The press 

specifications will be compared to the stock selected and you will receive a warning if the stock size 

does not match the press. 

7. Enter a description 

8. If this product uses a stock, then you can use the drop down you can select the stock to be used. When 

you select the stock the parent size will automatically be filled in from the stock information. 

9. Complete the run size, finish size, folded size, original sheets and UP/ON. With this information an 

image of the layout will be displayed. 

Note The Up and On fields are calculated automatically based on the settings in the Paper Calculator 

window but change them as necessary. Up indicates how many images fit on the run sheet. On indicates 

how many unique images (originals) you have. Again, if you are producing one kind of flyer this should b e 

set to 1. 
 

10. In the Sheets field, enter the number of originals involved. Sheets can also be the number of versions if, 

for example, you are producing four different variations of a flyer. If, however, you are producing one kind 

of flyer from one original, you should leave Sheets set to 1. 

11. The Press field shows the number of impressions needed to get a finished quantity and is calculated by 
dividing the number Ordered by the number Up. (If the Press total cannot be divided evenly by the Up 

number, it is rounded up.) Change the number in the Press field if necessary, but keep in mind that 

PrintSmith Vision will then change the number in the Ordered field. 

12. Enter the run method. Often only one option will be available based on the press and stock. 

13. Enter ink information and run method. You can identify the number of colors, passes and washes for the 

front and back of the material. You can also select or type in the ink to be used from the dropdown. 

a. For Colors, specify the number of colors to be printed on the front and back. The default is 1, but for 

multi-color jobs, enter the number of colors. 

b. For Passes, specify the number of runs that are needed for the number of colors specified. Initially, 

Passes is based on the number of color heads in the selected press. If you need to run one color 

twice, you can change the number of passes as long as it is higher than the minimum number of 

passes. (This is considered an override.) 

Note: Labor and run time are based on the number of passes, not the number of colors. Charges are 

based on the number of colors, not the number of passes. 

c. For Washes, enter the number of press washes for each side of the job. The number of washes (on 

both sides) is multiplied by the wash rate in the press definition and added to the price of the job. 

d. Click the Ink field and select (or enter) up to six colors. (The available selections come from the Ink 

Color table, which you maintain with Table Editor.) 

Notes: For CMYK, enter each color in a separate field (four fields alto gether). When you select 

an ink here, it is not billed. To include the ink in the job price, you must add ink charges.  
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You can type in a PMS ink in the small box displayed in the line. That ink will be displayed in the short cut menu 

and selecting the plus sign will enter that ink in the line.  

 
14. Enter the quantity. By selecting the + next to the quantity field you can enter multiple quantities. All of the 

information already entered will be copied over to the additional quantities. You can enter the new 

quantity in the new quantity field for the additional quantities. You will also see additional fields at the top 

of the screen with each of the quantities so you can tab between quantities. Select the confirm button 

after entering a new quantity and it will be reflected in the quantity options fields. 

 

15. Enter the Over/Under quantity if applicable. If you want to charge for the difference between the ordered 

quantity and the quantity actually delivered, in the Overs/Unders field, enter a positive number if the 

delivered quantity is over the ordered one or a negative number if it is under. Overs and unders typically 

apply only to jobs with large quantities involved. 

Notes The total price of the job (including all charges) is divided by the quantity ordered to get a unit  price. 

The unit price is then multiplied by the quan tity entered in the Overs/Unders field. This is added to the job 

price and the total job price. 

Any job that has overs or unders defined is shown with the quantity and price italicized.  

 

16. The In Sets of field typically applies when carbonless or NCR stock is being used for the job, and 

indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets of field. 

Otherwise, this field is not used. 

Tip: For an item like pads, enter the total number of items in the Ordered field. For example, if you need 100 

pads of 25 pages, you would enter 2500 in the Ordered field and 1 in the Sheets field. You would then use 

charge definitions to make the pads themselves. 

17. Finishing operations (such as bindery) may have some associated waste. As you add charges to the 

job, any associated waste is calculated and added to the Bindery Waste field. If necessary, enter a different 

number in the Bindery Waste field, but avoid doing this until you have added all finishing charges to the 

job. 

Note: When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are spoiled. 
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18. You can add Charges to the job using the “Add New” button available in the Job Details Screen. 

Note: When you are adding charges or modifying any existing charges, make sure to click on Confirm button 

and Done button to save the charges to the Job. 
 

Special Order 

 

If the stock requires a special order, click Special Order and complete the Stock Definitions window with 

information about the stock. 

If the stock for the job is not part of your inventory, then you can select the option for Special Order. This allows 

you to specify a special-order material. Here you can enter all the material specifications.  

If user wants to add the special-order stock into Stock definition for re-use, then you need to enable “Use in 

future” option. 
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After completing the first screen, the second screen allows you to enter cost information for different quantities.  

 
Select Done when you are complete, and the information will be copied to the job detail screen.  
 

Stock Picker 
If you want to see the full list of stock you can use the stock picker.  

You can look at all of the stocks in inventory from the stock picker list. You can use the blank f ields at the top of 

the screen as filters. For example, if you only want to see 80# stock enter 80 in the field below weight. When you 

select a column heading you will see an icon that allows you to sort according to that column in order or reverse 

order. Highlight the stock you want and select the confirm button. The stock information will be entered 

automatically in the job detail screen. 
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You can customize the Stock Picker window by going to the Customize Columns option and selecting the 

columns you want to see and the order you want to see them.  

 

 
Paper Calculator 

You may not need the paper calculator in all cases. The Paper Calculator will help in determining the amount of 

parent sheets needed and the material cost. You enter the specifications and the system will calculate the 

amount of material needed for the job. 

Review the settings in the Paper Calculator window, change them as necessary, and click Save. Be sure you 

specify the correct Run Size and Finish Size as an example. 



Estimating |  553 
 

 

 

 

 
 
 

 

Using the Paper Calculator 
Although not an imposition tool, Paper Calculator lets you specify certain aspects of the layout such as bleeds, 

gutters, and white space. Paper Calculator also shows you the number of sheets out and the number of cuts for 

any combination of parent, run, and finished sheet sizes. Although you can provide this information for each job, 

you can create paper templates for your standard layouts and re-use them in future jobs. 

 
 

Changing settings in Paper Calculator 
• When you open the Paper Calculator window opens after you select a stock for a job, the window 

already includes some information about the dimensions of the stock. Otherwise, you must provide this 

information. Always check the run and finish sizes and make sure other layout settings are as you want 

them. 

Note: The default settings of certain fields in the Paper Calculator window are controlled by your paper  

calculator preferences, but you can change them when using the Paper Calculator for a particular job.  

• The settings and features in the Paper Calculator window include the following:  

• If you have created paper templates, click the Paper Template dropdown list to locate and select a 
template for the job. The Template Name field then shows the template you selected. 

• Parent Size: The size you purchased. 

• Run Size: The size of the paper that goes through the machine. Change this by selecting a different 
size or entering a size. 

• Finish Size: The final size of the paper after the job is done. Change this by selecting a different 
size or entering a size. 
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Selecting the slide bar will display the options for the following elements.  
 

• Grip Edge / Gap: Select this check box to include a gripper edge. This is the amount of space required on 

one feed edge of the run sheet for the press to pick up the paper. You may be able to ignore this 

setting due to the placement of the image on the page. The size of the grip edge usually comes from the 

press definition but may come from your Paper Calculator preferences. You can, however, change the 

grip edge/gap in the Paper Calculator window for an individual job. 

• Folio Edge: Select this check box to include a folio edge. This is the amount of space that is reserved on 

an edge of the run sheet for a multi-part job. The folio edge is used when folding signatures to offset the 

imposed image and to leave one edge of the folded signature overhanging the other. If both the gripper 

and folio use the same edge, the larger of the two is used (they are not added together), and the edge is 

displayed half in red and half in green. 

• Color Bar: Select this check box to include a color bar opposite the gripper edge. 

• White Space: Select this check box if you want to define a part of the run sheet as unusable and have 
control over the page layout. 

• Gutter: Select this check box to include a space between multiple images on a sheet. The first value is the 
vertical gutter; the second is the horizontal gutter. 

• Bleed: Select this check box to include bleeds. A bleed extends the printed image beyond the edge of a 

page. This overlap is then trimmed to produce the final printed piece. Bleeds generally increase the 

number of cuts because the bleed must be trimmed off each finish sheet in addition to any cuts needed to 

separate each sheet. 

You can specify a different bleed for each edge, but since generally the same bleed is used for all sides, 

you can just enter a value in the Top field. The other bleeds are then automatically set to the same value. 

Bleeds are shown as blue borders around each sheet and are added to any gutter that is specified. 

Select the appropriate check box for these items as needed.  

• Work and Tumble: Select this check box to change the cut-out diagram for tumbling by showing two 

gripper edges. (The Work & Turn label in the Job window then changes to Work & Tumble.) Except for 

a possible change in the number of sheets out due to the additional gripper edge, no other change to 

pricing is made as a result of selecting the Work and Tumble check box. 

• Back Trim, Parent: Select this check box if you consistently trim the edges from all four sides of the 

parent sheet. This effectively adds four cuts to the parent cut and centers the run sheets in the parent 

sheet. 

• Trim Four Sides: Select this check box to center the image by trimming the edges from all four sides of the 

run sheet. This typically results in the best ink coverage. 

• Disable FSC options: Select this check box if a stock is tracked for chain of custody (such as FSC 

certification), but the customer did not request a certified stock, and therefore you want to omit the chain of 

custody information from the document. 

• Run to Finish Grain: If necessary, change this from Neither (where a best fit strategy is used without 

any sheet rotation) to Match Grain (sheets are never rotated to improve the number of sheets out) or 

Swing/Combination (sheets may be rotated to maximize the number of sheets that can be cut out). 

Notes: Sizes are defined in the Dimension table which you can edit with Table Editor. 

The area on the right shows the cut diagram. Select Parent & Finish; Parent & Run; or Run & Finish to change 

what is shown. 

Tip When you are finished be sure to select Confirm 

Note The confirm button does not save the estimate. To save the estimate you must select the SAVE button on 

the estimate summary screen. 

 

Supplied Stock and Special Order 
If the stock will be supplied check that box and the cost of the stock will be removed from the price of the job.  

If the stock requires a special order, click Special Order and complete the Stock Definitions window with 

information about the stock. 
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Job Notes 

Selecting Job Notes will take you to a screen where you can add job ticket notes. “Add Time Stamp” will put the 

date and time with the notes. 
 

Digital Assets 

The Digital Assets option will allow you to upload digital files. 

Delete button 

User can delete individual job from the job details screen using Delete button 

Note When a user deletes the job and confirms they are taken to Estimate/Invoice summary screen. 

Confirm 

Once the information has been entered selecting Confirm will save the job information and you can move to the 

estimate summary screen. 

Important Selecting Confirm does not save the estimate. You must use the save button on the estimate 

summary screen. 

 
There are several command options available when you create a job. 
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Carton Labels 

You can create labels for the containers that hold the finished job. You can also define the format of these labels. 

Note You must save the estimate from the estimate summary screen before you can print labels. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. If necessary, in the Label Format field, select a different format. Carton Labels is automatically selected as the Label 
Format. You can create and edit label formats by clicking Define Label Format. 

2. Enter a Total quantity 
3. Enter Items Per Box 
4. Enter Number of Boxes 
5. Enter a Starting Number, if is other than 1, as well as a Ending number 
6. If you have a partial sheet of labels and you need to skip over them to the first good label, enter the number in the 

Labels to skip field. 
7. In the Label Text field, enter any additional information to print on the label. 
8. Select to use Today’ Date or End Date 
9. Select the information that you want to include on the label, for example, Job Description, Today’s Date, or Estimated 

Weight. 
10. Enter the information on how you want the labels to print 

11. Click PRINT after you specify all the carton label information. 
 

Defining, editing, or deleting label formats 
You can define, edit, or delete the formats for carton labels. PrintSmith comes with several pre-defined 

formats for labels. You can modify these formats or create as many additional formats as you need using the 

Define Label Format button (see step 2 below). 

The table below describes the pre-defined label formats supplied by EFI. 

 

To define a label format 

1. In the Job window, click Carton Labels on the toolbar or click Carton Labels under Commands. The 

Carton Labels window opens. 

2. Click Define Label Format. The Define Label Format window opens. 

Note: This window is also used for defining, editing, and deleting shipping and mailing labels. 

3. In the Existing Formats field, select <new format>. 

4. Enter a Format Name. 

5. Specify the label details and click Print Sample to see if the label looks the way you want it. 

6. Click OK. 
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To edit or delete an existing format 

 
1. In the Carton Labels window, click Define Label Format. The Define Label Format window opens. 

2. In the Existing Formats field, select the label format you want to edit or delete. 

3. If you are editing the format, make your changes; if you want to delete the format, click Delete and then 

click Yes to confirm the deletion. 

4. Click OK. 

 

Reviewing Production Data 
You can review production data from the Job Window. Here you can review production and pricing information 

for the job. The information displayed in this window comes from your pricing definitions and should not be 

changed except under special circumstances. The information that is displayed also depends on the job pricing 

method. For example, outside service or merchandise jobs have far less data than printing or l arge format jobs. 

Note  You can prevent an individual user from opening the Production Data window with a security 

setting (select Admin > Security Setup and disable Job Production Data). 
 

 

 
Production Data Information  

 
Parent Size - The size of the purchased sheet. This is taken from the selected stock. (For large format jobs, this 

is Roll Width, not Parent Size.) 

Parent Costs - Your price for the Parent Size sheet for the number of sheets shown in the per field. (For large 

format jobs, this is for square area.) 

Press/Run Size - The dimensions of the sheet being run. 

Out - The number of Press/Run Size sheets that you can get out of a given parent sheet. (You can override this 

number, but if you do, PrintSmith Vision cannot generate a cutout diagram.)  

Press Speed – This is expresses in Impressions/minute. (For B&W, color, and large format jobs this is Copier 

Speed.) 

Production Run - The number of impressions per run. (This cannot be changed) 

Markup - The markup on the stock (your gross profit on the stock).  
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Requires - The number of parent sheets (or other unit) required to run the order. (This cannot be changed)  

Sheets Purchased - The number of sheets purchased for the job. (If the selected stock has a minimum 

quantity, this number may be higher than the actual sheets required for the job. The cost of the additional paper 

is included in the job if the Charge Customer for Entire Order check box is selected in the stock definition.) (This 

cannot be changed) 

Press - The press definition selected for the job. (For B&W, color, and large format jobs, this is Copier – the 

digital definition used for the job.) (This cannot be changed)  

Labor Rate/Markup - The labor rate and labor markup used for the press.  

Setup, Run, Washup, Total Time - The time to set up the press and the time required for washup apply only to 

jobs based on press definitions. The run time is based on information in a press or digital definition.  
 

Job Price 

This area of the Production Data window breaks down the job price:  

 
 Stock The Cost, Markup, and Price breakdowns for the stock for the job. 

Labor The Cost, Markup, and Price breakdowns for the labor for the job. 

Itemized Markup The total markup charges (if any) attached to the job. Markups are calculated 

separately after all other charges are calculated so they are based on the most 

current prices and exclude invoice level charges or customer discounts.  

Other Markup The total of all charges attached to the job that are not markups.  

Production The total charged for washups. (For jobs not based on press definitions, you can use 

the field to add any additional production fees for which you do not already have a 

charge, for example, a delivery fee to an outside vendor.)  

Target Adjust For offset jobs where you have a price list if you price the job differently than the price 

list the difference will be displayed in Target Adjust.  

Job Price The total of all the prices shown in the window (unless the job price was overridden).  
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Estimator Checklist 

PrintSmith Vision includes an “estimator checklist” so you can review the entire job – from specification creation 

to production – in one place. The estimator check list has two sections, one for the item list and the other for the 

items table. 

One checklist is opened for each job in a document. The item list shows general information about the job; the 

items table provides details of the items that make up the job. Items that are red and underlined indicate 

conflicting information or information that was overridden and warn you to follow up. 
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Price List 

Once the detail is entered you can create a price list. This is used for customers that are not sure of the quantity 

they want to order. 

 
 

Roll-fed Job 

The Roll Fed job method is for jobs that are printed on an offset web press, for example, a newsletter printed in 

four colors on two sides. These jobs are based on roll -fed press definitions. 

Roll-fed jobs are identical to printing jobs (see above), with these exceptions:  

• The Roll Width is the width of the entire roll of stock. This comes from the stock definition and cannot be changed. 

• The Cutoff field specifies the circumference of the physical cylinder on the press, for example, 11 inches. This comes 
from the press definition and cannot be changed. 

• By definition, there is only one pass on a roll-fed press, so Passes is always set to 1 (and cannot be changed.) 
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B&W or Color Digital Job 
 

The B&W and Color job methods are for black-and-white and color copy jobs. Much of the information for such 

jobs comes from the digital definition and stock definition selected for the job. For many jobs, a description and 

the number of copies ordered is all that is required to price the job. 

1. Follow the general procedure for creating a job and select B&W or Color as the job method. (Your 

company may use different names for these job methods.) Then select a stock and make any necessary 

changes in the Paper Calculator window. 

2. In the Description field in the Job window, enter a name for the job, for example, Color Copies. 

3. Tab through and complete the fields on the right side of the Job window: 

a. In the Ordered field, enter the job quantity. For information about specifying more than one 

quantity for a job. 

b. If you want to charge for the difference between the ordered quantity and the quantity actually 

delivered, in the Overs/Unders field, enter a positive number if the delivered quantity is over the 

ordered one or a negative number if it is under. Overs and unders typically apply only to jobs with 

large quantities involved. 

Note The total price of the job (including all charges) is divided by the quantity ordered to get a unit 

price. The unit price is then multiplied by the quantity entered in the Overs/Unders field. This is 

added to the job price and the total job price. 

Any job that has overs or unders defined is shown with the quantity and price italicized.  

c. The In Sets of field typically applies when carbonless or NCR stock is being used for the job, and 

indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets of field. 

Otherwise, this field is not used. 

Tip For an item like pads, enter the total number of items in the Ordered field. For example, if you 

need 100 pads of 25 pages, you would enter 2500 in the Ordered field and 1 in the Sheets field. You 

would then use charge definitions to make the pads themselves. 
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d. In the Sheets field, enter the number of originals or number of versions (see examples below). 

Note In certain kinds of jobs (such as booklets), sheets are equivalent to leaves. When entering a value in 
the Sheets field for jobs like these, keep in mind that you are always describing the finished product. 

Example 1: In a job for a set of single-sided copies, Sheets is the number of originals. If you are 

making 100 copies of 10 pages, Sheets would be set to 10. (If the job is double-sided, Sheets would 

be set to 5.) 

Example 2: In a job for four different versions of a single-sided flyer, Sheets is the number of versions 

so should be set to 4. 

Example 3: In a job for a 100-page comb-bound booklet, Double-Sided would be selected and Sheets 

would be set to 50. 

Example 4: In a job for a 16-page booklet which is the result of folding the paper in half and 

saddle-stitching, Double-Sided would be selected and Sheets would be set to 4. (4 double-sided 

sheets folded in half and saddle-stitched result in a 16-page booklet.) 

e. The Up and On fields are automatically calculated but change them as necessary. Up indicates how 

many images fit on the run sheet. On indicates how many unique images (originals) you have. For 

example, if you are producing business cards with four different names, On should be set to 4. 

f. The number Ordered divided by the number Up results in the value in the Copies field (which may 

be rounded up). Change the value in the Copies field if necessary, but keep in mind that 

PrintSmith Vision will then change the number Ordered. 

g. Finishing operations (such as bindery) may have some associated waste. As you add finishing 

charges to the job, any associated waste is calculated and added to the Bindery Waste field. If 

necessary, enter a different number in the Bindery Waste field, but avoid doing this until you have 

added all finishing charges to the job. 

Note: When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are 
spoiled. 

h. In the Est Waste field, enter the number of sheets you expect to lose during the production 

process to get the required number (Ordered quantity) of good prints. Normally, Est Waste is set to 

0, but you can override it (if you have permission to do so). 

Note: Usually, waste is added to the run length. This affects the estimated run time for the job and the 

amount of labor. When labor is a factor in calculating the price, the price changes to reflect this. If the 

stock cost is part of the price calculation in the digital definition (the Stock Price is field is either set to 

marked up Stock Cost or set to from Copier 1, 2, or 3 in Stock Definition), waste is included in the 

price. 

4. The stock information and dimensions should be correct based on your stock selection and the 

information you provided in the Paper Calculator window. If you need to change the stock, click 

Change Stock Selection under Commands. 

5. The Pricing Copier field defaults to the digital definition associated with the stock (if any) or your 

default B&W or color digital definition depending whether you are creating a B&W or color job. Select 

the correct digital definition for the job. 

The Costing Copier is the printer you want to use for costing if a job is quoted on a low-end printer but is 

run on a high-end printer. The price of the job stays the same, but your costs will be accurate if the high -end 

printer is used. Typically, you do not need to change this field.  

6. Select Single Sided or Double Sided. 

7. Add any setup and finishing charges to the job as described on page 80. For example, if you are folding 

and stitching the job, add a folding charge and a stitching charge. 

8. Click Save to save the job. The document window opens with the job and its charges listed. 
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Add/Modify Special Pages 
You may have pages that are different than the rest of the pages. It could be some color pages where the rest are black and 
white, or it may be an insert. 

Here you can define the special pages and add them to the job detail  
1. Enter the page numbers for the special pages 
2. Select the type of pages 
3. Enter the description 
4. Select the stock type 
5. Select the stock color 
6. Identify as Simplex or Duplex 

Selecting Print Services will allow you to enter some specific printing services.  
 

 

Large Format Job 

The Large Format job method is for jobs that are printed on a wide-format digital press. These jobs are 

based on large-format digital definitions. 

Large-format jobs are almost identical to B &W and color jobs, with these exceptions:  

• The stock selections (in the Stock Picker window) are limited to stocks used for large-format work. 

• The Cutoff is the length of the stock used for the job. 

• The Est Waste field is for specifying the number of prints (not square area) that you expect to waste to get the 
required number of good prints. 

• The Pricing Copier field defaults to the digital definition associated with the stock (if any) or your default large-
format digital definition. If necessary, select a different large-format digital definition for the job. 

 

Charges Only Job 

The Charges Only job method is for jobs that consist of just setup or finishing charges, for example, design work.  

 

1. Follow the general procedure for creating a job and select Charges Only as the job method. 
2. In the Description field, enter a name for the job, for example, Design and Consulting. 
3. If you plan to add more than one job aware charge, in the Ordered field, enter the job quantity. This quantity is 

then used automatically in all the job aware charges. Otherwise, leave the Ordered field set to 0. 
4. In the Notes field enter any comments to explain the job. 
5. Add the charges to the job. 
6. Click Save to save the job. 
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Job for Blank Stock 

The Blank job method is for selling blank stock. The prices for blank stock are taken from the Pricing for 

Blank Sheets area on the Pricing tab in the Stock Definitions window. 

Note: Blank stock pricing is based on the Blank Stock Pricing quantity and markups in your Stocks and Sizes 
preferences and the costs in the stock. 

PrintSmith Vision uses the blank sheet pricing to calculate a unit price and then multiplies this by the 

quantity ordered for the job. 

To create a job for blank stock 
1. Follow the general procedure for creating a job and select Blank as the job method. Then select a stock and 

make any necessary changes in the Paper Calculator window. 

 
 

2. In the Description field, enter a name for the job. 
3. In the Ordered field, enter the quantity and press the TAB key. The Unit Price and Price are calculated according 

to the blank stock pricing in the stock definition. 
4. Click Save to save the job. 

 

List Based Job 

The List job method is for print jobs based on list pricing. List prices are tables of quantities and either 

numbers of colors or numbers of passes through the press. PrintSmith Vision includes some list price 

schedules to get you started. You can change the contents of the schedules or delete them as long as at 

least one is left. (There must always be at least one predefined price schedule.)  

Note: List pricing is useful if you need to match another pricing system or a printed price list exactly, but 

you do have to enter and change the prices manually.  

If you use Crouser pricing, see the guide PrintSmith Vision - Crouser Pricing. Crouser list price schedules 

work very much like the standard list price schedules described here except that you cannot edit or delete 

them. 

If you create jobs based on list pricing, you can (but do not have to) assign price list schedules to stock 

definitions. When you select a stock for a list-based job, and the stock has a list price schedule associated 
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with it, that list price is used for the job. Otherwise, PrintSmith Vision warns you that the default price 

schedule will be used. You should then select a list price for the job.  

Before you can create jobs based on list pricing, you must create your list price schedules or review and 

adapt the predefined price list schedules. 

 

Creating List Price Schedules 
Select Pricing > List Price Schedules. The List Price Schedules window opens. 

To create a list price based on quantities (copies) and number of colors, click New Color Schedule. A 

window with Colors at the top opens. 

Alternatively, to create a list price schedule based on quantity and number of passes through the press, 

click New Pass Schedule. A window with Passes at the top will open.  

To complete the price list information: 

 

1. In the Name field, enter a descriptive name for the schedule. 

2. By default, the price list is based on the ordered quantity, but if necessary, select one of the following 

in the Method field: 

• Use press sheets – the run quantity of sheets through the press. 

• Use press sheets and bindery waste – all the paper running through the press. 

• Use ordered quantity per sheet (originals) – the ordered quantity for each original, for 

example, 25 business cards for each name. 
 

3. Enter your quantities and prices in the table. Note that the fields below the table are used for 

whatever additional increment that you specify; +1000 in the example below. 

 

4. Click OK 
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Modifying list price schedules 

EFI recommends that you review the pre-defined list price schedules and adapt them to your needs.  

1. Select Pricing > List Price Schedules. The List Price Schedules window opens. 
2. Select the list price schedule you want to review or edit from the drop-down list. The list price 

schedule opens. 
3. Edit the schedule as necessary and click OK. 

 

Copying list price schedules 

1. Select Pricing > List Price Schedules. The List Price Schedules window opens. 

2. Select the list price schedule you want to copy. The list 

price schedule opens. 

3. Select the Duplicate button in the upper right-hand corner of the window and provide a name for 

the new List Price Schedule. 
4. Edit the schedule as necessary and click OK. 

 

Deleting list price schedules 
You can delete any list price schedule, but the system must always include at least one li st price 

schedule so that a default exists. 

1. Select Pricing > List Price Schedules. The List Price Schedules window opens. 

2. Select the list price you want to delete click Delete. 

3. Click Yes to confirm the deletion. 

 

Assigning list price schedules to stocks 
When you use list pricing as the job method, your stock definitions can be (but do not have to be) 

associated with list price schedules. When a list price schedule is associated with a stock that you select for 

a list -based job, the list price schedule is used to price the job. If the selected stock does not have an 

assign ed list price schedule, you are warned that the default list price schedule wil l be used for a list-based 

job; you can then select a list price schedule for the job.  
Note The default list price schedule is the first one listed in the List Price Schedules window.  
 

To assign list price schedules to stocks 
1. Open a stock. 

2. In the Stock Definitions window, click the Pricing Options tab. 

3. Under Schedule for List Pricing, click Select Schedule and make your choice. The name of 

the schedule is now displayed to the right of the Select Schedule button. 

4. Save the stock definition. 

Creating jobs based on list price schedules 

When you select List as the job method, a list price schedule must also be selected. If the stock you 

select for the job is associated with a list price schedule (see above), that schedule is used (although you 

can change it). Otherwise, you must select a schedule while creating the job.  

Follow the general procedure for creating a job and select List as the job method. Then select the stock. 

1. In the Description field in the Job window, enter a name for the job. 
2. If you were warned that the default list price schedule will be used, select a different schedule. 
3. In the Quantity field, enter the quantity ordered. If the schedule is based on colors, the initial calculated 

price is based on one color on the front. For passes through the press, the price is based on one pass. 
4. In the area below Costing Press, for a schedule based on colors, enter the number of colors on the 

front and back as shown in the figure below. (If the schedule is based on passes, enter the number of 
passes as necessary.) The price of the job is automatically updated based on the information in the list 
price schedule selected for the job. 

 

5. Click Save. 
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Outside Service Job 

The Outside Services job method is for jobs that you send out to other vendors, not do in -house. Such jobs are 

also known as brokered or vended jobs. An outside service job is marked up according to your outside services 

markup preference (Admin > Preferences > Estimator > Markups). (You can always adjust the markup as 

market conditions change.) 

Note Jobs are not identified as outside service jobs on estimates or invoices so your customers will not know 

these jobs were sent out. 

If purchase orders are enabled in your system, you can create a purchase order for the outside service.  

1. Follow the general procedure for creating a job and select Outside Services as the job method. (This 

may have a different name in your shop.)  

2. In the Description field, enter a name for the job, for example, Design Work for Spring Promotion. 
 

3. In the Notes field enter any comments to explain the job. These notes are for the outside service 

(vendor) and are not shown to the customer unless you select the Show Notes check box. 

4. In the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list of vendors in the 

Vendor table.) 

5. In the Quantity field, enter the number ordered. 

6. Do one of the following: 

• In the Unit Cost field, enter the cost of one unit of the item you are having done. The system then 

calculates the Total Cost by multiplying Unit Cost by Ordered (quantity). 

• Enter the Total Cost. (No Unit Cost is calculated in this case.) 

Note The Price is Total Cost multiplied by the Markup. 

7. Click Save to save the job. 

Note If you activated any of the five Merch pricing methods (in the Pricing Method preferences), they 

work just like the Outside Services method. Typically, the Merch pricing methods are used to group 

outside services by different sales categories. 

 

Merchandise Job 

The Merchandise job method is for any kind of work that is not accounted for by one of the other job methods. A 

merchandise job is marked up according to your merchandise markup preference (Admin > Preferences > 

Estimator > Markups). 
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1. Follow the general procedure for creating a job and select Merchandise as the job method. (This may have a 

different name at your shop.) 
2. In the Description field, enter a name for the job, for example, Frames. 

 

3. In the Notes field enter any comments to explain the job. These notes are not shown to the customer 
unless you select the Show Notes check box. 

4. If applicable, in the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list of 
vendors in the Vendor table.) 

5. In the Quantity field, enter the number required.  
6. In the Unit Cost field, enter the cost of one unit of the item you are selling. 

Note: Total Cost is the Unit Cost multiplied by the Quantity, and the Price is Total Cost multiplied 
by the Markup 

7. If necessary, add charges to the job. 
8. Click Save to save the job. 

 

Multi Part Job 

The Multi-Part Job pricing method is for complex jobs that include sub-jobs. For example, you have an 

order for a booklet that has a cover and a number of inside pages. The cover might be a process color job 

on coated stock while the inside pages might be photocopied. The cover may need negatives, stripping, 

plates, scoring, and so on, while the inside pages are a simple copy job. Since the jobs are related,  you 

want to keep them together. 

Some charges would apply to the entire job (for example, collating or binding) while others (for example, 

embossing the cover) would apply just to the cover job. Similarly, you might have an order for an unusual 

banner that involves three separate jobs: printing the banner itself, sending it out to be sewn, and sending it 

out for installation. 

After you select the Multi-Part Job pricing method, you first provide some general information about the 

overall job, after which you add the individual jobs that make up the parts of the overall job.  

To create a multi-part job 

1. Follow the general procedure for creating a job and select Multi-Part Job as the job method. 

2. Select the product. In the Product field, select the type of product the job represents. (You can 

use Table Editor to define product types in the Products table.) 

Note: If Product Type for Job is selected in the Mandatory Field preferences, the Product field is 

outline in red. You must select a Product before you can save the job. 

3. If necessary, change the settings of the Brokered or Finished check boxes. (Brokered is 

automatically selected if you create a job based on the outside service pricing method.) Identify if the 

job is Finished 

4. If you are using Tracker, in the Location field, select the area where the job takes place. 

5. If the Product you select for a job is associated with a specific tax table (in the Products table), the 
Tax Table field is (with some exceptions) set to that tax table. 

6. If you are using Tracker, in the Location field, select the area where the job takes place. 

7. If you need to change the pricing method for the job, select it in the Type field. (Other fields in the 
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Job Window will be affected by your selection.) 

8. In the Comment field, enter any notes about the job. 

9. Enter the description. The job method will default into the description field but it can be edited, 

removed or added to. 

10. Enter notes about the job. You can check the box to have notes included in documentation and invoice. 

11. You can add charges for the overall multi job in addition to the charges that may have been added 

to individual job parts. 

12. Finishing operations (such as bindery) may have some associated waste. As you add charges to 

the job, any associated waste is calculated and added to the Bindery Waste field. If necessary, 

enter a different number in the Bindery Waste field, but avoid doing this until you have added all 

finishing charges to the job. 

Note: When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are 

spoiled. 

13. In the Est Waste field, enter the number of sheets you expect to lose during the production process 

to get the required number (Ordered quantity) of good prints. 

Note: As you complete each job part be sure and select Confirm. This will add the job charges to the 

multi - part job. 

Each part of the multi part job can be different job methods and are defined when you create the part. Use 

the “Add Part” button to add each part to the job.  

When you select add a job, you will be taken back to the add job screen where you can select the job 

method for that part. After adding a job, you can select the Go to Job Details button and you will be taken 

back to the multi - job page where you can see all of the job parts and charges, including charges added to 

each job part. 

 

 

Free Style Job 

There may be times when you do not need a job ticket or estimate and just want to produce an invoice for 

the customer. For a free style job all you enter is the job description, quantity and price.  

 

 

Create Job from Account History 
If you select Account History, then you will see a list of account historical invoices or you can select from 

historical estimates. This is helpful for reprint jobs where the price may or may not have changed. You can 

narrow the search by using the search fields at the top of the list to select from the posted date, invoice or 

estimate number, description, cost or sales rep. 
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Note For walk-in customers you will also see a column for account name. 

 

 
You will then see a new screen with the information from the historical invoice or estimate. Select the one you 

want and then select NEXT. This will take you to the estimate summary screen. If the prices have changed since 

the invoice or estimate was originally created, you will be given the option to update the price definitions. 

 

 
You can select the product from the drop-down list. 

 

 
The quantity will default from the original estimate or invoice but you can change it. The price will automatically be 

recalculated based on the new quantity. If you need to make changes to the job you can select the job detail tab 

and make changes there. For more information on the job detail screen see the prior section on the job method 

that is appropriate. 
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Create Job from Templates 

In the section on create from there are two views with different options. If you choose to use template 

categories then you only see the options of Create New Job, Account History and Templates. If you 

do not use template categories, then in addition to the others you will see the option of Job 

Templates. The check box for Template Category View is under Preferences > HTML View.  

Without the Template Category View you can choose from Job Templates or Templates. For either one 

you can then select invoice or estimate templates.  

 

If you select job templates, you will see all of the job methods and as you select  the job method you will 

see the templates that have been set up for that job method.  

 

If you select for the Template Category View, then when you select Template you will be shown the list 

of template categories. You can select to show all templates or select a specific category and then you 

will see only the templates for that category. 

You can also use the column headings to search for specific templates, just start typing in the selected field. 

In accounts you can identify templates or job templates for a specific account. When you search for 

templates or job templates you will see all of the templates, but you can use the column heading for 

customer to select the account you want and then only the templates set up in the account will be 

shown. See Selecting Invoice and Job Templates under Accounts. 

 

 
You can create a template category from the template list or when you create a template from an 

estimate on the estimate summary screen. 

 
After selecting the invoice or estimate template, the new estimate screen is opened. If there has been a price 
change in any of the operations or material since the original invoice or estimate was done you will get an  alert and 

you can decide to have the new estimate updated with the new price or keep the old pr ice
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Account information 

You should always review the information in this window, provide any missing information, and make any 

necessary corrections. 

Note: If any account or contact fields are required (as specified in the Mandatory Field preferences), you must 

provide this information before continuing. This applies to the walk -in account, too. If there is a Red box around 

the contact area that indicates that there is some missing information regarding that contact. User will not be able 

to proceed until the mandatory information is filled. 

Review the Invoice Address; if necessary, click Edit to change it. Doing so changes the address only in the 

document, not in the customer account. 

Note: You can change the account name and address if Can change address on ALL document’s preference 

is selected in the Estimator Behavior preferences (Admin > Preferences > Estimator > Estimator Behavior ). 

The Contact field includes information about the invoice contact from the selected account. If necessary, do one 

of the following: 

Note: A temporary contact is not added to the customer account. In addition, if PrintSmith is integrated with  

SugarCRM, temporary contacts are not sent to Sugar. For more information, see the PrintSmith Vision – 

SugarCRM Integration Guide. 

• If the contact you want to specify is not in the Contact List, add one by clicking New (or by selecting File > 

New) and completing the Edit Contact window. This new contact is added to the customer account 

when you save the document. 

 
 

 
Add 

Contact 

 
 
 
 

 
Edit contact 

 
 
 
 
 
 
 
 
 
 

 

Account Status and Type 

You can identify the status of the account and the types of payments that will be accepted from that account.  
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Invoice and Delivery Address 

In addition to the contact information, you will also see the invoice address and delivery address. The invoice 

address cannot be changed from this screen and must be changed in the customer account information. From the 

Quick Access Screen in the Legacy version select account and the select the account from the provided list and 

then you can change the invoice address using the edit option. Changing the invoice address in the customer 

account will not change the address in the estimate account information. You will need to create a new estimate. 

 
 

You can change the delivery information by either selecting from Contact list if there are other contacts already 

set up or you can enter a new delivery. To enter a new delivery address, select the option of Other and that will 

then open the option to edit delivery. 
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Internal Information 
There is also some internal information that is needed for this invoice. 

 

 
1. The Taken by field identifies the person who created the document (based on the user name entered 

to log into PrintSmith Vision). If necessary, change this name. 
Note For better job tracking always log in as yourself; do not share your login with other users. 

2. If you selected an account for the document, the name of the sales representative associated with the 
account is displayed in the Sales Rep field. If necessary, select a different representative. 

3. If necessary, in the Hold field, select a hold state if the job needs to be held or the customer is on 
credit hold. You can see hold information in the Work in Progress report. (You can edit the Hold 
State table with Table Editor to include the kind of states that apply to your business.) 

4. If necessary, select a Lead Source. (You can edit the Lead Source table with Table Editor to include 
the kind of leads that apply to your business.) 
Note: When you convert an estimate to an invoice the selection in the Lead Source field is kept; if 
you copy the document to a new invoice or estimate, the value is not kept. 

5. If necessary, in the Proofreader field, enter the name of the person doing the proofing. 

 

Missing Information Warning 

If any information is missing you will see a warning and the area for the missing information will be 

outlined in red. 

Note: Until user adds the missing information, they will not be allowed to switch to another tab. 
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Estimate Summary 
There are several features available from the estimate summary screen. 

 

Adding Free Style Items, Jobs or Charges to an Estimate 
 

Add Free Style Item 

Sometimes you may have a situation where a customer is ready to place an order, but they do not want to wait 

while you enter all the information needed to create a job. This works well if it is something basic such as a 

business card or stationery where you know the price and the specs. You can provide the customer with an 

invoice and then later fill in the job specifications. In this situation, you will select ‘Add Free Style Item’  

• To enter a Free Style Item: 

• Select the product 

• Enter a description 

• Enter a quantity 

• Enter the item total charge. The unit price will be calculated form the quantity ordered and total cost 

• Select if the line item is to be taxed or not. 
 

After adding Free Style job and saving the estimate you will get the option to convert  to job. The Price of the 

Free Style job is automatically locked. To make changes to the job you will need to unlock the item by clicking 

on the lock. 
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After converting the job, you will be directed back to the job detail screen. On the job detail screen, you can 

change the job method and add the required job information, you can also mark the job has Finished and 

Brokered. You can add charges to the job. 

Note: User is not allowed to Add charges to Free Style job before saving and converting to a job. However, once 

the job is converted you can add the charges. 

Add Job 

Adding a job will take you a screen where you can select how you want to add a job. It has all the same options as 

the original new job screen. 

 

 

See the information on “Adding a job”. After adding the job, it will be reflected in the total estimate. 
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Add Charges 

Charges are set up in the Legacy version. Go to Pricing > Charge Definitions.  

Note: When you are adding charges or modifying any existing charges, make sure to click on Confirm button 

and Done button to save the charges to the Estimate. 

 

 

Create Account from a Document 

This is only available with Walk-In accounts. When you have an estimate or invoice from a Walk-In account and 

want to make them a new account you can use this feature. You must have a company name an address f or this 

account. 

 

Save as a Template 

 
 

1. Select if you are creating an estimate or job template. 
2. Enter the template name 

3. Select the template category from the dropdown. 

If you create a job or estimate and anticipate using it in again you can create a job or  estimate template. A job 

template consists of a single job and all the setup and finishing charges for that j ob. An estimate template 

contains all of the information from the original estimate. Templates can be used many times. You can create an 

estimate from a template and then make changes to that estimate as needed.  
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You can also create templates for multi-part jobs. In this case, the template contains the overall job, its charges, 

and the parts (jobs) that make up the overall job, as well as their charges. For any repetitive jobs, templates save 

time and reduce errors. 

Note: To see how to “Create Template Categories”. 

Templates can also be associated with customer accounts (on the Templates tab in the Customer window). This 

facilitates the process of selecting a template when working with an account.  

 

Copy to a New Estimate 

This option allows you to copy the entire estimate over to a new estimate. You will get a warning if you have not 

saved prior to copying. 

 

Email Estimate 

Selecting this option will first save the estimate if it is not already saved and then open an email window with a 

preset message. 

 

 

 

Estimating Notes 

You can enter estimating note in the following window. 
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Print Estimate 

Note: Estimate must be saved before printing. If you select print estimate before saving the program will save the 

estimate automatically. 

You can print an estimate also from Pending Documents. You can also define the style to be used for the printing.  

 

Change Account 

You can change the account for the estimate. Click on the account name and then use the drop down to select 

the new account. You can also type in part of the name. 

Note: Change account is only available from the Account Information screen or Invoice/Summary screen. The  user must 
have permission to change an account. 

 
One portion of the estimate summary screen is minimized by default use the arrow at the bottom to display this 

portion of the screen. 

 
 

Special Instructions 

You can enter special instructions that will appear on the estimate. 

 

Sales Categories 

This shows the invoice sales breakdown for each sales category  

Note: The total for the sales categories comes from the invoice item total and not the invoice total that could  

include taxes, discounts or markups. 
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Dates 

You can mark the wanted date as firm and mark to file the originals. 

 
User can select\update the shipping method here from dropdown. 

 

 
When the PO number is mandatory then the field would be highlighted so that user can enter the data, Warning 

is not displayed when an Invoice is saved. However, when user tries to pick up the Invoice the following warning 

is displayed. 

“Orders for this customer require a Purchase Order. Please enter a PO#.”  

Price Information 

The Price information area shows the estimate totals. To enter a shipping amount, enter or change a customer 

discount percentage, select a different tax table and tax code click Edit (plus sign after label).  
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There are several options in the section for the price information section 

You can add a discount or markup by selecting the plus sign. It can be entered as a percentage or a fixed 

amount. 
 

 
Note: If the account had a one-time discount defined, and you indicated you wanted to apply it when you created 

the document, the discount is shown in the Discount Amt field, and the Apply one-time discount check box is 
selected. If no discount was defined, you can enter one now.  

You can add a delivery fee. 

You can add or change a sales tax by selecting the plus sign. 
 

Selecting the No Tax check box will result in zero tax for the invoice/estimate.  

If the customer is taxable you can still identify which lines are to be taxed and which are not.  

Note: At charge level user needs to open the charge and check if it’s taxable or not. Identification mark is not 

available. 

 

 

You can also change the customers tax exemption status 
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Command Line Option 

You can lock the price as shown in the following image. 

 
This locks the price for all items on the estimate. You can unlock the price for all items by changing it here. 

When the price is locked it will display a lock for each line item. 

 

You can unlock the price for an individual item by selecting the lock  

If there is a royalty associated with this estimate you can make it exempt. 

Click Recalculate to update each job and charge in the document with the latest pricing information and then 

recalculate the entire estimate. 

From each line item you have other options. 

 

Specifying multiple quantities with different job specifications 

If you want to add multiple quantities for a job or want the ability to change job specifications for different 

quantities, use the Multi-Qty field in the Job window as follows: 

 
When creating a job in an estimate, enter the first quantity in the Ordered field, provide other information about 

the job, for the next quantity in the same job, click + next to the Quantity field, click to add another quantity, enter 

the second quantity in the Ordered field, change other information about the job as necessary. Click Confirm. 
 

 
 

If you want to estimate multiple quantities from the estimate summary screen use the Add Multi Quantity option 

available for each line. 
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You can edit the description using this icon to the right of the trash can 
Note: If you have multiple lines on the estimate summary screen you can change the sequence of the lines by  

clicking and dragging the description. 

 

Cost Tab 

Cost is the amount you spend to produce the order; price  is the amount you charge your customer. The 

difference is your profit. 

Although PrintSmith Vision does not require you to enter your costs, without them you will not be a ble to see 

where you are making (or losing) money. 

You define costs in your pricing definitions: 

• For charges, costs are entered by clicking Costing in the Charge Definitions window. 

• For digital definitions, costs are entered in the Cost-Plus area of the Digital Definitions window. 

• For stocks, costs are entered on the Specification and Pricing tab in the Stock Definitions window. 

 
Notes EFI recommends that you build most of your profit into labor rather than having very high stock markups 

to compensate for a printing labor rate that is too low. 

You can change costs in a locked document (one that is in history). 

After you select charges, stock, and a press or printer for an order, the costs associated with your selections are 

calculated as estimated costs. If you use Tracker, it will calculate actual costs for you; otherwise, you can enter 

the actual costs manually if they differ from the estimates. You can review the estimated and actual costs in the 

Costing window as described below. On the estimate summary section there is also a cost tab. The estimated 

cost, actual cost (once the job is complete), the difference, selling price and job margins is displayed for each line 

item. Cost is the amount you spend to produce the order; price is the amount you charge your customer. The 

difference is your profit. 

 

Entering actual costs 

Although PrintSmith Vision does not require you to enter your costs, without them you will not be able to see 

where you are making (or losing) money. 

 

To review or enter actual costs 
1. When a document is open, On Estimate summary tab click on Costing button.  

2. Review the costs. 
 

 
3. If you know the actual cost, then click the Actual column and enter the actual cost. Blue identifies costs 

that you entered. Red alerts you that an item was priced below cost. The margin will automatically 

recalculate. 
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If there are additional charges using the arrow on the left-hand side will open the display to show those items 

also. 
 

 

Saving an estimate 

Until an estimate is saved, you will see the message at the top of the screen that the estimate is not saved. Mak e 

sure to save the estimate after any modification. 

You should then see the message that the estimate has been successfully saved.  

Note The message will only stay on the screen for a few seconds and then disappear. 

Once the estimate has been accepted you can convert it to an invoice. 
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Copy Invoice 

Notes 

Raise PO 

for Invoice 

Email 

Invoice 

Save as 

Template 

Print Job 

Ticket for 

Invoice 

Add Free Style 

Add Job 

Add Charges 

 

 

 
 

Creating Invoices 

Invoicing 

As mentioned earlier several of the screens, features, and methods of creating an invoice are the same as 

creating an estimate. 

The steps for creating a new invoice that are the same as creating an estimate are : 

• Selecting the account  

• Creating a new job  

• The only option available in invoicing that is not in estimating is the ability to print the job ticket.  

• The accounting tab is the same 

• There are some differences in the summary tab and those will be discussed below. 

• The costing is handled like it is in estimating. 

 

Invoice Summary 
On the invoice summary screen there are several command options. You have the option to add to the new 

invoice items that were not on the original invoice or not part of the job specification s. You can add a freestyle 

item, a job, or a charge. You can also copy everything to a new invoice at this level.  

 

 

Add free style, add job, add charges, save as a template, copy, email and print invoice are all the same as in 

creating an estimate.  

 

Copying purchase orders when copying invoices 

When you copy an invoice and the invoice has purchase orders associated with it, you can choose also to copy 

some or all of the purchase orders to the new invoice. If you know you will need to purchase goods or sup plies 

for the new invoice, the ability to copy the purchase orders saves you time – you can just make some minor 

changes (such as due date) and re-issue the purchase orders. 
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Print Email Create a 

New PO 

Add a Line 

Item 

 

 
1. When an invoice with purchase orders is open, select Invoice > Copy to New Invoice. A message asks 

if you want to copy the purchase orders. 
2. Click Yes to copy the purchase orders along with the invoice or No to just copy the invoice. 
3. If you clicked Yes, the Invoice PO List window opens and lists all the purchase orders that were created 

for the invoice. 
4. To select all the purchase orders, click the top check box; to select individual purchase orders, click their 

check boxes. 
5. Click Duplicate. 
6. When asked, update pricing if necessary (recommended). 
7. Click Save to save the new invoice. A message informs you that purchase orders were copied to the 

invoice. 
8. Edit the purchase orders as described in “Reviewing, editing, and copying purchase orders” and then 

print or e-mail them. 

 

Raise a PO 

If you need to have an outside purchase for part of all  of the job, then you can create a purchase order. 

Selecting Raise a PO will take you to a screen where you can enter the information about the 

purchase. 

 

You can select the vendor from the drop down. 
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Notes 

In order for a vendor to be displayed for a PO the box labeled “use for purchasing” in the vendor record must 

be checked. 

You must enter the wanted date before you can email or print the PO. If you are going to email, then you must 

have an email address in the vendor record. 

 
When you add a line to a PO you will get a new short cut menu screen where you can enter the information for 

the new line item. 

 
 

Once a purchase order is saved you can access it again using this feature.  

 

 
For each line item you can edit it, mark as complete or delete the item. 
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You can also use the check box next to the items to Delete or Mark as Complete. If you check the box above the 

items, it will select all items. 

You can have multiple purchase orders for one invoice. Just create the first PO, enter the information including 

the due date and save. Then you can create another PO by using the NEW button. Then all of the purchase 

orders will be listed and available. 

 
 

Tax 

You can now choose to have tax displayed for purchase orders. To activate this feature, go to Preferences > 

Settings > System > HTML view and check the box to Enable Tax for Purchase Order. There is a warning 

associated with this selection. 

With the tax box checked when you open a purchase order the tax will be displayed. 

 

 

Note Since the tax option was not available in prior versions these fields will be disabled for older views. 
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You can now edit the Quantity, Unit Price and Sub Total fields. If you change the sub total then the unit price will 

recalculate, if you change the unit price the sub total will recalculate and if you change the quantity the sub total 

will recalculate. 

The taxes are also displayed in the total. 

 
The default ship to address for the PO will be the same as the company address. Selecting the pencil icon will 

allow you to edit either the bill to or ship to address.  

If you want to use the Invoice address as the Delivery Address use the toggle to make that selection.  

If you change the delivery address when you are using the invoice delivery address you will get a warning 

message asking you want to also change the invoice delivery address to this new address  

 
 

You can also raise a PO for a line item.  

 
 

Invoice Notes 

Selecting this option will give you a short cut menu where you can enter notes on the invoice. These are internal 

notes and will not show in the invoice. 

 

Email Invoice 

Selecting this option will save the invoice if it is not already saved and then open an email window with a preset 

message. 
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Print Job Ticket for Invoice 

This option will print job tickets for all the jobs on the invoice.  

 

Resequencing Line Items 
You can now re-sequence the line items by clicking and dragging the + sign next to the item to be moved. 

 

If the customer is taxable you can still identify which lines are to be taxed and which are not. 

 
 

Sales Format 

This displays the different options of how the invoice will print when the print invo ice button is selected. 
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You can mark the due date as firm 

You can select\update the shipping method here from dropdown. 

 
If the customer has a resale number, it can be entered here. You can enter the customers purchase order 

number. When the PO number is mandatory then the field would be highlighted so that user can enter the data, 

Warning is not displayed when an Invoice is saved. However, when user tries to pick up the Invoice the following 

warning is displayed. 

“Orders for this customer require a Purchase Order. Please enter a PO#.”  

 
 

 
 

Under User Preferences there is a listing for Summary configuration. Here you have the option to expand the 

Estimate/Invoice Summary or not. The estimate summary and invoice summary screens have a portion of the 

screen that is collapsed. If you check this box, then it will open the summary screens expanded and if unchecked 

the summary screens will open with it collapsed. 
 

 

Price Information 
The Price information area shows the invoice totals. To enter a shipping amount, enter or change a customer 

discount percentage, select a different tax table and tax code click Edit (plus sign after label) 
 

 
 

There are several options in the section for the price information section 
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You can add a discount or markup by selecting the plus sign. It can be entered as a percentage or a fixed 

amount. 

 

Note: If the account had a one-time discount defined, and you indicated you wanted to apply it when you created 

the document, the discount is shown in the Discount Amt field, and the Apply one-time discount check box is 

selected. If no discount was defined, you can enter one now. 

 
You can enter a delivery fee. 

You can add or change a sales tax by selecting the plus sign. 

 

Selecting the No Tax check box will result in zero tax for the invoice/estimate. 

You can also change the customers tax exemption status 

If you have multiple tax tables for an invoice it will be identified on the invoice summary  screen 
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They will be identified separately on the printed invoice.  
 

 
 

You can add deposit to the invoice 

You can add up to three deposits, identifying them by payment method and a reference number.  
 

 

Command Line Option 

You can lock the price as shown in following figure. 

This locks the price for all items on the invoice. You can unlock the price for all items by changing it here. 

 
When the price is locked it will display a lock for each line item 
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You can unlock the price for an individual item by selecting the lock 

 
 

If there is a royalty associated with this invoice you can make it exempt. 

Click Recalculate to update each job and charge in the document with the latest pricing information and then 

recalculate the entire invoice. 

Saving an Invoice 

Until an invoice is saved, you will see the message at the top of the screen that the invoice is not saved. Make 

sure to save the Invoice after any modification. 

 

 
If this customer has “Require purchase order” enabled in Account setup then when you try to save the invoice you 

will get an alert that a purchase order is required. 

Note Be sure to update all mandatory fields before saving the invoice 
You will need to enter the customer’s purchase order number before saving. You should then see the message that the 
invoice has been successfully saved. 

Note The message will only stay on the screen for a few seconds and then disappear 

 

Delivery Ticket 
On the invoice summary screen in the line item, you can access the delivery ticket. 
 

 

 
 

Here you can verify delivery address, change the location of the item and mark it as shipped. 
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You can also enter the shipping information as shown in the following figure. 

 

 
You can also produce a new delivery ticket, print a packing slip and shipping label. 

 

 
You can search for a different delivery ticket through search option provided at top of the window  

When you search for a delivery ticket you will be taken to that ticket in pending documents.  
 

 

The delivery ticket allows you to change the location of the product and mark it as shipped. 

You can check the box for an item and then mark it as shipped.  
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Recording Notes About Orders 

When you are working in a document window, you can use the note pad to record notes related to an order. For  

example, if you are taking an order over the phone, you may want to jot down some notes so you can complete 

the document later. Similarly, if you purchased stock at a special discount and passed some of the savings onto 

the customer, you could record this. If the customer placed the same order again, and the stock is priced 

normally, the customer might question the price. The note you recorded would remind you of the reason f or the 

price difference. In addition, if you lock prices, you may want to note the  reason for doing so. 
 

Note You can change information on the note pad even if a document is locked.  

Except for the wanted by date (entered in the When field), none of the information you enter on the note pad is 

used in the document, but you can use the note pad to guide you in creating the job. The notes are saved with 

the document so you can return to them later when you have time. 

 

To record notes 
1. Click Invoice Notes on the toolbar in the document window. 

 

2. Enter or modify information in the note fields: Who, Phone, What, How Many, What Size, Paper, Notes, 
and When. (When corresponds to the wanted by date.) 

3. If you want the note pad to open automatically whenever you open the document, select the Show Note Pad 
when document opens check box. 

4. Click OK. 
 
Note For detailed information on functionality please refer to PrintSmith Vision setup and User guide. 
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Cash Register 
 

Settings 

Customer Payment Options 

You can only use payment methods that have been approved for that customer. To access the set-up program 

for accounts, select Accounts from the Quick Access Panel on the Dashboard.  

 

Select if you are searching for customers, prospects, or contacts. 

Next select the account name. 

 

This will take you to the screen where you can set up various customer preferences and controls. 

Under Credit Control you can set up the types of payments that are available to that customer.  

Note Be sure and save your settings. 
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If you have the customer set for cash only then the Cash Register program will show that as the default option.  
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Credit Card Surcharge 

You should also set up any surcharge you want to add when the customer pays by credit card. To get to this 

setting go to Preferences > Settings > Account > Credit Card Info. 

 

 
This will display a screen where you can set up different surcharges for different credit cards. These can be 

based on what your credit card processor charges you. This is not considered income since it is paid to the 

processor. The surcharge will apply for all customers. Be sure and save before closing. 

 

Receiving Payment 
The first step is to identify the customer. You can enter a few characters of the customer’s name and it will show 

you those that fit. 

Next you will need to add invoices that are to be paid with the payment received. 
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You will then be shown a list of the unpaid invoices for that account. Use the check boxes on the left to identify 

the invoices you want added to the cash register. After the selection use the Add to Pick Up button to place those 

invoices in the cash register 
 

If you know the invoice number, you can also enter it manually. 

 

 

Next select the payment method 

Payment by Check 

Select the check payment method and enter the check number. The Amount Paying will default to the total of the 

added invoices. 

 

After you select the Receive Payment button you will get the option to print a receipt, select the print format for 

the receipt or email the receipt. When that is complete, select Post.  

Each invoice will print a separate receipt and when you are finished with them you will get an information 

message that the transaction processed successfully.  
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Payment by Cash 

The only difference in receiving a cash payment is if you are in a country where cash is rounded to the nearest 5 

cents. This is set up under Admin > Preferences > International. Check the box for Use Australian Cash Register 

Rounding. This will cause cash receipt to round to the nearest 5 cents and any difference will show in rounding.  

 
 

 
 

When paying by cash it rounds the 94.93 invoice to 94.95 with .02 going to rounding.  

 

Payment by Credit Card 

You can use CardConnect® as your card processor. For more information on use CardConnect® see the 

document for CardConnect® Integration. CareConnect® is a third-party credit card processing company. For this 

document we will go through the steps of using a credit card regardless  of the system you use to process the 

card. In the case of CardConnect® a reference number will be supplied directly to the cash receipts program. In 

other cases, you will need to enter the reference number you get from you credit card processing company.  

You can select the credit card type and then enter the reference number. To get the reference number you need 

to go to your merchants account screen and make the payment. You will get a reference number or approval 

number that is then entered in Cash Register. 

After entering the reference number select Receive Payment.  

If you try to process the payment before entering the card transaction reference number, you will get a warning 

that the card will not be processed. 

 
Charge Accounts 

A transaction can be charged only if a customer account is selected for the transaction and the account allows 

charges. This type of transaction is called a POS charge. A POS charge commonly occurs when a regular 

customer comes in, makes a small purchase, and asks you to charge it to his or her account. It is neither cost 

effective nor efficient to create a standard invoice for a small amount. Furthermore, you do not want the account 

history full of small transactions because it makes the history less useful. To see how to set u p the account to 

accept charges and to set the credit limit for the account see the Payment Options set up . 

PrintSmith Vision maintains a special balance, called the merchandise charge balance, in each account for these 

small POS charges. These charges do not appear on statements. At the end of the month or some other suitable  
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occasion, you should use AR > Post POS Charges to print a special statement composed of all POS charges. As 

part of this process, PrintSmith Vision makes a single entry in Accounts Receivable for the entire amount in the 

merchandise charge balance so the payment can be posted and included on statemen. 

You can set up charge accounts for customers and then you can charge the invoice to those accounts. Charge 

an account does not impact your AR, you will need to post payments for the charged amount in the Post 

Payment application. 

Select Receive Payment and that will give you a new screen where you can Post the charge. 

When the customer pays their charges, you will use Post Payments to process that payment. 

Department Charges 

In addition to invoices, you can add department charges. These are typically items purchased that are not part of 

the job such as boxes. To create a department charge, go to Preferences > Settings > POS > Cash Register.  

Here you can create a department charge by entering the name, selecting the sales category, enter the charge 

for the item if you want and selecting the taxing method. Be sure and check the box to the left of the charge so 

that it will be available. 
 

 

To add a Department Charge, fill in the information on the screen and select Add. If the price is not already 

defined you will need to enter the unit price and the quantity.  

 

Once you have identified the method of payment and selected Receive Paymen t you can print or email a receipt 

and Post the payment. 

Regardless of the payment method you have the option to print or email the invoice to the customer. You will also 

have the option to use the customized email and attach the invoice and receipts.  
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Post Payments 

Applying Payments to Invoices 

If you picked up and posted an invoice under Cash Receipts and charged that invoice to an account then later 

when the customer pays for that invoice, you must apply the payments against the invoices so they are recorded 

as Accounts Receivable receipts. This process reconciles the money you received with the money that was due 

(as recorded in your invoices). In PrintSmith Vision this is known as posting payments. 

 

Why posting payments is important 

A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up 

invoices without applying them to invoices. This has some undesirable side effects:  

• Invoices that were paid are still shown as open and may cause the account to become past due when it 

really is not. 

• The list of open invoices can get long making it more difficult to find an invoice to apply payment to it. 

• Customers may not understand statements that include invoices they think they paid. 

• The receipt is considered “on account,” and is not included as a taxable cash receipt in Accounts 

Receivable. 

 

Posting payments 

To post payments first select the account. This will then display the invoices that have been charged to that 

account. 

 
Notify 

Customer/ 

Follow Up 

 
 

 

Clear 

and 

refresh 

the 

page 

 
 
 
 
 
 
 
 

Selecting Invoices for Payment 

After you select the customer you will see the invoices that have been charged to their account as well as their 

status. If you want to see more detail about the invoice, select Properties. In properties you can edit the 

description. You can also edit the description from the line item by selecting th e pencil to the right of the three 

dots. 

Next select the payment method they are using. Only the payment methods you have appr oved for that customer 

will be available options. 
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After the payment method has been selected you have several options as to h ow to record payments to the 

invoices. This is the same process regardless of the payment method selected but some of the payment 

methods will need additional information that is discussed in the portion for each method.  

1. Using the check boxes to the left of the invoices you can select the invo ices to be paid and then select 

“Calculate Payment”. The program will enter the amount paid on the selected invoices in the right-hand 

column labeled PAY and enter the total of those invoices in the amount receivable. 

Note If you select the top box next to REF it will select all invoices.  

2. You can enter the payment amount in the Amount Receivable field and select Auto Apply and the 

amount will be applied to the oldest invoices first. 

3. If the customer is making partial payments to invoices, then you can select the field for that invoice 

under pay and a field will open to allow you to enter the amount of payment for each invoice. Then 

select Calculate Payment and the total will be entered in the Amount Receivable field. 

Tip You can select invoices before you enter an amount and then click Calculate Payment on the toolbar, 

so the Amount is calculated automatically. 

 

Payment Method 

Payments by Cash 

Enter the amount of cash received and you can either use Auto Apply or select the individual invoices to which 

the payment is to be applied. 

Payment by Draft 

Enter the reference number you received from the bank and then proceed to identify the invoices as the 

procedure above outlined. 

Payment by Check 

Enter the check number and then select the invoices. 

Payment by Credit Card 

If you are manually processing the card outside of EFI PrintSmith Vision you will select the card type and enter 

the reference number, you got from your card processor. 

If you are using USA ePay or CardConnect® then select the card icon to the right of the reference number field. 

You will then get a pop-up box where you can either manually or automatically process the card depending the 

option chosen. If you are not given a reference number you will need to enter  one. 

For more information on using USA ePay or CardConnect® see the documentation on those specific processes.  

After selecting the payment method and the invoices select Post Payment. If the customer still has an amount 

due the program will default to the remainder going on account. If the customer overpaid on the total amount 

due, then you will need to select how the refund is to be handled but using the dropdown for that field.  

Handling refunds 

If a payment is greater than what the customer owes, the Remainder field in the Post Payments window lets you 

indicate how you want to handle the overpayment.  

• You can select one of the following in the Remainder field: 

• On account: The overpayment is not refunded but is posted to the account as an unapplied credit. 

• Return cash: Cash is refunded and subtracted from the cash total in the PrintSmith Vision “cash 

drawer.” 

• Write check: A check is written. Since PrintSmith Vision does not handle check writing, it records only half 

the transaction. It adds the refunded amount to the account balance and the AR balance, but does not 

record a negative receipt. Instead, a special refund check is shown during daily closeout and is printed 

on the deposit ticket. The Daily Sales report includes a Refund Check category to show the total amount of 

refund checks during the period. 

• Credit card refund: A negative amount is applied to a credit card. This is recorded in the cash drawer 

credit card category and is a separate item in daily closeouts. 

• Direct Deposit: You will need to enter the reference number of the deposit. 
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Note: The remaining selections in the Remainder field are credit card refunds for a specific card.  

Issuing a refund for overpayment 

Problem: You receive a check from a customer to pay for a group of invoices, one of which was already 

paid. You agree to send the customer a refund check.  

Solution: 

1. In the Post Payments window, enter the amount of the check as written. 

2. Select the items that are to be paid. 

3. In the Remainder field, select write check. This refunds the amount of the overpayment with a 

check, which you must write later. (Checks are not written in PrintSmith Vision.) 

4. Click Post. 

Alternatively, if your customer agrees, you can leave the overpayment on account and apply it to later sales; 

this is the recommended method as no special action is required. You can access the screen to make 

journal entries from here or you can use the quick buttons on the left of the screen. Go to accounting > AR 

> Journal entries. 

For more information on making journal entries see the section on journal entries. 

The section on the lower left-hand corner of the screen gives you the option of printing a receipt or 

emailing the invoice. You can select the format to be use 

 

Issuing a refund on a paid invoice 
 

Problem: You receive a complaint from a customer about an order for which the customer already paid 

and agree to refund part or all of the order by sending the customer a check.  

Solution: 

1. In the Post Payments window, select the invoice that you are refunding and click Add Journal Entry.   
2. Make the appropriate correction and click OK. The Post Payments window opens, and both the invoice and journal 

entry are highlighted. 
3. In the Remainder field, select write check. 
4. Click Post. 

To email an invoice to the customer 

If you have set up customer email formats, then you will see the option for customize email.  

To print a receipt 

a. Select the Print Receipt check box. 

b. Make sure a printer is selected in the Current Printer field on the toolbar. (This field is displayed 

only when the Print Receipt option is selected.) 

Note: By default, Current Printer is set to the printer selected in the cash drawer preferences (reference 

from flex side), but you can select a different printer if you have more than one receipt printer. All users 

who log into PrintSmith using the same browser will see the same printer selected. This printer is also 

automatically selected in the Cash Register and Invoice windows. If you click Restore Settings in the 

Post Payments window, the printer reverts to the default preferences. 
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Notify Customer 

This will allow you to create an activity to notify the customer.  
 

You can choose from pre-defined activities and a note will be added to the customer account log.  

 

 

 
Follow-up required gives you the opportunity to enter a follow up date and who is to follow up. You can also enter 

follow-up comments. 

Completed allows you to enter the date complete, completed by and the action taken. 

You can email directly from this screen. 

 
 
 
 
 
 
 

 
\ 
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Journal Entries 

General Procedure for Making Journal Entries 

This section provides general information about making journal entries and some examples of particular types of 

journal entries. 

1. Select AR > Journal Entry. The Journal Entry window opens. 

Tip: In situations where you need to adjust a locked invoice, you can open the Journal Entry window directly 

from the Post Payments window. 

2. Complete the top part of the window: 

a. Depending on what you need to do, click Select Customer to select an account or click Select 

Invoice and enter the number of the invoice you want to adjust. In the case of an invoice, the account to 

which the invoice was posted is displayed, and a reversing entry for the invoice is set up. If all you want 

to do is write off an invoice, just click Update & Post. 

b. If you want to print a credit memo for the journal entry (for example, to give to a customer to show that 

you credited the account), leave the Print Document check box selected. The credit memo will be 

printed after you click Update & Post. 

c. If you want to e-mail the credit memo, select the E-Mail check box.  

d. Customize email. You have the option of creating a customized email. 

e. Leave the Affect Sales check box selected so that sales totals are updated as a result of the journal 

entry. 

Warning A journal entry that does not affect sales can unbalance your books. The only time you should 

clear the Affect Sales check box is while entering beginning balances when first setting up the system, 

for a job the customer refuses at pickup, or if a customer’s check does not clear. If you are not sure 

whether sales should be affected, consult an accountant to learn if your sales need to be reduced, or if a 

deduction should be taken at tax time. 

f. Leave the Update Customer Statistics check box selected so that the customer’s sales statistics are 

adjusted when you post the journal entry. This is intended primarily as a means of adjusting total sales 

when you write off an invoice. The system also adjusts the document count used to calculate the 

average order and ratio of estimates to orders if you use the Select Invoice button to set up the entry. 

3. Review and/or change the distribution amounts (journal entry details) and the memo totals. 

Each distribution amount is added to the Sub-Total and the Tax Sub fields unless you override the Tax Sub 

amount. Sales tax is recalculated after each change. When Tax Sub does not equal Sub-Total, they are 

shown as overrides, and changes that you make in the detail fields do not change Tax Sub. You can either 

remove the override from the Tax Sub field by deleting it (PrintSmith Vision then synchronizes Tax Sub with 

Sub-Total) or you can manually adjust Tax or Tax Sub. 

Note: If you change Tax Sub so that it differs from Sub-Total, distribution amounts that you enter 

subsequently will update Sub-Total but not Tax Sub. Both Tax Sub and Tax are shown as overrides. This is 

useful when backward calculation does not generate exactly the amount you need, or when only part of the 

journal entry is taxable. 

You can ignore the distribution amounts and enter amounts in the totals section directly.  If you enter an 

amount in the Sub-Total, Total, or New Balance fields, the rest of the memo is calculated backwards. This is 

useful if you already know what you want the end result to be. 
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For example, if a customer has a balance of 72.46, and you want to write off the entire balance, you can enter 

0 in the New Balance field, and a memo is generated to arrive at that balance. In this case, the total amount 

of the memo is 72.46 (a credit memo). If the Taxable check box is selected, the system calculates the subtotal 

needed to generate a taxable amount that, when taxed and added together, equals 72.46. If the tax rate was 

6%, the subtotal would be 68.36 and the tax 4.10. If the Taxable check box is cleared, the subtotal is the 

same as the total. 

4. The Description field includes some default text; change it if necessary (up to 255 characters). This 

description is used in account history and in credit memos. 

5. If you contact the customer whose information you are viewing in the Journal Entry window, log the 

interaction and, if necessary, indicate that follow-up is required: 

a. Click the Notify icon. The Notify Customer window opens. 

b. Complete the Notify Customer window. 

6. In the Sales Rep field, select a sales representative if the journal entry affects the commissions earned by that 

sales representative. 

7. In the Comments field, enter a detailed explanation of the reason for the journal entry, for example, Bad 

check. The comment is included in printed credit memos. 

8. To change all positive numbers to negative numbers and all negative numbers to positive ones, click 

Reverse. For example, if you receive a bad check, you do not want to remove the record, but you do want to 

add back the debt to the customer’s account. 

9. To zero all fields in a journal entry that are not related to taxes, click Only Tax. Typically, this button is used 

when adjusting (adding or removing) tax from an invoice. Everything is zeroed except Tax Sub, Tax, and 

Total. 

10. To write off a percentage of some known amount, enter a percentage in the field to the right of the Calc 

Adjustment button, and then click Calc Adjustment. 

11. When the journal entry is set up the way you want, click Update & Post. 

12. If you initiated the journal entry from the Post Payments window (see below), you automatically return to the 

Post Payments window where the original entry and the journal entry are automatically selected and 

ready to be posted. Click Update & Post. to apply one to the other. 

 

Originating journal entries from the Post Payments window 

When you need to adjust invoices that are locked because you already performed a closeout, you can simplify 

the steps in making a journal entry by starting the process from the Post Payments window.  

1. In the Post Payments window, select an account. 

2. Select the invoice you need to adjust and click Add Journal Entry. The Journal Entry window opens, and 

information from the selected invoice is displayed in negative format, ready to be adjusted. 

3. Make the necessary adjustments and click Post. For examples of the types of adjustments you may want to 

make, see “Journal entry examples”. 

4. After you click Post in the Journal Entry window, the journal entry is added to the Post Payments window 

which re-opens automatically. Both the original invoice and journal entry are selected and ready to be 

posted. Click Update & Post to apply one to the other. 

You can print and email the credit memo. If you want to email you have the option of the standard email template 

of you can customize the email template. 

 

E-mailing Credit Memos 

When you post journal entries, you can e-mail the credit memo for the posted journal entry (and/or print the credit 

memo). 
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In addition: 

• The invoice contacts for your accounts must have e-mail addresses. 

• The E-Mail check box must be selected in the Journal Entry window before you post the journal entry. 
 

When you e-mail a credit memo from the Journal Entry window, it is sent directly (you cannot review it before it is 

sent). By default, the credit memo is sent to the contact for the invoice or the invoice contact for the account. 

If the Credit Memo log text field in the E-Mail preferences includes text, e-mailed credit memos are logged in 

the customer account (on the Log tab). 

If the Credit Memo log text field in the E-Mail preferences is blank, e-mailed credit memos are not logged. 

If the Use log text for subject and file name check box is selected in the E-Mail preferences, the Credit Memo 

log text is also used for the subject of the e-mails and the name of the PDF attachment (the statement). If the 

Use log text for subject and file name check box is cleared. 

 

Journal Entry Examples 

This section provides some examples of journal entries. Many of the examples assume you are familiar with the 

Sales Summary report. In this report, sales information is on the left and receipt information is on the right. You 

can use journal entries to adjust them both. (To run the report, select Reports > Daily Sales, select Sales 

Summary, and double-click the date for which you want the report.  

Tip: Remember that if you are creating a journal entry for a locked invoice, you can initiate the process from the 

Post Payments window as described in “Originating journal entries from the Post Payments window” . 

 

Writing off an invoice as un-collectable 

If a customer refuses a job, you must write off the invoice. The invoice s till remains in the customer’s account 

history but is taken care of from an accounting perspective.  

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be canceled. A 

reversing entry for the invoice is created. 

2. Make sure the Update Customer Statistics check box is selected. 

3. Click Update & Post. 

4. Select AR > Post Payments and then select the account with the bad invoice. 

5. Select the memo and then select the invoice. Alternatively, if these are the only two open items, click 

 Auto Apply. 

6. Click Update & Post. 

Tip: To avoid basing a new invoice on the bad (refused) invoice, EFI recommends that you enter a note about  

the invoice in the account history to clarify it was a bad invoice. 

Writing off an entire account balance as un-collectable 

If a customer goes out of business, you must write off the entire account balance.  

1. In the Journal Entry window, click Select Customer and select the account you want to write off. 

2. Clear the Affect Sales check box. 

3. Enter 0 in the New Balance field. If the Taxable check box is selected, the entire amount due is treated as 

taxable sales. You must manually calculate the taxable amount if only part of the balance is taxable. 
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4. Enter an appropriate description and click Update & Post. The journal entry is posted. At this point, sales are 

adjusted, a negative adjustment to new charges is made, and the account balance is 0.00. There are still 

open items, however, which you should “pay” off with the journal entry you just created. 

5. Select AR > Post Payments and select the account you are writing off. There may be several open 

items. The last open item is a journal entry, the one you just created. 

6. Click Auto Apply to select all of the open items. 

7. Click Update & Post. The account balance is unchanged, but there are no longer any open items. 

 

Handling a bad check 

If the customer gave you a bad check, you must make a journal entry to add back the debt to the customer’s 

account. 

1. In the Journal Entry window, click Select Invoice and select the invoice for which you got the bad check. 

2. Clear the Affect Sales check box since you did not sell the job. 

3. Click Reverse to turn all the negative amounts to positive ones (because you need to add them back as 

what the customer still owes you). 

4. Click Update & Post. 

Discounting a percentage of an invoice 

If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by 

discounting the invoice by some percentage, for example, 10%. If a closeout was already performed, you must 

make a journal entry to account for the discount. 

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice you want to 

discount. 

2. In the field to the left of the Calc Adjustment button, enter a percentage, for example, 10 and press the 

TAB key. 

3. Click Calc Adjustment, and all the amounts change to 10% of the original amounts. 

4. Click Update & Post. 

5. In the Post Payments window, select the original invoice and the memo you just created and then click 

 Update & Post. 

Note: The invoice in account history will continue to show the original amounts. 

 

Giving a dollar discount 

If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by giving a 

fixed amount back (rather than a percentage as shown above). 

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice you want to 

 discount. 

2. Select the sales category from which you want to take the money and enter the amount as a negative 

number. 

3. Delete the entries in all the other sales categories (so they are blank). 

4. Click Calc Adjustment, and the amounts reflect the fixed amount you applied as a discount. 

5. Click Update & Post. 

6. In the Post Payments window, select the original invoice and the memo you just created and then click 

Update & Post. 
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Removing tax from a posted invoice 

If you learn after a closeout that an invoice was taxed when it should have been tax exempt, you mus t make a 

journal entry to remove the tax. This also corrects your taxable sales and non -taxable sales. 

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be adjusted. 

2. Click Only Tax. All of the details are cleared except for Tax Sub and the rest of the totals. Tax Sub is a 

special number used strictly for calculating tax. With Sub-Total set to 0.00, the only real amount is the tax. 

3. Click Update & Post. A credit memo is created. 

4. In the Post Payments window, select the original invoice and the credit memo you just created and then 

click Update & Post. 

 

Adding tax to a posted invoice 

If you learn after a closeout that an invoice was not taxed when it should have been, you must make a journal 

entry to add the tax. This also adjusts your taxable sales and non -taxable sales. 

Note: This procedure assumes that the document was made tax-exempt the recommended way, by using the 

No Tax button in the Document Totals window. If you marked each item in the invoice as not taxable, you must  

manually calculate the tax amount before using this procedure  

1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be adjusted. 

2. The invoice was not taxable, so the Taxable check box should be cleared. If there were items in the 

invoice that are taxable, there will be an amount in the Tax Sub field. Select the Taxable check box to 

calculate the tax based on the document’s tax table. 

3. Click Only Tax. All of the details are cleared except for Tax Sub and Tax. Tax Sub is used strictly for 

calculating tax. With Sub-Total set to 0.00, the only real amount is the tax. 

4. Click Reverse. This changes the journal entry into a debit memo. All the amounts become positive. 

5. Click Post. Tax Sub is added to taxable sales. On the receipts side, Tax is added to tax on sales and to 

new charges. 

6. In the Post Payments window, select the original invoice and the debit memo you just created and then 

click Update & Post. 

 

Issuing a refund 

Suppose that you overcharged a customer in a cash register transaction, the customer paid, and you performed 

a daily closeout. If the customer returns and requests a refund, you must issue a credit memo and then refund 

the amount. 

1. In the Journal Entry window, select the account to be used for issuing the credit. An “In House” account is 

 useful for these types of transactions. 

2. Enter the amount of the refund as a negative number in the Total field and press the TAB key. If the 

 Taxable check box is selected, the Tax Sub and Tax are calculated. 

3. Click Update & Post. A credit memo is posted to the account. This takes care of adjusting sales and tax on 

sales, but cash is not yet affected. 

4. Select AR > Post Payments and select the account. The credit you just posted will be at the end of the list 

of open items. 

5. Select the credit memo. 

6. Select the type of refund in the Remainder field (on account, return cash, and so on). This indicates 

that the entire credit memo is to be returned to the customer and identifies how it is being returned. 

7. Click Update & Post. The amount of the credit memo is removed from the cash drawer. 
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Adjusting sales categories 

If you discover that a charge was posted to the wrong sales category, you must create a zero-balance journal 

entry that moves the amount to the correct sales category. EFI recommends that you create an “in ho use” 

account to use for these types of transactions to avoid cluttering up customer histories  with housekeeping journal 

entries. If you do not want to create a customer account for this type of transaction, you can use the walk -in 

account. 

For example, if $100 was charged to the HP 5000 sales category instead of the VUTEk sales category, you 

would make the following journal entry: 

1. In the Journal Entry window, click Select Customer and select the “in house” account to use for the transaction. 
2. In the HP 5000 field, enter -100. 
3. In the VUTEk field, enter 100. 
4. Click Update & Post. A zero-balance journal entry is recorded. 

The sales report shows this as a $100.00 decrease in the HP 5000 sales category and a $100.00 increase in the 

VUTEk category, with no other effect on sales. 

 
Notify Customer Clear Journal Entry 

 
 
 
 
 
 
 
 
 
 
 

Notify Customer 

This will allow you to create an activity to notify the customer.  
 

 

You can choose from pre-defined activities and a note will be added to the customer account log. 
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Follow-up required gives you the opportunity to enter a follow-up date and who is to follow up. You can also enter 

follow-up comments. 

Completed allows you to enter the date complete, completed by and the action taken.  

You can email directly from this screen. 
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Cash Drawer Status 
To aid in balancing there is a window showing the cash register status. This window is accessed by selecting 

Accounting > Point of Sales > Cash Drawer Status. 

This program will calculate all of the transaction shown. If there is a difference, then the Fix button will be active 

and you can use it to correct the problem. 
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Register Tape 
PrintSmith Vision keeps a detailed record of all transactions for each sale’s “day” on an electronic register tape. 

A sales day ends when you perform a closeout, and a new tape is started. The register tape records  significant 

events such as deposits, document voids, posted payments, finance charges, and journal entries. When you 

post transactions in the Cash Register window, they are recorded on the register tape. 

If you are using line-item taxation and a transaction involved more than one tax table, all the tax tables are listed 

in square brackets, but the Tax amount is the total tax (the amount is not broken down on the register tape).  

 

Voiding entries on the register tape 

Occasionally, people make mistakes: they select the wrong invoice for posting, enter a check as cash, and so 

on. Sometimes a customer may change his or her mind about a purchase or ask for a refund. When this 

happens, you want to be able to correct the problem quickly. In PrintSmith Vision, you can adjust your 

accounting records in two ways: you can make a journal entry or you can void the transaction on the register 

tape. Whenever possible, EFI recommends that you void the transaction on the register tape. 

After you perform a closeout, the register tape for that period is locked. As a result, you should review the tape to 

determine if any transactions need to be voided before performing a closeout. It is much easier to void the 

transaction before the closeout than to create a journal entry afterwards. A journal entry does not cancel the 

transaction; it creates a new transaction that counteracts or reverses the original transaction. A journal entry can 

sometimes be difficult to set up and it is subject to the same kind of errors as the original transaction. 

When you void a transaction, on the other hand, a new transaction is not created except to record the void itself. 

For example, if you void an invoice pickup transaction, the invoice is removed from the acco unt history and 

placed back in the pending invoice list just as though it had never been picked up. 

Voids are not allowed in a few situations: 

• Deposit entries. To remove a deposit, open the invoice and use Invoice > Deposit Entry to zero out all the 

deposit information. 

• Invoice cancellations. Once an invoice is canceled, the data in the invoice is gone – there is no way to 

recover it, so no way to void a cancellation. 

• Voided entries. You cannot void an entry that was already voided, or an entry that records a void.  

• Invoices or payments that were already paid or applied in a later transaction. PrintSmith Vision will notify 

you of the problem and identify the entry that is at fault. For example, if you pick up an invoice and later use 

AR > Post Payments and apply the payment, you cannot void the invoice pick up until you void the 

payment. 

• POS charges. You cannot void charges that were posted using AR > Post POS Charges. 

Note: You can only void transactions if you have permission to do so. 

To void a transaction, select it and then the VOID button will be active and you can use it (if you have 

permission). Once the transaction has been voided it will have a line drawn through it and a new entry will be 

added that a transaction has been voided. This is the recommended way to correct mistakes; once a closeout 

takes place, you must make journal entries to correct mistakes, which can be more complicated to set up.  
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You can also print the tape register by selecting that feature. Since register tapes can be quite long you can also 

search using the standard search at the top of the screen. You can search by date or date range, ID number, 

price or total. 

If you are using line-item taxation, and a transaction involved more than one tax table, all the tax tables are 

listed in square brackets, but the Tax amount is the total tax (the amount is not broken down on the register 

tape). 

 

Opening Old tapes 

As part of a daily closeout, the register tape for that period is archived and locked, and a new tape is started. You 

can use the Old Tape button to open register tapes from previous closeouts (identified by date). While you can 

review and print any tape, you cannot void entries in old tapes because they are locked after a daily closeout.  
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Closeout 
 

A closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or 

month. 

 

What do “daily” and “monthly” mean? 
 

Daily Closeout 

Despite the name, how you define “daily” is up to you. You pick the frequency. 

• Daily does not need to correspond to a 24-hour calendar day. 

• The period represented by a daily closeout can span several days, e.g., every Wednesday. 

• More than one daily closeout can be performed during a 24-hour period. 

 

Monthly Closeout 

Despite its name, a monthly closeout can be run at any time, but typically you would do this at the end of a 

calendar month. The monthly closeout just summarizes the daily closeouts.  

What to avoid 

• The longer the period between daily closeouts, the harder it can be to track down discrepancies – the 

volume of transactions will be higher.  

• The period represented by a daily closeout should never span the end of the month, e.g., if a daily 

closeout was run on April 28, do not run the next one on May 2 – this will distort your monthly figures. 

 

Manual vs. Automatic Closeouts 

Closeouts are typically performed manually (as described below), but you can also automate the process. For 

information and recommendations about automatic closeouts . 

Note: Auto closeouts do not allow for a review of detail reports.  

 

Manual closeouts 

Closeout checklist 

1. Post POS charges 

2. Start daily closeout: new vs. append. 

3. (Optional) enter productivity data. 

4. Balance cash drawer. 

5. Look at sales summary. 
6. Run trial closeout to verify numbers. Trial closeout will lock everyone out of the system. 

7. Verify sales summary report against invoice pickups, payments, journal entries, and tax 

summary. 

8. Run real daily closeout. 

9. As needed, run monthly closeout. 

 
Details of these tasks follow. 

Task 1: Post POS charges 

If you charged any cash register transactions to accounts, post those charges before starting a c loseout: 

1. Select AR > Post POS Charges. 

2. Select the options you want (for example, Print Summary Report) and click OK. 
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Task 2: Start daily closeout 

Click on Accounting on the left panel > AR > Closeout 

1. Select Trial closeout or Daily closeout. EFI strongly recommends you always run a trial closeout before 

doing a “real” closeout – this gives you the opportunity to review various closeout reports and correct any 

discrepancies if necessary. Trial closeout also allows you to just select the reports you want to see by 

checking the box Quick Trial Close. If you do not check that box, then the rest of the closeout process 

is the same for Trail or Daily. 

2. Select one of the following: 

• New closeout for today – always select this unless you are doing more than one closeout during the 

same calendar day. 

• Append to closeout – select only if you are performing more than one closeout during the same 

calendar day (this can be useful if you have multiple shifts and want to close out each shift). 

After selecting the type of closeout then you have the option to “Capture Productivity Data”. There are four 

steps to the closeout process. 

1. Productivity Data (Optional) 

2. Balance Cash Drawer 

3. Review Sales Summary 

4. Verify Reports 

 

Automatic closeouts 

Instead of performing daily or monthly closeouts manually, you can have closeouts performed automatically – 

without any user interaction – at a time of your choice. 

Before you begin: important recommendations and notes 

• Monthly closeouts: EFI recommends doing automatic monthly closeouts to ensure your monthly totals are 

captured at month’s end. For example, if you are travelling, or if the end of the month falls on a weekend 
or holiday, an automatic monthly closeout ensures the closeout always takes place. 

• Daily closeouts: EFI does not recommend automatic daily closeouts for normal use because you have no 

opportunity to balance the cash drawer by counting cash or credit cards, reviewing deposits, and so on. In 

general, manual daily closeouts are recommended. Automatic daily closeouts can be useful, however, if 

you cannot always be there to perform the closeout manually but want to make sure the closeout takes 

place regularly. 

 

Note: An automatic daily closeout will take place only if the register tape has items on it. If you perform manual 

daily closeouts on most days, and the register tape is empty, automatic closeouts will not take place on those  

days. 

If the system finds discrepancies in the cash drawer during an automatic daily closeout, the closeout will fail, and 

you will need to perform a daily closeout manually to correct the problem(s). For this reason, if you frequently 

correct discrepancies in the cash drawer during manual daily closeouts, automatic closeouts are not a good 

solution for you. 

Activating automatic closeouts 

To take advantage of automatic closeouts, you must activate them in the PrintSmith Vision Closeout 

preferences. 

1. In PrintSmith Vision, click Preferences in the Quick Access panel (or select Admin > Preferences). 

2. Under Accounting, select Closeouts. 

3. Select the Activate Auto Closeout check box. 

4. To perform daily closeouts automatically, select the Perform daily closeout automatically check box 

and then select a Time of Day. (The default time is 20:00.) 
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5. To perform monthly closeouts automatically, select the Perform monthly closeout automatically check 

box and then select a Time of Day. (The default time is 23:00.) Automated monthly closeouts always take 

place on the last day of the month. 

6. To ensure some members of your organization are informed if a closeout fails or is interrupted, enter: 

• Failure Notification E-Mail Addresses (separated by ;) 

• Subject Line of e-mail that is sent 

• Body Text of e-mail that is sent 

Important: For e-mail to be sent, you must have e-mail enabled and configured in PrintSmith Vision. For 

information, see “E-Mail preferences” in the PrintSmith Vision – Setup and User Guide. 

7. Click Save. 

The daily and/or monthly closeouts will now take place automatically at the time you specified. 

 

Closeout warnings 

Users who are logged into PrintSmith Vision are given a 15-minute warning that an automatic closeout is about 
to begin so they can finish their work and log out. If they remain logged in, their session is suspended until the 
closeout is done. 

In addition, if users try to log in while a closeout is taking place, they will be prevented from doing so. 

 

Automatic daily closeouts 

Note the following about automatic daily closeouts:  

• A daily closeout will only take place if the register tape has items on it. 

• If a daily closeout already occurred on a calendar day (typically due to a manual closeout), the automatic 

daily closeout will be appended to the previous closeout. 

• If the system finds discrepancies in the cash drawer during an automatic daily closeout, the closeout will fail, 

and you will need to perform a daily closeout manually to correct the problem(s).  

 

Automatic monthly closeouts 

An automatic monthly closeout will take place only if the register tape is empty. If it is not empty, the system 

automatically performs a daily closeout before the monthly closeout.  

 
Status of automatic closeouts 

A history of all your automated closeouts is available under History in the Closeout preferences. Here you can 

see what type of closeout was performed, when it was performed, and whether it was successful.  

1. Click Preferences in the Quick Access panel (or select Admin > Preferences). 

2. Under Accounting, select Closeouts. 

3. Check the History. (Click Refresh to update the results.) 

In addition, if a closeout failed, and you specified one or more Failure Notification E-Mail Addresses in the 

Closeout preferences (and have e-mail enabled and configured in PrintSmith Vision), those users will be notified 

by e-mail. Typically, they will need to correct problems by performing a manual daily closeout.  

 

Closeout reports 

No closeout reports are printed when an automatic daily or monthly closeout takes place, but those reports and 

deposit tickets are available from the Reports menu for viewing and printing later: Reports > Daily Sales, 

Reports > Monthly Sales, and Reports > Deposit Ticket. 

 

Closeout Steps 

Productivity Data 

You can enter the productivity data if you want to track productivity statistics.  

• Square feet in Store: your square footage. This is used to calculate sales per square feet. 

• Number of Workers: the number of employees. This is used to calculate sales per employee. 

• Press Hours Worked: the number of billable hours for all your printers. 

• Other Prod Hours: other direct labor hours such as setup and finishing. 
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• All Other Hours: other hours worked that are not related to production. This would normally include 

sales and supervisory hours. 

 

Balance the Cash Drawer 

Important: The process of balancing the cash drawer is the single most important verification procedure you  

perform in PrintSmith Vision. Never finish a closeout if the Balance Cash Drawer window has unexplained 

discrepancies. 

Count cash 

Count all the cash you have on hand. This amount should match what is shown in the Cash in Drawer field. 

PrintSmith Vision automatically subtracts the amount in the Change Fund field from the amount in the Cash in 

Drawer field and displays the total cash to deposit in the Cash to Deposit field. This amount is also shown on 

the right side of the window so all the deposit totals are in line.  

Note: You cannot finish a closeout if Change Fund is larger than Cash in Drawer. Since Change Fund is the 

amount of cash held out of the deposit, you cannot have more in the drawer than you actually have. You must  

make sure the change fund does not exceed the cash in the drawer.  

Common problem: 

You have less in the Cash in Drawer field than is shown in the Change Fund field. 

A returned deposit almost always causes this problem. If you return a deposit made with a check that was posted 

on a previous day, the check is no longer in the cash drawer. When this happens, Prin tSmith Vision issues a 

cash refund because it no longer has the check to return to the customer. Often, you will have issued a business 

check for the refund, and this causes the discrepancy.  

A discrepancy can also occur if you entered a check while posting payments for more than the total selected for 

payment and did not apply the remainder to the account. In this case, PrintSmith Vision issues a cash refund to 

the customer instead of crediting the remainder to the account. 

Solution: 

Review the register tape (POS > Open Tape) to find the problem and correct it. Look for Refund - CASH in 

transaction records on the register tape. 
 

Count checks and drafts. Checks and drafts are shown in the deposit item list (at the top of 

the Balance Cash Drawer window) in the same order they were posted. 

 
• Verify that each item in the list matches an actual check. (Alternatively, add up all the checks on hand and 

compare this to the amount shown for Checks in the Balance Cash Drawer window.)  

• If you have checks on hold or on automatic release, keep them separate so they are not part of your 

verification.  

Handle refund checks 

When posting payments, you can issue refunds by writing a check. In this situation, only half of the transaction is 

completed in PrintSmith Vision. The check itself is not written in PrintSmith Vision so the record of a refund check 

in PrintSmith Vision is just a reminder that a check must be written to complete the transaction . 

Count credit cards 

Credit cards are slightly different from checks and drafts. Typically, the credit card processing system issues a 

summary report with transaction counts and totals for each type of card. For a summary of charges for each 

credit card, click the button to the right of the Credit Card total in the Balance Cash Drawer window. 

Note: Credit card transactions that are on hold are not included in this window. Keep these transactions 

separate. 

Add checks 

Balance Cash Drawer window. 
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Warning: Checks added this way are included only on the deposit ticket, and almost always result in a variance 

in your daily sales report unless offset by a change in cash. EFI strongly recommends you fix the transaction that 

caused the problem rather than add a check. 

Added checks are placed at the end of the list in the Balance Cash Drawer window with the word Add in the 

Status column. 

Change checks in deposits 

You can change the reference number or amount for a check if necessary (by selecting a check in the Balance 

Cash Drawer window and clicking Change Check in Deposit). 

Warning: A change to the reference number or amount of a deposit affects only the deposit ticket, and almost 

always results in a variance in your daily sales report unless offset by a change in cash. EFI strongly 

recommends you fix the transaction that caused the problem rather than change a check. 

Hold or release checks 

To place a check on hold or to release a check so it is included in the deposit, select the check in the Balance 

Cash Drawer window and click Hold/Release Check. Items on hold have Hold in the Status column. They are 

not included in the deposit total on the deposit ticket. On subsequent closeouts, they are included in Items on 

Hold. 

 

Correct discrepancies 

If there are any discrepancies, identify them and fix the problems before continuing with the closeout. Click  

Cancel in the Balance Cash Drawer window to cancel the closeout. 

Typically, once you identify an incorrect transaction, you must use POS > Open Tape to find and void the 

transaction and then you must re-enter the transaction correctly. 

Note: Always void the most recent transactions first. 

When trying to identify discrepancies, watch out for: 

• The amount on a deposit item differs from the amount in PrintSmith Vision. Always fix this situation. 

Find the transaction on the register tape and void it. Then enter the transaction again with the correct 

amount. Although you can modify the reference number or amount of any transaction, avoid doing this 

because it almost always introduces accounting errors. 

• Payment type totals do not match. If the total of all payment types in PrintSmith Vision does not match 

all of the payments in the cash drawer, payments of the wrong type were probably entered. For example, if 

cash is over by $100 and checks are under by $100, a payment was probably recorded as cash instead of 

being recorded as a check. To fix this problem, identify the faulty payment, void it, and re-enter it as the 

correct type of payment. EFI strongly recommends that you always fix this type of problem to maintain a 

strong audit trail. 

• Extra check, credit card, or draft in hand - You probably forgot to post a payment in PrintSmith Vision or 

forgot to enter a deposit on an invoice. If one of the other payment types is too high, a payment or deposit 

may have been entered with the wrong payment type. Look for a transaction with a different payment type 

that matches the amount on the check or draft. Void the transaction and re-enter it with the correct payment 

information. If it is a deposit, open the affected invoice, change the type of the deposit, and save the 

document. 

• Extra check or draft in PrintSmith Vision. If all the other payment type totals are correct, a payment was 

made that should not have been made. The information in the list of deposit items will help to identify 

the incorrect transaction. Most of the time, this is a pickup or POS charge that was paid for in PrintSmith 

Vision when it should have been charged to the customer’s account. Void the transaction and then charge 

it to the customer account. 

• Cash in hand is too high. Unless this is your very first closeout, and beginning cash was not entered in 
the Change Fund field, you probably forgot to enter a payment or a deposit. 

• Cash in hand is too low - If cash or credit cards are correct, you probably entered a cash payment in the 

cash register that should have been a charge or entered a cash deposit when one was not made. 

Alternatively, you entered the wrong payment amount. If cash or credit cards do not match, find those  
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mistakes first. If cash is still off, look for the mistakes in cash transactions. Void the incorrect transaction 

and re-enter it. 

 

Review Sales Summary 

After you click NEXT STEP in the Balance Cash Drawer window, the Daily Sales window opens. This includes 

the A/R Balance – this is the original balance (from the last closeout) minus payment plus new charges adjusted 

by any journal entries. 

Note: Although you can review the contents of this window, it is more important to compare the contents of  

certain reports during a trial closeout. 

 

Verify Reports 

Here you can select the reports that you want to see. At a minimum you should select the following reports.  

• Sales Summary 

• Invoice Pickups  

• Payments 

• Journal Entries  

• Tax Summary 

The reports that you selected open in a preview window, from which you can print them. 

Verify the Sales Summary report against the Invoice Pickups, Payments, Journal Entries, and Tax Summary 

reports. 

If you find discrepancies, correct them. If everything is correct, continue to the real daily closeout.  

When you select “Finish Trial Close” the reports that you selected will be displayed on the screen where you 

have the option to print or download them. 

The daily closeout will take you through the same step s as the trial closeout except that you do not have the 

option for Quick Trial Close. 

• The daily closeout does the following: 

• Adds an entry to the register tape indicating that a closeout was performed. 

• Archives the current register tape and creates a new register tape. The archived tape is locked so it 

cannot be changed, but you can use Reports > Open Old Tape to review an archived tape. 

• Resets the cash drawer. Cash is set to the amount in the Change Fund field. Checks are set to reflect any 

checks on hold. Credit cards are zeroed. AR balance is unchanged. 

• Updates the daily sales summary. This summary includes information about new invoices and invoice 

pickups, as well as tax details.  

• Saves a copy of the deposit ticket. 

Tip: To print a deposit ticket after a closeout is done, select Reports > Deposit Ticket. In the Deposit Ticket 

window, you can select a deposit ticket (identified by the date of the closeout) and then preview and print the 

Daily Deposit Record. You can also select multiple deposit tickets in the Deposit Ticket window and then 

click Select to generate a report that includes a Daily Deposit Record for each of the deposit tickets you 

selected. 

• Opens each of the closeout reports you selected in a preview window from where you can print them. 

Only on the daily closeout will you have the option of having the system verify the closeout tax detail and tax 

summary data. To activate this feature, go to the Legacy version > Preferences > HTML View and check the b ox 

to Enable discrepancy Check Button in Closeout. A new button will be displayed in the Closeout screen called 

Verify Closeout Data. 

Important: You will get the warning that it is recommended to start this process during your non-business hours 

because it will take some time depending upon the size of transactions. Please make sure tax elements and 

rates are matching in all current tax tables. 

After running Verify Closeout Data you will get a message that the closeout data is done, and you should check 

the Tax Detail and Tax Summary Reports. 
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Monthly Closeout 

A monthly closeout provides a summary of the sales for a calendar month and updates customer sales statistics  
and account histories. The system automatically figures out which month needs to be closed out next and 

informs you what it is going to do. You do not have to enter anything except the optional productivity data.  

Although typically you will perform a monthly closeout at the end of a month, you can do so at any time. If a 

closeout was already done during the current month, PrintSmith Vision updates the monthly sales figures instead 

of starting a new month. 

Note: Monthly closeouts are currently done in the Legacy version and will lock everyone out of the system. 

 

To perform a monthly closeout 
 

1. Go to Legacy UI 

2. Click Accounting > AR > Monthly Closeout. 

3. Before starting the closeout, PrintSmith Vision informs you what period is being closed out. Click 

Continue to review the productivity information and change it if necessary. 

4. When the Monthly Sales window opens, review the information and then click Continue. \ 

5. In the Closeout Reports window, select the reports you want to print. Click Trial Closeout to perform 

a trial closeout or Finish Closeout to complete the monthly closeout. 

6. The reports that you selected open in a preview window from where you can print them. \ 

7. Check the Total in the Sales Summary report as follows: 

• Take the Total from the Invoice Pickups report. 

• Subtract the Total from the Journal Entries report. 

• Add the POS sales (open each daily tape for the month and manually add up the totals). 
The result should match the Sales Summary Total.  

8. When the closeout is finished, you are asked if you want to update account history with sales 

statistics. Click OK if this is the “final” closeout for the month. 

Tip: Updating sales statistics can be time-consuming so you can skip this step if you know this is not the last 

closeout for the month. 
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Pending Documents 
The Pending Documents window is a “command center” for managing your active documents. These are all 

the invoices that are in production or are waiting to be picked up as well as all the estimates that were not 

voided (canceled), archived, or converted to invoices. You can control which columns are displayed in the 

Pending Documents window and the order in which they are displayed, as well as the colors that identify 

certain kinds of information. 

The Pending Documents Window 

 

The Pending Documents window has four tabs across the top that you can use to select which documents you 

want to see, or you can select to see all documents. The documents can be identified by the icon on the tab and 

to the left of the account. Each tab will also display the number of documents in each category. 

Tip The number of web orders is not included in the total number of invoices. 

You can filter further, regardless of the tab you are using, by selecting the TYPE dropdown.  

 
Each user can determine which columns are displayed, number of days of estimates to display and the color 

indicator for invoices and estimates at different stages.  

 



Pending Documents |  135
5 

 

 

 

Each column can be sorted high to low or low to high by selecting it. Or if you are looking for a specific 

invoice/estimate you can just enter the information in the appropriate field. You can click and drag columns to 

change the layout. Note also that the wanted date now includes time.  

 

 
If you are looking for something within a specific date range, you can enter  the date range by selecting the 

starting date and then the ending date. If you are looking for a specific date the starting and ending date selected 

will be the same. 

Tip: Only click once when you select the date, do not double click.
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You can clear all filters 

 
 

You can access the job contained in an invoice or estimate by selecting the > to open the detail.  
 

You can change the location of each job. The location for the estimate/invoice will reflect the latest location that 

was changed for a job. When you change the location of the estimate/invoice that location will be reflected in 

each job. You can add job comments. 
 

 

 

 

You can change the wanted date of an estimate/invoice. 

Selecting the document number will take you to the estimate/invoice where you can make changes if needed. 

The three-dot symbol will show you other options. Those options are different for each tab.  
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Estimating options 

Open in new tab will open the estimate/invoice in a new tab for modification or review. 

Convert to Invoice will convert the estimate to an invoice and take you to the invoice screen. 

Notify Customer will allow you to create an activity to notify the customer. 

 

You can choose from pre-defined activities and a note will be added to the customer account log. 

Follow-up required gives you the opportunity to enter a follow-up  date and who is to follow up. You can also enter 

follow-up comments. 

 
Completed allows you to enter the date complete, completed by and the ac tion taken.
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You can email directly from this screen. 

Hold estimate will allow you to select the reason for the hold 

Note: The next time you open this option after putting the document on hold you will have the option to 

release the hold. 

 
Lost estimate will allow you to identify the reason for the loss. 

 
 

If you select other reason you can enter comments below. You can also print or archive the estimate. 

Archive Estimate will remove it from Pending Documents.  

For invoices some of the options are the same but there are some specific to invoices. 
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Pickup Order takes you to the Cash Register program. You can pick up more than one order, but they 

must all be for the same account. 

 
Note: When you click Pick Up, PrintSmith Vision checks whether the tax rate on the invoice is current. If the rate changed 
since the invoice was last opened, you are warned that the tax is incorrect. If you receive this 

warning, open the document, check the tax (which is recalculated when the document opens), and save the document 
before picking it up. You can ignore the warning and pick up the document, but the sales tax will be incorrect. 
 
Release for Pickup changes the status to ready to pick up. You can print the invoice or job ticket. 
 
You can also void an invoice. If the invoice has a deposit on it, you will be notified and asked if you want 

to refund the deposit. 

If you select Yes, then the amount should be returned and in credit card manager the amount will be 

voided. If user says No, then the deposit will be FORFEITURE. 

 

Web Orders 

Under Web Orders you can also produce a delivery ticket and shipping label.  
 

 

You can enter the weight, delivery date and tracking number.  

Using the label icon, you can print a shipping label.  
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Work in Progress (WIP) 

Work in Progress contains all the jobs that are waiting for processing. There are two views available for WIP, 

WIP mode or Report mode. 

 

WIP Mode 

In the WIP Mode you can choose to display jobs or documents. A document may contain more than one job. You 

can use the heading to filter out certain jobs based on the headings as well as have them sorted in ascending or 

descending order. You can use click and drag to change the position of the column headings. Each job or 

document will be displayed in the color that matches the status. (See customizing the list to set the color) 
 

 

The screen shot above is displaying documents. If you select jobs, then you will see a different layout. Additional 

tabs will be displayed. If you are using Fiery and you have jobs assigned to Fiery, then the Fiery Integrated tab will 

be visible and you can select for those jobs. 
 

You can print out the WIP list as a csv file using the “Download as CSV” icon in either view.  

If you select the “Download as pdf icon you will see the different print options, you have in either view. Only the 

items on the screen will be printed. 
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• Print with extra space will add a blank line after each row in PDF. 

• Print with Job Comments will add job notes after each row in PDF. 

• Repeat Headers will repeat the column header on each page if generated PDF have multiple pages. 

• Open PDF in new tab will open the PDF in new tab instead of showing the download option. 

• The user has the option of selecting a standard paper size or selecting custom and entering in the width and 

height. The units field is used to select the units for the entered width and height. 

• You can also select the orientation and scale to be used in the PDF. 

 
Selecting the “Customize List” option you will get a short cut menu screen where you can change the columns to 

display, identify the color for each item based on its status and set up other filter options.  
 

 

 
There are different column options depending if you are displaying jobs or documents. You can determine if yo u 

want to include estimates or not. You can set up additional filters here also. You can set up a filter based on the 

order price you enter. You can also set up filter for order where you have received the deposit and determine if 

you want to include shipping and tax amount in the displayed totals. In the case of order price amount and 

deposit received with orders they become a filter you can select. If you check include shipping and tax amount in 

totals, then the totals will change to reflect that amount.  
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In this screen you can also determine the color you want to use to identify the different statuses of the jobs. You 

can enter a specific hexadecimal color code or you can select the color field and select the color th at way. 

 

 

The documents are color coded according to the guide 

 
 

By using the drop down, you can filter the jobs you can display based on their status or a saved filter . 
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Once you have created a filter you can save and use it later. 

In this example a filter was created for a particular customer, 1111 Football Management. 

Selecting “Save Filter” gives a short cut menu where you can name the filter 

 

This filter now becomes available in the search field. 
 

 
 
 

Selecting “Manage Filters” allow you to modify or delete the saved filter.  
 

 
 

You can clear the filter. 
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Hovering the mouse over the document title will show more detail about the job. Double clicking on the document 

title will take you to the job details screen for the invoice.  
 

 
Once you select one or more documents or jobs you have other options depending on which screen and which 

tab. 

On the documents screen you can print job tickets. Selecting this option will print the job ticket(s) for the jobs in 

the document. 

 
 

 

On the jobs screen under both the All Job or the Fiery Integrated tabs you have these options  
 

Print job ticket will print the job ticket to the screen where you can determine wh ere you want the document to 

print. 

The next field will display the options of where the job can be processed. The column “Device ID” will display the 

device ID. 

Note: This is only available on the job screen display. 

Select users to Assign gives you the option to assign a user to the job. A list of users will be displayed in the 

dropdown. You can also use the three dots to assign job. The user can then be used as a search option.  

The submit to Fiery field will allow you to submit the job to fiery.  

The options displayed under the tabs works well when you are working with multiple jobs, but you also have 

options available for each job. Assign job, Submit to Fiery and print job tickets work just like the above options. In 

addition to those you can, mark the job as outsourced and notify the customer. 

Note: If the job has already been submitted to Fiery, that option changes to Void Fiery job which will cancel the  

job in Fiery. 
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You can mark the job as outsourced by moving the sliding dot. This will cause the job  to be marked as 

outsourced and change the number of jobs in the outsourced total.  

Note: Marking a job as outsourced does not change its pricing method and job price.  

 
Selecting “Notify Customer“ brings up a box that shows all of the current activities and the ability to add an 

activity. 

 

 
 

When you select Add New you will be shown a place to enter a new activity  
 

 

Report Mode 

Using the Report mode, you can select the type of report. 

Note: The maximum number of records displayed is limited to 500. 
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Report Types 

Several variations of the Work in Progress report are available: 

• Standard for a list of orders by number, customer name, title, ordered date, wanted by date, proof date, and 

total amount due. 

• Date and Time for a report very similar to the Standard report except that instead of showing the total due, 

the report shows the time of the order in addition to the date of the order. 

• Location for a list of orders by number, customer name, title, ordered date, wanted by date, name of user 

who entered the invoice (taken by), and location. (The location may have been manually entered or 

scanned.) 

• Weekly Schedule for an overview of the number and type of orders due in a week, starting on the next 

Monday. Orders due before then are listed in the Earlier column. 

• Press Schedule for a breakdown of invoices by jobs and for information about the workloads for each 

press according to the date and time jobs are wanted. 

You also have options as to how you want the reports grouped.  
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In this example they are grouped by account. 

 
 
 
You have the option to choose additional information to be displayed. In this case 2 items have been selected to 

be displayed. 
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When you select Show Total you will see the totals for each group and a total for all records. 

 

 
 

The Report Mode the job columns and document columns are fixed and cannot be customized like the WIP 

mode. You can still indicate the color to be used and also identify items you want included on the reports. Yo u 

still have the option to use the column headings for sorting or filtering. 
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PO History 

The PO history process allows you to view all purchase orders including completed purchase orders and the 

current status of the purchase order. 
 

You can filter purchase orders by selecting a vendor, date range or status using the column headers. Select ing 

this icon will clear the filters and list all purchase orders.  
 

Checking the box “Show Completed” will add completed purchase orders to the list.  

Double clicking on any PO number will open that purchase order. From there you can edit or change the  status 

of a line or the entire purchase order. 

You can sort the purchase orders in ascending or descending order by using this icon.  

You can mark a PO as complete by checking the box next to the PO and then select Mark as Complete. 

You can delete purchase orders by checking the box next to the purchase orders you want to delete and then 

selecting the delete icon. 

Selecting the plus sign allows you to create a generic  purchase order that is not related to an invoice.  

1. Select the vendor 

2. Enter the required date. Clicking on the field will display a calendar. 
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3. Enter the buyer information and description. 

4. Select add a line item and complete the information on what you are ordering. 

Note: The PO type is now generic. 

 
 

You have the same features that you have when raising a PO in invoicing. You can edit, mark as complete or 

delete an item. 

The Required by Date can be edited in the Purchase Order . 

 
You can email, print and save the PO. This now includes the ability to print completed purchase orders.  

 
 
 
 
 
 

Note: If you want to email to the supplier then you must include their email address in the vendor record.  

 

Duplicate a PO 

You can duplicate a PO from the History screen or with in a PO.
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When you duplicate a PO, it will also display the Source PO # and you can access the source PO by clicking on 

the link. Also, it will keep the shipping address from the original PO. 

 

Print PO 

There are two versions of the PO available, one that displays taxes and one that does no t. Either of these reports 

may be customized by the customer to add their logo or make other changes but the standard reports must be 

used as the basis for the customization. Go to Legacy version > Reports > Report Manager to identify the report 

format you want to use. As identified above you can print the PO from the PO History screen and also in the PO.  

 

Tax 

Just as when you raise a PO in Invoicing you can see the tax information. 

With the tax box checked when you open a purchase order the tax will be displayed. 

Note: Since the tax option was not available in prior versions theses fields will be disabled for older views.  

You can now edit the Quantity, Unit Price and Sub Total fields. If you change the sub total then the unit price will 

recalculate, if you change the unit price the sub total will recalculate and if you change the quantity the sub total 

will recalculate. 

The taxes are also displayed in the total. 



154  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

 

 
Shipping Address 

You can edit the shipping address from PO history with the same methods you had when raising the PO from the 

invoice. 
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Accounts 
 

About Customer Accounts 

In PrintSmith Vision, you can define accounts for both prospects and customers. Prospects have not  yet done 

business with you, but you hope to turn them into customers. Customers have done business with you, and 

invoices have been created for them. Once you create an invoice for a prospect, that prospect is automatically 

converted to a customer. If customers become inactive, they can be turned into prospects again.  

Accounts are a key part of your PrintSmith Vision system. Invoices are assigned and posted to accounts, 

payments are made for accounts, account histories are tracked, and sales statistics are  kept for each account. 

Tip: The terms customer and account are often used interchangeably in PrintSmith Vision.  

In addition, each account has contacts associated with it. An account may have a single contact person or 

different people. For example, one contact may receive invoices and another receive statements. You can 

always add a contact while you are setting up an account, but you can also manage contacts independently of 

accounts and provide additional information about the contacts.  

 

About Master Accounts 

Master accounts are very useful if you do business with several departments or locations at one company or 

organization but need to send the statements to a central location for payment. You can track each of the 

departments or locations with a separate account and then tie them together through a master account for billing 

purposes. For example, you do business with the London, San Francisco, and Santiago offices of a company 

named SuperPromos, but all payment comes from SuperPromos Corporate. In th is case you would set up four 

accounts: SuperPromos Corporate would be the master account and the SuperPromos London, SuperPromos 

San Francisco, and SuperPromos Santiago sub-accounts would all be linked to the SuperPromos Corporate 

master account. All orders and order history will be tracked for each sub-account, but billing statements will be 

sent to the master account with a breakdown for each sub-account. 

Note: A master account is created like any other account; nothing in the account settings identify it as a master 

account. When you create sub-accounts, however, you link them to the master account on the Settings tab in the 

Customer window. This is how a master account is established. 

 

General Guidelines for Working with Accounts 

When setting up accounts for prospects and customers, keep the following in mind:  

• To get started, you only need to create accounts for customers that have an outstanding account 

balance; add other customers later as needed. 

• The creation of a customer or a prospect is the same, you identify them on the Marketing tab. 

• You can create any number of accounts for a single customer, as long as the name on the account is 

unique – the accounts can all have the same address (or no address at all). 

• When you create accounts for a large customer who requires centralized billing and therefore a master 

account, create the master account first and then create the sub-accounts that are linked to the master 

account. For more information, see “About Master Accounts” above. 

• Although not required, you should create accounts for all your regular customers even if you do not plan to 

extend them credit. 

• PrintSmith Vision has a special walk-in account for occasional or walk-in business, but you can use it any 

way you see fit. Avoid changing the walk-in account to a charge account, however. Whenever you extend 

credit to a customer, always set up an account and assign any pending documents for the customer to 

this account (instead of using the walk-in account). 

• EFI recommends that you create a few special accounts: one for in -house printing and one for “junk” 

transactions (tax adjustments and so on) that you do not want to clutter up other accounts. 

• Multiple users can work with accounts at the same time, but if one user opens an account, it is locked so 

other users cannot work with it. When an account is locked, and you try to open it, a message informs 

you it is unavailable. 
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Understanding the Customer Window 

You manage the information about your customer accounts in the Accounts window. To open this window, click 

Accounts in the Quick Access panel (or select AR > Accounts.) You will be shown a list of accounts and column 

headings. You can search on any of the headings but to select an account you must click on the account name. 

You can customize the column to be displayed on the list using the Customize feature. Some of the columns 

cannot be removed and they will be grayed out.  

Selecting one or more accounts using the check box to the left will allow you to delete accounts or sync them with 

MDSF. Accounts that have been synced with DWF will be identified by the globe to the left of the check box. 

Using selectors at the top you can display only those accounts that have been synced with MDSF or just those 

not MDSF registered. You can also use the three dots to delete, sync an account with MDSF or add a contact to 

the account. 
 

 

Deleting Accounts 

You can delete a prospect account at any time if you think the prospect will never turn into a customer. 

You can delete a customer account only if the customer does not have an open balance and there are no 

estimates or invoices on the pending list for the customer.  

Note: You can restore a deleted account as long as you know the number of an invoice or estimate that was 

created for the account. 

To restore a deleted account. 

If an account was deleted, but invoices or estimates were created for the account before you deleted it, you can 

rebuild the account history from an invoice or estimate and recover almost all the customer information.  

1. Select Invoice > Review Any Document to open any invoice or estimate that was created for the deleted 
account. 

2. Select Invoice > Create Customer Acct fm Document or Invoice > Create Prospect fm Document. The 
restoration can take several minutes depending on the size of your database. 
The account is restored using the name and address information in the document except that the account name 
is Recovered acct #xx, where xx is the account number. It is placed at the beginning of the Customer list or 
Prospect list (if restored from an estimate) in the Account Picker window. 
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3. Select the account, specify the account type and credit limit, and correct the name. 
4. If necessary, change a prospect to a customer by selecting Customer on the Marketing tab of that prospect. 
5. Save the account. 

The recovered account has its full history, account information, and sales statistics.  

 

Adding Contacts to Accounts or Prospects 

To be used in PrintSmith Vision, a contact must be associated with an account. Add contacts to an account in 

any of these ways: 

While creating a document 

1. While creating an invoice or estimate, select the customer account in the Account Picker window. 

2. In the Account Info window (which opens automatically), click New to the right of Contact List. The Edit 

Contact window opens. 

3. Enter the contact information and click OK. The Contact List field now includes **NEW CONTACT**. 

In the Account Window 

1. Click Accounts in the Quick Access panel. 

2. In the Account Picker window, double-click the account to which you want to add a contact (or click the 

account and click Select). 

3. On the Address tab, click near the bottom of the window. The Contact window opens. 

4. Provide information about the contact and click Save. 

In the Contact window 

1. Click Contacts in the Quick Access panel. The Contact Picker window opens. 

2. Click New. The Contact window opens. 

On the account picker, select an account for the contact, enter the contact information, and click Save. 

 
 

Create 
Account 

Customize 
List 
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Creating Accounts 

The process of creating an account for a prospect and a customer is identical, except that you identify the 

account as a prospect or customer account. 

 

General procedure for creating accounts 

Note: A master account is a centralized billing account (such as a university) with associated sub-accounts (such 

as university departments). All statements are sent to the master account, but the sub-accounts do their own 

ordering, have their own order history, and so on. You create a master account just like any other account – it is 

not identified as a master account in the account set up. When you create the sub-accounts, however, you link 

them to the account you want to serve as the master account. This is how a master account is established.  

 
Select the Create Account button and the New Account window opens. (After you save an account, the window 

title changes to the account number and name.) 

1. Enter Account name. 

Note: In the Name field, enter a unique name for the account (up to 70 characters). If the account is for a  

person, enter the last name first, for example, Smith, John, so it is easy to find in the alphabetical list of 

accounts, but enter the name in the address fields as John Smith so that John Smith is the name on 

invoices and statements. 

Tip: You can change the name of any account at any time, except for the <<<WALK-IN>>> account 

2. Enter Account Type 

Under Type, select the account type. This controls what type of payment is accepted for the account. When 

you create a new account, Type is automatically set to Cash/Check/Credit Card, but you can change this as  

necessary. 

Full Deposit When an invoice is opened or saved with a balance due, you are 

reminded that this customer must pay in advance. Payments can be 
made with cash, checks or credit cards. 

Cash The customer must pay with cash. Checks and credit cards are not 

accepted, and charges are not allowed. 

Cash/Check/Credit 

Care 

The customer must pay with cash, check, or credit care, charges are 

not allowed. 

Charge Account The customer may charge the amount to the account, but can also use 

any other payment type, for example, cash or credit card. 

Credit Card on File For a trusted customer, a credit card that is on file can be accepted 

when picking up an invoice. You can select this option only if you are 
using integrated credit card processing in PrintSmith Vision. For 
information, see the guide to PrintSmith Vision – Secure Credit Card 

Processing. 

3. Enter Account Status. 

Ignore Account Status when you are setting up your PrintSmith Vision system. By default, the account that 

you set up are considered New. The status information is updated automatical ly when account aging takes 

place. Typically, account can be a certain number of days past due according to three aging classifications 

with standard values of 30, 50 and 90 days. You can change these aging classifications as needed with 

the aging periods preferences. On a case-by-case basis, you may need to change the account status as 

follows. 

New When an account is first created, and has never been aged, it is considered a new 

account  

Current An account is current if all amounts owed are within the allowable limits 

Past Due The account has open items picked up more than 30 days ago. (The number of days 

may be different if you changed it in your aging preferences. 
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Delinquent  The account has open items picked up more than 60 days ago. (The number of days 

may be different if you changed it in your aging preferences 

Inactive As of the last aging, the customer was inactive for the period specified in your 

credit/default preference. Invoices or payments all cause the customer to be active 

again. 

Frozen The account aging process can automatically freeze accounts with open items 

picked up more than 90 days ago. Once an account is frozen, no more invoices 

can be created, and no charges can be accepted. An account is normally unfrozen 

manually, or automatically during the aging process. A frozen account will still be 

displayed in the list of accounts but if it is selected you will get a pop-up message 

identifying it as a frozen account. The account will need to have the status 

changed if you want to create an estimate or you must have Admin access. 

Note: You cannot copy an invoice from a frozen account. 

4. Enter Sales Rep. 

 
There are 4 tabs where you can enter the account information, Contact and Address, Credit/Tax Control, 

Settings and Marketing. 



Accounts |  161
9 

 

 

 

 

Contact and Address 

Use the Contact and Address tab in the to provide general information about the customer, for example, name, 

invoice and statement addresses, and associated contact information. This tab also includes the account 

number, which is assigned automatically when you save a new account, and which you cannot change.  

Each account can have two separate addresses: invoice and statement (billing). The invoice address is copied to 

an estimate or invoice when you select an account for the document. When printed, documents can include either 

an invoice or statement address (or both). Likewise, either address can be included on statements.  

Note: Any required fields (as specified in the Mandatory Field preferences) are outlined in red. You must  

complete these fields before you can save an account. 

You can create a customer account without any contacts, but EFI strongly recommends that you always create 

at least one contact at the same time as you create the customer account. Once a contact is assigned to a  

customer, the customer must always have an assigned contact, but you can change the contact. You just cannot 

change an account so that it no longer has a contact assigned. You can create additional contacts later.  



162  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

 

Tip: If you plan to e-mail documents (for example, invoices, estimates, or statements) from PrintSmith 

Vision, make sure all contacts include an e-mail address. 

 If there is a central phone number for the customer, enter it in the Main Switchboard Number field. 

1. The External Accounting ID can be used as a reference for an identification in something such as a CRM. 

2. If you are using an external system (such as an accounting package), in the External Ref # field, 

enter the account ID from the other system. You can search for customers by this reference 

number and you can also include the number on documents, job tickets, and statements. 

3. Enter the address for invoices. The name you entered for the Name field for the account will 

default as the name in the Invoice address, but you can change it if needed. 

Tip: You can use Table Editor to maintain information in the City, State, Zip, and Country tables so 

that this information can be selected instead of typed. You can also start typing part of a city, state, 

zip code, or country in one of these fields, and the selections will be filtered. For example, type ba in 

the City field to see all cities (in the City table) that begin with ba. 

4. Select Done 

5. Enter the address for Statements. The name will default but can be changed. If the statement 

address is the same as the invoice address, the invoice address is automatically used for both. 

If a different address is required for statements, you can make changes before you select Done. 

After selecting Done you can still edit any of the information by selecting the Edit button. 

6. Select Done. 

7. Enter the information on the Invoice Contact. The contact is automatically assigned to the 

account as the default invoice contact. The contact is also now listed in the Contact List field.  

Note: On an existing account if you search for a contact you must search by last name. 
8. Select Done.  

9. Enter the information on the Statement Contact. If the statement contact is the same as the 

invoice contact, the invoice contact is automatically used for both. You can change the 

information in the Statement Contact if it is different. 

10. Select Done. 
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Credit/Tax Control 

Use the Credit Control tab in the Customer window to set credit limits, finance charges, discounts, and so on.  
1. In the Credit Limit field, enter the maximum amount the account can charge to the account. By default, the 

system credit limit is used. (You set the system limit in the Legacy version. Go to Admin > Preference and 

under Accounting, select Credit/Defaults.) If no system credit limit is defined, and you leave this field blank, 
Unlimited Credit is displayed to the right of the field. 

2. In the Due Days from Posting field, enter the number of days to add to the current date to calculate a due 
date for an invoice that is picked up and posted in the cash register. If you d o not provide a value here, 
PrintSmith Vision uses the value (if any) in the Number of days due before field in the Estimator Printing 
preferences. This is found in the Legacy version under Admin > Preferences and under Estimator select 
Estimator Printing. The due date is included under the amount due in the totals section of the invoice if the 
Show payment due date check box is selected on the Footer tab in the Document Preferences window. In 

the Legacy version go to Admin > Document Preferences > Footer tab. 
3. In the Monthly Finance Charge Pct field, enter the percentage for calculating finance charges when 

statements are generated. 
 
If this field is set to 0.00%, the system default finance charge rate is used (as defined with the Credit/Defaults 
preferences. (You set the Finance Charge in the Legacy version. Go to Admin > Preference and under 
Accounting, select Credit/Defaults.) When the system default rate is used, it is displayed to the right of this 
field as shown in the figure above: Using standard rate of 1.50%. The system default rate is used unless you 
enter a different rate in the Monthly Finance Charge Pct field or select the Never calculate finance charges 

check box. 
 
Note: The finance charge is the rate used each time finance charges are calculated when you generate 
statements. It is not an annual rate. 
 
After the account has some history, additional information is displayed on the Credit Control tab: Avg Days 
to Pay shows the average time it takes the customer to pay an invoice; Finance Charges YTD shows the 
total amount of finance charges posted to the account in the current year; and Current Balance shows the 
total amount owed to you by this customer, including merchandise charges or POS charges.  

4. In a franchise situation, select the Royalty Exempt check box if jobs for the account are not subject to royalty 
payments. (Ignore this check box if royalty payments do not apply to you.) The check box is always displayed 
but can only be selected or cleared by a member of the owner or system admin access groups. 
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Note: Individual invoices can be flagged as royalty exempt (or non-exempt) in the Document Totals window. 
5. If the account uses standard corporate-wide pricing, select the National Pricing check box. If the account 

uses specialized pricing, leave the check box cleared. 
6. If you want to give the account a discount (or you want to markup invoices for the account), under 

Automatic Discount, do one of the following: 
 

• Select Percent and enter a discount as a positive percentage and a markup as a negative percentage. 
This discount (or markup) is applied each time you create an invoice for the customer. 

• Select Dollars and enter a discount in dollars. This fixed discount is applied each time you create an 
invoice for the customer. 

 

Note: If you want the discount to be a one-time discount, select the One-time discount check box. For 

example, you may want to offer a special deal to first-time customers or you may want to promote a new 

service. 

When you create an invoice for the account, and a one-time discount was specified, you are asked if 

want to apply the discount. If you click No, the discount remains in the customer account. If you click 

Yes, the discount amount is applied to the invoice and cleared from the Credit Control tab. 

Under Tax Setup: 

If the account is subject to sales tax: 

a. In the Tax Table field, select the tax table you want to use for the account. The tax table is set 

up in the Legacy version, go to Admin > Table Editor > Tax tables. This tax table is known as the 

parent tax table and is automatically used on invoices for the account unless you change it at the 

invoice level. In addition, the parent tax table is used by default for charge definitions, unless you 

select a different tax table (in the Preset Info window). 

b. In the Tax Code field, select a tax code to categorize the sale. (A tax code results in a separate 

line in the tax detail report for the same tax table to identify the organization that is levying the tax. 

Use Table Editor to maintain your tax codes.) 

c. In the Resale field, enter the customer’s license number. This number is included on 

 documents created for the account. 

If the account is tax exempt: 

a. In the Resale field, enter the account’s tax exemption ID. This ID is included on documents created 

for the account. 

b. In the Certificate Expires field, enter the date (if any) the account tax exempt certificate expires. 

c. Select the Tax-Exempt check box so that no sales tax is applied to the account. 
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Settings 

Use the Settings tab in the account window to control or modify how the account is used throughout PrintSmith 

Vision 

1. In the Business Type Code field, enter a SIC code or ABC code to classify the account. (For example, the 
Customer List report can be sorted by business type.) 

2. In the Ship Via field, select a default shipping method for the customer. 

3. In the PO Number field, enter the purchase order number if one is required; it will be included on all new 

invoices. 

4. In the Default Invoice and Default Estimate fields, select the invoice and estimate formats to use by 

default when creating invoices or estimates for the account. EFI supplies some standard formats, but you 

can also create custom ones. 

5. Select or clear the following check boxes: 

PO required on Invoice 

Select this check box if the account requires a purchase order. When the check box is selected, you are 

warned to enter a purchase order number when you create an invoice, but the invoice is still created even if 

you do not enter the number. The invoice cannot be picked up until you enter a PO number, however. Also, 

until you enter a PO number, the warning is displayed when an estimate is converted to an invoice, as well 

as each time the invoice is opened. 

Do NOT generate statements 
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Select this check box if do not want statements generated automatically for the account. (You can s till 

generate a statement for any account by selecting the account.) This option is useful for sub - accounts of a 

master billing account that do not require their own statements.  

Account is commissioned 

Select this check box if commissions are paid on sales for the account. (You can use this information in 

custom commission reports.) 

Always file originals 

Select this check box so that invoices for the account indicate that you are saving files provided by the 

customer (typically artwork). You can change this setting when you create an invoice. 

6. Select invoice and job templates. 

A template contains the complete specification of an order or of a job that you can re-use over and over 

again without having to re-enter all the details. You can create a template based on any invoice, estimate, 

or job. 

Use the Templates feature to associate invoice or job templates with an account, so they are available 

when you want to create an invoice, estimate, or job for the account. This allows you to have templates 

specific to this customer readily available. 

• For invoice templates, select the + and you will see a pop-up box listing estimating and invoice 

templates. Select all appropriate and when invoicing for that customer they will be available options. 

When creating an invoice or estimate from a template all estimate and invoice templates will be 

displayed. Entering the account name in the Name column header will then only display those 

templates that have been set up for that account. 

• For job templates, follow the same procedure. When creating an invoice or estimate from a job template 

all estimate and invoice templates will be displayed. Entering the account name in the Name column 

header will then only display those job templates that have been set up for that account. 

7. In the Security level of this account field, enter a security level to prevent access to the account by 

users whose security level is lower. If a user’s access level is lower than that specified here in the 

Security level of this account field, the user cannot use the AR > Accounts, AR > Post Payments, 

and Reports > Account History commands, but can still select an account for an estimate or invoice. 

 

Marketing 

Use the Marketing tab in the account window to record background information about the customer that can, for 

example, help you design promotional mailings or otherwise track customer data.  

Note: Several fields on the Marketing tab are related to tables you maintain with Table Editor. See steps 5 

through 7 below. You may want to review and edit these tables before starting to enter information on this tab 

because you can customize what is entered in some of the fields.  
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Any required fields – as specified in the Mandatory Fields preferences – are outlined in red. 

Under Company 

1. Indicate if the account is for a Customer or Prospect. If a customer cannot be changed to a prospect, 

these selections are unavailable, as in the figure above. (For example, you cannot convert a customer to a 

prospect if the customer has a balance or pending invoices.) 

2. If the account is for a person rather than a business, select the Personal Account check box. You can 

take advantage of this setting when creating mailing labels (with Reports > Mailing Labels) to 

segregate personal accounts for targeted mailings.) 

3. If you do not want to include the account on mailing labels or in mail merge files (generated with Reports > 

Mailing Labels), select the Do not mail check box. 

4. In the Number of Employees field, enter the number of employees in the company to help you 

target companies based on their size. 

5. In the Annual Revenue field, enter the annual amount of revenue of the account or the annual target 

you expect from the account. This information can help target companies based on their revenue 

stream. 

6. In the Business Type field, select the kind of work done by the company. This information is stored in 

the Business Type table which you can change with Table Editor. 

7. Under Marketing Dates, enter up to five dates for any purpose, for example, Anniversary or Birthday. 
 

Note: The labels of the five fields under Marketing Dates are stored in the Marketing Date Labels table and are 

initially named User 1 through User 5. Use Table Editor to change these labels to suit your purposes. For  

example, the figure below illustrates how the User 1 field was changed to Anniversary and User 2 was changed 

to Birthday. Any changes you make to the field labels are also reflected on the Marketing tab in the Contact 

window. 

Under Marketing Tags, provide further information about the account. Note the following: 

• The Lead Source fields both use data from the same table (named Lead Source). Use Table Editor to 

change what this table includes. 

• Eight User tables are available for customization. You can use Table Editor to change the name of a 

User table (which will change the label of the corresponding marketing tag field) and to edit the contents of a 

table. For example, the figure below shows several renamed user tables: Common Interest, Likes, Type of 

Work, Sport Interest, and Mailer Type. You can enter data in the table, so users can select it in the field and 

you can also allow users to enter data directly in the field.  
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Master Account   Add charges to job Notes 

Note: Any changes you make to the user tables are also reflected on the Marketing tab in the Contact window. 

Under Custom Data, enter further information about the account, for example, its web site or LinkedIn URL.  

Tip: The Custom Data fields are text fields that can be used for any purpose (up to 255 characters per field).  

The labels of the fields shown in the figure below are the default labels, but you can change these to anything 

you want by editing the Account Custom Labels table with Table Editor. (You can edit the records in the Account  

Custom Labels table, but you cannot delete or add records.) 
 

 

Note: You must save the account before using the following procedures. 

 

 

Add charges to invoice 

 

Master Account 
If you are creating a sub-account for a customer with centralized payables (known as a master account in 

PrintSmith), click Master Account to select the central payables account. The master account must already exist 

and cannot be a sub-account that is already linked to a master account. 

 

Add Charges for jobs or invoices 
Under Add Charges you can select charges to apply as predefined charges to invoices and estimates created 

for the account and/or to jobs created for the account.  
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Notes 
Use Notes to enter notes that are displayed in different contexts. 

Important: These notes are all designed for small amounts of text (up to 255 characters). They are not for 

lengthy messages or for record keeping; use the Log tab instead. 

1. In the Account selection notice field, enter a note for one of two purposes: 

• To notify your users of something special about the account whenever the account is selected for a 

document. 

• To place these notes in the Special Instructions field of a document. 

2. When you select an account for an estimate or invoice (or copy a document for the account), a window 

opens displaying this notice and asks if you want the text copied to the Special Instructions field. 

3. In the Notes to insert in each job field, enter the text that you want automatically copied to job ticket notes 

whenever a new job is created for the account. (This text is not copied to job ticket notes for existing jobs for 

the account.) For example, you may have a customer for whom you will not start production unless a proof 

was signed, or to whom you always return the artwork. If you enter this information in the Notes to insert in 

each job field, the note is automatically included on the job ticket. 

4. In the Notice to place on statements field, enter the text that you want to include on statements generated 

for the account. For example, you can enter text to customize collection notices for an account or to remind 

a customer of upcoming repeat orders. (The notice is included on statements if the Show customer 

statement notes check box is selected on the Output tab in the Generate Statements window. To access 

this in the Legacy version go to AR > Generate Statements.) 

 

Log 
Use the Log feature to record your interactions with the customer, flag items for follow-up, indicate that an issue 

is complete (resolved), and review information in the log.  

In addition to information you enter directly on the Log tab in the Customer window, the following are logged 

automatically: 

• Documents e-mailed to the customer from the Invoice, Estimate, Cash Register, Post Payments, 

Journal Entry, and Generate Statements windows are logged automatically on the Log tab if you 

configured e-mail logging in your E-Mail preferences. Both the Type and Comment for an e-mail item 

come from the E-Mail preferences. 

• Any information that is entered in the Notify Customer window is logged automatically. These log entries are 

preceded by (Notified) on the Log tab. 

 

Tip: The Notify Customer window can be opened by clicking a Notify button in these windows in PrintSmith 

Vision: Pending Documents, Contact, Work in Progress, Post Payments, and Journal Entry.  
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1. To log the communication you had with the customer: 

a. Select Add New 

b. To categorize the kind of communication you had, select a Type, for example, CALL or VISIT 

If you selected a Type, some default text is displayed in the Add to customer account log field. Edit this 

text or enter your own (up to 255 characters). 

Tip: The selections in the Type field and the default text in the Add to customer account log field come 

from the Customer Log Type table. 

c. Click Add. 

2. To see a log entry in full, select it in the list at the left of the Log tab so it gets displayed at the right of the tab. 

Tip: If the log includes many entries, shorten the list by entering part of the entry in the blank field and select 

the look up button. 

3. To edit a log entry, select it in the list, make your changes, and click Done. 

4. If follow-up is required for a particular log entry: 

a. Select the log entry in the list. 

b. Select the Follow-up required check box. 

c. In the Follow-up date field, enter or select the date on which you need to contact the customer. 

d. The Follow-up by field is automatically set to your user name, but if you want another user to do the 

follow-up, select that user. 

e. In the Follow-up comment field, enter more details (up to 255 characters) of what needs to be done. 

f. Click Save. 

4. To indicate that the issue raised in a log entry was resolved: 

a. Select the log entry in the list. 

b. Select the Completed check box. 

c. In the Date Completed field, select the date on which you resolved the issue. 
 

d. The Completed by field is automatically set to your user name, but if another user was responsible for 

resolving the issue, select that user. 

e. In the Action taken field, explain what was done (up to 255 characters) so you have a record of it. 

5. To remove an entry from the log,  select it in the list and click Delete. 

6. To print the entire log for the customer, click Print Log. This will print only the follow up log information. 

For activities you can select how far back you want to see by selecting 30, 90, 180 days or all. 

 

Web 
If you are using eFlow based MDSF Integration, the customer window also includes a Web button. (For 

information, see section Register Accounts and Contacts to Market Direct StoreFront.)  
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Sales Info 

The Sales Info button in the customer dashboard contains sales statistics. As you do business with the 

customer, information will become available over time and you can view that information here. You can update 

the customer’s statistics and perform an instant aging of the account.  
 

There is a pie chart which shows this customer’s aging. 
 

The next chart displays customer account statistics for different periods.  
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Sales statistics for this month, this year and last year. 

Year over year growth 

Quotes Vs Orders – The ratio of estimates to orders. This helps to identify accounts for which you are continually 

entering estimates but rarely getting jobs. The number of estimates may not be ex act. PrintSmith Vision counts an 

estimate only when you save it. If the account is in use in another window or by another user, it is not counted. An 

estimate is also not counted if you change the account on an existing estimate.  

Estimate Won Vs Lost 

Sales Ranking will compare the sales volume of the account to other accounts. For a rank to be available, you 

must run and save the Account Ranking report. The sales ranking is based on the last time you ran the report.  

Another chart shows the sales trend for different periods. You can choose to the order trend for 1 month, 3 

months, 6 months of 1 year. If you hold your cursor over a period it will display the total number of orders and 

sales during that period. 

 

 
 

Sales Dates 
 

Created The date the account was created in PrintSmith Vision. 

Last Billed The date a statement was last generated for 
the account. 

Last Payment The date the last payment was received for the account and 
recorded with AR > Post Payments. 

Last Aged The date the account was last aged. 

Last Invoice The date the last invoice was created. 

Last Estimate The date the last estimate was created. 

First Invoice The date the first invoice was created. 

First Estimate The date the first estimate was created. 

Estimates Won/Lost The ratio of estimates that were won  
(you got the business) to estimates that were lost.  
PrintSmith Vision tracks this information automatically. 
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Customize 

list 

 

 

Contacts 
 

Contacts are the people associated with an account, for example, those who receive statements or invoic es or to 

whom you send promotional mailings. An account may have a sing le contact or may have many; it depends on 

the account. 

Although you can enter some contact information while working with a customer account, you may want to enter 

additional information about contacts or create additional contacts, perhaps with different addresses. In addition , 

some information – as specified in the Mandatory Fields preferences – may be required. (Required fields are 

outlined in red.) 

You can access the contacts window by clicking Contacts in the Quick Access panel (or select AR > Contacts.) 

 

Understanding the Contact Window 

 
Each contact is color coded to indicate if the parent is account, parent is prospect or no parent is assigned.  

A default account is identified by the symbol  

You manage the information about your contacts in the Contacts window. To open this window, click Contacts in 

the Quick Access panel (or select AR > Contacts.) You will be shown a list of contacts and column headings.  

You can search on any of the headings but to select a contact you must click on the contact name. You can 

customize the column to be displayed on the list using the Customize feature. Some of the columns cannot be 

removed and they will be grayed out. 
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Sync with MDSF Delete Contacts 

 
Selecting one or more contacts using the check box to the left will allow you to delete contacts or sync them with 

MDSF.  
 

Deleting Contacts 

You can delete a contact only if the contact is not in use in the system or is not the default contact for an 

account. 

1. In the Quick Access panel, click Contacts (or select AR > Contacts). The Contact Picker window opens. 

2. Find and display the contact you want to delete. 

3. Click Delete on the toolbar and then click Yes to confirm the deletion. (If the Delete button is unavailable for a 

contact, the contact cannot be deleted.) 

 

Editing Contacts 

You can edit the contacts for an account. For example, you may want to change an address or log your 

interactions with the contact. 

1. Click Contacts in the Quick Access panel (or select AR > Contacts). The Contact Picker window opens. 
 

2. Find and open the contact you want to edit and select Edit Contact 

3.  Make your changes on the tabs. (For information about the fields on the tabs, see the sections that begin 

with “General procedures for creating contacts”.) Note the following on the Address tab: 
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• A <default contact> serves as both the shipping and billing contact. If nothing is displayed, the contact 

is assigned to an account but is neither the shipping nor the billing contact. 

• You can change the account to which the contact is assigned for any type of contact except the default 

contact. You can only change the default contact for an account on the Address tab in the Customer 

window.  

4. Click Save on the toolbar. 

Tip: To create a new contact from the Contact window, click New Contact on the toolbar. 

 

Creating Contacts 

1. Select Create Contact. 

2. Select the account name. 

3. Select the sales rep. 

4. If the contact is for a person rather than a business account, select the Personal Account check box. This 

setting helps you segregate personal accounts for targeted mailings. 

5. Select the Do not mail check box to remove the contact from labels or mail merge files generated with 

Reports > Mailing Labels 

6. Contact type is for MDSF. 

7. Click the Address tab to enter or edit basic information about the contact.  

8. Click the Marketing tab to provide information that is useful in targeting marketing materials to the contact. 

9. If you are using integrated credit card processing in PrintSmith Vision, use the Credit Info tab to save credit 

card information for the contact. For information, see the guide PrintSmith Vision - Secure Credit Card 

Processing. 

10. Enter MDSF name for this contact. 

11. Click Save on the toolbar. 

 

Contact Address tab 

Contact Detail and Communication Address 

Here you can enter the name and other information about the contact. If you e -mail documents to customers, be 

sure to include an e-mail address for all contacts. The communication address for the contact is highlighted in 

red to indicate it is required. 
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Select the Use Contact Address check box if you want to use the contact address instead of the account 

address when you select the contact for estimates or invoices. When you select this check box,  the Address 

area becomes available below the check box. Click Edit to provide the address 

 

 
Shipping Address 

A contact may have many shipping addresses. You can select a shipping address at various points when 

creating jobs for the account, for example, in the Account Info window or on the delivery ticket. Under Shipping 

Address, manage the shipping addresses for the contact as follows: 

• To add a shipping address, click Add New and complete the Edit Address window. The address is then 

listed under Shipping Address (as shown in the figure below). 

• To edit a shipping address, select it under Shipping Address and click Edit. 

• To remove a shipping address, select it under Shipping Address and click Delete. 
 

 

Marketing tab 
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Use the Marketing tab to provide information about a contact to help you with promotional mailings aimed at 

particular contacts. This tab is similar to the Marketing tab for a customer account but applies to a contact.  

Note: Several fields on the Marketing tab are related to tables you maintain with Table Editor. See steps 3 and 

4 below. If you did not already do so when setting up accounts, you may want to review and edit these tables  

before starting to enter information on this tab. 

1. If the contact is for a person rather than a business account, select the Personal Account check box. 

This setting helps you segregate personal accounts for targeted mailings. 

2. Select the Do not mail check box to remove the contact from labels or mail merge files generated with 

Reports > Mailing Labels. 

3. Under Address, enter up to five dates for any purpose, for example, Anniversary or Birthday. 

Note The labels of the five fields under Address are stored in the Marketing Date Labels table and are initially 

named User 1 through User 5. If you did not already do so when setting up accounts, use Table Editor to 

change these labels to suit your purposes. Any changes you make to the field labels are also reflected on the 

Marketing tab in the Customer window. 

Under Marketing Tags, provide further information about the account. Note the following: 

• The Lead Source fields both use data from the same table (named Lead Source). Use Table Editor to 

change what this table includes. 

• Eight User tables are available for customization. You can use Table Editor to change the name of a User 

table (which will change the label of the corresponding marketing tag field) and to edit the contents of a 

table. For example, the figure below shows several renamed user tables: Common Interest, Likes, Type of 

Work, Sport Interest, and Mailer Type. You can enter data in the table, so users can select it in the field and 

you can also allow users to enter data directly in the field. 
 

Note: Any changes you make to the user tables are also reflected on the Marketing tab in the Customer 

window. 

 
• The Gender field uses data from the Gender table and the Age Range field uses data from the Age 

Range table. (If either field is required – as specified in the Mandatory Field preferences – it is outlined in 
red.) 
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Credit Info tab 

If you are using integrated credit card processing in PrintSmith Vision, use the Credit Info tab in the Contact 

window to save credit card information for a contact. Here you can enter the information about the account 

holder. Then select add card. This will take you to the USA ePay site where you can enter the information about 

the credit card. Save the information and you will get a message from USA ePay that the transaction was 

successful. On the credit info tab the card holder name and the account numbe rs last four digits will be 

displayed. 

For more information, see the guide PrintSmith Vision - Secure Credit Card Processing. 

You can delete the card information by selecting the delete button.  

Using the Web tab for Contact 

If you are using eFlow based MDSF Integration, the Contact window also includes a Web button.  
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Register Accounts and Contacts to 
Market Direct StoreFront 

Understanding the relationship between accounts, contacts and 
MDSF 

A customer account in PrintSmith Vision is equivalent to a company in Marketing Direct Sto reFront. 

Contacts in PrintSmith Vision are equivalent to users in Marketing Direct StoreFront. The users, also known as 

buyers, place orders on the Marketing Direct StoreFront site.  

Information about accounts and contacts when sent from PrintSmith Vision to Market Direct StoreFront is known 

as registering accounts and contacts. If you update a company or user in Market Direct StoreFront, the 

corresponding account or contact is updated in PrintSmith Vision. But, if you delete a company or user in Market 

Direct StoreFront, the corresponding account or contact remains in PrintSmith with no indication it is no longer 

present in Market Direct StoreFront. 

Note: If you make changes to an account or contact in PrintSmith Vision after the account or contact is  

registered, the changes are sent to Market Direct StoreFront automatical ly. 

 

Registering accounts and contacts to MDSF 

Before you can register a contact as a buyer in Market Direct StoreFront, the contact must have an e -mail 

address and a MDSF user name defined in PrintSmith Vision. 

Before you can register an account as a company in Market Direct StoreFront, the account must have at least 

one contact with an e-mail address and MDSF user name defined. 

You can register accounts and contacts in different ways, but in all cases you must first make sure that contacts 

have e-mail addresses and MDSF user names. 

 

Method 1: Register a contact and automatically register the account 

Start by going through your accounts and identifying those contacts you want to register as buyers for the 

account (this is often all the contacts). When you register a contact, the contact’s account is also automatically 

registered (if not already registered). 

1. For each account you want to register in Market Direct StoreFront as a company, do the following: 

a. Click Accounts in the Quick Access panel (or select AR > Accounts). 

b. In the Account Picker window, select an account. 

c. On the Address tab, in the Contact List field, select a contact you want to be a buyer in Market Direct 

StoreFront and click Open Invoice Contact Button. 
 

The Contact window opens. 

Tips You can also open a contact by clicking Contacts in the Quick Access panel and selecting a contact in the  

Contact Picker window (contacts are always identified by their accounts). If you are creati ng a new contact, 

you must save the contact before you can register the contact. The contact must also be associated with an 

account. 
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2. In the MDSF User Name field, enter a unique name. The contact will use this name to log into the 

Market Direct StoreFront site. 

3. Click on Web button. 

Note If the name is not unique, you will be asked if you want to use the e-mail address as the user name. 

Click Yes or No. 

If you click No, enter a different name and click Web button again.  

 

4. After you click Web button, a message informs you that registration was initiated, and that the contact will 

be e-mailed login information after registration is complete 

 
 
 
 
 

After registration is complete: 

 
• The contact is registered as a user in Market Direct StoreFront. 

 
• The contact receives an e-mail with a link to the Market Direct StoreFront site and a user name 

and password. After first logging in, the user will be forced to change the password. 

 

• The account with which the contact is associated is also registered in Market Direct StoreFront 

(unless it was already registered) 
 

Important: Never add, edit, or delete a company in Market Direct StoreFront because that information is 

not sent to PrintSmith Vision. Companies (meaning accounts) must always be managed from PrintSmith 

Vision. 

Or click of Web button in the Contacts window:  

• There is an Update Contact button so you can update contact information in Market Direct StoreFront 
if it changes. 

• The Last Registration Date and Registration Status are updated. 

• The Unregister Contact button becomes available. You can use this if you no longer want 

the contact to be a user in Market Direct StoreFront. 
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Method 2: Register individual accounts and their contacts 

 
You can also register an account from the Customer window, as long as the default invoice contact 

for the account has an e-mail address and MDSF user name defined. If the account has other 

contacts that you want to register as users in Market Direct StoreFront, they must also have an e -mail 

address and MDSF user name defined. 

 
1. Click Accounts in the Quick Access panel (or select AR > Accounts). 

2. In the Account Picker window, double-click the account you want to register. 

3. Click the Web button 

a. You will be asked if you want to register default contact(s). 

b. Click Yes to register default contact(s) or No to select specific contacts if the account has multiple 

contacts. If you clicked Yes, registration is initiated. 

c. If you clicked No, in the Customer’s Contacts List window, select the check boxes of the contacts 

you want to register as users in Market Direct StoreFront and then click Select Contact(s). 

 

Note: If a contact is missing a MDSF User Name or E-mail, you will not be able to register the contact 

without providing the missing information. 

You could now provide the missing information in Account contact list’s popup itself, just click in the 

space under column of MDSF User Name and E-mail, you would be able to edit the information 
 

 
4. When you receive a message informs you that registration was initiated, and that the contacts will be emailed 

login information after registration is complete, click OK to continue. 

 
 
 
 
 
 

After registration is complete, as with the first method of registering accounts and contacts, both a company and 

user(s) are created in Market Direct StoreFront the information under Web button is updated, and the contacts 

receive an email with login information. 
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Method 3: Register multiple accounts in one step 

 
If the default invoice contacts for accounts you want to register in Market Direct StoreFront already have an e- 

mail address and MDSF user name defined, you can register all the accounts and all their default invoice 

contacts in one step. 
 

Important: When you register several accounts in one step, only the default  invoice co ntacts for the accounts are 

registered as users in Market Direct StoreFront. If an account has multiple contacts that you want  to register, 

either register the account as described for Method 2 above or register the contacts  individually from the Web tab 

in the Contact window as described for Method 1. 

 
1. Click Accounts in the Quick Access panel (or select AR > Accounts). 

2. In the Account Picker window, select the check boxes of the accounts you want to register 

 
If the default invoice contact for an account is missing a MDSF user name or Email id, you are notified, and 

will not be able to register the account until the contact has a MDSF User Name (on the Web tab in the 

Contact window). 

 
 

3. Click Register Account. 
 
 

  
 

4. After you click Register Account, a message informs you that registration was initiated, and that the contacts 

will be e-mailed login information after registration is complete 

 
 
 
 

 

After registration is complete, the accounts will have Globe icon next to check box in the Account Picker 

window. 



184  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

 

If you have a long list of accounts, you can enable MDSF Register toggle in the Account Picker window to 

see all the accounts that are registered with Market Direct StoreFront.  

Updating accounts and contacts 
If you change some information about an account or contact that is already registered, the information is sent 

to Market Direct StoreFront automatically to update the corresponding company or user in Market Direct 

StoreFront. 

 
Some changes to an account, however, for example, to the address, are not automatically updated for a contact 

that uses the address. In this case update the contact manually as described below.  

 

1. Open the account or contact in PrintSmith Vision and click the Web Button in the Customer or 

Contact window. 

2. Click Update Account or Update Contact depending on what you are updating.  

 

Unregistering accounts and contacts 

If you want to delete a particular company or user in Market Direct StoreFront, you must unregister the account 

or contact in PrintSmith Vision. The account or contact will still exist in PrintSmith Vision, but the corresponding 

company or user will be deleted in Market Direct StoreFront.  

When you unregister an account, no contacts (users) associated with the account can place orders in Market 

Direct StoreFront. When you unregister a contact, that person can no longer place orders in Market Direct 

StoreFront. 

Important: Never delete a company or user in Market Direct StoreFront because that information is not sent to  

PrintSmith Vision. Companies (meaning accounts) and users (contacts) must always be removed from Market 

Direct StoreFront by being unregistered in PrintSmith Vision.  

1. In PrintSmith Vision, open the account or contact you want to unregister (delete from Market Direct 

StoreFront). 

2. Click the Web button in the Customer or Contact window. 

3. Click Unregister Account or Unregister Contact depending on what you are deleting.  

 
The company or user is then removed from Market Direct StoreFront.  
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Account History 
You can access account history by selecting the icon in the quick access panel or using the menu on the left of 

the screen by selecting Accounting > Reports >Account History. 
 

The initial display of account history will be in document order. You can sort by selecting a customer and then 

further refine you search by History Type and Period. When a customer is selected their Current Balance and 

Merchandise Balance will be displayed next to the History Type. 

  
 

The options for Period are: 
 

All Starts with the first item posted to the account. 

First Open 
Starts with the first open (unpaid) item and continues to the end of 
the list. (The history shows all items after the first open item. This 
is generally more useful in checking on payment status than AR > 
Post Payments, which shows only open items.) 
 

This Month 
Starts with the first item in the current month. 

Prior Month 
Starts with the first item in the previous month. 
 

This Qtr 
Starts with the first item in the current quarter.  

This Year 
Starts with the first item in the current year. 

Last Year 
Starts with the first item last year. 
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You can further search for specific transactions by using the column headers just as you would for other 

programs. For the date range column click on the starting date, then click on the ending date and then use the 

select button. 

The columns in the account history report include the following:  

 

 
 

The three-dot ellipsis will display different options depending on the type of transaction. For invoices you will 

have the options to Open in new tab, Notify Customer, Properties or Print Invoice. For the other transactions the 

only option is Properties. If necessary, you can change the Description when viewing the Properties.  

 
Open in new tab will take you to that invoice. Notify Customer will bring up that feature.  
 
Properties will display the details for that transaction. Print Invoice will print the invoice. 

 

Analyze account will give you a report on the account of their Sales Breakdown, Receipts Summary and 

Production Data. Analyze Selection will give you the same type of information but just for those transactions that 

you selected by using the box to the left of the item. 

Other options for account history include: 

Notify Customer Clear Filter 

 
 

Posted The date that the entry was posted to the account history. Entries are displayed in the 
order in which they were posted. To reverse the order, click the column header. 

Document 
Number 

The number of the invoice posted to the account.  

Title A description of the document. For invoices, this is the invoice title. For payments, the 
description is generated by PrintSmith Vision when the document is posted. (To change 
the description, select the document, click Properties on the toolbar, and edit the 
Change Description to field.) 

Total 
The amount of the document when it was originally posted. The total is underlined if 
there was a deposit on an invoice. 

Contact Name The default contact for this customer. 

Paid on For invoices and journal entries, the date a payment was last applied to that item. For 
payments, the date is blank. 

Ref # For invoices and journal entries, the check number or credit card reference 
(authorization) number. 

PO# 
The purchase order number, if any. 

User  
The name of the user. 

Sales Rep 
The name of the Sales Rep associated with this account.  

Balance Due 
The current balance due on the item. Negative amounts are credit balances that were 
not applied to a debit (invoice or debit memos). 
Items with no balance due were paid off or fully applied (payments and credit memos).  
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Copy an Invoice 
If you previously created an invoice for a customer, and want to re-use it, you can go to the customer’s account 

history and re-create the invoice: 

1. Select Reports > Account History.  

2. Select the account you want. 
3. Find the invoice you want to re-use and double-click it. 

4. The invoice opens in a locked state. Select Invoice > Copy > Copy to New Invoice to create a new 

invoice based on the old invoice. You can also select to Copy to New Estimate. 

The documents in account history are “locked” since they form part of the audit trail PrintSmith Vision maintains. 

All details in the document are retained, however, and you can copy these documents to new estimates or 

invoices. You can update the pricing with the latest prices when you copy a document, but all of the descriptive 

information and notes you made on the job (the location and condition of the artwork, special pricing instructions, 

and so on) are retained. 

When you copy a document from history, PrintSmith Vision keeps track of the source document. For example, 

the old document number is displayed in the document window and printed on job tickets. If you file artwork by 

document number, and get a repeat order, the job ticket has the old document n umber so you can locate the 

artwork. 

 

Editing Account History 

You can edit the Title for any transaction in account history and you can edit the PO number for invoices. 

Select the edit Icon.    to edit. 
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Estimating History 
You can access Estimating History by selecting the icon in the quick access panel or using the menu 

on the left of the screen by selecting Accounting > Reports > Estimating History.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

  
 

The Estimating History report will display all historical invoices. You can select a specific account to 

display and further filter the estimates by the Period the estimate was created. The options are:  

All, this month, prior month, this quarter, this year or last 

year. The columns in this report include the following: 

Account The account under which the estimate was created 

Estimate # 
 

The number of the estimate. 
 

Created The date that the estimate was created 

Title A description of the estimate. (To change the description, select the 
estimate, click Properties on the toolbar, and edit the Change Description to 
field.) 

Total The amount of the estimate. 

Status The won/lost status of the estimate. 

Invoice # The invoice number if the estimate was converted to an invoice (because 
the customer accepted the job). 

Off Pending The date the estimate was removed from the pending list. 

Reason The reason the estimate was lost 

 

Across the top of the report there are 4 displays that will show the total estimates, estimates won, estimates lost 
and estimates that are neutral. In each display there are two numbers, the first represents the total of that category 
for the customer selected and the second is the total of all estimates in history for each category. 
 
The colors representing each category are also used along the left of the estimates to show the category for each 
estimate. 
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Reasons 

You can define the reasons for a lost estimate. Reason codes are set up under Table Editor > Reasons. 

You can enter a reason code for an estimate from either the Estimate History Report or from  

 
 

Selecting the + will open a new field where you can enter a new reason. Updating the reason string will update 

the existing reasons string in the Estimate history window. Reason codes  

 

Changing the Status of an Estimate 

Normally, the status (Won, Lost, or Neutral) of an estimate is determined by the system, but you may need to 

change the status yourself. For example, if a customer decides to go ahead with an order after all, you can 

change the status of an estimate to Won. Also, if you created several estimates for a job, but only used one of 

them, you would typically set the status of the unused estimates to Neutral (since they were neither won nor 

lost). For more information about won/lost status, see below.  

To change the status of an estimate, select it in the Estimate History window and then select Won, Lost, or 

Neutral in the Status field. 

 

To keep accurate won/lost records, keep the following in mind: 

• When you convert an estimate on the pending list to an invoice, the original estimate is placed in history and 

considered Won. When you copy an estimate to an invoice, the original estimate remains in the pending 

list and is not put into the estimate history (and is therefore not considered won or lost). For this reason, EFI 

recommends you use Invoice > Convert to Invoice and not Invoice > Copy to New Invoice when 

changing an estimate to an invoice. 

• When an estimate is converted to an invoice, the winning invoice number is recorded in the historical 

estimate and included in history. If you open a historical estimate that was won, the deposit entry area in 

the Estimate window shows the number of the invoice to which the estimate was converted. 

• If you convert a previously lost estimate to an invoice, the status of the estimate is changed to Won in 
estimate history. You can only convert an estimate to Won once. 

• If you use Admin > Clear Estimates to clear estimates from the pending list, during this process you can 

indicate whether the estimates were Lost or are Neutral (neither Lost nor Won). When the system auto-

archives estimates, however, they automatically are given a status of Lost 

• If you make a mistake and want to discard the estimate, void it. A voided estimate does not affect the 

won/lost ratio and is not recorded in estimate history. 



Estimating History |  191
9 

 

 

 
 

Using the ellipsis will give you some other options: 
1. Open in new tab will open the selected estimate in a new window. 
2. Notify customer will give you the screen for notifying customer. 
3. Estimate notes allows you to add notes about that estimate such as to explain unusual features or explain why an 

estimate was lost. You can identify if there are notes for an estimate by the icon to the left of the check box. 
 

 

Notes can also be edited. 

You also have the following options for the Estimate History report. 

Print Data Clear Filters 

 
 
 
 

Download as CSV 

 

Copying an Estimate 

1. Find the estimate you want and double click on the estimate number. 

2. The estimate opens in a locked state. Enter the product and then select Copy. 

3. Select Copy to New Estimate or Copy to New Invoice. 

The documents in account history are “locked” since they form part of the audit trail PrintSmith Vision 

maintains. All details in the document are retained, however, and you can copy these documents to new 

estimates or invoices. You can update the pricing with the latest prices when you copy a document, but all of 

the descriptive information and notes you made on the job (the location and condition of the artwork, special 

pricing instructions, and so on) are retained. 

When you copy a document from history, PrintSmith Vision keeps track of the source document. For 

example, the old document number is displayed in the document window and printed on job tickets. If you 

file artwork by document number, and get a repeat order, the job ticket has the old document n umber so 

you can locate the artwork. 

 

Changing an Estimate Title 

When you hover the mouse over the estimate title you will see the full title and also a symbol that when 

selected will clear the current title and provide you a place to enter a new title.  
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Import Stock 
 

Importing Stock Catalogs 

In addition to entering stock definitions, you can import stock definitions and update prices from an electronic 

price catalog from a vendor, as long as the import file meets certain requirements as described below.  

 

Stock import file format 

• To import stock definitions successfully, the import file must be in the correct format. 

• The file must be a comma-delimited (CSV) text file. 

Important: The delimiters used in the CSV file must match what is specified in the Default CSV Separator 

and Default CSV Quote Character fields in your International preferences. If these fields are blank in the 

International preferences, the CSV field separator defaults to comma (,) and the quote character used to 

enclose text strings defaults to double-quote (“), which are the standard delimiters in the U.S. In other 

countries, different delimiters are used and can be specified in the International preferences 

• The following fields are mandatory and if they are not filled in then the import will not be successful. The 

mandatory fields are marked with an asterisk * on the mapping screen 

• Vendor Name 

• Unique Stock ID 

• Stock Name 

In addition, if you do not have a vendor listed then it might create a new stock . 

• Each stock must have a unique ID (stock ID). If you do not know or have a stock ID, you must obtain it or 

make one up and enter the ID in the import file for the stock to be imported correctly.  

• By default, column E of the stock import file includes a single uppercase letter corresponding to a stock 

group, e.g., S= sheet, R = roll (see “Fields in import file” below). If you want to use a different character for a 

stock group, you can use Table Editor to edit the Stock Group table and enter an uppercase letter in the Key 

(Alpha) column for a particular stock group. During a stock import, if the character in column E of the import 

file matches a value in the Key (Alpha) column in the Stock Group table, the stock is assigned to that stock 

group. Otherwise, the stock import uses the standard values as described for column E in the table below. 

• If any information about the stock is not available or does not apply, leave the field blank in the import file. 

(Otherwise, data will shift over to the wrong field.)  

• For a stock definition to be updated, the stock number and vendor name in the import file must match 

exactly what is already in PrintSmith Vision. 

• The following fields must not have decimal formatting, or they will be imported as 0: Costing units, Bracket 

1-5 qualifier (1-6 qualifier for the HTML version) Lot count, and Carton count. 

 

Fields in import file 

The fields in the import file should be as listed below.  

Note: To help you keep track of the fields, the first column in the table below has column letters (corresponding 

to columns in a spreadsheet). These are just to help you verify that all the necessary fields are in the import file.  

In the HTML version you can map fields so the actual column number is not critical. 

You can download a sample csv file to see the format. 

There are two different file formats, one for Flex (Legacy) and one for the Fast Track (HTML) Version. While this 

document deals primarily with the HTML version the Flex version has also changed so it is included here for 

reference. 

 
Important: You must never use the HTML csv file version for importing into the FLEX version as it will corrupt your data. 
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Flex version column headers 

 

Col  

 

Field Value 

A  Vendor name  The name of the vendor (up to 70 characters). If not supplied, the name in the 
Default vendor name field on the Preview tab in the Import Stock Catalog 
window is used instead. The vendor name is required for price updates of 

existing stock  

definitions.  
B  Unique stock ID  (Required) A unique vendor stock ID (up to 40 characters) – this is the Stock # 

in the stock definition in PrintSmith.  
C  Parent sheet size  The parent sheet size in decimal format (no fractions), for example, 8.5x11.00.  
D  Stock name  The name of the stock (up to 70 characters).  

E  Stock group  The stock group (a single uppercase letter):  

S-Sheet R-Roll  

E-Envelope C-Carbonless O-Other  

If this field is blank, this defaults to S (sheet).  

If, however, the Stock Group table includes a Key (Alpha) value that is used in 
the import file, the stock is associated with that stock group.  

F  Costing units  The costing units – the quantity in which the stock is priced. (This must not 
have decimal formatting,  

or it will be imported as 0.)  
G  Basis weight  The basis weight of the stock.  
H  M weight  The M weight (weight of 1000 sheets) of the stock.  

I  Caliper  The caliper or thickness of the stock.  
J Envelope size  

 

The size of the envelope. (An entry must exist in the Dimension table for each 

envelope size.) Only applicable if unit description (in column E) is set to E. If 
blank, sheet size is used.  

 

K Bracket 1 pricing  

 

The first bracket pricing (see the Settings tab in the Import Stock Catalog 
window).  

 

L  Bracket 2 pricing  The second bracket pricing.  
M  Bracket 3 pricing  The third bracket pricing.  

N  Bracket 4 pricing  The fourth bracket pricing.  
O  Bracket 5 pricing  The fifth bracket pricing.  
P  Bracket 1 qualifier  Quantity break for pricing in bracket 1 (in sheets). (This must not have decimal 

formatting, or it will be imported as 0.)  
Q  Bracket 2 qualifier  Quantity break for pricing in bracket 2 (in sheets). (This must not have decimal 

formatting, or it will be imported as 0.)  

R  Bracket 3 qualifier  Quantity break for pricing in bracket 3 (in sheets). (This must not have decimal 
formatting  

L  Bracket 2 pricing  The second bracket pricing.  
M  Bracket 3 pricing  The third bracket pricing.  
N  Bracket 4 pricing  The fourth bracket pricing.  

O  Bracket 5 pricing  The fifth bracket pricing.  
P  Bracket 1 qualifier  Quantity break for pricing in bracket 1 (in sheets). (This must not have decimal 

formatting, or it will be imported as 0.)  
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Q  Bracket 2 qualifier  Quantity break for pricing in bracket 2 (in sheets). (This must not have decimal 

formatting, or it will be imported as 0.)  
R  Bracket 3 qualifier  Quantity break for pricing in bracket 3 (in sheets). (This must not have decimal 

formatting, or it  

will be imported as 0.)  
S  Bracket 4 qualifier  Quantity break for pricing in bracket 4 (in sheets). (This must  

not have decimal formatting, or it will be imported as 0.)  

T  Bracket 5 qualifier  Quantity break for pricing in bracket 5 (in sheets). (This must not have decimal 
formatting, or it will be imported as 0.)  

U  Color  The stock color, up to 30 characters. (You must supply either this or a generic 
color.) If the color is not currently in the Stock Colors table, it is added to the 
table.  

V  Generic color  A generic color (up to 30 characters) as defined in the Generic Colors table. 
(You must supply either this or a stock color.) If the color is not currently in the 
Generic Colors table, it is added to the table.  

W Product finish  

 

The finish (dull, gloss, and so on), up to 20 characters. This is added to the 
product name.  

X  Carbonless parts  The number of carbonless parts. Only applicable if the unit description (in 
column E) is set to C.  

Y  Price expiration date  Date in mm/dd/yyyy format after which the price is no longer valid.  
Z  Not used  Not used  
AA  Lot count  Minimum order quantity (lot count). (This must not have decimal formatting, or it 

will be imported as 0.)  
AB  Carton count  Number of sheets per carton. (This must not have decimal formatting, or it will 

be imported  

as 0.)  
AC  Stock type  The numeric stock type ID as defined in the PrintSmith Basic Sizes table:  

1 = Business Papers  

2 = Book Papers 3 = Cover Papers 4 = Index  

5 = Tag Board  

6 = Blanks  

7 = Vellum Bristol  

9 = Blotter  

10 = Label  

11 = Newsprint  

If you leave the stock type blank, but provide the basic size (next field), the 

system looks up the stock type in the Basic Sizes table.  
AD  Basic size  The basic size in decimal format (no fractions), for example, 25.5x28.5.  
AE  Metric size  A setting that indicates if the stock is metric: Y or N.  

AF  Product coating  A setting that indicates if and how stock is coated:  

0 = Not coated  

1 = Coated one side  

2 = Coated two sides  
AG  Grade  The numeric ID of a grade as defined in the PrintSmith Stock Grade table.  

AH  Percentage  The percentage of recycled matter, for example, 10% or .10.  
AI  Type of management  The type of forest management (up to 70 characters) from the PrintSmith Stock 

Forest Management table, for example, Green Seal Certified. If not found in 

the table, it is added to the table.  
AJ  FSC Certified  A setting that indicates if the stock is FSC certified:  

Y or N (or 1 or 0)  



Import Stock |  195
3 

 

 

AK  SFI Certified  A setting that indicates if the stock is SFI certified:  

Y or N (or 1 or 0)  
AL  

AM  

AN  

AO  

AP  

AQ  

Green Seal Certified  

Normal Run Size  

MDSF Display Name  

MDSF gsm Weight  

MDSF Media Type  

MDSF Media Weight 
Description  

A setting that indicates if the stock is Green Seal certified: Y or N (or 1 or 0)  

The normal run size for this material  

The name that is displayed for this stock in MDSF  

The gsm weight for this stock as displayed in MDSF  

The media type for this stock As displayed in MDSF. For example, envelope, 

letterhead, Plain paper.  

The media weight description As displayed in MDSF. For example, Bond (20 
pound)/75 gsm  

AI  Type of management  The type of forest management (up to 70 characters) from the PrintSmith Stock 
Forest Management table, for example, Green Seal Certified. If not found in 
the table, it is added to the table.  

AJ  FSC Certified  A setting that indicates if the stock is FSC certified:  

Y or N (or 1 or 0)  

AK  SFI Certified  A setting that indicates if the stock is SFI certified:  

Y or N (or 1 or 0)  
AL  Green Seal Certified  A setting that indicates if the stock is Green Seal certified: Y or N (or 1 or 0)  

AM Normal Run Size The normal run size for this material 

AN  MDSF Display Name  The name that is displayed for this stock in MDSF  

AO MDSF gsm Weight The gsm weight for this stock as displayed in MDSF 

AP  MDSF Media Type  The media type for this stock As displayed in MDSF. For example, envelope,  

AQ  MDSF Media Weight 

Description  

letterhead, Plain paper.  

The media weight description As displayed in MDSF. For example, Bond (20 
pound)/75 gsm  

 

Fast Track (HTML) version column headers. 
 
 

Col Field Value 

A Vendor name The name of the vendor (up to 70 characters). If not supplied, the 
name in the Default vendor name field on the Preview tab in the 
Import Stock Catalog window is used instead. The vendor name is 

required for price updates of existing stock 
definitions. 

 
B 

Unique stock ID (Required) A unique vendor stock ID (up to 40 characters) – this is 

C Parent sheet size The parent sheet size in decimal format (no fractions), for example, 
8.5x11.00. 

D Stock name The name of the stock (up to 70 characters). 

E Stock group The stock group (a single uppercase letter): 
S-Sheet R-Roll 
E-Envelope C-Carbonless O-Other 
If this field is blank, this defaults to S (sheet).  
If, however, the Stock Group table includes a Key (Alpha) value that 
is used in the import file, the stock is associated with that stock 
group. 
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R Bracket 2 qualifier Quantity break for pricing in bracket 2 (in sheets). (This must not 
have decimal formatting, or it will be imported as 0.)  

S Bracket 3 qualifier Quantity break for pricing in bracket 3 (in sheets). (This must not 
have decimal formatting, or it 
will be imported as 0.) 

T Bracket 4 qualifier Quantity break for pricing in bracket 4 (in sheets). (This must not 
have decimal formatting, or it 
will be imported as 0.) 

U 

 
 

Bracket 5 qualifier 

 
 

Quantity break for pricing in bracket 5 (in sheets). (This must not 
have decimal formatting, or it will be imported as 0.) 
 

 
V 

 
Bracket 6 qualifier 

Quantity break for pricing in Bracket 6 (in sheets). (This mush not 
have decimal formatting, or it will be imported as 0.)  

W Color The stock color, up to 30 characters. (You must supply either this or 
a generic color.) If the color is not currently in the Stock Colors table, 
it is added to the table. 

 
X 

 
Generic color 

A generic color (up to 30 characters) as defined in the Generic 

Colors table. (You must supply either this or a stock color.) If the 
color is not currently in the Generic Colors table, it is added to the 
table. 

Y Product finish The finish (dull, gloss, and so on), up to 20 characters. This is added  
to the product name. 

Z Carbonless parts The number of carbonless parts. Only applicable if the unit 

description (in column E) is set to C. 

F Costing units The costing units – the quantity in which the stock is priced. (This 
must not have decimal formatting, 
or it will be imported as 0.) 

G Basis weight The basis weight of the stock. 

H M weight The M weight (weight of 1000 sheets) of the stock.  

I Caliper The caliper or thickness of the stock. 

J Envelope size The size of the envelope. (An entry must exist in the Dimension table 
for each envelope size.) Only applicable if unit description 
(in column E) is set to E. If blank, sheet size is used. 

K Bracket 1 pricing The first bracket pricing (see the Settings tab in the Import Stock 

Catalog window). 

L Bracket 2 pricing The second bracket pricing. 

M Bracket 3 pricing The third bracket pricing. 

N Bracket 4 pricing The fourth bracket pricing. 

O 

 
 

Bracket 5 pricing 

 
 

The fifth bracket pricing. 

 
 

P Bracket 6 pricing The sixth bracket pricing 

Q Bracket 1 qualifier Quantity break for pricing in bracket 1 (in sheets). (This must not 
have decimal formatting, or it will be imported as 0.)  
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AA Price expiration date Date in mm/dd/yyyy format after which the price is no longer valid. 

AB Not used Not used 

AC Lot count Minimum order quantity (lot count). (This must not have decimal 
formatting, or it will be 

imported as 0.) 

AD Carton count Number of sheets per carton. (This must not have decimal 
formatting, or it will be imported as 0.) 

AE Stock type The numeric stock type ID as defined in the PrintSmith Basic Sizes 
table: 
1 = Business Papers 
2 = Book Papers 3 = Cover Papers 4 = Index 
5 = Tag Board 

6 = Blanks 
7 = Vellum Bristol 
9 = Blotter 
10 = Label 
11 = Newsprint 
If you leave the stock type blank, but provide the basic size (next 
field), the system looks up the stock type in the Basic Sizes table. 

AF Basic size The basic size in decimal format (no fractions), for example, 

25.5x28.5. 

AG Metric size A setting that indicates if the stock is metric: Y or N. 

AH Product coating A setting that indicates if and how stock is coated: 
0 = Not coated 
1 = Coated one side 
2 = Coated two sides 

AI Grade The numeric ID of a grade as 
defined in the PrintSmith Stock Grade table. 

AJ Percentage The percentage of recycled matter, for example, 10% or .10. 

AK Type of management The type of forest management (up to 70 characters) from the 
PrintSmith Stock Forest Management table, for example, Green 
Seal Certified. If not found in the table, it is added to table. 
 

AL FSC Certified A setting that indicates if the stock is FSC certified:  
Y or N (or 1 or 0) 

AM SFI Certified A setting that indicates if the stock is SFI certified:  
Y or N (or 1 or 0) 

AN 
 

Green Seal Certified 
 

A setting that indicates if the stock is Green Seal certified: Y or N (or 
1 or 0) 
 

AO 

 
 

Normal Run Size 
 

The normal run size for this material. 

 
AP 
 

MDSF Display Name 

 
 

The name that is displayed for this stock in MDSF 
 

 
AQ 

 

MDSF gsm Weight 

 
 

The gsm weight for this stock as displayed in MDSF 
 

 
AR 

 
 

MDSF Media Type 
 

The media type for this stock As displayed in MDSF. For example, 
envelope, letterhead, Plain paper. 

AS 
 

MDSF Media Weight 
Description 
 

The media weight description As displayed in MDSF. For example, 
Bond (20 pound)/75 gsm 
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AT 

 
 
 

MDSF Media ID 
 

The ID number as displayed in MDSF. You can only allow them to  
enter the new unique stock ID. 

AU New Unique Stock ID If the vendor changes the stock ID then this column allows them  
to enter the new unique stock ID.  
 

 
 

Note: For the HTML version only, If the file to be imported does not follow the mapping listed above you can change the 
mapping using the import program prior to uploading.  
 
 

Manually Mapping to MDSF  
Manual mapping is used when you have a stock in the plant but may not want that stock listed in MDSF. Manual mapping 

allows you to link the stock in the plant to the stock in MDSF for pricing only. You have two options in manually mapping to 
MDSF. The first is in the Flex (legacy) version and the second is on the HTML version.  
 

Manual Mapping in Flex  
On the Flex (Legacy) version the mapping is done in Pricing > Stock Definitions. The procedure is similar to registering 
individual stocks (see Market Direct StoreFront Integration Guide, Task 10: Register Stocks in Market Direct StoreFront. 
The difference is that instead of selecting the Register Stock button and allowing the system to determine the MDSF 
Media ID, you enter the ID of an existing item. By entering that ID number in the MDSF Media ID field you are mapping 
the stock you are entering to an existing MDSF stock for pricing. Since the pricing is controlled from MDSF the s tock in the 
plant that is mapped to a MDSF stock will have the same pricing plan as the MDSF stock.  
 
Select Register Stock. Now the message will indicate that you are manual mapping instead of registering the stock.  
 
Note: In Flex (Legacy) MDSF is listed as DSF but that will be changed in a later release. For this document it will be 
referred to as MDSF but the screen shots will still show DSF. 
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Important: You cannot use the same MDSF stock for more than one mapped stock.  

 

Enter the Media ID from an item that is already registered in MDSF. 

Select Register Stock 

You will get the message that the manual mapping of stock with DSF is saved.  
Once the item is manually mapped the MDSF info screen will look like this . 

Manual Mapping in HTML 

During the Import process there is a column for MDSF Media ID. You can enter the ID number of an existing 
MDSF item in the column and it will be manually mapped during the import. You can only manually map items 

that have not been automatically assigned an ID by the system, those cannot be changed. If the item has already 

been manually mapped and there is an MDSF ID in the field you can change to a different MDSF ID number.  

Note: If you export a csv file from the data base there will be a column named Manually Mapped. That is for 

information only and is not used for an import. You do not have to remove that column it will just be ignored  

during the import. 

 

Import procedure 

Warning A large catalog from a vendor may take some time to import. For example, 15,000 stocks typically 

take about 2 hours to import. Consider doing the import at night.  

1. Make sure you have an import file from a vendor (or have set up an import file yourself). 

2. Select Pricing > Import Stock Catalog. The Import Stock Catalog window opens. 
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3. Select the file to be uploaded or you can drag and drop the rile. 
 

 

Import Settings 

• Select the Verify each stock check box if you want to be asked – for each stock being imported – 

whether you want to create a new stock definition or update an existing stock definition. This can take a long 

time if the import file includes many records. 

• Select the Metric check box to import metric information. This automatically selects the Metric check box 

in the stock definition, too. 

• Select the No Broken Cartons check box to set the Min. Order field in the stock definition to the value of 

the lot count when importing stock. 

Note If you select the No Broken Cartons check box, after the stock import, the Charge Customer for 

Entire Order check box is automatically selected on the Specification and Pricing tab in the Stock 

Definitions window. 

• Select the Full update, not just Prices check box so that all information about existing stock is updated 

when you click Update Prices, not just prices. For example, if the name of the stock changed, it will be 

updated. If this is unchecked, then only the prices are updated. 

 

Adjust Price Brackets By 
• Select Percent if you want to change the bracket price being imported by a percentage or select 

Amount if you want to change it by a fixed dollar amount. Increase the price by entering a positive 

percentage or amount or decrease the price by entering a negative percentage or amount. 
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• Select the check boxes of the price brackets (Price 1 through Price 6) you want to adjust. If you select just 

one bracket, for example, Price 4, the stock cost is placed in the first price column in the stock 

definition. If you select two brackets, for example, Price 1 and Price 3, the bracket for price 3 would also 

be imported into the price 2 column. 

 

Mapping the import file 

After selecting the file to import and the settings for the import select NEXT. This will take you to the Stock 

Catalog Mapping screen. The mapping will automatically be done for any fields in the data base with the same 

name as those in the csv file. Any that do not match will remain in the Drag to Target to map column and will 

need to be manually mapped if they are to be used. 
 

 

Once that is done you will see a sample of the data in the source csv. After mapping the file, you can save it by 

entering the name in the field under Import Rule and then selecting SAVE. You can then use that mapping for 

future uploads. If you have previously saved mapping rules you can select it from the dropdown.  

You can un-map the entire import rule by using the un -map button or you can un-map individual items by 

selecting the X for that target item. Selecting the three lines next to the X and dragging will allow you to move 

that target to a different map location. 

Note The three source items identified with an asterisk * are mandatory and must be mapped in order for the csv 

file to be properly imported. 

Important If you do not map a source item but there is data in that field in the data base the data for that item  

will not be changed. 
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Edit 

Name 

Delete 

Managing the Import Rules 

Selecting Manage will give you a list of the saved mapping rules. 

 
 
 
 
 
 

 
 
 
 
 
 
 

Selecting NEXT will take you to the Stock Catalog Preview. This preview will display all of the mapped columns 

and the data. 
 

 
Selecting Import All will start the importing process. Next you will see the Stock Import Results form. This report 

only displays some of the basic information and not all of the column data.  
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You will be notified when the process is complete. If you have other imports you can select Start Over and you 

will be taken back to the first screen. 

Any changes made in the HTML version can also be seen in the Legacy version. To view the changes in Legacy 

go to Pricing > Stock Definitions. 

 

Export Report 

There is a new report on the HTML side named EFI_Stock Definition Export V1.rpt which includes all the fields. 

You can export the appropriate report, make changes and then use that report to upload your changes. It is 

important that you use the Stock Definition Export V1 report only for updating the HTML version and the EFI 

Stock Definition Export report for the Legacy version. Using the wrong format will corrupt your data.  

 

If the report is not visible in the Custom list : 

1. Go to Reports > Report Manager > Custom. 
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2. Select Add and you will see a list of available custom reports 
 

 
3. Select the report you want. 

4. Click on the Select button and the report will be added to the list.
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Stock Definition 
You manage the information about your stocks and substrates in the Stock Definitions window. To open this 

window, click Stock Definitions in the Quick Access panel (or select Pricing > Stock Definitions.) The Stock 

List window opens first. When you select a specific stock the Stock Definitions window will open.  
 

Stock List Window 

Selecting Stock Definition will take you to the Stock List. The first time you open Stock Definition the column 

headers displayed will be the same as you found in the Legacy version. Those can be found in the Legacy 

version > Preferences > Estimator > Stock Definitions. Those headers checked in that table will be the ones used 

in the HTML version. 
 

 
You can use the Customize List option to make changes in column headers.  

 

In addition, you can enable or disable the status icons, Inventory, Stock Expiry and Price Expiry.  

• Inventory lets you know if the stock that is kept in inventory. This is identified on the Inventory tab for each 

individual stock. There are two colors for this icon. If the Icon is Green, then the available status of 
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the stock is positive and if it is Red then the available quantity is negative. This mean that while the stock is 

an inventory stock there is more stock allocated to jobs than there is stock on hand in inventory. 

 
• Stock Expiry is the date that the stock will expire. It is also identified on the Inventory tab. 

 
• Price Expiry is the date the price for the stock will expire. It is set up on the Pricing tab. 

 

If the icon is grayed out then hovering over it will display a message that it is not applicable for this stock. 
 

 
 

A fourth icon will show when the stock is registered with MDSF.  

 
All of the standard filtering and sorting is available on the stock list. In addition, you also have advanced search.  

You can also use the toggle buttons to view only inventory stock, MDSF Registered or MDSF Non 

Registered stock. 

Create stock will take you to the Stock Definition tabs. You must enter a stock name before saving the new entry.  
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Advanced Search is used to find a list of stocks based on the entered criteria. You can search by size, weight, 

CWT, price, Quantity on hand or Roll width. Enter the information for the range of stocks you want to display and 

then select the Apply & Search button. Select Clear All to start a new search. You can use the check boxes to 

select “Show Shell Account: All” Or Show Special Stocks not on the list. 
 

 

You can also sort by Stock Method using the dropdown. 
 

 

The three-dot ellipsis allows you to Edit Stock, Duplicate Stock, Sync with MDSF or Delete Stock. When you 
duplicate stock the new stock name will be as the original but with the word COPY appended to the end of the 

name. You can save as is or you can edit the new stock and then save.  
 

 
 
 

You can check the box to the left of the ellipsis of multiple stocks if you need to perform the same function on 

multiple stocks. The options available or Sync with MDSF, Unregister with MDSF or Delete Stocks.  
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Note: After sync with MDSF you will need to manually refresh the screen. 

Clicking on the stock name will take you to the stock definition page where you can view and edit the information 

about that stock. 

 

Stock Definition Window 

The Stock Definitions window has general information about the stock and then four standard tabs 

(Specification and Pricing, Pricing, Definition and Inventory). 

Note: If PrintSmith Vision is integrated with the Fiery, a Fiery Paper Catalog tab is available. (For information, 

see the PrintSmith Vision - Fiery Integration Guide.) If PrintSmith Vision is integrated with Market Direct 

StoreFront, a Web tab is available. 

 
 

This shows thee basic information about the stock and this is displayed regardless of the tab you are viewing. 

First enter the general information about the stock: 

1. In the Name field, enter a description of the stock. Limit the name to a description since there are 

separate fields for weight, color, finish, and size. 

2. In the Group field, select a group for the stock, for example, Paper or Envelopes. 

3. Select from the drop down the appropriate Stock Method. 

4. Check the Metric box to use the metric system for measurements. When the Metric check box is 

selected, the M weight and basic seize fields are removed from the stock definition and the thickness 

measurement is changed to microns (one millionth of a meter). 

 
 

Note The items in each drop-down list come from tables in the Legacy version. If you enter something else in 

the field you will get a message asking if you want to add the new value to the table. 
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Specification Tab 

Some of the fields will change depending on if the Metric check box is checked. These changes will be 

discussed for each tab. 

1. In the Stock Definitions window, click the Specification tab. 

2. In the Vendor field, select the vendor of the stock. If you purchase the same stock from multiple 

vendors, create a stock definition for each vendor. (Use Table Editor to maintain your vendors in the 

Vendor table.) 

3. In the Stock # field, enter the part number used to order this stock from the vendor. 

4. In the Class Field use the dropdown to select the appropriate class. 

5. In the Weight field, enter the basic weight of a stock. This field is used to calculate the M Weight and 

Carton Weight of the stock (on the Specification and Pricing tab as described below). If the weight is 

part of the stock name, EFI recommends removing it from the name and entering it only in this field. If you 

are using Metric then this field is labeled GSM and you would enter that information. 

6. In the Stock Type field, select a category of paper from the dropdown, for example, Business Papers or 

Book Papers. In non-metric stocks, this information is critical because it determines the Basic Size that is 

displayed. This size is used to calculate both the M weight and the CWT price. (Stock types are stored in 

the Basic Sizes table. Generally, you should not modify this table unless you are certain of the changes you 

are making. This table already includes all the common stock types and associated sizes.) 

7. For non-metric stock you will see Basic Size. It is not editable but displays the basic size based on the 

stock type selected. This field is not visible for Metric stock. 

8. In the Parent Size field, enter the size of the stock you purchased from the vendor. You can separate 

two numbers by /, for example, 17/28, and this is automatically displayed as 17 x 28. 

9. In the Normal Run Size field, specify the most common run size when you create a job using this stock 

definition. The number of sheets that can be cut out of the selected parent sheet is then automatically 

calculated. If you do not specify a run size, the system assumes it is the same size as the parent size. 

10. In the Color field, enter or select the color of the stock. This should be the full “mill” color. For example, if 

the mill color of white paper is Avon Brilliant, enter that in the Color field rather than just White. If you 

enter a color that is not in the Stock Colors table, you are asked whether you want to add it. (Use Table 

Editor to maintain colors in the Stock Colors table. 

11. If necessary, select a color in the Generic Color field. (For more information about generic colors. 

When you enter or select a color in the Color field, PrintSmith Vision looks for a matching generic color in 

the Stock Colors table. For example, Avon Brilliant has a generic color of White. If PrintSmith Vision does 

not find a generic color, it asks you to select one, and then updates both the Stock Colors table and the 

stock definition with your selection. 
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12. In the Finish field, select a texture such as Linen or Laid. (Use Table Editor to maintain these finishes in 

the Stock Finish table. 

13. In the Grade field, select the brightness of the stock, for example, #1 Coated, #1, #2, #3, and so on. 

(Use Table Editor to maintain grades in the Stock Grade table.) 

14. Enter the Thickness of the stock and select a unit of measurement: Caliper, Points, Mils, Thous, Plies, 

Microns, or Millimeters. Microns and millimeters are used for metric stocks while the other types of units 
are interchangeable and are used for certain types of stocks as follows: 

 

Caliper Caliper is the thickness of a paper measured in thousandths of an inch, 

traditionally applied to most printing papers which are between 0.001 and 0.008 

inch thick. 

Microns A micron is one millionth of a meter and is a unit of thickness for metric stocks.  

Points One point is the equivalent of 0.001 inch, traditionally used to indicate heavy card 

stock such as coated covers. For example, 12 point cover is 0.012 inch thick (12 

points x 0.001inches). 

Thous One thou is equal to 1/1000th of an inch. 

Mils One mil is equal to one thou. 

Plies Plies are traditionally used to indicate the thickness of card or chipboard. A sheet 

of 6-ply board is 0.024 inch thick. (Multiply the ply value by 3 and add 6 to that 

result.) 

Millimeters A millimeter is one thousandth of a meter and is a unit of thickness for metric 

stocks. 

 
M weight is displayed and calculated from the basic size, parent size and weight.  

15. In the Coated field, select None if the stock is not coated and if it is coasted select 1 side or 2 sides. 

 
16. In the Sheets/Carton field, enter the number of sheets of the parent size in a single carton. You can 

also use this field to specify the number of parent sheets in a skid. 

 

17. In the Min. Order field, if stock can be ordered in any quantity, enter 1. If the stock has a minimum 

order, such as a ream that can only be ordered in sets of 500, enter this quantity. For example, enter 500 

for a ream. This ensures that the stock order and job ticket correctly reflect the amount of stock to be 

ordered. In addition, it allows you to pass on to your customer the cost for ordering more stock than 

needed for a job. 

For example, if a job requires 200 sheets and the minimum order for the stock is 250, the customer is 

charged for purchasing 250 sheets. Although the number of sheets purchased is greater than needed for 

the job, the production charges are based on the number of sheets used in the job, not the full quantity 

purchased. 
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18. Select the Charge Customer for Entire Order check box to add the cost of the entire stock order to the 

stock charge for the job. This cost is marked up in the usual manner, but the additional sheets are not 

included in the charge for printing or copying. For example, if the minimum purchase is 250 sheets, the 

stock cost reflects this. 

19. In the Cut/100 field, enter the cut charge for each 100 parent sheets. This charge is added to the stock 

cost and is useful when the vendor charges for cutting parent sheets to the size you entered in the 

Parent Size field on the Specification and Pricing tab. The cut charge includes estimated waste and is 

added to the cost of the stock after the stock is marked up. The cut charge itself is not marked up. 

Tip: For best results, add a pre press cutting charge to the stock definition instead of using the Cut/100 field; 

a charge more effectively calculates the number of cuts and lifts that are needed. 

 

20. In the Min. Cut Chg field, enter a minimum charge for cutting. (Use this in conjunction with the Cut/100 

field.) If no cutting charge is specified, the minimum is added to the stock for all quantities.  

21. In the Forest Management field, select the type of forest management used for this stock: FSC Mixed, FSC 

Pure, Green Seal Certified, or SFI Participant. (These selections are defined in the Stock Forest 

Management table, which you can edit with Table Editor.) 

22. In the PCW Recycled % field, enter the percentage of recycled post consumer waste in the stock. 

23. Select the check boxes for the type of certification the stock has received: FSC Certified, SFI Certified, 

and/or Green Seal Certified. 

Tip: You can set preferences to specify what kind of chain of custody information is included on your job tickets 

 
 

Pricing Tab 

Use the Pricing Options tab in the Stock Definitions window to specify the pricing for the stock when it is used in 

jobs. Some fields on the Pricing Options tab apply to all types of stock; others depend on the type of stock you 

are adding, for example, sheet stock versus roll stock. The procedures that follow explain what different types of 

stock require. 

The pricing tab is the same for Metric and non-metric stocks. 
1. Under Pricing for Blank Sheets, 

a. Blank sheet pricing is used for jobs based on the Blank method. The pricing is automatically calculated 

and is based on the blank stock markup in your Stocks and Sizes preferences and the cost of the stock 

as specified on the Specification and Pricing tab (in the Cost row under Qty. Adjustments). If 

necessary, change these prices and/or the quantities. 

b. Select the Auto Calculate Blank Stock check box to ensure that blank stock pricing is automatically 

updated if costs change. If you do not want prices calculated automatically, clear this check box. 

 

Note EFI recommends that you select the Auto Calculate Blank Stock check box unless you have very specific pricing 
targets for blank stock that do not depend on the stock cost. 

 
2 Under Qty. Adjustments, provide a “price table” for the substrate with costs and markups for various 

quantities: 

 
a. In the Qty. breaks row in the table, enter the maximum quantity of parent sheets for each column in 

the price table. For example, if you enter 1000, 2000, and 3000 in the first three columns, the first 

column is used for the stock cost and markup for quantities up to and including 1000. The second 

column is used for quantities from 1001 to 2000. The third column is used for quantities greater than 

2000. If a column does not include a quantity, the system assumes you are not using that column. 

b. In the Cost row, enter your costs for a particular quantity in the Qty. Breaks row, taking into account 

the costing unit you specified in step 5a. 

c. In the CWT (Hundred Weight Price) row, enter the cost for 100 p ounds of paper regardless of size. 

CWT pricing is a convenient way to compare paper prices for different stocks in different sizes. 

Although there is some variation within a given stock family for different size stocks, the CWT price is 

generally similar. You can enter a cost in either a CWT field or a Cost field, and the other field is 

calculated provided there is sufficient information available in the stock definition to make the 

calculation. (In order to calculate the CWT price, the Basic Size and Weight must be entered and be 

correct. The Basic Size is controlled by the Stock Type you selected.) 

 

d. In the Markup row, enter the amount to mark up the stock above your cost. If the markup in the first 

column is not overridden (overrides are shown in underlined italic), this is the standard stock markup 

defined in your Stocks and Sizes preferences. 

and invoices.  
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e. Normally you do not need to alter the standard stock markup in the first column. Only change it if you 

want a particular stock to be marked up differently from the standard stock markup you specified in 

your Stocks and Sizes preferences. Enter a markup rate in columns 2 through 6 when the markup 

you want to use is different from that in the first column. Leave the markup fields empty across the 

row unless the rates in columns 2 through 6 are different from the first. 

Note: If you change the standard stock markup in your Stocks and Sizes preferences, you will change 

the markup for all stock definitions except those which you overrode. 

f. In the List/M row, enter an additional price per thousand sheets to use with the list job pric ing method 

because list pricing does not factor in the stock cost when generating a price. The amount (plus or 

minus) entered in this field is divided by 1000 and multiplied by the quantity ordered and added to the 

price of the job. For information about jobs based on the list price method. 

For example, a price schedule is used for a stock that costs $10.00 per thousand. You want to use it for 

a stock that costs $11.00 per thousand. If you enter 1.00 in the List/M field, $1.00 is added to each 

thousand ordered. 

3. In the # Sheets/Set field, enter the number of sheets that make up a “set” of the stock. For example, if you 

have a 3-part carbonless stock, enter 3 in this field. The system can then automatically make the correct 

calculations based on the number of sheets in a set. 

4. In the Price Expires field, enter an expiration date for the price if necessary. This information may be 

automatically provided when you import stock prices from a stock vendor. The date tells you whether the 

price shown in the stock definition is valid. If the price has expired, you receive a warning message that 

the price has expired, but you can still use the stock. 

 
Definition Tab 

The definition tab is the same for both metric and non -metric stocks. 

1. In the field Select Press for Printing, select the press you want to use with the stock. If you do not want 

a preset press for the stock, select <use default press>. 
2. When you select a stock for a job, and the stock has a preset press, the press is assigned to the job, 

along with any charges that are part of the press definition. If you select a stock definition without a preset 

press, the default press definition is used for the job.  

Note: PrintSmith Vision is designed so that you can use press definitions to define your production  

environments. If you know a stock is always used in a particular production environment, you can create a  

press definition and preset the press for each stock definition  to which it applies. Envelopes are a good 

example of stock that requires a particular production environment. 

3. Use the dropdown Select Schedule to choose the list price schedule you want to use for the stock. List 

price schedules apply only to jobs based on the List method. You create the schedules using Pricing > List 

Price Schedules.  
 

When a price schedule is assigned to a stock, its name is displayed to the right of the Select Schedule 

button. To remove an assigned schedule, click Select Schedule and then click Clear when the schedule list 

is displayed. 

4. Under Adjust Digital Matrix and Select Default, 

1. In the field to the right of B&W, enter the amount to add to the digital matrix price of the selected 

stock if the Stock Price is field in the Digital Definitions window is set to from Copier 1 in Stock 

Definition. To preset a B&W digital definition for the stock, select it instead of <use default digital>. 

2. In the field to the right of Color, enter the amount to add to the digital matrix price of the selected 

stock if the Stock Price is field in the Digital Definitions window is set to from Copier 2 in Stock 

Definition. To preset a color digital definition for the stock, select it instead of <use default digital>. 

3. In the field to the right of Large Format, enter the amount to add to the square area of the digital 

matrix unit price for the selected stock if the Stock Price is field in the Digital Definitions window is set to 

from Copier 3 in Stock Definition. To preset a large format digital definition for the stock, select it instead 

of <use default digital>. 

Note: When a stock with a preset digital definition is selected for a job, this digital definition is used for 

the job, along with any charges that are attached to the digital definition.  

To remove a preset digital definition, select <use default digital>. 

5. In the Comment field, enter any other notes about the stock. 
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Inventory Tab 

The inventory tab is the same for both metric and not-metric stocks. 

1. Select the Stock is Standard Inventory Item check box to activate the fields on the Inventory tab. 

2. In the Stock on Hand field, enter the amount of stock that is currently in inventory. (For large format 

stock, this is the length, not the total area.) 

3. If some stock is already committed to current jobs, enter the amount in the Committed field. Normally, 

committed stock is automatically calculated. As stock is selected and assigned to a job, the number in the 

Committed field increases. 

Note: Stock that was selected for a job before the stock was defined as a standard inventory item is not 

included in the committed inventory count. 

As the system tracks committed stock, it shows the difference between what is on hand and what is  

committed in the Available field. You cannot edit this field. You can also see inventory act ivity under 

Inventory History. 

4. If you are just starting out, in the On Order field, enter the amount of stock that is currently ordered. After 

that, as you record your orders with PrintSmith Vision with Admin > Order Stock the amount is entered for 

you automatically. 

5. In the Target Level field, enter the amount of stock you always want to keep in inventory. 

6. In the Reorder Point field, enter the “trigger-point” at which new stock should be ordered. 

7. In the Min. Order Qty. field, enter the minimum amount that can be ordered at one time. If the amount that is 

ordered should always be in even quantities, select the Even increments, like ream size check box. 

8. In the Stock Expires field, enter the expiration date of the stock, i f applicable. When the field is blank, the 

stock never expires. 

9. If applicable, in the Bin Location field, enter an identifier for the place where the stock is stored. 
10. If the stock is a shell item (for example, business card masters that are imprinted at a later date), select the 

Shell Item check box. 

11. If the stock is for a specific customer, click Assign Customer Account and select an account. 
 

Defining rigid substrates on the Specification and Pricing tab 

In addition to completing the fields on the Specification and Pricing tab described previously, for rigid 

substrates do the following: 

1. In the Stock Type field, select a category of substrate, typically, Business Papers. 

2. In the Parent Size field, enter the size of the substrate you purchased from the vendor. You can separate two numbers by /, 
for example, 48/96, and this is automatically displayed as 48 x 96. 

3. In the Min. Order (area) field, if the substrate can be ordered in any size, enter 1. Otherwise, enter the minimum size in 
square units that you will sell at one time, for example, 864 for a 24 x 36 sheet. 

4. Under Qty. Adjustments, provide a “price table” for the substrate with costs and markups for various quantities:  

a. In the Costing Units field, enter the square area by which you are costing, for example, 864 inches 

for a substrate that is 24 inches by 36 inches. 

b. In the Qty. Breaks row in the table, enter the maximum amounts for costing and markup purposes. 

For example, if you enter 1000, 2000, and 3000 in the first three columns, the first column is used for the 

stock cost and markup for quantities up to and including 1000. The second column is used for quantities 

from 1001 to 2000. The third column is used for quantities greater than 2000. If a column does not 

include a quantity, the system assumes you are not using that column. 

c. In the Cost row, enter your costs for a particular quantity in the Qty. Breaks row, taking into 

account the costing unit you specified in step 3a. 

d. In the Markup row, enter the amount to mark up the substrate above your cost. 

e. In the Price Expires field, enter an expiration date. 
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Defining roll stock on the Specification and Pricing tab 

In addition to completing the fields on the Specification and Pricing tab described previously, for roll stock do 

the following: 

1. In the Roll Width field, enter the width of the entire roll you purchased from the vendor. 

2. In the Roll Weight field, enter the weight of an entire roll. After you enter the minimum weight of a roll you 

will sell in the Min. Order (weight) field, PrintSmith Vision calculates the minimum number of rolls this 

represents and displays it in the Rolls/Order field. 

3. In the Min. Order (weight) field, if stock can be ordered in any quantity, enter 1. Otherwise, enter the 

minimum weight of the roll stock that you will sell at one time. 

4. Under Qty. Adjustments, provide a “price table” for the roll stock with costs and markups for various 

quantities: 

a. In the Costing Units field, enter the weight by which the roll stock is priced, for example, 100 

pounds. 

b. In the Weight Breaks row in the table, enter maximum weights for costing and markup purposes. 

PrintSmith Vision uses this information for the stock cost and markup for weights up to and including 

the weight you specify in each column. 

c. In the Cost row, enter your costs for a particular quantity in the Weight Breaks row taking into 

account the costing unit you specified in step 4a. 

d. In the CWT (Hundred Weight Price) row, enter the cost for 100 pounds of paper regardless of 

size. When you enter a cost in a CWT field, the corresponding Cost field is calculated for 

you provided there is sufficient information available in the stock definition to make the 

calculation. (In order to calculate the CWT price, the Basic Size and Weight must be entered 

and be correct. The Basic Size is controlled by the Stock Type you selected.)  

e. In the Markup row, enter the amount to mark up the stock above your cost. as described 

previously. 

f. In the Price Expires field, enter an expiration date as described previously. 

 

Defining large format stock on the Specification and Pricing tab 

In addition to completing the fields on the Specification and Pricing tab described previously. 
1. In the Roll Width field, enter the width of the entire roll you purchased from the vendor. 
2. In the Min. Order (length) field, if the stock can be ordered in any length, enter 1. Otherwise, enter the minimum 

length of the stock that you will sell. 
3. Under Qty. Adjustments, provide a “price table” for the stock with costs and markups for vario us quantities: 

a. In the Costing Units field, enter the square area by which the stock is priced, for example, 144 

inches. 
b. In the Area Breaks row of the table, enter the maximum areas of the large format stock for costing and 

markup purposes. PrintSmith Vision uses this information for the stock cost and markup for areas up to and 
including the area you specify in each column. 

c. In the Cost row, enter your costs for a particular area in the Area Breaks row, taking into account the costing 
unit you specified in step 3a. 

d. In the Markup row, enter the amount to mark up the stock above your cost. as described previously. 

e. In the Price Expires field, enter an expiration date as described previously.



218  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

Remove 

Mapping from 

all devices 

Remove 

mapping from 

this device 

View all 

mapped 

items 

 

 
 

Fiery Paper Catalog Tab 

The Fiery Paper Catalog tab is the same for both metric and non-metric stocks. 

In addition to the automatic media mapping that the system performs when you add a Fiery device, individual 

stocks in PrintSmith can be mapped to a media in the paper catalog on a particular Fiery device. If you have 

multiple Fiery devices, you can quickly map the same stock to more than one Fiery. 

1. Click Stock Definitions in the Quick Access panel (or select Pricing > Stock Definitions). 

2. In the Stock List window, select the stock you want to map to media in a Fiery catalog. 

3. Click the Fiery Paper Catalog tab. 

 
 
 
 
 
 
 
 
 

 

 

4. From the dropdown select the Fiery Device on which you plan to use this stock. (This is the physical 

equipment itself as defined in the Production Copiers table in PrintSmith Vis ion. 

5. Under Paper Catalog, select the media to which you want to map the PrintSmith Vision stock by 

clicking on the radio button. 

The stock name will show next to the Fiery Device and you can also hover over the mapped item area and 

the mapped stock will be displayed. 

Note: You can use all of the column headers to filter the list of displayed items.  
6. If you have multiple Fiery devices, repeat steps 5 and 6 to map the current stock definition to a stock in the 

paper catalog on a different Fiery device. (You can have different mappings on different devices.) 

7. Click Save on the toolbar of the Stock Definitions window. 

 
To remove the mapping from the selected Fiery device use the remove mapping button to the left of the 

fiery device that also shows the mapped material.  

If you have mapped to multiple Fiery devices and want to remove the mapping from all of the devices use 

the Remove All Mapping button on the right of the screen. 

Tip: Always click Synchronize Media after you make a change in PrintSmith Vision that may affect 
mapping. 

 

The Show All button on the right of the screen is turned off by default. When it is off only unmapped stocks will 

be displayed. If you slide it on then all stocks for that device will be displayed, mapped, and unmapped. 
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Note: Market Direct StoreFront comes with some pre-defined media. Typically, you should delete the media 

before registering the stocks from PrintSmith Vision so the only media in Market Direct StoreFront are 

mapped to stocks in PrintSmith Vision. 

 

Web Tab 

Register Stocks in Market Direct StoreFront 

You can fully control the stocks that are available to buyers when they are placing or ders in Market Direct 

StoreFront. You should always define stocks in PrintSmith Vision and send information about them to Market 

Direct StoreFront. As with accounts and contacts, this process is known as registering stocks. In Market Direct 

StoreFront, stocks are known as media. 

The registered stocks must then be priced in Market Direct StoreFront – which always controls the pricing. (You 
should still price stocks in PrintSmith for non-Market Direct StoreFront orders, but this pricing is ignored for 
Market Direct StoreFront orders.) 

With the exception of pricing, information about stocks is always controlled from PrintSmith Vision – the 

information is sent from PrintSmith Vision to Market Direct StoreFront. Information about stocks (known as media 

in Market Direct StoreFront) is never sent from Market Direct StoreFront to PrintSmith Vision. For example, if you  

create media in Market Direct StoreFront, no corresponding stock is created in PrintSmith Vision. Likewise, if you 

update media in Market Direct StoreFront, the corresponding stock definition is not updated in PrintSmith Vision. 

As a result, avoid creating or updating media in Market Direct StoreFront. 

When stocks are registered, PrintSmith Vision sends the name, size, and color of the stock to Market Di rect 

StoreFront. 

When a Market Direct StoreFront order comes into PrintSmith Vision and includes a registered stock, the stock is 

“recognized.” For example, costing information is available. In addition, with the exception of stock for special 

pages, if the stock is inventoried, inventory is adjusted 

 
You can register (send) stocks in two ways:  

• Register multiple stocks at the same time.  

• Register stocks individually. 
 

 

Method 1: Register multiple stocks at a time 

You can register multiple stocks at a time from the Stock List window. 

1. In PrintSmith Vision, click Stock Definitions in the Quick Access panel (or select Pricing > Stock 

Definitions). 

2. Select the check boxes of the stocks you want to register. 

3. If you select a stock with a needed missing detail you will get an error message. Edit the stock to 

include the missing information. (You cannot register the stock without this.) 

Important:  For stock to be registered in Market Direct StoreFront, the stock definition must include a 

Thickness (on the Specification and Pricing tab) and a Normal Run Size (on the Pricing tab) in 

the Stock Definitions window. 
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Hovering the mouse over the orange exclamation point will show you the information that is missing  and 

required. 

Note: When you are using Metric stock and enter the weight in the Specification tab you enter it as gsm and 

the weight will be shown as gsm in the Web tab. But if you are not using Metric you enter weight in the 

Specification tab as pounds but it will not display as pounds in the Web tab. You have to manually enter the 

weight for non- metric stock on the Web tab. That field accepts both gsm and pounds. 

4. Click Sync with MDSF. 

 
 
 
 
 
 
 

5. A message informs you that registration has started. 

A New icon will also indicate that the registration is in process.  
 

After the stocks are registered, a green check mark is displayed in the MDSF column in the Stock List 

window. 

The Registered icon will be displayed when the registration is complete.  

6. In Market Direct StoreFront, the stocks are now listed in the Media Catalog. Price the media in Market 

Direct StoreFront and add it to ticket templates. 

 

Note: Very occasionally a stock may not be registered (perhaps due to a network issue). For information 

about resetting the item so you can re-send it, see “Error! Reference source not found.” on page 

Error! Bookmark not defined. 
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Note: Very occasionally a stock may not be registered (perhaps due to a network issue). For information 

about resetting the item so you can re-send it, see “Error! Reference source not found.” on page 

Error! Bookmark not defined. 

 

 
 

Method 2: Register one stock at a time 

You can also register stocks as media in Market Direct StoreFront one at a time from the Stock List or the Stock 

Definitions window. 

 

From the Stock Definition Window 

 
1. In PrintSmith Vision, click Stock Definitions in the Quick Access panel (or select Pricing > 

Stock Definitions). 

2. In the Stock List window, find and select the stock you want to register in Market Direct StoreFront, and 

click that stock. The stock definition window for that stock will open. 

3. In the Stock Definitions window, click the Web tab. 

4. Under MDSF Info, click Register Stock. 

 

5. A message informs you that registration has started. Click OK. 

After the stock is registered, the Last Registration Date is updated and the Register Stock button 

changes to Update Stock. 

 

In addition, the Registered stock icon will be displayed next to the Stock List window.  

6. In Market Direct StoreFront, the stock is now listed in the media catalog. Price the media in Market 

Direct StoreFront and add it to ticket templates. See below. 
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Important:  With the exception of pricing, never edit mapped media in Market Direct StoreFront because that 

information is not sent to PrintSmith Vision. Stocks must always be managed from PrintSmith 

Vision. 

 

 

From the Stock List select Sync with MDSF 
 

The rest of the process follows the same as in the Stock Definition window.  

 

 
Price media and add to ticket templates 

After you register stocks as media in Market Direct StoreFront, they are listed in the Market Direct St oreFront 

media catalog. (PrintSmith Vision sends the name of the stock, its size, and its color to Market Direct 

StoreFront.) 

 

 

You must now price the media in Market Direct StoreFront and add media to ticket templates.  

The price you set for the media is what buyers pay, and this price overrides the price of the associated stock 

defined in PrintSmith Vision. 

In Market Direct StoreFront, the recommended way to price media is by editing a price sheet (although you can 

price media individually). Go to Administration > Pricing, open a price sheet, select Media in the View By 

field, and then edit a group of related media to add prices. For information about price sheets in Market Direct 

StoreFront, see the online Help in Market Direct StoreFront when on the Administration tab. 

Tip:  Click to open Help in Market Direct StoreFront.  

After your media is priced, you can add selected media to your ticket templates. When a ticket template is 

associated with a product in Market Direct StoreFront, buyers ordering that product will be able to choose the 

media specified in the ticket template. For information about creating ticket templates and products, see the 

online Help in Market Direct StoreFront when on the Administration tab. 

 

Updating stocks 

If you change some information about a stock in PrintSmith Vision, you can update the corresponding media in 

Market Direct StoreFront. 

1. After you make changes to a stock in PrintSmith Vision, click the Web tab in the Stock Definitions 

window. 

2. Under MDSF Info, click Update Stock. 

Note: If you did not delete the pre-supplied media in Market Direct StoreFront, you can recognize your 

registered stocks in the Market Direct StoreFront media catalog by their ID – they will all have an ID 

numbered in the hundred thousands, for example, 100009 or 100014. 



Generating Statements |  225
5 

 

 

Important: Never delete a mapped media in Market Direct StoreFront (one that you registered from PrintSmith 

Vision) because that information is not sent to PrintSmith Vision. Media (meaning stocks) must 

always be unregistered in PrintSmith Vision so they are deleted in Market Direct StoreFront. 

 

Unregistering stocks 

If you want to delete a particular media in Market Direct StoreFront, you must unregister the stock definition in 

PrintSmith Vision. The stock definition will still exist in PrintSmith Vis ion, but the cor responding media will be 

deleted in Market Direct StoreFront. 

When you unregister stock, it is no longer available as a selection to buyers placing orders in Market Direct 

StoreFront. 

You can unregister stocks either from the Stock List window or the Stock Definitions window. 

 

To unregister stocks from the Stock List window 

1. In PrintSmith Vision, click Stock Definitions in the Quick Access panel. 

2. In the Stock List window, select the check boxes of registered stocks (ones with green icon next to the 

stock. 

3. Click Unregister Stock from MDSF. 
 

 
 

To unregister a stock from the Stock Definitions window 

1. In PrintSmith Vision, click Stock Definitions in the Quick Access panel. 

2. From the Stock List window, open the registered stock definition you want to unregister. (These stock 

definitions have a green icon next to the stock). 

3. In the Stock Definitions window, click the Web tab. 

4. Under MDSF Info, click Unregister Stock. 
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Generating Statements 
 

Statements are optional but are an extremely important part of Accounts Receivable. You can review the status 

of accounts by aging them and apply finance charges as necessary. Typically, you generate statements at 

regular intervals (such as monthly) so that you can let customers know of their outstandi ng balances. 

You can either print or e-mail statements. For information about e-mailing statements. 

Tip: If you want to add your logo to printed or e-mailed statements (or make other minor formatting changes).  

You can print statements in two currencies if the Use alternate currency system preference is selected (Admin 

> Preferences > System > Alternate Currency). 

If you want to include accounts with zero balance use the slide to do that.  
 

 

General procedure for generating statements 

1. Select AR > Accounting > Account Utility > Generate Statements . The Generate Statements window 

opens. The top and bottom of this window include general information. Tabs in the window let you control 

what the statements include. 

Note: If you are printing statements instead of e-mailing them, the E-Mail button at the bottom of the window 

changes to Print. (You can control whether statements are printed or e-mailed on the Reports tab.) 
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2. Complete the general information at the top of the window: 

a. The Closing Date field defaults to the current date; this is the date shown on the statement. PrintSmith 
Vision ignores all open debit items with posting dates after the closing date. Open credit items after the 
closing date are also not included on the statement but are considered in the calculation of the aging 
status and finance charges since these are based on account balance. If necessary, enter a different 
date. 

b. The Payment Date field shows the due date of the payment. If necessary, change the date or remove 
it so the date is not included on the statement. 

c. Select the Calculate Finance Charge check box if you want PrintSmith Vision to calculate finance 
charges. (Then make some further choices on the Accounting tab about how you want the charges 
calculated; see “Completing the Accounting tab for statements”.) 

Notes: PrintSmith Vision determines the rate used for the finance charge by first looking at the customer  

account. If Never calculate finance charges is selected (on the Credit Control tab in the Customer 

window), no finance charge is calculated for the account. If the account has a special finance rate defined, 

the rate from the account is used. Otherwise, the system default rate is used from your PrintSmith 

preferences (Admin > Preferences > Accounting > Credit/Defaults). When you generate a master 

billing statement, sub-account settings for finance charges are ignored; only the master account settings 

are considered. 

When finance charges are posted, an entry is made on the register tape. If you discover an account was 

charged a finance charge in error, void the transaction before doing a closeout.  

d. If you selected the Calculate Finance Charge check box at the top of the General Statements 

window, select or clear any of the following check boxes to further refine how the finance charge is 

calculated: 

• Only apply to items past due 

Select this check box so that only past due items are subject to finance charges. If the check box is 

cleared, all open debits are subject to finance charges. 

• Apply outstanding credits 

Select this check box so that any outstanding credits are subtracted before a finance charge is 

calculated. The credits are applied based on aging. Suppose that today you post a payment for $100 

dollars without applying it to a debit and generate statements. If the delinquent agin g total is $50 and 

the past due amount is $25, the credit is applied to the delinquent amount reducing it to 0. The 

remaining credit amount of $50 is then applied to the past due amount also reducing it to 0. The end 

result is a proposed account status of Current. If, however, the Apply outstanding credits check box 

is cleared, the account in this example would have a proposed status of Delinquent because the 

outstanding credit would not have been used to adjust the old debit. Normally, you would leave the 

Apply outstanding credits check box selected. 

• Calculate only once per month 

Select this check box so that PrintSmith Vision checks when the last finance charge was posted to the 

account and only generates a finance charge if the statement date is in a different calendar month. 

Notes: A month in this context is a calendar month, not an elapsed month, and the closing date, not the 

current date, is used to determine the calendar month. 

The date a sub-account last had finance charges posted is ignored when you generate a master 

billing statement. 

 
e. Select accounts for statements in one of these ways: 

• To generate statements for all your accounts, select All. Every account is then processed. 

• To generate statements for a range of accounts, enter the text with which you want to begin to select 
accounts in the From field and the text with which you want to end in the To field. For example, if you 
enter a in the From field and az in the To field, statements are printed starting with the first account 
whose name starts with a through the last account whose name starts with az. If you leave the From 
field blank, the statements start with the first account. If you leave the To field blank, statements stop 
with the last account. If you leave both To and From blank, this is the same as selecting All. 
 

• To generate statements for selected accounts, click Selected Accounts. After you click Print, Preview, or 
E-Mail you can then select the accounts you want from the Account Picker window. 
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f. Click the Output tab to further refine the criteria for selecting accounts and control what is included on 

the statements. For information, see below. 

g. Click the Accounting tab to define how aging is performed, what to do about changing the 

customer account status as a result of aging, and how to handle finance charges.  

h. Click the Addressing tab to determine the format of the address and the information that is included 

on the statement besides the accounting information. 

i. Click the Reports tab to control whether a statement summary report is printed, control the detail it 

includes, and indicate whether you want to save the report for future reference.  

j. Click the Form Layout tab to control how your printed or e-mailed statements look.  

k. In the Message to print on each statement field, enter a message (such as a seasonal or 
marketing message) that you want to include on all printed statements. You must enter a 
message each time you run statements as this text is not saved. 

 Note: If you are using preprinted forms, put them in the printer before step 9.  

l. If you want to print or e-mail the statements without previewing them, click Print or E-Mail at the bottom 

of the Generate Statements window. (Printing versus e-mailing is controlled on the Reports tab.) 

Otherwise, click Preview to review the statements and decide whether you want to generate them.  

Note: If you chose Selected Accounts, the Account Picker window opens after you click Preview, 

Print, or E- Mail. You can select several accounts at once (using SHIFT or CTRL). The Account Picker 

window will keep opening until you click Cancel in that window. 

m. If you chose to have a summary report printed, you are warned to change the paper in the printer to 

plain paper. Click OK to print the report or Cancel to continue without printing. 

 

Completing the Output tab for statements 

Use the Output tab in the Generate Statements window to control which accounts are selected for statements 

and what is included on the statements. 

 
1. If you have master accounts in your system: 
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a. Select the Create master billing statements check box to generate a consolidated statement that 

includes the statement items for the master account as well as a breakdown of items for all its sub-accounts. 

b. If you selected the Create master billing statements check box, select one of the following: 

• Only master billing accounts to ignore all accounts except those that are used for master billing. This 

is useful if you do not normally generate statements at all, but you have master billing accounts and 

want to send statements only to those accounts. 

• Skip sub-accounts so that sub-accounts do not also receive a statement. (This is what you would 

typically select when creating statements for master billing accounts.) 

• Additional sub-accounts to generate statements for sub-accounts as well as master accounts. Use 

this only if you want to send “informational” statements to sub-accounts, and the recipients understand 

their purpose. If a sub-account is specifically marked not to have statements generated (on the 

Settings tab in the Customer window), no statement is generated for the account even if Additional 

sub-accounts is selected. 

2. Select the Skip accounts with current status check box to send statements only to those customers with 

balances due (as aged from the posting date). 

Note: When you age from the posting date, the account status is determined by the posting date of the 

oldest open item. 

3. Select the Skip accounts with current balance check box to send statements only to those customers with 

past due balances as aged from the date of the last payment. When you age from the last payment date, 

an account may have open items that are several years old and still be current if a payment was recently 

sent. 

4. Select or clear the following check boxes: 

Show new payments 

Select this check box to include all payments made since the last statement as well as all open items.  

Show aging amounts 

Select this check box to include an aging summary on the statement that shows the totals for each of the four 

aging categories (for example, current, 30 days, 60 days, or 90 days).  

Show aging titles 

Clear this check box if you use pre-printed forms with pre-printed aging category titles. The only advantage to 

printing the titles is that if you change aging periods (for example, change 30 days to 45 days), these changes 

are reflected in the aging titles. 

Show reminders 

Select this check box to include predefined reminder notices on the statement. You control the text of these 

reminders with preferences (Admin > Preferences > Accounting > Aging Periods ). 

Show customer statement notes 

Select this check box to include the statement note defined for the customer account on t he statement. You enter 

this text on the Notes tab in the Customer window). 

 

Completing the Accounting tab for statements 

Use the Accounting tab in the Generate Statements window to define how aging is performed, what to do about 

changing the customer account status as a result of aging, and how to handle finance charges.  

Note: The finance charge rate for the whole system is set in your preferences (Admin > Preferences > 

Accounting > Credit/Defaults). You can override this rate for individual accounts on the Credit Control tab in 

the Customer window. 

The purpose of account aging is to determine the status of the account and warn you of accounts that may need 

collection action. An accurate gauge of the state of your AR is essential to running a healthy business.  
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When PrintSmith Vision ages an account, it looks at all of the open debits (money owed to you) as well as all 

open credits (money you owe to the customer or did not yet apply to a debit) to determine how long the customer 

has owed you money and when you last received a payment from the customer. Based on this information, 

PrintSmith Vision adjusts the account status according to the rules that you set in this window and with your aging 

period preferences (Admin > Preferences > Accounting > Aging Periods). 

 

1. Select one of the following to control whether the account status is changed: 

• Always change account status so the account status is automatically changed based on your aging 

rules. 

• Ask before changing status so you can review the aging totals, the old status, and the proposed 

status in a summary window and decide if you want to update the account status. 

• Never change account status so the account status remains unchanged. 

2. Select one of the following to determine which date is used for the account status: 

• Status from Posting Date so the date of the oldest open debit is used to determine the proposed 

account status. 

• Status from Payment Date so the date of the last payment received is used to determine the proposed 

account status. This also affects the aging report because a partial payment on an open item ages that 

item based on the payment date. 

3. Select or clear the following check boxes: 

Freeze after 90 days 

Normally, the proposed account status is Current, Past Due, or Delinquent. Select this check box to freeze the 

account status if there are open items older than the oldest aging period (by default this is 90 days). When an 

account is frozen, you can only post payments to the account (AR > Post Payments) – no further work can be 

accepted for the account. 

Unfreeze after 90 days 

Select this check box so the status of a frozen account is automatically changed after 90 days if payment is 

made. (You can also change this status manually on the Credit Control tab in the Customer window.) 

Mark inactive accounts 

Select this check box to identify inactive accounts. An account is considered inactive if nothing was posted to the 

account for the inactive period specified in your preferences (Admin > Preferences > Accounting > 

Credit/Defaults). When you see which accounts are inactive, you may want to contact the customers and find out 

the reason for the inactivity. 

Inactive account to prospect 

Select this check box to reclassify inactive customer accounts as prospect accounts. When this check box is 
selected, and you generate statements or perform an account aging, all inactive accounts are converted to 

prospect accounts. 

Caution: Use this feature with care. You cannot easily reverse changes to account classification. Also, this 

feature does not consider how long a customer has been inactive; it changes all inactive customers to prospects . 
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Completing the Addressing tab for statements 

Use the Addressing tab in the Generate Statements window to determine the address and related information 

that are included on the statement besides the accounting information.  

 

1. Either select Use Statement address to use an account’s statement address on the statement or select 

Use Invoice Address to use an account’s invoice address. 

Important: If you are e-mailing statements, this selection determines whether the e-mail address for the 

statement contact or for the invoice contact is used. Make sure your accounts include e -mail addresses for 

the statement and invoice contacts. 

2. Select or clear the following check boxes: 

Show account number 

Select this check box to include the customer account number on the statement. On statements that use payment 

stubs at the top or bottom, the account number is placed in the billing summary section. The size of this section is 

adjusted as necessary. If the reference number is also included, it is comb ined with the customer account number 

in the same block. 

Show reference number 

Select this check box to include the customer’s external reference number on the statement. On statements that 

use payment stubs at the top or bottom, the number is placed in the billing summary section. The size of this 

section is adjusted as necessary. If the account number is also displayed, it is combined with the reference 

number in the same block. 

Show sales representative 

Select this check box to add the name of the sales representative to the statement. On statement forms using 

payment stubs at the top or bottom, the name is placed in the  billing summary section. The size of this section is 

adjusted as necessary. 

3. In the Attention is field, indicate where you want the “Attn” line printed on statements: on top or on bottom 

of the address block, or not shown. 

4. In the Postal bar code is field, indicate where you want the bar code printed on statements: on top or 

on bottom of the address block, or not shown. 

 

Completing the Reports tab for statements 

Use the Reports tab in the Generate Statements window to control whether statements are printed o r e-mailed, 

as well as whether a statement summary report is printed. At a minimum, this report includes the name and  aging 

totals for each account for which a statement was generated, but you can control the detail it includes. You can 

also save the report for future reference. (You can only reprint a report if you save it.)  



232  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

 

 
 

1. Select either Print Statement or E-Mail Statement. Depending on your selection, the button at the bottom 

of the window will be Print or E-Mail. 

Note: If you are e-mailing statements, your accounts must include e-mail addresses for the invoice or 

statement contacts (depending whether you selected Use Statement Address or Use Invoice Address on 

the Addressing tab in the Generate Statements window). 

2. Enter the Email “from Address” 

3. Select the Print summary report check box to generate the summary report after statements are 

generated. (If printing statements, PrintSmith Vision waits for statements to finish printing so you can insert 
plain paper into the printer.) 

4. If the Print summary report check box is selected, select or clear the following check boxes: 

Detailed report 

Select this check box to include the details of each open item in the report.  

Alternate lines in aging columns 

If the amounts in a statement are very large some of the amounts may creep into adjoining columns and 

make the report unreadable. Select this check box to print every other amount on alternate lines. 

(Alternate lines can make the report much longer.)  

Add collection information 

Select this check box to include the sales representative, contact name, phone number, last payment 

date, and amount in the report. This information makes the report more valuable as a collection tool.  

5. The statement summary report is not saved automatically. To save the report so you can reprint it later, 

select the Save report check box. 

 

Completing the Form Layout tab for statements 

Use the Form Layout tab in the Generate Statements window to control how your printed or e-mailed 

statements look. You can either use a pre-printed form or have PrintSmith Vision generate a form for you. If you 

want to add a logo to your printed or e-mailed statements, see “Customizing your statements” below.  

Note: Printed and e-mailed statements must be customized separately. 



232  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

 

 
 

• Select one of the following: 

• Use pre-printed form if you use pre-printed statement forms. EFI generally recommends that you pre- 

print your statement forms for the best presentation and fastest printing. 

• Generate detailed form if you want PrintSmith Vision to generate the statement form. 

• Generate basic form if you want PrintSmith Vision to generate a stripped -down version of the form. 

This form may be more suitable for some low-resolution printers. It can also be useful for filling out a 

pre-printed shell. 

• Select one of the following: 

• Standard format for a letter format, which may be suitable for printing on your standard letterhead. 

• Remittance advice on right for a format similar to the standard format except that it includes a tear-off 

remittance area on the right side of the form. (This compresses the line-item information.) 

• Payment stub on top for a form that includes a tear-off payment stub at the top that is designed to be 

placed (along with the check) in a remittance envelope with a window. 

• Payment stub on bottom for a form that includes a tear-off payment stub at the bottom that is 

designed to be placed (along with the check) in a remittance envelope wi th a window. 

 

Customizing your statements 

You may want to customize your statements by including a logo  or making other formatting changes. Printed 

statements and e-mailed statements must be customized separately, although the general procedure is identical:  

• Download one of the EFI-supplied statements (in the form of an .rpt file). Separate .rpt files are 

available for printed versus e-mailed statements. 

Important: Because printed and e-mailed statements are based on different report (.rpt) files supplied by 

EFI, you must customize them separately. For example, you cannot customize the report file for printe d 

statements and use it for e-mailed statements. 

• Use i-net Designer to edit a copy of the statement report you downloaded (for example, add your logo). 

Note: In customer-hosted installations, i-net Designer must already be installed as described in the 

PrintSmith Vision - Installation and Upgrade Guide. In EFI-hosted installations, i-net Designer and other 

required components must already be installed and configured as described in the PrintSmith Vision - EFI-

Hosted Guide. 

• Override the EFI-supplied statement with your own version. 
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Details of these procedures follow. 

Download an EFI statement report file 

PrintSmith Vision includes four different .rpt files for printed statements and four for e -mailed statements. These 

correspond to different combinations of options on the Format Layout tab in the Generate Statements window. 

The names of the reports that corresponds to the options you select are displayed in the Associated Report and 

Associated E-Mail Report fields. For example, for printed statements, if you select Use pre-printed form and 

Standard Format, EFI_Statement.rpt is displayed in the Associated Report field. For e-mailed statements, 

EFI_StatementEmail.rpt is displayed in the Associated E-Mail Report field. 

Notes If you already customized printed statements, and now want to e-mail statements, you must download 

EFI_StatementEmail.rpt and customize it. You cannot use the report you customized for printed statements.  

In customer-hosted installations of PrintSmith Vision, both the standard and custom statement report files are 

saved in a repository folder on the PrintSmith Vision server. For Windows this is C:\Program Files 

(x86)\EFI\PrintSmith\PrintSmith Reports\Crystalclear Reports 12.1\reportRepository and for Macintosh this 

is Applications/EFI/PrintSmith/PrintSmith Reports/Crystalclear Reports 12.1\reportRepository. 

1. In PrintSmith, select AR > Generate Statements. 

2. Click the Form Layout tab. 

3. Select the form layout options you want in your statements. 

4. Click Download below the Associated Report field or Associated E-Mail Report field. The report 

identified in the Associated Report or Associated E-Mail Report field is placed in your default Downloads 

folder. 

Tip: The location of the Downloads folder is specified in your browser settings. For example, in Chrom e, it is 

one of the advanced settings; in Firefox it is one of the general options.  

 

Customize the statement report with i-net Designer 

1. Start i-net Designer from the shortcut on the desktop (Windows) or from the dock (Macintosh). 

2. Select File > Open, navigate to your Downloads folder and select the statement .rpt file that you 

downloaded (for example, EFI_Statement.rpt). 

3. Select File > Save As and enter a name for the report. (This cannot begin with EFI_.) 

Tip: To identify your report more easily, consider using a prefix (such as the initials of your company 

name) in the report name, for example, AT_Statement.rpt. 

4. Use the red descriptive text to identify the section of the statement that you need to modify. (This text is not 

printed on the statements.) For example, in the figure below, you can see that the Page Header –c section 

is what you need to modify if you are using standard remittance. 

5. Add your logo to the statement: 

a. If necessary, move some fields around (see step 6) to make room for the logo. 

b. Click on the toolbar (or select Insert > Image) and browse to your logo. 

c. Position the logo where you want it. 
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6. If you want to move fields around either to make room for the logo or to display information in a different 

order, click and drag a field. To move two (or more) fields at the same time, click one field, press and hold 

CTRL, and click the second field. Then drag from the center of one of the fields – the other field will follow so 

they are lined up. 

7. To change the font, point size, or justification of a field, select the text you want to change and make your 

 change using the toolbar. 

8. After you finish making changes, click Save on the toolbar (or select File > Save). 

You must now override the EFI-supplied statement with your customized version. 

Override the EFI statement with your customized version 

1. In PrintSmith, select Accounting > Accounts Receivable > Account Utility > Generate Statements. 

2. Click the Form Layout tab. 

3. Click Override 
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4. Locate the statement report you just customized. 

Note: You cannot use the same customized report for printed and e-mailed statements. The report you 

upload must be based on the appropriate report supplied by EFI (for example, EFI_Statement.rpt or  

EFI_StatementEmail.rpt). 

5. Click Yes to confirm the override. 

Tip If you change your mind about the report you selected, click Remove below the Associated Report field 

or Associated E-Mail Report field. The Associated Report or Associated E-Mail Report will revert back 

to the original EFI statement report file, for example, EFI_Statement.rpt . You can then repeat steps 1 to 5 

above to override this with another custom statement.  

When you next generate statements, they will be included your customizations. 

 

Previewing statements 

After you define the settings for your statements in the General Statements window you can preview the 

statements and decide whether you want to print or e-mail them. 

1. In the Generate Statements window, click Preview. 

After you click Preview, each account (that meets the criteria you specified) opens in a window so you can 

decide how to handle the statement for the account. 

Note: If you chose Selected Accounts, the Account Picker window opens after you click Preview. You can 

select all the accounts for which you want to generate statements (by using SHIFT or CTRL  to select 

accounts). 

2. If a finance charge was calculated, it is displayed below the status information as well as in the item list (in 

red). To eliminate the finance charge from the statement, click Remove Finance Charge. After you 

remove a finance charge, the button changes to Restore Finance Charge so you can restore the 

finance charge if necessary. (Finance charges are not posted until you click Print or Print Remaining.) 

3. Click one of the following: 

• Print Remaining or E-Mail Remaining to print or e-mail the rest of the statements without continuing to 

review them one by one. If printing, the statements will open in a preview window from which you can 

print them. If e-mailing, the statements are sent automatically. 

• Print or E-Mail to accept the statement. After you finish reviewing the remaining statements, the printed 

statements will open in a preview window from which you can print them. E-mailed statements are sent 

automatically. 

• Skip to not generate a statement for the account and continue to the next account. 

• Stop to stop reviewing statements for any other accounts, stop generating statements, and open a print 

preview window for those statements that you already accepted (by clicking Print). 

 

Note: If you chose Selected Accounts, the Account Picker window will keep opening until you click Cancel 

in that window. 
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E-mailing statements 

For statements to be e-mailed, e-mail must be configured in PrintSmith Vision Legacy. In the legacy version go 

to Preferences > System > E-mail and check the appropriate boxes. As part of this configuration, be sure to 

define the e-mail body on the Statement tab in the E-Mail preferences. 

In addition, make sure all your accounts have e-mail addresses specified for the invoice and statement contacts. 

To e-mail statements 

1. Select Accounting > Accounts Receivable > Account Utility > Generate  Statements. 

2. Click the Addressing tab and select Use Statement address or Use Invoice address. This selection 

determines whether the invoice or statement contact e-mail address is used when statements are e-mailed. 

3. Click the Reports tab and select E-Mail Statement. 

4. Click the Form Layout tab and customize the e-mail report used for statements. See “Customizing your 

statements”. 

Note: If you already customized your printed statements, you must repeat the process for e-mailed 

statements. E-mailed statements are based on a different report supplied by EFI. You cannot re-use the 

report you customized for printed statements. 

5. Make other selections in the Generate Statements window as necessary and then click E-Mail. 

Note: If you chose Selected Accounts, the Account Picker window will keep opening until you click Cancel 

in that window. 

The Statement E-Mail Status window opens and lists the accounts for which statements will be e-mailed. 

6. To review a statement, click the button in the Preview Attachment column. 

7. Click Send E-Mail. A message informs you when the e-mails have been sent. 

When statements are e-mailed, they are automatically logged in System Monitor (Admin > System Monitor > E- 

Mail Status) with the Type of the e-mail identified as Statements. 

logged in the customer account (on the Log tab). If the Statement log text field in the E-Mail preferences is 

blank, the e-mails are not logged on the Log tab in the customer account but are still logged in System Monitor. 

If the Use log text for subject and file name check box is selected in the E-Mail preferences, the Statement 

log text is also used for the subject of the e-mails and the name of the PDF attachment (the statement). If the  

 

Reprinting statement reports 

If you choose to generate a statement report and also selected the Save report check box on the Reports tab in 

the Generate Statements window, a copy of the report is saved so that you can reprint it later if necessary.  

A saved report is named Statements followed by the date you generated the statements, for example,  

Statements – 04-12-2016. 

To reprint a saved statement report 

1. In the Generate Statements window, click Open. The Download Files window opens. 

2. Select the report you want to reprint. 

3. Click Open. The report opens in a preview window from which you can print it. 
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Ordering Stock 
 

PrintSmith Vision includes several features to help you order stock and track what you ordered. You can keep 

track of all the stocks that need to be ordered, as well as keep track of placed and received stock orders. You 

can also create purchase orders for your stock orders. When an order is received, inventories for the stock are 

automatically adjusted (if you track inventory for the stock).  

 

Understanding the Order Stock window 

You record information about the stock that you need to order in the Order Stock window. To open this window, 

select Reports > Order Stock. There are two tabs on this page, To Order and Stock Order.  

Tip: If you are creating a job for an invoice, and the job requires stock to be ordered, you can click Order Stock 

under Commands in the Job window. When you save the invoice, the stock order is recorded, based on the job  

specifications. 

 

To Order 

The tab To Order has two sections, Pending List Items and Low Inventory. 

 

Pending List Items 

The pending list items is for items that are not part of your inventory. When an invoice is created for stock that is 

not part of your inventory that stock will automatically be added to this list. You can use the columns across the 

top to select the stock you want to order. The check box at the top will select all items.  

 

Recording the stock that needs to be ordered 

When you are ordering stock, you may want to: 

• Order stock for a particular invoice and job. 

• Order a particular stock that is in inventory and has an available quantity that is negative.  

Ordering stock for a particular invoice and job 

If you want to order stock for a particular invoice and job, you must know the invoice number and job number (if 

the invoice includes more than one job). For a multi -part job, you must also know the part of the job for which you 

want to order stock. 

Select Reports > Order Stock. The Order Stock window opens. You can use the search fields across the top of 

the page. Generally, you will use the invoice/job# field but you can also search by stock name.  
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The Order Quantity is automatically calculated by PrintSmith Vision based on the job specifications; change it if 

necessary. 

Select the stock(s) you want to order by selecting the check box to the left of the stock.  

After selecting the stock select the “+ Order” button in the upper right-hand corner of the page. The stock will now 

be displayed under the Stock Order tab. See the Stock Order tab. 

 

Ordering an inventory stock 

The system will track inventory stock and will identify it a low stock if the quantity on hand is less than the 

quantity committed. 

1. Select Reports > Order Stock. The Order Stock window opens. 

2. Click the Low Inventory tab Select Stock tab. 
 

The ordered quantity will be displayed based on the quantity needed to fill all commitments, target level and 

reorder quantity. 

You can use the column headers to refine your search for the stock. 

Select the inventory stock(s) to be order and select the + Order button in the upper-right hand corner of the 

screen. 

The stock will now be displayed in the Stock Order tab.  

 

Stock Order 

After identifying the stock to be ordered the stock will now be displayed in the Stock Order tab. From the stock 

order tab, you can place manual orders if you do not want a purchase order, create a purchase order or add a 

select stock that may be special order for a customer. 
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Reviewing and managing stock orders 

After you record your stock orders, you can review the orders that need to be placed. You do this in the Stock 

Order window. At this point you can create purchase orders for the stock by selecting the Purchase Order button 

If you do not create purchase orders, you can manually order the stock using the Man ual Order button. You can 

also use the + Select Stock button to manually enter information for special order stock.  

Placing stock orders 

The stock orders you recorded in the Order Stock window (Reports > Order Stock) are listed in the Stock 

Order window where you can keep track of which orders have been placed and received. Here you can also 

create purchase orders for stock you are ordering.  

1. Click select Reports > Order Stock > Stock Order. The Stock Order window opens. 
 

 

2. To hide stocks for which you already placed orders (ones with * in the Placed column), select the Hide 

previously ordered stocks check box. Doing so makes it easier to see which stocks still need orders 

placed for them. 

3. To change the sort order, click a column header. 

4. To see more or less information, make columns wider or narrower. 

5. To edit a stock order item: 

a. Select the edit option from the three-dot ellipsis and the Edit Order Stock window opens. 
 

 
The edit stock window will open. 
 

 



240  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

 

 
 

If the allow modification to stock order is checked then all of the fields except roll width and roll weight can 

be edited. If it is not checked then only the vendor, stock number, order quantity, stock order #, PO# and 

delivery date can be edited. 

 
b. Make your changes (for example, change the order quantity) and click Order. The change is reflected in 

the Stock Order window. 

6. To remove a stock order item, select it and click Delete. 

7. To create a purchase order for an item, select it and click Purchase Order. For information, see “Creating 

purchase orders from the Stock Order window”. 

8. To produce a report for each vendor (to facilitate tracking by vendor): 

a. Use the drop down to select Each Vendor or Consolidate 

b. Click Print. 
 

 
 

Manually ordering stock 

If you do not need or want a purchase order, then you identify that stock as being manually order by selecting the 
stock(s) using the check box next to the stock name and then selecting Manual Order. This will then cause an 

icon next to the stock to be highlighted to identify that stock as manually ordered.  
 

 

Creating a Purchase Order 

1. Open the Stock Order window 

2. Select the stock for which you want to create a purchase order by checking the box next to the item and 

click Purchase Order on the toolbar. 
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The Purchase Order window opens. If the stock is for a specific invoice, its number is automatically entered in 

the Document# field. The Item Name, Qty and Unit Price come from the stock definition; the Qty defaults to 

the Costing Units for the stock, but this can be changed; and the Description identifies the stock the same 

way as it is identified in a job (with the size, color, and weight included).  

Tip: You can re-size and re-position the Purchase Order window, as well as change the widths of the 

columns in the line-item list. 

3. Complete the top part of the Purchase Order window: 

a. PrintSmith Vision automatically assigns unique numbers to purchase orders, but if you want to enter a 
particular number or change the numbering sequence, enter the number in the Purchase Order **new** 
field. (When you save, print, or e-mail a purchase order, and you manually assigned a number, PrintSmith 
Vision asks if you want to start a new numbering sequence starting from the number you entered.) 

b. The first Purchase Order field is for a prefix and the third field is for a suffix. If a prefix or suffix was defined 
in the PO Settings preferences, it is displayed. If the PO Settings preferences allow a prefix or suffix to be 
edited, edit or enter a prefix if necessary. 

c. Click Change Supplier and select the supplier you want to use for the item. 
d. In the Date Required field, enter the date when you want the item(s) in the purchase order. Optionally 

enter a Time. 
e. To provide the supplier with information about the person to contact about the purchase, select a 

Buyer. 

Note: Be sure to select a buyer because this also identifies who created the PO in other parts of 

PrintSmith Vision. 

f.    In the Description field enter a general explanation of the entire purchase order. This description is 

included on purchase orders and is also used to identify the purchase order in purchase order history. 

Details are very useful here. 

4. To review or edit the line item on the purchase order (for example, to change the quantity) select the edit 

icon 

5. To remove an item from the PO, select the delete icon. 
 

6. Do any of the following as necessary and then click OK: 

• For stock or generic purchase orders, you can specify a customer account for the item you are 
purchasing. Click Change Account and select the account. For invoices, jobs, and charges, a 
customer account is automatically selected. 

• If the Item Code field is blank or if you want to specify the ID of the item you are ordering (for example, 

the stock number from the supplier’s catalog), enter this ID in the Item Code field. 

• Change the Item Name to match the way the supplier names the item. 

• If necessary, correct the Total Quantity. (Unit Price for stock usually does not require changing.) 

• Enter or change the Line Item Description (required) and/or enter an Additional Description. 
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7. To purchase another item of the same type (for example, stock) from this supplier, click in the Purchase 

Order window and complete the Purchase Order Line Item window (which will have blank fields). 

8. To save the purchase order, click Save in the Purchase Order window. (To save the purchase order, but 

leave the Purchase Order window open, select File > Save.) 

9. Print the purchase order select the print icon and to email use that icon. 
 

An icon next to the stock will be highlighted to show that the stock was purchased using a purchase order.  

 

Receiving stock orders 

How received stock is recorded depends on whether you create purchase orders for stock from the Stock Order 

window or not. 

When purchase orders are not created from the Stock Order window 

If your company does not create purchase orders for stock from the Stock Order window (as described in 

“Creating purchase orders from the Stock Order window” below,  complete these steps to indicate the stock was 

received: 

1.  If the complete order for a stock was received, select the stock (using the check box next to the stock) in the 

Stock Order window and click Order Received on the toolbar. 

Tip: If the orders were received for all the stocks listed, click Select All and then click Order Received. 

After you click Order Received, the value in the Received column is the same as that in the Quantity 

(ordered) column, and * is displayed in the Filled column. Also, if you track inventory for the stock, the 

information on the Inventory tab in the Stock Definitions window is updated as shown below for a stock 

order for a particular invoice. 

2. If part of the stock order was received: 

a. Select the stock in the Stock Order window and click Partial Order Received. The Stock Received 

window opens. 
 

 
b. Enter the Quantity Received and click SAVE. The quantity received is displayed in the Received 

column. Also, if you track inventory for the stock, the information on the Inventory tab in the Stock 

Definitions window is updated. 
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When purchase orders are created from the Stock Order window 

If your company creates purchase orders for stock from the Stock Order window (as described in “Creating 

purchase orders from the Stock Order window”), when you edit the purchase order to indicate tha t it is complete 

(the stock was received), the Stock Order window gets updated automatically.  

For example, 

• If you enter a value in the Partial Received field in the Purchase Order Line Item window, the 

Received column in the Stock Order window is automatically updated with this value. 

• If you select the Complete check box in the Purchase Order Line Item window, the Received column in the 

Stock Order window is automatically updated with the full ordered quantity and * is displayed in the Filled 

column. 

• If you select the Complete All check box in the Purchase Order window, any stocks in the Stock Order 

window that match those on the purchase order are automatically updated with the full ordered quantity an * 

is displayed in the Filled column. 
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Report Manager 
Report Manager is a separately licensed tool that is fully integrated with PrintSmith Vision and availabl e from the 

Reports menu. You can use Report Manager to do the following: 

• Replace one of the standard PrintSmith Vision reports with one of your own reports. 

• Add and run custom reports. 

Important: If you plan to customize PrintSmith reports or create custom reports yourself, you must use i-net 

Designer. 

In customer-hosted installations, i-net Designer must already be installed as described in the PrintSmith Vision - 

Installation and Upgrade Guide. In EFI-hosted installations, i-net Designer and other required components must 

already be installed and configured as described in the PrintSmith Vision - EFI-Hosted Guide 

• Download reports to a client computer and upload them to the PrintSmith Vision server (where all 

reports are stored). 

• Export data from a custom report. 

• Schedule custom reports. 

 

EFI-Hosted vs. Customer-Hosted Installations 

When editing or creating reports with i -net Designer, the procedure is somewhat different when PrintSmith Vision 

is EFI-hosted versus customer-hosted. 

 

EFI-hosted installations 

When PrintSmith Vision is hosted by EFI, you cannot edit or create rep orts with i-net Designer directly on the 

PrintSmith Vision server. Instead, you must install i -net Designer and other required components (such as 

Postgres and a demo database) on a client computer. 

Important: Be sure to follow the setup instructions under “Customizing Documents and Reports” in the  

PrintSmith Vision – EFI-Hosted Guide. 

You can then download reports from the PrintSmith Vision server to the client computer, edit the repor ts with i - 

net Designer, and upload the changed (or new) reports back to the server.  

 

Customer-hosted installations 

When you are hosting PrintSmith Vision, you can work directly with report (.rpt) files in this folder on the 

PrintSmith Vision server: 

• Windows: C:\Program Files (x86)\EFI\PrintSmith\PrintSmith Reports\Crystalclear Reports 

12.1\reportRepository 

• Macintosh: Applications/EFI/PrintSmith/PrintSmith Reports/Crystalclear Reports 

12.1/reportRepository 

Tip: If PrintSmith Vision is customer-hosted, but you want to work on reports locally on a client computer (instead 

of on the PrintSmith Vision server), you can download report files from the PrintSmith V ision server, edit them, 

and then upload the changed reports to the server (so they are available to a ll users). See pag e 249. 
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Understanding the Report Manager Window 
 

You can look at all reports, a list of scheduled reports or using the drop down you can identify the category of 

reports you want to view. 

As with all PSV windows like this you can use any of the column headers to select specific reports.  

 
For non-custom reports you can override or download. 

 
For custom reports you can print and export, set schedule, download or remove from custom.  
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Also, for custom reports you can display scheduled reports, add to custom reports, send the reports to your FTP 

site and access them from there. 
 

 
 

Overriding a Standard Report with Your Own Version 

If you want one of the standard PrintSmith reports to include different information, you can edit a copy of the 

report with i-net Designer and then use Report Manager to override the standard report with your version. This 

version will then be available in PrintSmith wherever the original PrintSmith report was available. 

“Reports” in PrintSmith include mailing labels, purchase orders, and job tickets, as well as traditional reports. To 

find out which reports you can override with your own, select Reports > Report Manager and check the listed 

reports for each Category (for example, System or Pricing). 

Follow the following steps to override a standard report with your own version  

Caution EFI strongly recommends that you always leave the original version of a report file in case you want to 

revert to it. 

1. If PrintSmith Vision is EFI-hosted: 

a. Download the report from the server. 

b. Start i-net Designer and select File > Open to open the report you downloaded. 

c. Select File > Save As and enter a name for your version of the report (it cannot begin with EFI_). 

If PrintSmith Vision is customer-hosted: 

a. If you want to edit the report on a client computer, download the report from the server and rename it. 

b. Start i-net Designer from the shortcut on the desktop (Windows) or from the dock (Macintosh). 

c. If you are working on a client computer, select File > Open and locate the copy of the report (the one you 

downloaded and renamed). 

2. Edit the report and then save your changes. 

3. In PrintSmith Vision, select Reports > Report Manager. The Report Manager window opens. 

4. If PrintSmith Vision is EFI-hosted, upload your customized report (.rpt) file to the PrintSmith Vision server. 

If PrintSmith Vision is customer-hosted, but you are working on a client computer:  

a. Upload your customized report (.rpt) file to the PrintSmith Vision server. 

b. Select the Select file from server check box. 

5. Select a Category and then select the report you want to override. 

Must be selected if you are on a client computer and PrintSmith is customer hosted. 
 

6. Click Override, locate your customized report (.rpt) file, and click Open. 

The name of your report file is now displayed in the Report field. 

7. Click Close. 



Report Manager |  247
7 

 

 

 

Your report will now run whenever you use the same method that you used to run the original PrintSmith report. 

For example, if your report replaces the standard Digital Definitions report, your version of the report w ill run 

when the Digital Definitions window is open and select File > Print.  

Tips: If you want to revert back to the default report (as supplied by EFI), select the report in the left-hand pane 

in Report Manager and click Remove. 

If you already overrode a report, but have a different version you want to use, first remove the report you 

previously supplied (which restores the default report supplied by EFI) and then override the EFI report with your 

latest version. 

 

Adding and Running Custom Reports 

You can also use i-net Designer to create custom reports. You then add the custom reports to Report Manager 

and run them from there. 

Tip: EFI has created numerous custom reports for your use. Before creating your own, check the Custom 

category in Report Manager to see what already exists. Also click Add when the Custom category is displayed to 

see if new custom reports are available to be added. 

1. Use i-net Designer to create a custom report. 

2. If PrintSmith Vision is EFI-hosted, upload the report to the PrintSmith Vision server. 

Tip: If PrintSmith Vision is customer-hosted, but you created a custom report locally (on a client computer), 

you must upload it to the PrintSmith Vision server. 

3. Add the custom report to Report Manager: 

a. In PrintSmith Vision, select Reports > Report Manager. 

b. In the Category field, select Custom. The Report Manager window now includes some additional buttons 

and fields. All custom reports that are available (including those supplied by EFI – identified by an EFI_ 

prefix) are listed in the left pane. 

c. Click Add. 

d. In the window that opens, find your custom report and click Add. 
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The report is now listed in the Report Manager window. 

Note: To remove a custom report from Report Manager, select the report and click Remove. (The report 

itself is not deleted.) 

4. Run the report: 

a. A report may include search rules, which are criteria such as dates to control what a report includes. To 

see and change the search rules before running the report, select the Show search rules before 

printing check box. (If the report has search rules, but the Show search rules before printing check box 

is cleared, the report runs with its default settings.) 

b. Select the report you want to run and click Print. 

If the Show search rules before printing check box was cleared, the report opens in a preview window 

from which you can print it. 

If you selected the Show search rules before printing check box, a window opens showing the default 

search rules, for example, a range of dates. (If no search rules were defined, the report is just g enerated.) 

c. To change a search rule, click a value in the When field is column and enter a new value using the 

specified format (for example, YYYY-MM-DD for a date). 

 

The following date shortcuts are available for date fields so you can avoid entering speci fic dates. 

(These shortcuts are case-sensitive. 
 

/D/ Current date 

/YD/ Yesterday’s date 

/SW/ Week starting date 

/EW/ Week ending date 

/LSW/ Last week’s starting date 

/LEW/ Last week’s ending date 

/SM/ Month starting date 

/EM/ Month ending date 

/LSM/ Last month’s starting date 

/LEM/ Last month’s ending date 

/SY/ Standard year starting date 
(Jan 1) 

/EY/ Standard year ending date 
(Dec 31) 

/LSY/ Last year’s starting date 

/LEY/ Last year’s ending date 

/BSY/ Business year starting date ** 

/BEY/ Business year ending date ** 

/LBSY/ Last business year’s starting 

date ** 

/LBEY/ Last business year’s ending 
date ** 

** The business year start and end dates are based on the fiscal year specified in your Business Calendar 

preferences. 

d. Click Print. The report opens in a preview window from which you can print it. 

Note: Custom reports that you add to Report Manager can only be run from Report Manager. 
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Downloading and Uploading Reports 

If you want to customize documents and reports, and PrintSmith Vision is EFI-hosted, you must use Report 

Manager both to download report files from the PrintSmith Vision server and to upload them to the server. 

If PrintSmith Vision is customer-hosted, you do not need to download or upload reports unless you want to work 

with reports on a client computer. In this case, you must use Report Manager both to download report files from 

the PrintSmith Vision server and to upload them to the server.  

Important: This section just describes how to download and upload report files – how to get them from and to 

the PrintSmith Vision server. You must then use i -net Designer to edit the reports. 

 

Downloading Report Files from Server 

When you download report files from the PrintSmith Vision server, they are placed in your default Downloads 

folder. 

Tip: The location of the Downloads folder is specified in your browser settings. For example, in Chrome, th is is 

one of the advanced settings; in Firefox it is one of the general options.  

1. In PrintSmith Vision, select Reports > Report Manager. 

2. Select Download for the report you want. 

You will get a screen to determine what is to do with the file.  

 

 
 
 

Uploading Report Files to Server 

After you finish working on a report that you downloaded or after you create a new custom report, you must 

upload it to the PrintSmith Vision server if it is EFI-hosted or if it is customer-hosted, but you are working on a 

client computer. (If PrintSmith is customer-hosted and you work on reports on the server, you can just copy the 

files to the appropriate repository on the PrintSmith Vision server.) 

Note: You cannot upload a report file which has an EFI_ prefix as part of the name. This is reserved for reports 

supplied by EFI. 
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1. In PrintSmith Vision, select Reports > Report Manager. 

2. Click Upload. 

3. Locate the report file you want to upload and cl ick Open. The system confirms the upload. 

4. Depending on the type of report you uploaded, complete any additional steps. For example: 

• If this is a custom report you are adding to Report Manager, select the Custom category, click Add, 

and select the report. You will then be able to run the report. (Until you add it, the report cannot be run.) 

• If you are replacing a standard report with one of your own, see steps 5 and 6 under “Overriding a 

Standard Report with Your Own Version”. 

 

Printing and Exporting Data from a Custom Report 

When you add a custom report to Report Manager, you can export data from the report to a text file. You can then 

import this data into other applications, for example, a Microsoft® Excel® spreadsheet. Just like when printing 

reports, you can apply search rules to the data that is exported.  

When you export a report, the resulting text file is formatted according to what is specified in the Default CSV 

Separator and Default CSV Quote Character fields in your International preferences. If these fields are blank in 

the International preferences, the CSV field separator defaults to comma (,) and the quote character used to 

enclose text strings defaults to double-quote (“), which are the standard delimiters in the U.S. In other countries, 

different delimiters are used and can be specified in the International preferences field and text delimiters 

specified in your International preferences. In addition, numeric data that is exported from reports is formatted 

according to the Decimal Delimiter and Thousands Delimiter specified in your Numbers preferences. 

 

To export data from a custom report 

1. In PrintSmith Vision, select Reports > Report Manager. 

2. In the Category field, select Custom. 

3. Select the custom report you want to export. 

4. Click Export. 

5. A window will open where you can identify the date range for the report, customer or account ID. You also 

select the file format. 

6. Select either Print or Export. 
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Scheduling Custom Reports 

You can schedule custom reports from Report Manager. The reports can run at a time and frequency of your 

choice, and they can be generated as PDF files for printing and/or as CSV (Excel) files. By scheduling reports 

you ensure that they run automatically and regularly without you having to remember to run them. 

1. Select Schedule from the three-dots. 

A window will appear where you can identify the date(s) and time you want the report to run.  

 

 
 

2. Select one of these frequencies for the report: 

• Select Daily and a Time to run the report every day at a particular time, for example, at 17:00. 

• Select Weekly, a Day of week, and a Time to run the report every week on a particular day and at a 

particular time, for example, every Friday at 19:00. 

• Select Monthly and one or more of the following: 

• The Beginning check box and a Time to run the report on the first day of the month at a particular time, 

for example, 19:00. 

• The Ending check box and a Time to run the report on the last day of the month at a particular time, for 

example, 19:00. 

• A Day of the month and a Time to run the report on a particular day of the month at a particular time, for 

example, the 15th day of the month at 19:00. 

Note: If you select more than one Monthly setting (as shown in the figure below), the Time is always the 
same. 

• Select On selected days, the days you want, and a Time to run the report on particular days of the 

week at a particular time, for example, on Wednesday and Friday at 17:00. (This is useful for reports 

you want to run more than once a week.) 

• Select On selected hours and the hours you want to run the report, for example, 1 AM and 7 PM. (This 

is useful for reports you want to run more than once a day.) 

3. If a report has search fields (below the Print and Export check boxes), in the When field is column, enter 

the criteria you want to use to include data in the report. For example, search fields may be an account 

number or part of a customer name. 

/D/ Current date 

/YD/ Yesterday’s date 

  

/SW/ Week starting date 

/EW/ Week ending date 

/LSW/ Last week’s starting date 

/LEW/ Last week’s ending date 

/SM/ Month starting date 

/EM/ Month ending date 

/LSM/ Last month’s starting date 

/LEM/ Last month’s ending date 

/SY/ Standard year starting date 
(January 1) 
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EY/ Standard year ending date 
(December 31) 

/LSY/ Last year’s starting date 

/LEY/ Last year’s ending date 

/BSY/ Business year starting date ** 

/BEY/ Business year ending date ** 

/LBSY/ Last business year’s starting 
date ** 

/LBEY/ Last business year’s ending 

date ** 

4. Select the Print check box to save the report as a PDF file and/or select the Export check box to save the 

report as a CSV (Excel) file. 

Note: If you click Preview or OK in the Set Schedule window without selecting the Print or Export check 

box, you will be asked to do so. 

The report will now show in the scheduled report list and the clock icon next to the report will be highlighted 

to indicate the report is scheduled. 

 
You can also send the reports to your FTP site and access them from there.  

 

If you want to use your FTP site for reports 

If you have an FTP site and want reports made available on the site, you should configure the FTP site before 

you start scheduling reports. 

1. In PrintSmith Vision, select Reports > Report Manager. 

2. In the Category field, select Custom. 

3. Click Set Up FTP for Scheduled Reports. 

4. Complete the fields in the Set Up FTP for Scheduled Reports window: 

• FTP Host name: the host name of the FTP server 

• FTP Port number: the port number on which the FTP server is running 

• User Name: the user name to the access FTP server 

• Password: the password to access the FTP server 

• FTP Path: if report files should be uploaded to the root folder of FTP server, leave this field blank; 

otherwise, enter the path to a specific folder using / (forward slash) as a delimiter between folder 

names. 

5. Save. 
 

After scheduled reports are generated 

• Once reports are being generated according to the schedule you set, from Report Manager you can: 

• Review which reports have run and check their status. 

• Open or download reports. 

• Delete any reports you no longer need. For example, if you run some reports daily, you will quickly have 

many versions of the reports so you may want to delete older versions. 

 
To review, open, download, or delete reports that were generated 

1. Select Reports > Report Manager and then select Custom in the Category field. 

2. Click View List of Scheduled Reports. 

The View List of Scheduled Reports window lists all the reports that were generated to date. 
Note: If a report is scheduled but has not run yet, it will not be listed in this window until it has run.  
 
Click to display information about 

To find a particular report, filter the list by Report Name or Execution Date/Time. 

3. Click next to a report name to display information about it. Then do any of the following:  

• See when a report was run and check its status. 
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• Depending whether the Print check box and/or Export check box was selected for the report, click the 

PDF icon or the Excel icon in the Download/Delete column. Then select Open with or Save File and 

click OK. 

Note: When you save a file, it is automatically saved in your Downloads folder. 

• If you run certain reports frequently, and no longer need older versions, click to delete a report. 

Tip: You can also open, download, and delete reports from the Change Schedule window as described next.  

 

Changing the schedule 

You can change the schedule for a report. For example, you may want to change the frequency at which the 

report runs, change search field criteria such as the range of dates included in the report, or indicate that you 

want to export the report to a CSV file instead of (or in addition to) having the report in PDF format. You can also 

unschedule the report altogether. 

While changing the schedule you can also review when the report ran, open and download versions of the 

report, or delete versions of the report (the same way as in the View List of Scheduled Reports window).  

To change the schedule 

1. Select Reports > Report Manager and then select Custom in the Category field. 

2. Select the report you want to reschedule and click Change Schedule. 

3. Adjust the schedule as necessary, for example, change the frequency at which the report is generated or 

change search field criteria. 

Note: To unschedule the report, select No Schedule. Alternatively, you can click Delete to remove the 

schedule and also remove all the reports that were generated to date. 

4. To review your changes, click Preview. 

5. To review the reports that were run to date and to open, download, or delete them, click List. 

The bottom of the Change Schedule window expands so you can see all the times the report was run and 

the status of the reports. 

6. Depending whether the Print check box and/or Export check box was selected for the report, click the PDF 

icon or the Excel icon in the Download/Delete column. Then select Open with or Save File and click OK. 

Note: When you save a file, it is automatically saved in your Downloads folder.  

7. If you run the report frequently, and no longer need older versions, click to delete a version of the report. 

8. Click OK. 
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Account Aging 

The purpose of account aging is to determine the status of customer accounts and warn you of accounts that 

may need collection action. An accurate gauge of your receivables is essential to running a healthy business.  

When PrintSmith Vision ages an account, it looks at all of the open debits (mon ey owed to you) as well as all 

open credits (money you owe to the customer or did not yet apply to a debit) to determine how long the customer 

has owed you money and when you last received a payment from the customer. Using this information, 

PrintSmith Vision adjusts the account status according to rules that you set. 

You can age accounts when you generate statements (AR > Account Utility > Generate Statements), but you 

can also do so without generating statements as described here.  

 

Procedure for aging accounts 

1. Select AR > Account Utility. The Account Utility window opens. From this window you can generate 

statements age accounts. To age without generating statements select as shown below: 

The Aging window will open. 

 

2. The Closing Date field is automatically set to the current date. Change it if necessary. This is the date that 

PrintSmith Vision uses to determine the aging status of accounts. Except for credits, open items with posting 

dates later than this date are ignored in the aging process. 
3. Use the Output tab to control how each account is handled during the aging process. For information, see 

pa 516. 

4. Click the Accounting tab to define how aging is performed and what to do about changing the customer 

account status as a result of aging. 

5. Click the Reports tab to generate a summary report of the aging. 

6. Click OK to initiate the aging process. 

7. If you selected the Pause after each check box on the Output tab, information about each account is 

displayed. If you also selected Ask before changing status on the Accounting tab, click Yes or No to 

change the status of the account based on the aging. 

Note: To cancel the aging procedure, close the window (by clicking X in the upper right corner). 

8. If you chose to generate a report, a preview window opens. Click to print the report. 
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Completing the Output tab for Account Aging 

1. Use the Output tab in the Account Aging window to control how each account is handled during the aging 

process. 

Select the Age master billing accounts check box to age a master billing account and all its sub-accounts 

as a single account. 

Note: The aging summary on the Sales Info tab in the Customer window shows aging amounts that can be 

considerably higher than the account balance because the summary includes the amounts for all the sub- 

accounts. This is normal. 

2. If you selected the Age master billing accounts check box, select the Skip sub-accounts check box so 

that sub-accounts are not aged (based on the assumption that the master account is responsible for 

payment). 

3. Select the Pause after each check box so that PrintSmith Vision stops after each account so you can 

review the results. 

4. Select the Include zero balance accounts check box to include all accounts, regardless of balance, in the 

aging report. 

 

Completing the Accounting tab for account aging 
Use the Accounting tab in the Account Aging window to define how aging is performed and what to do about 

changing the account status as a result of aging. 

Note: The aging period preferences (Admin > Preferences > Accounting > Aging Periods) also define aging 

rules. 

 

 

1. Select one of the following to determine which date is used to calculate the account status: 

• Status from Posting Date to use the date of the oldest open debit to determine the account status 

when aging is performed. 

• Status from Payment Date to use the date of the last payment received (as well as the status of each 

open item with a partial payment) to determine the account status. 

2. Select one of the following to control whether the account status is changed: 

• Always change account status so the account status is automatically changed based on your aging 

rules. 

• Ask before changing status so you can review the aging totals, the old status, and the proposed 
status in a summary window and decide if you want to update the account status. 

• Never change account status if you never want the account status changed. 

3. Select or clear the following check boxes: 

• Freeze after 90 days 

Normally, the proposed account status is Current, Past Due, or Delinquent. Select this check box to 

freeze the account status if there are open items older than the oldest aging period (by default this is 90 

days). When an account is frozen, you can only post payments to the account – no further work can be 

accepted for the account. 

• Unfreeze after 90 days 

Select this check box so the status of a frozen account is automatically changed after 90 days if payment 

is made. (You can also change this status manually on the Credit Control tab in the Customer window.) 
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• Mark inactive accounts 

Select this check box to identify inactive accounts. An account is considered inactive if nothing was 

posted to the account for the inactivity period specified in your preferences ( Admin > Preferences > 

Accounting > Credit/Defaults). When you see which accounts are inactive, you may want to contact 

the customers and find out the reason for the inactivity.  

• Inactive account to prospect 

Select this check box to reclassify inactive customer accounts as prospect accounts. When this check 

box is selected, and you perform an account aging, all inactive accounts are converted to prospect 

accounts. 

Caution: Use this feature with care. You cannot easily reverse changes to account classification 

(customer to prospect). Also, this feature does not consider how long a customer has been inactive; it 

simply changes all inactive customers to prospects. 

 

Completing the Reports tab for account aging 

Use the Reports tab in the Account Aging window to control whether a summary report of the aging is printed, 

control the detail it includes, and indicate whether you want to save the report for future reference. 

 

1. Select the Print summary report check box to generate a summary report after the aging is complete. 

2. If the Print summary report check box is selected, select or clear any of the following check boxes: 

• Detailed report 

Select this check box to include in the report the details of each open item in the account within the 

aging period specified by the closing date. 

• Add collection information 

Select this check box to include the sales representative, contact name, phone n umber, last payment 

date, and amount in the report. This information makes the report more valuable as a collection tool.  

• Alternate lines in aging columns 

If the amounts in the report are very large some of the amounts may creep into adjoining columns and 

make the report unreadable. Select this check box to print every other amount on alternate lines. 

(Alternate lines can make the report much longer.)  

3. The account aging report is not saved automatically. To save the report so you can reprint it later, select the 

Save report check box. The report is named Account Aging followed by the date you performed the aging. 

 

Reprinting account aging reports 

If you choose to generate an account aging report and also selected the Save report check box on the Reports 

tab in the Account Aging window, a copy of the report is saved so that you can reprint it later if necessary.  

A saved report is named Account Aging followed by the date you generated the statements, for example,  

Account Aging – 04-12-2016. 

To reprint a saved account aging report 

1. In the Account Aging window select the aging and statement reports icon. 
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2. The aging and statement reports window opens. 

 

 
3. Select the report you want to reprint. 

4. Click Open. The report opens in a preview window from which you can print it. 

 

Verifying Accounts Receivable 

If the Balance in Account is greater than Total Open Invoices, figure out the reason. Examine the account history 

(Reports > Account History) to see if an invoice was somehow not posted. Important Although you can cli ck Fix in 

the Verify Customer Balance window to replace the account balance with the total of the open items, you sho uld 

always try to figure what is causing the discrepancy. Contact PrintSmith Vision Support if necessary.  

If you want to update the aging totals stored in a customer account so they match the balance in the account, 

click Age Now.
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Account Ranking Report 
The Account Ranking report lists accounts in order by different criteria, for example, by balance, number of 

orders, or sales. You can save these rankings so they are available elsewhere in PrintSmith, for example, on the 

Sales Info tab in the Customer window (AR > Accounts). 

1. Select Reports > Account Ranking. The Account Ranking window opens. 
 

2. In the Rank Accounts by field use the drop down to select the way you want to see the accounts ordered: 

Balance, Sales current month, Sales current year, Sales prior year, Number orders, Sales by sales 

category, Sales by date range, or Sales by category and date. 

 
3. Under Include Accounts, select the check box of the type of account to include in the ranking: Customer, 

Prospect, or both. 

4. If Rank accounts by is set to Sales by sales category or Sales by category and date, in the Category field 

under Limit to Sales Category, select the sales category for the report. (The sales categories come from 

your preferences: Admin > Preferences > Accounting > Sales Categories.) 

5. If Rank accounts by is set to Sales by date or Sales by category and date, under Date Range, enter the 

dates for the ranking in the From and To fields. 

6. If you want to save more than one ranking based on different criteria, under Ranking Storage, select a 

 Custom ranking. You can save up to six different custom rankings.  

7. After you specify all the ranking criteria, click Run Ranking to generate the results. 

8. Sort the ranking results by clicking the column headers in the bottom half of the Account Ranking window. 

9. To print the report, click Print. 

Note: Account ranking will be saved and printed when the print button is clicked.  
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10. To save the account ranking (so it is reflected in customer account records): 

a. Click Save. 

b. Click Yes to confirm. 

You can then see the ranking on the Sales Info tab in the Customer window. 
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Press Definition 
Press definitions in PrintSmith Vision provide pricing information for your presses based on the type of work you 

perform on a particular press. 

 
In the PrintSmith Vision Dashboard, click Press Definitions (or select Pricing > Press Definitions). The Press 

Definitions window opens. Within Press Definition, you have four options for printers. Offset, Web, 

B&W/Color, and Large Format. User can duplicate an existing press definition to keep some changes and 

input new settings or create a new press definition. 

 

Creating Press Definitions 

You can create a new press definition by clicking Create Press Definition. The fastest way to set up your press 
definitions is to create a few “standard” definitions and then copy and adapt these definitions. To copy a press 

definition, click the three dots in the far-left column and select Duplicate. 

 

 
 

In the press definition window, you will be able to make quick changes to the definition settings. For 

example, changing the definition name, production location, and machine name. Within the definition you 

set a labor rate, labor markup, speed table, waste chart, and target pricing. Charges you want added to 

every job using that definition can be attached directly to the definition. 
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1. In the Name field, enter a name to identify the definition. 

2. When you have more than one definition for the same press, enter a number in the Machine ID field to 

identify the press. The Work In Progress report uses this ID to sort jobs by the press on which they 

are produced rather than by the press definition that was selected for the job. 

3. Select the Costing Press check box so that if a job is run on this press when another less expensive 

press is unavailable. The costing amount is based on this press definition used in conjunction with 

the Tracker module. 

4. In the Machine Name field, select the name of the press for which you are creating a definition. 

5. In the Output Description field, enter the description of this printing process as you want it to appear 

on invoices and job tickets, for example, printed or reproduced. 

6. If you use Tracker, select a location in the Production Location field. If you use Scheduler, select a 

Cost Center for the press definition. Under Paper Style, leave Sheet-Fed (Printing) selected for 

offset printing or select Roll-Fed for printing on a web press. 

 

 
 

Main- You provide the details for a sheet-fed press definition in the Max Paper Size through Washup Time per 

Fountain fields in the Press Definitions window. 

• Paper Size: In the Max Paper Size field, enter the largest sheet size (including bleeds) that you want to 

allow to be run. In the Min Paper Size field, enter the smallest sheet size you want to allow, for example, 

3.5 x 5.5. 

 
• Labor: In the Labor Rate field, enter the hourly cost of running the press. This number is very important 

in terms of determining whether you are making money. The labor rate should be “fully burdened,” 

which means that it should include the cost of labor and the cost of the press, as well as any overhead. 

In the Labor Markup field, enter the markup you want to apply to the rate you entered in the Labor Rate 

field. In the Minimum Labor field, enter the fewest minutes for which you want to charge on short jobs. 

 

• Setup: In the Setup (minutes) field, enter the number of minutes it typically takes to prepare the press 

for the first run of the day including the first color. For multi-pass jobs, in the Setup Add’l Run field, enter 

the time in minutes to get ready for an additional run (plate change and so on). This is always less than 

the initial setup. 

 
• Fixed Waste: In the Fixed Waste field, enter the number of sheets of setup (make ready) spoilage you 

anticipate. 

 

• Washup: To specify a fixed cost for washup, enter it in the Washup Fee field. Because no time is 

associated with this fee, it is not included in the estimate. As a result, EFI recommends that you leave 

the Washup Fee field blank and complete the Washup Minutes and Washup Time per Fountain fields 

instead. The value in the Washup Minutes field is a one-time charge per pass and the Washup Time per 

Fountain is multiplied by the number of washes (specified in the job). 
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• Heads: In the # Heads field, enter a number corresponding to the number of colors associated with the 

press definition (not the number of actual print heads on the press). For example, if the press definition 

is for one-color work, enter 1 in this field. For multi-color runs, in the Setup Add’l Head field, enter the 

time in minutes to set up additional heads. This is always less than the initial setup specified in the 

Setup (minutes) field. 

 
• Additional Signatures: For jobs with more than one signature (such as booklets), in the Setup Add’l 

Signatures field, enter the time in minutes for additional signatures after the initial make-ready. For 

example, if initial make-ready takes 5 minutes, additional signatures may take 3 minutes. For multi-color 

jobs with more than one signature, in the Add’l Signatures Add’l Head field, enter the time in minutes 

to set up additional heads 

 
Charges- Charges can be attached to definitions in the Charges Column. The preset charges make it possible 

to generate complex quotes quickly and consistently. The key is to add charges to a press definition that will  

make sense to the person creating the estimate. You can add a minimal set of charges and leave it to users to 

add any additional charges or you can add a larger set of charges and have users remove those that do not 

apply to a particular job. 
 

Speed Table- Generally, the longer the run, the closer a press gets to its rated speed since there are fewer stops 

for adjustment on a long run once the job is running properly. On long runs, each piece is therefore cheaper to 

produce. EFI recommends that you create a speed table for each of your press definitions to account for the 

speed of the press based on the length of runs and type of work being performed. 

 
Waste Chart- A press definition can have setup spoilage specified in the Fixed Waste field, but for run spoi lage 

you must use waste charts. Each type of press may have different spoilage characteristics so you may want to 

define individual waste charts for your press definitions, although they can also share waste charts. Once a 

waste chart is assigned to a press definition, the name of the waste chart is displayed in the Title Field.  
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Target Pricing- Target pricing involves setting up variable discounts or markups while remaining both profitable 

and competitive. Although typically you want to maintain a high level of profitability, you may sometimes want to 

lower your profit to remain competitive. Target Pricing is designed to allow you to adjust you r regular pricing up or 

down as needed to remain competitive in your market. In the Target Pricing windo w, you can set up the quantities 

you want, and PrintSmith will show you your current pricing based on the header parameters and what you have 

set up in the definition. You can then either override the prices or adjust the markup amounts so as to refine you r 

sell prices as needed. As your costs increase or market conditions change, you can adjust your Target Pricing 

accordingly. When you define Target Pricing for a press definition and then use that press definition for a job, the 

price is looked up in the Target Pricing table associated with the press definition.  
 

 

About Digital Definitions 
 

Digital definitions provide pricing information about your large  format and digital printers (B&W/Color and Large 

Format). You may own only one or two digital and large format printers but perform different types of activities 

on those printers. Each activity that requires different pricing would be represented by a di gital definition with its 

own pricing characteristics. 

 

Creating Digital Definitions 

When you start out, you must create your digital definitions from scratch, but if you later need to create similar 

definitions, you can copy existing ones and adapt them. 

1. To create a new B&W/Color definition, you must click the create digital definition button or duplicate an 

existing definition. The definition can represent black-and-white, color or both. To select this setting, 

you must choose the options under Printer Type. Unlike the offset and web definition settings, the 

B&W/Color printer Main tab is where you will put in the details for pricing, cost, and size. Digital 

Definitions do have the option to add a running waste chart. You will find those options under the 

Waste Chart tab. 
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2. Large Format definitions are for printers that produce banners, signs, vehicle wraps, etc. These 

definitions are similar to standard digital definitions but have the option to price by area and use both roll and 

rigid substrates. 

 

 

Selecting Pricing Information 
 

The pricing method that you select for a digital definition controls how PrintSmith Vision calculates the price of 

jobs that are based on the definition. The pricing method is therefore a key part of the digital definition. T he 

pricing methods that you can select depend on your Printer Type selection in the Digital Definitions window. For 

B&W and/or Color, five methods are available, three of which are matrix style.  
 

 

• In the Method field, select the pricing method you want to use. This is a key part of a digital 

definition. For information about the different pricing methods available. 

• The Price 2 Sided By field. This controls how two-sided jobs are priced. In each digital definition you 

must decide how to charge for the second side. 

• To charge more for the second side by multiplying the rate for the first side by a set factor, select using 

Side 2 Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 Factor field, for 

example, 1.3 to multiply the first side rate by 30%. 
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• Stock Price is a part of each digital definition, you must indicate whether stock is included in the pricing 

and how it is calculated. 

• Stock Markup lets you have one set of stock markups fo r copy jobs and another for printing jobs. For 

example, your standard stock markup (in the stock definition) for printing jobs may be 50% (1.5), but you 

may want to markup stock for copy jobs by only 20% (1.2). In this case you would enter 1.2 in the Stock 

Markup field and select the Use Digital Stock Markup check box. 

• If you have variable stock costs, and want to add a single markup on top, enter it in the Copy Markup 

field. 

• All the large-format pricing methods and three of the B&W/color copy pricing methods are based on matrix 

tables. These pricing methods require you to enter data in a table to define quantity breakpoints and unit 

prices. Different types of Matrix Tables are available. The most common is “copy cost” for obtaining a 

unit price, but you can also use a matrix to specify volume-based discounts, to do stepped pricing, or to 

define markups to use in addition to the machine cost per copy (or square unit for large format jobs). 

 

Selecting a pricing method 
The pricing method that you select for a digital definition controls how PrintSmith Visi on calculates the price of 

jobs that are based on the definition. The pricing method is therefore a key part of the digital definition.  

 
The pricing methods that you can select depend on your Printer Type selection in the Digital Definitions window. 

For B&W and/or Color, five methods are available, three of which are matrix style. For information, see below. 

For Large Format, four matrix-style methods are available. (The matrix style methods involve tables of quantities 

and prices that you set up.) 

 
B&W and color pricing methods 

 
If the Printer Type field in the Digital Definitions window is set to B&W and/or Color, you can select one of the 

following pricing methods in the Method field: 

 

 
 

Flat rate 

 
In this method, the rate per copy is always the same regardless of quantity: 1 copy has the same unit price as a 

million copies, and printing 100 copies of 1 original is the same as printing 1 copy of 100 originals. This may be 

useful for pricing on a convenience copier, but it is difficult to be competitive wi th this type of pricing. 

 
After you select Flat rate in the Method field in the Digital Definitions window, 

 
1. In the Rate/Copy field, enter what you want to charge per copy, for example, .1 (10 cents). 
2. Make your two-sided pricing and stock pricing selections as described in “Pricing two -sided jobs” in 

“Handling stock pricing”. 
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In the Price 2 Sided by field: 

 
To not charge for the second side, select not changing price. In this case there is no difference in price 

between one-sided and two-sided work. 

 
To charge more for the second side by multiplying the rate for the first side by a set factor, select using Side 2 

Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 Factor field, for example, 1.3 to 

multiply the first side rate by 30%. 

 

Copies and Originals 

 
In this matrix-based method, the number of copies in the job is used to find the copy price based on the number 

of originals, for example, 100 copies of 25 originals may be 0.0038 per copy.  

 
After you select Copies and Originals in the Method field, do the following: 

 

1. Create a matrix table as described in “Setting up a matrix table”. (The table may have extra columns for a 

second side depending on how you decided to price the second side.) 

 

 
 

2. In the Price 2 Sided by field: 

 
• To not charge for the second side, select not changing price. In this case there is no difference in 

price between one-sided and two-sided work. 

• To use the same rate for the second side as for the first side and to add the stock cost just once (not 

once for each side), select using first rate side. 

• To establish varying rates for the second side, select using second rate side. (The matrix table for the 

pricing method you selected will now have more columns to account for the second side pricing).  

• To treat the second side as an additional quantity (by doubling the number of originals before looking up 

the price), select counting as more originals. In this case 100 two-sided copies are priced the same 

as 200 one- sided copies. This is the most popular method for two-sided pricing. 

• To charge more for the second side by multiplying the rate for the first side by a set factor, select 

using Side 2 Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 Factor 

field, for example, 1.3 to multiply the first side rate by 30%. 
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Copies per original 
In this matrix-based method, the rate is based on the number of copies per original. After you select Copies per Original in 
the Method field: 
 

1. Make your two-sided pricing and stock pricing selections as described in “Pricing two -sided jobs” in 

“Handling stock pricing”. 

2. Create a matrix table as described in “Setting up a matrix table”. (The table may have extra columns for a 

second side depending on how you decided to price the second side.) 

 

 
 

In the Price 2 Sided by field: 

 
▪ To not charge for the second side, select not changing price. In this case there is no difference in 

price between one-sided and two-sided work. 

▪ To use the same rate for the second side as for the first side and to add the stock c ost just once (not 

once for each side), select using first rate side. 

▪ To establish varying rates for the second side, select using second rate side. (The matrix table for the 

pricing method you selected will now have more columns to account for the second side pricing). 

▪ To treat the second side as an additional quantity (by doubling the number of originals before looking up 

the price), select counting as more originals. In this case 100 two-sided copies are priced the same as 

200 one- sided copies. This is the most popular method for two -sided pricing. 

▪ To charge more for the second side by multiplying the rate for the first side by a set factor, select 

using Side 2 Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 Factor 

field, for example, 1.3 to multiply the first side rate by 30%. 

 

Total of all copies 

 
In this matrix-based method (the most popular for copy jobs), the total number of copies i n the job is used to find 

the unit price in the matrix, which is then multiplied by the number of copies in the job. For example, if the job is 

for 10 copies of 10 originals, the total number of copies is 100 so the price per copy is advantageous to your 

customers. 

 
After you select Total of all Copies in the Method field in the Digital Definitions window, do the following: 

Create a matrix table as described in “Setting up a matrix table”. (The table may have extra columns for a second 

side depending on how you decided to price the second side.) 
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In the Price 2 Sided by field: 

 
• To not charge for the second side, select not changing price. In this case there is no difference in price 

between one-sided and two-sided work. 

• To use the same rate for the second side as for the first side and to add the stock cost just once (not once for 

each side), select using first rate side. 

• To establish varying rates for the second side, select using second rate side. (The matrix table for the 

pricing method you selected will now have more columns to account for the second side pricing).  

• To treat the second side as an additional quantity (by doubling the number of originals before looking up the 

price), select counting as more originals. In this case 100 two-sided copies are priced the same as 200 

one- sided copies. This is the most popular method for two -sided pricing. 

• To charge more for the second side by multiplying the rate for the first side by a set factor, select using 

Side 2 Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 Factor field, for 

example, 1.3 to multiply the first side rate by 30%. 

 

Large-format pricing methods 

 

If the Printer Type field in the Digital Definitions window is set to Large Format, you can select one of the 

following matrix-style pricing methods in the Method field: 

 
Square Area and 

Originals Total of 

Square Area Square 

Area and Copies 

Square Area per Copy 

Total of square area is the most commonly used pricing method for large-format jobs. 

 

Square area and originals 
In this method, the total square area of a job is used to find the unit price in the matrix table based on the number 

of pieces (originals). 

 



Account Ranking Report |  271
9 

 

 

 
After you select Square Area and Originals in the Method field in the Digital Definitions window, 

 
1. Make your two-sided pricing and stock pricing selections as described in “Pricing two -sided 

jobs” in “Handling stock pricing”. 

2. Create a matrix table as described in “Setting up a matrix table”. (The table may have extra columns 

for a second side depending on how you decided to price the second side.) 

 

Total of square area 
In this method (the one most commonly used for large-format work), the total square area of the job is used to 

find the unit price in the matrix table, which is then multiplied by the number of units in the job.  

 

 
After you select Total of Square Area in the Method field in the Digital Definitions window, 

 
1. Make your two-sided pricing and stock pricing selections as described in “Pricing two -sided jobs” in 

“Handling stock pricing”. 

2. Create a matrix table as described in “Setting up a matrix table”. (The table may have extra columns for a 

second side depending on how you decided to price the second side.) 

 
Square area and copies 
In this method, the total square area and the number of copies being produced are used to obtain a unit price 

from the matrix table. 

 
After you select Square Area and Copies in the Method field in the Digital Definitions window, 

 
1. Make your two-sided pricing and stock pricing selections as described in “Pricing two -sided jobs” in 

“Handling stock pricing”. 

2. Create a matrix table as described in “Setting up a matrix table”. (The table may have extra columns for a 

second side depending on how you decided to price the second side.) 
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Square area per copy 

 
In this method, the number of copies is used to obtain a price per square unit from the matrix table. 

 
After you select Square Area per Copy in the Method field in the Digital Definitions window, 

 
1. Make your two-sided pricing and stock pricing selections as described in “Pricing two -sided jobs” below and 

in “Handling stock pricing”. 
2. Create a matrix table as described in “Setting up a matrix table”. (The table may have extra columns for a 

second side depending on how you decided to price the second side.) 
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Pricing two-sided jobs 
Below the Method field in the Digital Definitions window is the Price 2 Sided By field.  
This controls how two- sided jobs are priced. In each digital definition you must decide how to charge for the second side. 

 

In the Price 2 Sided by field: 

 
• To not charge for the second side, select not changing price. In this case there is no difference in price 

between one-sided and two-sided work. 
• To use the same rate for the second side as for the first side and to add the stock cost just once (not once for 

each side), select using first rate side. 
• To establish varying rates for the second side, select using second rate side. (The matrix table for the 

pricing method you selected will now have more columns to account for the second side pricing. For 

information about setting up matrix tables.) 
• To treat the second side as an additional quantity (by doubling the number of originals before looking up the 

price), select counting as more originals. In this case 100 two-sided copies are priced the same as 200 

one- sided copies. This is the most popular method for two -sided pricing. 
• To charge more for the second side by multiplying the rate for the first side by a set factor, select using 

Side 2 Factor in the Price 2 Sided by field and then enter the multiplier in the Side 2 Factor field, for 

example, 1.3 to multiply the first side rate by 30%. 

 

Handling stock pricing 

 
As part of each digital definition, you must indicate whether stock is included in the pricing and how it is 

calculated. 

You can handle stock pricing in these ways: 

• Exclude it from pricing. 

• Add a marked-up stock cost to the price. 

• Add a specific price for the stock to copy/unit price. 

 
Excluding stock from the price 
If you want the cost of the stock selected for the job to be ignored in the pricing calculations, select included in 

rate in the Stock Price is field. 

 

 
 

Tip If you have variable stock costs, and want to add a single markup on top, enter it in the Copy Markup field. 
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Adding marked up stock cost to price 

 
Do one of the following: 

 
• If you want to add the cost of the stock to the rate per copy (or square unit in the case of large format jobs) 

and mark up the stock using the markup in the stock definition, select marked up Stock Cost in the Stock 

Price is field. 

• If you want to add the cost of the stock but use a markup that is different from that in the stock definition, 
1. Select the Use Digital Stock Markup check box. 

2. Enter a value in the Stock Markup field. 

 
This lets you have one set of stock markups for copy jobs and another for printing jobs. For example, your 

standard stock markup (in the stock definition) for printing jobs may be 50% (1.5), but you may want to mark up 

stock for copy jobs by only 20% (1.2). In this case you would enter 1.2 in the Stock Markup field and select the 

Use Digital Stock Markup check box. 

 
Adding a specific price for stock 

 
If you want to add a specific price for the stock to the price per copy (or per square unit), you must first  add the 

price to your stock definition and then indicate in your digital definitions that you want to use this price.  

 
1. For B&W digital definitions: 

 
a. In the Stock Definitions window, click the Pricing Options tab. (For information about defining stocks, 

see “Adding New Stocks”.) 
b. In the B&W field, enter the stock price. For example, to add 4 cents to the price of a copy, enter .04. 
c. Save the stock definition. 

 
 
 
 
 
 
 
 
 
 
 

2. In the Digital Definitions window, in the Stock Price is field, select from Copier 1 in Stock Definition. 

3. If the digital definition is for color printers, repeat the steps above but enter the stock price in the Color field 

on the Pricing Options tab and select from Copier 2 in Stock Definition in the Stock Price is field. 

4. If the digital definition is for large format printers, enter the stock price in the Large Format field on the 

Pricing Options tab and then select from Copier 3 in Stock Definition to add the stock price to the price 

per square unit. 

 

Setting up a matrix table 

 
All the large-format pricing methods and three of the B&W/color copy pricing methods are based on matrix tables. 

These pricing methods require you to enter data in a table to define quan tity breakpoints and unit prices. 

 
Different types of matrix tables are available. The most common is “copy cost” for obtaining a unit price, but you 

can also use a matrix to specify volume-based discounts, to do stepped pricing, or to define markups to use in 

addition to the machine cost per copy (or square un it for large format jobs). 
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To set up a matrix table 

 
1. After you select the type of pricing method you want to use, select the type of matrix you want to set up: 

 
• Matrix is Copy Cost for a table of quantities and prices to determine the sell price as quantities increase. 

This is the most common type of matrix. 

• Matrix is Discount Table if you want to start with a base rate and then provide discounts as quantities 
increase. 

• Matrix is Step Table if you want to step through a range of unit prices and add them up according to the 
quantity in the job. For example, if you defined breakpoints at 100 for .06, 200 for .05, and 300 for .04, and 

the quantity to price is 250, the prices are calculated as follows: 100 at .06 (6.00), 100 at .05 (5.00), and 50 

at .04 (2.00). It then adds all three results together: 6.00+ 5.00+2.00 = 13.00. A step table for a large format 

definition works the same way except that your quantities are in square units such as 144, 576, and 1296. 

• Matrix is Markup Table if you want to define markups to add on top of the machine cost per copy (or per 

square unit for large format definitions) based on different quantities. 

 
Tip B&W on the Pricing Options tab in the stock definition corresponds to the copier 1 selection in the 

Stock Price is field in the digital definition; Color corresponds to copier 2; and Large Format corresponds 

to copier 3. 

 
 

 
2. For large format definitions, select Square Area from Run Size or Square Area from Finished Size 

depending on whether you want to charge for any unused area (run size) or just the finished job.  
3. The examples of matrix tables shown earlier in this chapter are all based on a single side. If you do two - 

sided work, and did not already do this, decide how you want to price the second side by making a 

selection in the Price 2 Sided By field near the bottom of the Digital Definitions window. (For 

information about this field, see “Pricing two-sided jobs”.) 
4. Leave the Interpolate Matrix Values check box selected so that intermediate unit prices between 

breakpoints in the table are calculated when the amount being looked up does not exactly match an amount 

in the table. (This is usually better for you since it avoids the situation where an amount is just above a 

breakpoint and therefore gets the breakpoint price. With interpolation, the price changes are much smaller 

and more accurately reflect quantities ordered.) 

5. Click Edit Matrix to open the matrix table. 

6. Enter all the quantities for which you need to account and the corresponding copy or unit prices.  

7. If you selected using second rate side in the Price 2 Sided By field, the matrix table includes additional 

columns for the second side. Enter the price per side in each column. For example, if you decide to charge 

15 cents for a one-sided copy but want to charge 22 cents for two -sided copies, the price in the 2 Sided 

column should be .11 (11 cents) because that is the price per side for a two-sided copy. 

8. When your matrix table is done, click OK to save it. 
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Providing costing information 

 
EFI recommends that you provide some information about your costs in the Digital Definitions window. You can 

then make sure that your prices are higher than your costs so that you are making a profit. The figure below 

illustrates the type of information you may want to enter to about your costs.  

 
1. In the Copies/Minute field, enter the average number of copies that the printer produces in a minute. (For a 

large format definition, this is Length/Minute – the average number of units such as inches or centimeters 

that advance through the printer in a minute.) 
2. In the Monthly Burden Rate, enter the amount of your overhead carried by this equipment. 
3. In the Monthly Labor field, enter the monthly labor rate associated with the equipment.  
4. In the Click Cost field, enter the cost per impression. 

5. In the Maximum Size and Minimum Size fields, enter the largest and smallest sizes that you want to 

handle with the definition. (These do not have to be the sizes that the equipment can handle.) 

 
For large format definitions, complete the Maximum Width and Minimum Width fields – the largest and 

smallest widths of substrates handled with this definition.  

 
6. In the Open Days/Year, enter the number of days you are open for business. 
7. In the Monthly Payment field, enter your monthly payment for the equipment. If you own the equipment, enter what 

you would anticipate paying to replace the equipment. 

8. In the % Time in Use field, enter the estimated percentage of time the equipment is usually in use. For 

example, if you are open for 8 hours a day and the machine is usually in use for 2 hours, enter 25%. 
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9. If you are using Tracker, in the Hourly Costing Rate field, enter the cost per hour for running the machine 

(including overhead). For information about Tracker, see the PrintSmith Vision - Tracker User Guide. 

10. Ignore the Labor/Copy field; the Monthly Labor field provides more accurate information. If the definition is for a 

copier, and toner and developer (or other consumables) are not part of your overhead, enter the additional 

charges per copy in the Toner/Copy and Developer/Copy fields. (Otherwise, ignore these fields.) 

11. Leave the Copy Markup field set to 1 unless you want to add a markup to the Machine Cost per Copy (for 
B&W and color definitions) or Machine Cost per Sq. Unit (for large format definitions). For example, to 
mark up the cost by 30%, enter 1.3. 

12. In the Open Hours/Day field, enter the number of regularly scheduled hours your business is open. This 

should include scheduled overtime and second shifts. 

13. In the Monthly Maintenance field, enter your monthly maintenance charge (if any). If you do your own 

maintenance, enter a reasonable periodic charge for your costs to maintain the equipment. 

 
Using the information you provided, PrintSmith Vision calculates the Machine Cost per Copy for B&W and color 

definitions or Machine Cost per Sq. Unit for large format definitions. 

 

Selecting default digital definitions 

 
You should select the mostly commonly used digital definition for each printer type (B&W, color, and large 

format) as your default definition for that type of printer. When you then create a B&W job, for example, the 

default B&W digital definition is automatically used unless the selected stock has a different definition assigned 

to it. (You can always change the assigned printer when you are creating a job.) If you do not select a default 

definition for a particular type of printer, the first definition of that type in the list is used. 

 

Providing Costing Information 

EFI recommends that you provide some information about your costs in the Digital Definitions window. You can 

then make sure that your prices are higher than your costs so that you are making a profit. The figure below 

illustrates the type of information you may want to enter to about your costs. 
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• In the Copies/Minute field, enter the average number of copies that the printer produces in a minute. 

(For a large format definition, this is Length/Minute – the average number of units such as inches or 

centimeters that advance through the printer in a minute.) 

• In the Monthly Burden Rate, enter the amount of your overhead carried by this equipment. 

• In the Monthly Labor field, enter the monthly labor rate associated with the equipment. (Use an 

average if several employees work on the equipment.) 

• In the Click Cost field, enter the cost per impression. 

• In the Maximum Size and Minimum Size fields, enter the largest and smallest sizes that you want to 

handle with the definition. (These do not have to be the sizes that the equipment can handle.) For large 

format definitions, complete the Maximum Width and Minimum Width fields – the largest and smallest 

widths of substrates handled with this definition. 

• In the Open Days/Year, enter the number of days you are open for business. 

• In the Monthly Payment field, enter your monthly payment for the equipment. If you own the 

equipment, enter what you would anticipate paying to replace the equipment. 

• In the % Time in Use field, enter the estimated percentage of time the equipment is usually in use. For 

example, if you are open for 8 hours a day and the machine is usually in use for 2 hours, enter 25%. 

 

You have the option to print the digital definitions. The click cost and other details would be in this 

document. 
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Charge Definitions 
 

Charge definitions are a key part of the pricing system. A charge can be defined for any activity that takes 

place before printing (for example, design, plate-making, or proofs) or after printing (for example, cutting, 

folding, padding, or mailing). Anything that makes up the jobs you sell and that is not part of the production 

printing process can have a charge associated with it.  

 
1. In PrintSmith Vision, click Charge Definitions (or select Pricing > Charge Definitions). The Charge 

Definitions window will open. 

 

 
 

2. The shipped version of PrintSmith Vision includes five named charge commands: Pre Press, Bindery, 

Markups/Discounts, Mailing Services, and Large Format Finishing. You can rename these to better 

describe your business. Another five “empty” commands are available for your use as your business 

requires. You can place any charge definition under any of the pre-supplied commands, but EFI 

recommends you group them as follows: 

 

▪ Pre Press. For any charges related to preparing a job for production.  

For example; preflight, plates, typesetting, design, and proofs. 

▪ Bindery. For any charges associated with finishing a job, such as post press cutting, folding, scoring, 

drilling, stitching, padding, gathering, book assembly, packaging, and so on. 

▪ Markups/Discounts. For any charge that reflects a markup or discount.  

For example; a rush charge or 15% price adjustment. 

▪ Mailing Services. For charges related to mailing the final products. 

▪ Large Format Finishing. For charges related to large format work.  

For example; lamination, grommets, and so on. 
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3. Commands, Categories, and Charges are organized in a navigation pane on the Charge Definitions 

window. You can expand and collapse the contents of the pane by clicking the arrow next to the 

Command. 
 

 

4. You can rename any charge command. If you want to use one of the “empty” commands, you should first 

rename it so the name identifies the type of charges it will contain. 

5. When setting up your category headers, make it as easy as possible to locate the charges they 

contain. For example, list the categories in the same order as you perform the associated activities (so 

the category list serves as a checklist), alphabetize the category list, or place frequently  used 

categories at the top of the list so they are faster to select. The organization is up to you. Also try to 

avoid having too many categories that contain only one or two charges. Instead, consolidate similar 

charges in one category. 
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6. You can also create and edit charges. 
 

Editing Charge Definition 

Each charge is based on a particular method which is designed to handle certain types of pricing situations. 

PrintSmith Vision includes several charge methods.  

 
When editing a charge definition, you can make changes to the Name, Sales Category, Production Location, 

Production Code, and Cost Center. 

• In the Sales Category field, select the category where the dollars associated with the charge should go . 

• In the Prod Code field, select the type of product you are creating. (Use Table Editor to maintain product 

codes in the Products table.) 

If you are using PrintSmith Vision Scheduler, select a Cost Center option for the charge. For information about 

creating cost centers and using PrintSmith Vision Scheduler, see the Scheduler User Guide.  
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Pricing Tab 
 

 

1. In the Method field, select the pricing method you want to use. This is a key part of a Charge definition. 

 
• Job Aware Select if you want the price calculated automatically based on job quantities and 

specifications. (This is the most commonly used pricing method.) 

• Markup Select to mark up (or discount) all or part of a job or an entire invoice by a specific factor. 

• Flat Rate Select to add a fixed amount to a job. For example, $5 for delivery. 

• Always Ask Select if the quantity is not known ahead of time and the estimator has to provide it. (You 

can, however, preset a common quantity to make data entry easier.) 

• Price List Select if you want a price looked up in a table based on the specified quantity. (A price list 

must be created and attached to the charge.) 

• Rate List Select if you want a unit rate looked up in a table based on the specified quantity. This rate 

is then multiplied by the quantity to generate the price. (A rate list must be created and attached to 

the charge.) 

• Cutting Charge Select for prepress and finishing cut charges. 

• Ink Charge Select to calculate the ink price based on the percentage of coverage. 

• Shipping Charge Select to charge for deliveries based on the weight of a job. Fold Select to 

calculate pricing for folding and include a graphic of a fold style. 

• Linear Select to calculate pricing based on the linear edge (perimeter) of a sheet. Estimators can 

 select which edge(s) they want to use when they add the charge. 

• Square Area Select to calculate pricing based on the square area of the run or finish size (100% 

coverage is assumed). 
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2. In the Quantity field, select the type of quantity that applies to the pricing method you selected 

 
• The Quantity field in the Charge Definitions window has several possible settings. Not all of the 

selections are available with each charge pricing method. A change to the setting of the Quantity field 

affects how quantities are entered when the charge is used but does not directly change the price. 

 

• Quantity is the most common selection in the Quantity field and is appropriate for many kinds of 

charges except for markup and flat rate charges, or charges that are time-based such as 

consulting or design. 

 

• The quantity that you enter when you add the charge is multiplied by the rate specified in the charge 

definition. (For job aware charges, the quantity is calculated automatically so you do not enter it.) 

 
3. In the Pricing Type field, A charge can be based either on Cost Plus pricing (you mark up your costs) or 

Piece Pricing (you specify the rate you want to charge): 

 

• For cost plus pricing, select Cost Plus, specify your costs (by clicking Costing on the toolbar), and then 

in the Markup field, enter the markup percentage that you want to add to the calculated costs. For 

example, 1.2 for a markup of 20%. 

• For piece pricing, select Piece Pricing, optionally specify your costs so you can determine what your 

piece rate should be, select the Rate check box, and then enter your rate. (Costs for piece pricing 

are not required but help you price accurately.) 

 

Selecting Other Charge Settings 

Many additional settings are available in the Charge Definitions window for handling special circumstances and 

enforcing how a particular charge is used. Use this section as a reference to those settings.  

 
 
No overrides If you select the No overrides check box in the Charge Definitions window, nobody can override 

the quantity or price in the charge. (A change to the quantity is treated as an override in job aware charges 

because PrintSmith Vision generates the quantity automatically.)  

 
Do not discount If you select the Do not discount check box, charges (for example, postage or shipping) 

are not affected by customer and charge discounts. This type of charge is shown in the Invoice window with 

∆ next to the price. 

 
Excluded from workflow If you use Tracker or Scheduler, select the Excluded from workflow check box in 

the Charge Definitions window if the charge (for example, postage or boxes) does not require labor and is 

therefore not a step in the production workflow. The charge is then not displayed in Tracker and is not 

scheduled. 

 
Tracker Pre-Production If you use Tracker, select the Tracker Pre-Production check box in the Charge 

Definitions window to indicate that the work associated with the charge (for example, design) takes place before 

the job is released to production 

 

Hide price only If you select the Hide price only check box in the Charge Definitions window, the price is 

hidden in the invoice, but the charge description is still shown. This is different from the Hide charge in 

printouts. 
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Hide charge in printouts Not all charges need to be included in the printed invoice or estimate. To exclude a 

charge from printed documents, select the Hide charge in printouts check box in the Charge Definitions 

window. Hidden charges are underlined in th e navigation pane of the Charge Definitions window  
 

Bindery operation This check box applies only to cutting charges where more than one original is typically 

processed (cut) at the same time. Select this check box to provide more accurate pricing when the number 

ordered is less than the set size, and there are multiple originals.  

 
Ignore global price changes This check box is for excluding a charge from global pricing updates which is 

an option in the Press Definition windows. 

 
Do not allow purchase order This check box is for preventing a purchase order from being raised for the 

charge. For example, unless the charge is for something like ink that you might purchase from a supp lier or for 

something like design work that you always outsource, you would select the Do not allow purchase order 

check box. In this case, when the charge is added to a job, you will be unable to raise a purchase order for it.  

Price List Tab 

 
In a price list, the system looks up a quantity to obtain the total price for that quantity. For example, the price 

for a quantity of 50 might be $10 and for a quantity of 100 might be $18.  
 

Waste Chart Tab 
As part of an accurate estimating process, you need to estimate waste and spoilage. If you generate a fixed 

amount of waste during the setup associated with a bindery charge, you can specify it in the Fixed Spoilage 

field in the Charge Definitions window. (This field is not available for all types of charges.) You can also define 

waste charts for runtime spoilage and assign them to charges. Different types of charges may have different 

spoilage characteristics so you may need several waste charts, although different charges can share the same 

waste chart. 
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Costing Tab 
Costing is the process of identifying your costs associated with a charge. For example, setup, material, labor, 

and so on. Only by understanding your costs can you price charges accurately and do so in a way that gives 

you a profit margin. 

 
• Use No Cost for a markup charge such as a shop minimum where you have no costs. No further 

information is required. 

• Use 100% Cost for a charge such as postage for which you need to pass on the full cost. No further 

information is required. 

• Use Unit Cost if there is no internal labor associated with the item. There may be a setup cost with an 

outside vendor. For example, if you send out work for laminating or diecutting. You can either specify a 

unit cost or define a rate list, so the cost varies according to quantity. 

• Time and Materials is the most common costing method since many charges involve both material 
and time costs (labor). 

 

 

Specifying your costs for charges 

 
Costing is the process of identifying your costs associated with a charge, for example, setup, material, labor, 

and so on. Only by understanding your costs can you price charges accurately and do so in a way that gives 

you a profit margin. 

 
1. In the Charge Definitions window, select a charge in the navigation pane. 

2. Click Costing on the toolbar. The Costing window opens. 

 
Note Always click Preset Info after you select Number of Sets in the Quantity field to check that the default 

quantity is 1 (or the most commonly used quantity). This ensures that a price is generated when the charge is 

first selected. If the quantity is set to 0, no price is generated until a quantity is entered.  

 
Note Costing is not required for piece pricing (although is highly recommended), but is required for cost plus 
pricing. In cost plus pricing, you provide the markup you want to apply to your costs, and PrintSmith Vision 

calculates the price automatically. 
 

Note If no costing is specified for a charge, a no costing icon is displayed to the left of the charge name 

in the navigation pane, and the Costing Method is set to No Cost. 

 
3. In the Costing Method field, select No Cost, 100% Cost, Unit Cost, or Time and Materials. Different 

fields and buttons become available depending on your selection. 

4. Complete the fields in the Costing window as described for the different costing methods below and then 

click Save. 

 

No Cost method 

 
Use No Cost for a markup charge such as a shop minimum where you have no costs. No further information is 

required. 

 
100% Cost method 
Use 100% Cost for a charge such as postage for which you need to pass on the full cost.  No further information 

is required. 
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Unit Cost method 

 
Use Unit Cost if there is no internal labor associated with the item, but there may be a setup cost with an outside 

vendor, for example, if you send out work for laminating. You can either specify a unit cost or define a rate list so 

the cost varies according to quantity. 

 
To specify a straight unit cost 

1. If a setup cost is associated with the charge, enter it in the Setup Cost field. 

2. In the Unit Cost field, enter the expense associated with one piece, for example, one suction cup. 

(What makes up a “unit” depends on the charge you are costing.)  

 

 

To use or set up a rate list to define unit cost 
1. In the Costing window, select Unit Cost and then click Rate. The Price List window opens. 

 
 

2. Do one of the following: 

 
• To use an existing rate list, choose it and click Select. The name of the selected rate list is displayed to 

the right of the Rate button in the Costing window and Unit Cost is automatically set to Variable. 

• To create a new rate list, click New and complete steps 3 through 8 in “Creating a rate list”. Keep in 

mind that in a rate table you are defining the cost per unit for particular quantities. This unit cost is then 

multiplied by the quantity to come up with the total cost. 

 

Time and Materials method 
Time and Materials is the most common costing method since many charges involve both material and time 

costs (labor). 

 
1. If there is a one-time material cost (it applies only once for the whole job), enter it in the Fixed Materials 

field. 

2. In the Unit Materials field, enter the cost of the material per piece, for example, 3.50 per plate. 

3. In the Labor Rate field, enter the hourly labor cost associated with the charge, for example, 50.00. 

4. If setup time is involved, enter the number of minutes in the Setup (minutes) field, for example, 5 minutes. 

5. In the Pieces/Hour field, enter the number of units you typically produce in an hour, for example, 12 plates 

per hour. (You can enter a decimal in this field.) 

6. If you have a charge like folding or sewing where the process may get faster as quantities increase, you can 

use a speed table to vary the unit labor cost based on run quantity and speed. Click Speed and either select 

or create a speed table. The process is the same as for press definitions. 

 
Note After you complete steps 1 through 5, Total unit cost of the labor and material rates. If you are using Cost Plus 

for pricing, the total unit cost is also the basis for calculating the Sales Price per Unit. 
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List Price Schedule 
 

The List price schedule method is for print jobs based on list pricing. List prices are tables of quantities and 

either numbers of colors or numbers of passes through the press. PrintSmith Vision includes some list price 

schedules to get you started. You can change the contents of the schedules or delete them as long as at least 

one is left. 

 

1. In PrintSmith Vision, click Pricing > List Price Schedule. The List Price Schedule window will open. 
 

 
 
 

 
2. To create a list price based on quantities (copies) and number of colors, click + Color. 

Alternatively, to create a list price schedule based on quantity and number of passes through the press, 

click + Pass Schedule. 

 
You can also duplicate and delete price schedules. 
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3. By default, the price list is based on the ordered quantity, but if necessary, select one of the following in the 

Method field: 

• Use press sheets – the run quantity of sheets through the press. 

• Use press sheets and bindery waste – all the paper running through the press. 

• Use ordered quantity per sheet (originals) – the ordered quantity for each original, for example, 25 
business cards for each name. 

 

4. The horizontal column represents the number of copies and the vertical column is the number of colors. 
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5. Enter your quantities and prices in the table. Note that the fields below the table are used for every 

additional increment that you specify; +1000 in the example below. 
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6. Once done you can click save and access different schedules under List Price Schedule. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

‘ 
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Stamp Schedule 
 

Creating a job for a rubber stamp (Lines and Inches Pricing Method) 

The List price schedule method is for print jobs based on list pricing. List prices are tables of quantities and 

either numbers of colors or numbers of passes through the press. PrintSmith Vision includes some list price 

schedules to get you started. You can change the contents of the schedules or delete them as long as at least 

one is left. This is for list price schedules and not Lines and Inches.  

 
 

Editing the rubber stamp pricing table (Stamp Schedule) 

The rubber stamp pricing table contains prices based on the number of lines of text on a stamp and the width of 

the stamp in inches. The numbers of inches and lines in this table are always whole numbers, but users can 

enter fractional amounts when creating a job, for example, 2.5 lines or 6.25 inches. In this case, the next largest 

value in the schedule is used to find the price, for example, 3 lines or 7 inches.  

 
1. In the PrintSmith Vision, click Pricing > Stamp Schedule. The Stamp Schedule window will open. 
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2. The horizontal column represents the lines and the vertical column represents the number of inches. 

 

 
3. The last column represents an additional inch and the last row is for additional lines. 

 

 
 

4. The user cannot duplicate, edit, and/or delete the Stamp Schedule. The user can only save the stamp 

schedule. 
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Sales Tax 

In order to properly calculate and report your sales taxes, you need to set up tax tables in PrintSmith Vision to 

define your tax rates. If you do not charge and collect sales tax, you should ensure that no (zero) tax is being 

calculated. 

Where you sell determines how many tax tables you need. For example, if your business sells exclusively in a 

single tax jurisdiction, you only need one tax table. If, however, your business sells in multiple tax jurisdictions, or 

is international, you need to account for all these different taxes by setting up several tax tables. For example, 

international customers may require tax on tax and variable tax rates. Canada has a GST/HST tax. Chile also has 

special tax verification procedures. You must account for all these different tax s ituations. 

 
Default tax table 

One tax table is always identified as the default tax table. This may be the only tax table you use.  If, however, you 

have multiple tax tables, the default tax table should typically be for your most commonly used sales tax. The 

default tax table is automatically used for all taxable customers and invoices unless another tax table is assigned 

to an account or invoice. 

 

Taking advantage of product-level taxation 
When you add a job to an estimate or invoice and select a Product for the job, the tax associated with the product (in the 
Products table) is automatically set in the Tax Table field. 
 

 

 
The tax rate defined in the tax table is then applied to the subtotal of the invoice.  

 
Note If you then try to change the tax table at the estimate/invoice level (in  the Document Totals), the system 

will prevent you. If you want to apply a different tax table to the invoice, you must change Tax Table for the 

job in the estimate/invoice to Use Parent Tax Table. 

 
Unless you are also using line-item taxation, only one tax table can be associated with an estimate or invoice. If 

you have multiple jobs on a single estimate or invoice, they cannot be for products that are associated with 

different tax tables. What this means: 

 
• When you add a job to an estimate or invoice for a product that has an associated tax table, that tax table is 

used for the entire estimate or invoice. 

• After you add one job to an estimate or invoice for a product that has an associated tax table, you cannot 
add more jobs for products with different tax tables. The Tax Table field for those jobs must be set to Use 
Parent Tax Table (which means the job inherits that tax table from the estimate or invoice). 
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Line-item taxation 

You may find it necessary to tax individual line items in an invoice independently. For example, in some tax 

jurisdictions an item that involves just labor, (such as folding), may be taxed differently from an item that involves 

both labor and materials, (such as printing). In addition, jobs in an invoice may be delivered to different locations 

that are subject to different taxes. When using line-item taxation you can have up to five different tax tables per 

invoice. 

 
1. In the PrintSmith Vision, click Pricing > Sales Tax. The Sales Tax window will open. Wrong item 

highlighted 

 
 
 

2. You can edit an existing sales tax table or create a new one by selecting +Add 
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3. You can add multiple line item elements. For example: User can add a state tax and choose a specific 

percentage for the tax rate, and a city tax at a different rate. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. You can choose whether your customer can see the additional taxes. Also, you have the option to add on 

Tax Shipping, Separate Shipping, Tax on Tax, Build Tax on Price, and Round Tax up. 
 
 

 

Tax Shipping: Select this check box if you need to tax the amount you are charging for shipping (which is 

common in Canada). When the Tax Shipping check box is selected, all the check boxes in the Ship column are 

selected automatically so that all the tax elements in the table are used to calculate taxes on shipping. If you 

want to choose which tax elements to apply to shipping, select the Separate Shipping check box and then clear 

the check boxes in the Ship column for the tax elements you do not want to use in the calculation. For example, 

in the figure below, the city tax is not applied to shipping. 

Separate Shipping: Select this box if you want to show the shipping tax for line item.  

Tax on Tax: Select this check box if one tax must be applied to another. Normally, the rates in the tax table are 

added together to produce the effective tax rate. If you select the Tax on Tax check box, the effective tax rate is 

calculated differently. Suppose the first tax rate is 8% and the second rate is 2%. In this case, the 2% rate is 

applied to the 8% rate. An additional 0.16% (2% of 8%) is therefore added to the effective tax rate, and the 

result is 10.16%. 
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Build Tax on Price: (For future use) Select this check box if you want to hide the tax in the price for items and 

never show it separately. 

Round Tax up: Select this check box if you want to round up all the tax rates in the table. Generally, this check 

box should be cleared. The only case where EFI recommends selecting the Roun d tax up check box is in the 

state of Florida which has a sales taxing system that uses a table to look up actual tax amounts instead o f 

calculating with a formula. The closest PrintSmith could get to matching their system by formula exactly (based 

on the unofficial recommendation of the State of Florida tax departments) is to round up all taxes.  

 
5. When you complete your Sales Tax form, Select Save. 
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Preferences 

Preferences are a key part of PrintSmith Vision. They control many aspects of the system and its behavior. For 

example, you use preferences to define your business calendar, pricing markups, quantities for price lists, and 

aging periods. 

Preferences are critical to the way your system works so be sure to review all of the preference settings and 

make any necessary changes before you start using PrintSmith Vision. Not all preferences are applic able to your 

business, and many have default settings, but you should consider each preference and its effects. You can 

change preferences at any time. 

 
1. In the PrintSmith Vision, click Setting > Preferences > Settings. 

 

 
2. You can edit different preferences in System, POS, Estimator, and Account. 
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System Preferences 

Behavior: Use the Behavior preferences to control some of the general ways PrintSmith Vision acts. For example, 

you can choose to suppress some warning messages or force PrintSmith Vision to quit after a period of inactivity. 

Company: Use the Company preferences to enter your company information, which is included in some documents. 

For example, some of this information is used as the remittance address in statements, or when estimates or i nvoices 

are e-mailed. 

Business Calendar: Use the Business Calendar preferences to specify your fiscal year, as well as to set work days. 

The fiscal year you specify here affects how sales history is reported throughout PrintSmith Vision in terms of current  

and previous years, for example, in the Account History and Account Ranking reports, as well as on the Sales Info 

tab in the Customer window, the Dashboard, and so on.  

Numbers: Use the Numbers preferences to change some aspects of numeric formatting such as rounding. Numbers 

preferences are also related to localization, for example, the currency symbol or decimal/thousands delimiters used in 

a particular country. These settings are taken from operating system settings on the PrintSmith Vision server so you  

should not need to change them. For example, if the operating system is German, the delimiters will be set 

appropriately. 

Alternate Currency: Use the Alternate Currency preferences to set up and include another currency on invoices, 

estimates, statements, and receipts. In particular, these pre ferences support the European Union’s standard 

currency, the euro. 

International: Set the International preferences if you are located in a country other than the United States of 

America. Although some of these settings are country-specific, in all countries you should indicate the unit of measure 

for ink weight. In addition, if you normally use a character other than a comma (,) to separate fields in CSV files (used 

to import certain kinds of data into PrintSmith Vision), you can specify that character here. Likewise, if you do not use 

double-quotes (“) to delimit text in CSV files you can specify that character here.  

E-mail: Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can e-mail 

various documents, for example, estimates, invoices, purchase orders, statements, and credit memos. As part of 

configuration you can specify what the body of each type of e -mail includes. 

Fiery Media: Set size, recycled percent, thickness, and weight. 

Dashboard: Use the Dashboard preferences to control some aspects of the Dashboard. For information about the 

Dashboard, see “About the Dashboard”.  

 

Backup Manager: Use the Backup Manager preferences to schedule daily backups of your PrintSmith Vis ion system 

or to perform a backup right away (manually). EFI strongly recommends that you back up your entire PrintSmith Vision 

system regularly to avoid losing data critical to your business if a system failure (such as a hard disk crash) or some 

other disaster occurs. Always back up the data to an external device or take advantage of a cloud -based backup 

service. 

Mandatory Field: Use the Mandatory Field preferences to make certain fields required. Users will not be able to 

continue or complete a particular task without providing the required information 

HTML View: Changes view of different templates. 
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Point of Sale (POS) 

Receipt: Use the Receipt preferences to set the header and footer text for receipts as well as the receipt 

numbering and tax option. 

Cash Drawer: Use the Cash Drawer preferences to enable the optional receipt printer and to control aspects of 

receipt printing. The receipt printer – a Star TSP 700ll printer – must be purchased from EFI. 

Cash Register: Use the Cash Register preferences to control the names and purpose of the sales departments 

in the Cash Register window. If your business does a lot of small transactions, you should configure the cash 

register to match the types of transactions for which you do not need to create invoices 

 

Estimator 

Estimator Behavior: Use the Estimator Behavior preferences to control some general settings that affect the 

estimating process. For example, you can control whether the parent size of a stock is always used or whether 

the Paper Calculator window opens automatically when you create new jobs. 

Estimator Printing: Use the Estimator Printing preferences to determine if an invoice is closed after the job 

tickets are printed, what the default invoice and estimate formats are, and how the payment due date is 

calculated. 

Paper Calculator: Use the Paper Calculator preferences to enter default settings for the Paper Calcul ator. 

These defaults can be overridden when working in the Paper Calculator window.  

Job Ticket: Use the Job Ticket preferences to select a ticket style and decide what to include on job tickets . 

Quantity Break: Use the Quantity Breaks preferences to enter the quantities to use in price lists. These 

quantities serve as break points to determine prices based on a particular quantity ordered.  

Markups: Use the Markups preferences to set the amounts by which you want to mark up outside service jobs 

and merchandise jobs. Markups are based on total costs. The first amount covers costs from zero to the 

specified cost, and the last amount covers anything above the last specified cost. 

Stock and Sizes: Use the Stocks and Sizes preferences to specify settings for in stock, special order, and 

customer stock; provide formatting instructions for stock descriptions in documents; and specify markups for 

blank stock pricing. 

Pricing Method: Use the Pricing Method preferences to select the job pricing methods you want available as 

selections when creating jobs. (Selecting a job pricing method is the first step in creating a new job.) You can 

also change the title (name) of a pricing method to match conventions used at your company. The pricing method 

calculations, however, remain the same even if you change the name of a pricing method. For example, if you 

change Printing to Offset or B&W to Digital B&W, the underlying methods used for calculations remain 

unchanged. 

You can also use these preferences to control whether purchase orders can be generated when a particular 

pricing method is selected for a job. 
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Account 

Credit/Defaults: Use the Credit/Defaults preferences to establish credit limits and other defaults for accounts.  

Aging Periods: Use the Aging Periods preferences to define the number of days before an account is past due, 

delinquent, or frozen, as well as provide the notices that are included on statements for accounts that meet these 

criteria. The standard aging periods are 30, 60, and 90 days, but you can change these to suit your business 

needs better. 

Sale Categories: Use the Sales Categories preferences to group your sales for tracking purposes. Typically, 

you want to define sales categories that you can then associate with departments in the cash register and with 

job pricing methods, as well as with your press, digital, and charge definitions. PrintSmith Vision keeps track of 

sales categories by their numeric ID. Once sales are recorded in a category, they stay in that category based on 

its numeric ID, not its name. 

GL Profiles: Use the GL Profiles preferences if you use an external accounting package. With these 

preferences, you define a link to the accounting package, as well as define specific GL account numbers that 

relate to this accounting package. When you perform a closeout, you can export data (from the fields described 

below) in the form of an .IIF file. This file can then be imported to  your accounting system. 

Credit Card Info: If you are not using integrated credit card processing in PrintSmith Vision, use the Credit Card 

Info preferences to select the credit cards that you will accept as a payment method in PrintSmith Vision.  

If you are using integrated credit card processing in PrintSmith Vision (which is licensed separately), use the 

Credit Card Info preferences to configure the connection to the payment gateway. For information, see the guide 

PrintSmith Vision - Secure Credit Card Processing. 

Order Number Format: Use the Order Number Format preferences to specify the prefixes and/or suffixes that 

you want to use with invoice and estimate numbers. For example, your company may follow a convention where 

all estimates begin with a location or store number so this information would be your prefix for estimates  

PO Settings: Use the PO Settings preferences to specify a prefix and/or suffix to be used with purchase order 

numbers and to control where in PrintSmith Vision purchase orders can be created. 

Closeouts: Use the Closeouts preferences to schedule closeouts so they occur automatically . 
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Customer Lists 
The Customer List reports provide information about your customers and/or prospects, for example, addresses, 

account settings, and balance summaries. 

 
1. In the PrintSmith Vision, click Reports > Customer lists 

 

 

 
2. There are several variations of the Customer List report that are available 
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• Balance Summary for a summary of the current account balances for all customers. 

• Sales Summary for a summary of the sales amounts and average orders fo r each account by month and year. 

• Address List for the invoice and statement addresses for each account. 

• Posting Dates for a report on the various dates that PrintSmith Vision uses to track accounts, for example, 

estimate date and payment date. 

 
• Account Profile for a summary of some key settings for each account, for example, type and credit limit. The 

Account Profile report includes the following information: 

Resale- Shows the resale ID (if any). Accounts with a resale ID are not charged sales tax. 

Bus Type Shows the type of business the account represents. 

Table Shows the name of the tax table that is assigned to the account.  

Type Shows the type of the account, for example, charge. 

PO Req Indicates whether a PO is required on invoices for the account.  

Bill Indicates whether a statement is generated for the account. 

CR Limit If a credit limit was specifically set for the account, shows the amount of that limit. Default means 

that the system-wide credit limit is used. 

Disc% Shows any automatic discount percentage specified for the account. 

Interest Shows the rate used to calculate finance charges on statements. Default means that the system - 

wide rate is used. None means that no finance charge is ever calculated on the account. A percentage 

indicates the rate that is specified for the account. 

• Sales Rank Month for a report on the sales volume and relative standing of each account in the current month. 

A monthly closeout updates these statistics. 

• Sales Rank Year for a report on the sales volume and relative standing of each account for the current year. 

• Collection Follow-up for information that is useful for calling customers about their outstanding balances 

 
3. In the Sort by field, select the way you want to sort the report: 
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Account Name The name of the account. 

Account Number The number of the account. 

Account Status The status of the account (for example, current or past due).  

Business Type The code that you can enter in the customer account (on the Settings tab) to categorize 

accounts, for example, SIC code or ABC method of ranking 

Account Type The type of account, for example, cash only or charge.  

Sales per Month The sales for the account by month. EFI recommends that you sort this way after running a 

monthly closeout; otherwise, the monthly sales figures may not be correct. This is also useful for running a Sales 

Rank Month report. 

Sales per Year The sales for each account by year. (This is useful for running a Sales Rank Year report.)  

Sales Rep The sales representative. Balance The current balance, with the account with the highest balance 

shown first. (This is useful when running a Balance Summary report.)  
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Delivery Ticket Manager 

You can use Delivery Ticket Manager to review your delivery ticket history. You can also use Delivery Ticket 

Manager to create, modify, and customize delivery ticket forms, as well as add brokers. 

 
1. In the PrintSmith Vision, click Setting > Admin > Delivery Ticket Manager. 

 
 

2. Select an invoice. 

 



312  EFI Productivity Suite | PrintSmith Vision User Guide 
 

 

3. A delivery ticket displays the order information, where is was shipped from and to, the driver’s information, 

and tracking ID. 

 

 
4. If you want to change formats for different delivery tickets, select Settings > Configurations.
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• Use the Form Preferences tab to create, customize, or edit delivery ticket forms that can be selected when 

printing a delivery ticket. 

• Use the Brokers tab set up additional brokers that can be selected for deliveries. 

• Use the Upload/Download tab when customizing delivery tickets. 
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Credit Card Manager 
1. Select Settings > Preferences > Credit Card Manager. 
 

 

 
2. There’s two type of payment methods. USA ePay and Card Connect. This screen will display all transactions 

that made with PrintSmith Vision. 



Account Ranking Report |  315
3 

 

 

 

3. If a customer wants a receipt you can print receipt by selecting Receipt Printer. 
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User Definition 

Each person who uses PrintSmith Vision must have a user definition (profile). This definition establishes a 

username and password for logging into the system, associates the user with an access group, and controls 

some other features such as the user’s ability to change the credit limit for a customer. 

1. After you define your security access groups, you must define your PrintSmith Vision users. Select Settings 

> Admin > User Definition. 

 
 

 
 

2. Owners can add new users by selecting the + button. 

 

 

3. After you define your security access groups, you must define your PrintSmith Vision users. 

In the Access Level field, enter a number to control whether the user has access to information about 

customer accounts or history. 
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A customer account also has an access level; if the user has an access level lower than that set for an 

account, the user has no access to that account or its history. So, for example, if some users should never 

have access to account information, you could give these users access levels of 1 and then make sure that 

accounts have an access level higher than 1. (The security level setting for customer accounts is defined on 

the Settings tab in the Customer window.) 

4. After you configure e-mail in the E-Mail preferences, complete the e-mail fields as follows if you want the 

user’s e-mail address to be used as the “from” address when the user e-mails documents to customers. 

 

5. In the E-Mail User Name and E-Mail Password fields, enter the login credentials for the account If all three 

fields include valid information, the e-mail address is used as the “from” address when the user e-mails 

invoices and estimates. 

 
6. Unless you are integrated with Digital StoreFront, ignore the DSF SSO Token field 

 
7. Define a password and password rules to be used when the user logs into PrintSmith Vision: 

 
a. To enter the password for the user (or change the password of an existing user), click Set User’s 

Password. Passwords are never displayed. Once you give users their user name and password, they 

should change their own passwords with Admin > Change Password. 

 

b. To force the user to change the password at login, select the Force password change at signon check 

box. (Once the user changes his or her password, this check box is cleared automatically.) 

 

c. To force the user to enter a “strong” password, select the Use robust password rules check box. Robust 

passwords 

 
8. Select or clear the following check boxes: 

Not allowed to override: Select this check box to prevent the user from changing anything that is 

considered an override in PrintSmith Vision or from removing an existing override.  

 
Can override credit limit: Select this check box to allow the user to override the credit limit when charging 

items in the cash register and to change the credit limit and discount percentage on the Credit Control tab in 

the Customer window. EFI recommends you restrict this feature to managers.  

 

Lock sales rep names: Select this check box to prevent the sales representative assigned to an account or 

document from being changed. The user can only assign the sales representative if one is not assigned.  

 
Can refund on credit cards: Select this check box to allow the user to perform refunds on credit card 
transactions. 

 
Not allowed to return cash: Select this check box to prevent the user from cashing checks in the cash 

register. A transaction is rejected if the amount of change exceeds the total amount of cash  

 
Show user name on Log In window: Select this check box to display the user’s name in the list of users in 

the PrintSmith Vision Log In window. The user can then select his/her name instead of typing it when logging 

in. (You may want users to type their names for security reasons, in which case, leave this check box 

cleared.) 

 
Can edit QuickAccess Panel: (For future use) Select this check box to allow the user to edit the 

QuickAccess panel. 

 
 

9. Click Save to save the user definition. 
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Security Setup 
Access groups in PrintSmith Vision control which PrintSmith Vision commands or features members of an access 

group can use. When you define your users, you assign each user to an access group.  

 

1. After you define your security access groups, you must define your PrintSmith Vision users. Select Settings 

> Admin > Security Setup 
 

 
 

2. Access groups in PrintSmith Vision control which PrintSmith Vision commands or features members of an 

access group can use. When you define your users, you assign each user to an access group. 
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Three access groups are pre-defined and cannot be changed in any way: 

• Owner – allows access to all PrintSmith Vision features and allows members of the group to create, modify, 

and delete access groups, as well as to manage users in all access groups. 

**Note PrintSmith Vision is shipped with an admin user who is part of the owner group. This admin user cannot 

be deleted by any other user, even other members of the owner group. The admin is a “super user.”  

• System Admin – allows access to all PrintSmith Vision features and allows members of the group to create 

access groups, modify access groups (except for the owner and system admin groups), and manage users in 

other access groups (except for the owner and system admin groups). 

• Minimum – allows access only to those commands needed to get in and out of PrintSmith Vision (Log In and 

Exit). 

 

Creating Access Group 

The access groups that you set up should allow users to perform their particular jobs  using PrintSmith Vision. For 

example, you may want one access group for users who work at the front counter and another access group for 

managers (although you may want to consider the system admin group for those managers who need access to 

the full system). 

1. Select + to create new access group 

2. Enter a name in the Access Group field and click OK. 

3. Select or clear check boxes in the Enabled column to make commands available or unavailable to members 

of the group. 

4. Click Save on the toolbar to save the group. You can now assign users to this group (Admin > User 

Definitions). 
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Record Locks 
PrintSmith Vision allows multiple activities to take place on the system at the same time. As a result, users who 
are working at the same time may try to change the same information. To prevent this from happening, 

PrintSmith Vision locks records when certain events occur, for example, when a user is changing information.  

 
If a record is locked, and you try to open it, PrintSmith Vision informs you that the record is already in use and 

identifies the login name of the person who has the record open. When the other us er finishes work on the 

record, it is unlocked and becomes available to other users. Typically, the time a record is locked is so short that 

you are not aware of it. At times, however, records may be locked for longer periods. For example,  

 
• When a document is opened, it remains locked until the document window is closed. 

• When a pickup is being processed in the cash register, both the invoice being picked up and the 

associated account are locked until the process is complete. 

 
If a record is left locked accidentally (typically because a user closed the browser window without logging off) or 

is left locked for some other reason, you can unlock the record if you have permission to do so. ( Typically, this is 

a task performed by an administrator.) 

 

1. Select Profile > Record Locks. Record Locks makes locked records available to users again 
 

 
 

2. For Unlock locked records of, select Currently logged in user (yourself), User name, or All users. If you 

selected User name, enter the name of the user. 
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Change Password 

Access to PrintSmith Vision 

All users must log into PrintSmith Vision. As part of setup, you must define a login account (user name  and 

password) for each PrintSmith Vision user and decide which PrintSmith Vision features should be ava ilable to 

the user. You do this by assigning users to a security access group for the work they perform.  

Before you start defining PrintSmith Vision users, you should establish yourself as the administrator and change 

the admin password supplied by EFI. You should also prevent access to PrintSmith Vision without a password/  

Changing Password 

As administrator, you control access to PrintSmith Vision for all users. PrintSmith Vision is shipped with a pre-

defined admin user, designed to be used by the main sys tem administrator at your company. As a first step in 

establishing security, you should change the admin password (EFI provides an initial password).  

 
 

1. Select your profile then click My Profile. 
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2. Then select Edit. You can update general information and Change your password. 

 
 

3. A pop-up screen will appear and will allow you to update your password. 
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Fold Template 
EFI supplies a set of standard graphics for folding styles. You can change the names of these graphics, 

provide additional descriptions, and make them unavailable for selection by users if they do not apply to 

your business. 

 
1. Select Settings > Admin > Fold Template 

 

 
2. By default, all the fold graphics are active (available as selections to users), but if you have no need of a 

particular graphic, select it and clear the Active check box. 

 
To provide more information about a fold graphic (for example, to provide some instructions), select the 

pencil icon and enter the information in the Description field.  
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3. You can also print this data by selecting the printer icon. 
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Paper Template 
 

If you find that you use the same layouts for many of your jobs, create templates for them to avoid having to 

make the same selections in the Paper Calculator window each time you create a job with the same layout. 

 
1. Select Settings > Admin > Paper Template. 

 
 
 

2. To create a new template, click New. The Paper Calculator window opens so you can provide the 

information about the template. 
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To change the number of columns displayed, enter a different number in the Grid Columns field. For example, if 

you enter 4, 4 templates are displayed in each row. 

To locate particular templates, enter your search criteria such as the Min and Max values for Finish Size or Run 

Size. PrintSmith Vision then displays just the templates that meet the values you entered. To display all the 

templates again, click Clear Search. 

To edit a template, double-click it (or select it and click Edit). The template opens in the Paper Calculator 

window. 

 
3. Make your changes and click Save New Template. 
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Change Price 
Sometimes you may want to adjust your prices either up or down. For example, changed market conditions may 

require you to be more competitive through lower prices or increased costs may require higher prices so you are 

still making a profit. 

 

Instead of adjusting the prices of items one-by-one, you can do the following: 

 
• Change prices for all stocks or for selected stocks. 

• Change prices for all press definitions, digital definitions, charges (including price lists), and/or list price schedules. 

 
 

1. Accessing Change price can be done multiple ways and the option is available throughout PrintSmith 

Vision. For example, one way it can be done is by selecting Pricing> Press Definition. 
 

 
 

2. Select Change Price. 
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3. Then you will select your percentage. Whenever you select the change price option it will inform you what 

will be affect. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. When completed select Ok. 

 

Updating Stock Prices 

Instead of individually adjusting stock prices, you can change prices for all stocks, a group of stocks, stocks from 

a particular vendor, or stocks with prices older than a certain date. You can also control how the stock prices are 

changed: by manually entering a new price for each stock, automatically updating the stocks by a percentage, or 

automatically updating the stocks by adding a fixed amount to the price.  

 
1. Select Pricing > Stock Definition 
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2. Select a stock then click Change Prices. If you want to enter a new price for each selected stock manually 

by selecting Enter each stock price or you can update all stock price at once by selecting Auto update 

stock(s). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. If you want to enter a new price for each selected stock manually by selecting Enter each stock price. 

 
4. If you want to update all stock price at once select Auto update stock(s). 
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Post POS Charges 
When you charge small jobs to a customer account in the Cash Register, these POS charges accumulate in a 

merchandise charge balance for the account. PrintSmith Vision tracks these charge transactions separately to 

avoid cluttering up the account history with many small transactions. The merchandise charge balance is part of 

the account balance and is considered a taxable receipt, but is not a normal receivable, and cannot be paid until 

you post the POS charges. 

 
EFI recommends that once a month, before generating regular statements, you post the entire balance of 

these POS charges to Accounts Receivable as a single entry. Once posted, these charges can be billed on a 

statement, and can be paid just like any other open item. 

1. Select Accounting > AR > Post POS Charges 

 

2. Select or clear the following check boxes: 
Preview before posting: Select this check box if you want to review the details of the POS charges account 

by account. If the check box is cleared, the POS charges are automatically posted to an account, and 

PrintSmith Vision proceeds to the next account without stopping 

Print statements: Select this check box to generate a statement for each account with an outstanding 

POS charge balance. This statement uses the same format as specified by AR > Generate Statements. 

The statement, however, is only for POS charges, and cannot be rerun.  

Print summary report: Select this check box to generate a summary report of the POS charges that were 

posted. 
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Deposit Ticket 
 

 
1. To print a deposit ticket after a closeout is done, Select Account> AR> Closeout. 

 

 
2. Then Select a report. 
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3. Once selected you will be able to print Deposit Ticket. You can also select multiple deposit tickets in the 

Deposit Ticket window. 
 

 

 
4. Your report will then generate. 
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System Monitor 
PrintSmith Vision includes some features to help you monitor your system, for example, to check “user even ts” 

such as successful logins or failed login attempts, or to check for locked records (and unlock them). 

 
The System Monitor window includes the following buttons:  

• Record Locks makes locked records available to users again. 

• Sessions lets you see how many users are connected to the system. 

• Statistics lets you see how many records of various types (e.g., stock definitions) are in your system. 

 

Record Lock 

PrintSmith Vision allows multiple activities to take place on the system at the same time. As a result, users who 

are working at the same time may try to change the same information. To prevent this from happening, 

PrintSmith Vision locks records when certain events occur, for example, when a user is changing information.  

If a record is locked, and you try to open it, PrintSmith Vision informs you that the record is already in use and 

identifies the login name of the person who has the record open. When the other user finishes work on the 

record, it is unlocked and becomes available to other users. Typically, the time a record is locked is so short that 

you are not aware of it. At times, however, records may be locked for longer periods. For example, 

• When a document is opened, it remains locked until the document window is closed. 

• When a pickup is being processed in the cash register, both the invoice being picked up and the 

associated account are locked until the process is complete. 

If a record is left locked accidentally (typically because a user closed the browser window without logging off) or 

is left locked for some other reason, you can unlock the record if you have permission to do so. (Typically, this is 

a task performed by an administrator.) 

 
1. Select Pending Document then choose an invoice and select the Document No. 
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2. Select Profile > Record Lock. 
 

 
3. For Unlock locked records of, select Currently logged in user (yourself), User name, or All users. If you 

selected User name, enter the name of the user. Click Unlock Records. 
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Sessions 

Whenever someone logs into PrintSmith Vision, a user session is established. You can see the maximum 

number of user sessions allowed (based on your license), the number of currently active sessions , and the 

names of the users who are currently logged in along with the IP address (of the user’s  computer), the time th e 

user logged in, and the time the user last performed an activity.  

In addition to reviewing the active sessions, you can terminate a session. For example, if someone closes the 

browser without logging out, or a browser crashes, you may run out of licens es because the session for that user 

is still active. In this case you can end a session to free up a license. 

 
1. Select Settings > System Monitor > User Sessions. 

 

 
 

2. The user names of all logged in users are listed. If you need to terminate a user session (perhaps because 

you notice that person is logged in multiple times), select that session and click Terminate. 
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User Events 

You can track actions such as logins and logouts, failed logins, and password changes. Failed logins, for 

example, could indicate an unauthorized user was trying to use the system. 

 
1. Select Settings > System Monitor > User Events. 

 
 

 
2. The System Monitor window now lists activities such as logins, failed lo gins, and password changes by date 

and time and user name. You can also import CSV to get a detailed report. 
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E-Mail Status 

When you e-mail statements or e-mail posted invoices from the Cash Register or Post Payments window, the 

sent e-mail is automatically logged in System Monitor. 

 
1. Select Settings > System Monitor > Email Status. 

 
2. E-mails are identified by Type: Statements, Post Payments, or Cash Register. For statements, the Item 

Number and Description columns identify the number and name of the customer account; for posted 

invoices e-mailed from the Cash Register or Post Payments window, the Item Number and Description 

columns identify the number and description of the invoice. 

 



Account Ranking Report |  343
3 

 

 

 

Import Customers 

Import Customers lets you import customers, prospects, or contacts. As the result of an import, new contacts 

are created. If you re-import previously imported contacts, they are updated if any information changed.  

 
1. Select Accounting > AR > Contacts. 

 

 

 
2. Select Import Contact. 
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3. To import contact information successfully, your import file must be in the correct format. Follow these 

guidelines: 

 
• The import file must be a comma-delimited (CSV) text file. You may have your contact data stored in an 

application that can export data into a CSV file. Otherwise, you can create a CSV file using Microsoft Excel. 

 
• For fields to be mapped correctly, they must be in the correct order (see below). 

 
• If information is not available for a particular field, leave it blank in the import file. (Otherwise, data will shift 
over to the wrong field.) 

 
You can download template by Selecting Sample CSV Template. 

 

 
4. Once completed you will select Upload Files.
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5. You can review contact information at any time. To do so you must first find and open the contact. Select 

Accounting > AR > Contacts. 

Scroll through the list of contacts to find a contact. If you have many contacts, narrow down the 
list of contacts that are displayed by filtering. 

 
 
 

6. You can also update an existing customer by updating your previous CSV file and selecting 

the Update Customer in the import setting. 
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Notes The Backup Manager preferences apply only to customer-hosted installations of PrintSmith Vision; 

if PrintSmith Vision is EFI-hosted, backups are performed for you automatically. 

Security permissions control who can set up automated backups and/or perform backups manually. 

Note EFI recommends configuring Backup Manager on the computer where the PrintSmith Vision server 

resides. 

 

 

Backup Manager Preferences 
 

Use the Backup Manager preferences to schedule daily backups of your PrintSmith Vision system or to perform a 

backup right away (manually). 
 

EFI strongly recommends that you back up your entire PrintSmith Vision system regularly to avoid losing data 
critical to your business if a system failure (such as a hard disk crash) or some other disaster occurs. Always  

back up the data to an external device or take advantage of a cloud-based backup service. 

When you use Backup Manager, the following are backed up: 

• The PrintSmith Vision database. 

• The Scheduler database if you are licensed to use Scheduler. 

• All standard (EFI-supplied) and custom reports (including estimate and invoice reports). 

• The DigitalAssetsRepository folder that contains all the content files that were uploaded for jobs. 

• The ReportScheduleRepository folder that contains all the scheduled reports that were generated. 
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Note You must manually enter the path to an existing folder. 

Note For more information on finding the path to a folder on a Macintosh computer, see “Tips for Mac 
Users”. 

Note Do not enter time between 23:30 and 01:00 as the system performs internal maintenance during this 

period. 

Important   It is not recommended to store your backups on the same computer or the same drive where 
PrintSmith Vision resides. 

Set up Preferences for Automated and Manual Backups 

EFI recommends that you take advantage of automated backups to ensure that your backed up data is never 
more than a day old to minimize data loss. 

1. In PrintSmith Vision, navigate to Configuration > Preferences > Settings. 

2. Under the Security section, click Backup Manager. 

3. Select the Enable Automatic Backup Manager checkbox to schedule automated backups. 

4. In the Choose Backup Destination field, enter the full path to the folder where you want the backups to be 
stored.  

 
The following table shows examples of some directory and folder paths. 
System Type Path Description 

Windows D:\PrintSmith Backups 
 

To save the backups in a folder you 
already created, for example, PrintSmith 
Backups on the D:\ drive. 
 
Note This is an example for a single use 
backup only, and not recommended to be 
used for backups on continuous basis.  
 

Windows C:\Users\username\Desktop 
(where username is your Windows user 
name) 
 

To save the backups on the desktop. 
 
Note This is an example for a single use 
backup only, and not recommended to be 
used for backups on continuous basis.  
 

Windows E:\PrintSmith Backup To save the backups on external storage 
devices such as USB drive or external 
hard disk.  

Windows  \\servername\sharedfoldername 
 

To save the backups in a shared folder on 
a network drive. 

Mac 
(Macintosh) 

/Users/username/Desktop  
(where username is your user name)  
 

To save the backups on the desktop. 
Note This is an example for a single use 
backup only, and not recommended to be 

used for backups on continuous basis.  
 

Mac 
(Macintosh) 

/Users/username/Documents  
(where username is your user name) 
 

To save the backups in the Documents 
folder. 
Note This is an example for a single use 
backup only, and not recommended to be 
used for backups on continuous basis.  
 

Mac 
(Macintosh) 

//servername/sharedfoldername To save the backups in a shared folder on 
a network drive. 

 

5. Click Perform Backup Now to manually backup your data. 

• If you do not want to automate your backups, you can back up your data manually at any time. You can 
also back up data manually even if you do automated backups. 

6. Enter the time when the backup should occur automatically in the Time of day to Backup field. 

• By default, backup will occur at 23:00 (11:00 PM) daily. 
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Note The Number of Backups to keep applies only to automated backups, not for manual ones. You must 

delete manual backups when you no longer need them. 

Notes The shared folder can be in the same work group or a different workgroup. In either case, Username 

and Password are required. 

 Typically, the Username and Password would be the admin credentials for the computer where the 

folder resides (not your user credentials. 
If the network folder is not found when you try to do a backup, enter the domain and try again. 

 

7. Enter the number of backups that you want to store in the Number of Backups to keep field. 

• By default, the system keeps 7 backups in the backup destination folder that you specified. 

When the total number of backups reaches the number you specify, the system automatically 
deletes the oldest backup. If your database is very large, you may want to limit the number of 
backups to save on the disk space. 

 

8. In the Warning Before Backup field, enter time in seconds when logged in users are to be warned of a backup 
before the scheduled time.  

• Backup Scheduled for displays the date and time when the next automatic backup is scheduled. 

• Last Backup Performed displays the date and time when the last automatic backup was performed. 

9. In the Network Folder Access User Details section, enter the login credentials to access the network 
folder. 

• If you have specified a shared network folder in the Choose Backup Destination field, you must have 
read/write or full control access to the network folder.  

• Enter the Domain. 

• Enter the network Username and Password. 

• To backup PrintSmith Vision to a network folder on a Windows system, you must enable the SMB 1.0 
file sharing support protocol on the networked machine. To enable the SMB1.0 file share protocol, do 
the following: 

• Open the Control Panel window.  

• Click Programs > Programs and Features > Turn Windows features on and off.  

• Scroll down to SMB 1.0/CIFS File Sharing Support and click the checkbox.  

• Click the expand folder icon () a ) and verify the following options are enabled: 

o SMB 1.0/CIFS Automatic Renewal 

o SMB 1.0/CIFS Client 

o SMB 1.0/CIFS Server 

• Click OK.  
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Important It is recommended to store your backups on an external storage device or a different drive other than 

where PrintSmith Vision resides.  

 If the backup destination folder is on the same computer where PrintSmith Vision resides, always 

copy the backups to an external device, or take advantage of a cloud-based backup service. 

Otherwise, if the hard disk crashes, you will lose your backups along with your data. 

 

 

10. Click Save on the Backup Manager window. 

 

Tips for Mac Users 

If you are not sure how to specify the path to the folder where you want your backups to be saved on your Mac system, 
do the following: 

1. On your Mac, click Finder and right-click the backups folder to display the context menu. 

2. While in the context (right-click) menu, press and hold down the Option key to see the Copy “folder name” 
as Pathname option; it replaces the standard Copy option. 
Example: For a folder named PSV Backup on an external storage device, you will see the context menu as 
shown in the figure below. 

3. Click the Copy “folder name” as Pathname to copy the full path of the folder. 
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4. In PrintSmith Vision, click the Choose a Backup Destination field in the Backup Manager 
window and press COMMAND+V to paste the path.  

In the example above, you will see the destination path as /Volumes/name_of_drive/PSV Backup. 

 

What happens to users during a backup? 
If a user is logged into PrintSmith Vision when a backup begins, a window opens with the following warning message: 

 
 
If a user tries to log into PrintSmith Vision when a backup is taking place, the user is prevented from logging in and the 
following message is displayed: 

 
 

Locate Backed up Data 
For each backup (automated or manual), the system creates a folder in the backup destination folder that you specified. 

• For automated backups, the folder name is: PrintSmithDataBackup_Auto_date 

Example: PrintSmithDataBackup_Auto_05252021 for the backup that took place on May 25, 2021. 

• For manual backups, the folder name is: PrintSmithDataBackup_Manual_date  

Example: PrintSmithDataBackup_Manual_05262021 for    the backup that took place on May 26, 2021. 
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Notes If more than one backup takes place on the same day, a number is added as a suffix to the folder name. 
For example: PrintSmithDataBackup_Auto_date_1, PrintSmithDataBackup_Auto_date_2, and so on. 

The Number of Backups to keep setting controls the number of automatic backup folders to be 
retained. Older backup folders are automatically deleted. Manual backup folders are not tracked or 

limited – you must delete them manually. 

Important If the PrintSmith Data Backup folders reside on the same computer where PrintSmith Vision resides, 

always copy the backup to an external device, or take advantage of a cloud-based backup service. 

Otherwise, if the hard disk crashes, you will lose your backups along with your data. 

 

Each PrintSmithDataBackup folder includes the following: 

• The backed-up PrintSmith Vision database: printsmith_db_date.backup. 
Example: printsmith_db_05272021.backup for a backup performed on May 27, 2021 

• The backed-up Scheduler database (if using Scheduler): scheduler_db_date.backup.  
Example: scheduler_db_05272021.backup for a backup performed on May 27, 2021  

• A PrintSmith Reports\Crystalclear Reports 12.1\invoiceRepository folder with your document 
formats (invoices and estimates). 

• A PrintSmith Reports\Crystalclear Reports 12.1\reportRepository folder with all your reports 
(standard and custom). 

• A DigitalAssetsRepository folder with the content files (digital assets) used for jobs. 

• A ReportScheduleRepository folder with all scheduled reports that were generated (if you use Report 
Manager to schedule custom reports). 

 




